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Introduction

The Manitou Operator Workstation is the center of alarm processing for a Central Station.
From the Operator Workstation, Operators can handle alarms, enter customer information, set
up Dealers, run reports, among many other operations. 

Screen Overview

Manitou contains a very helpful User Interface.  Instead of memorizing keystroke patterns and
having to toggle between separate screens to take one action or another; Manitou offers a
Graphical User Interface (GUI).  An Operator can access alarms, create new customers, edit
existing customers and view log information without the necessity of closing one item to view
another.

Manitou contains a three-frame interface that eases and speeds navigation.  This three-frame
interface includes the following:
· Navigator/Note Pad
· Status
· Application View

Each of the three frames has a specific use.  Using all three frames in concert with one another
speeds up the transaction processes in a Central Station. The three-frame interface allows the
user to view the maximum amount of data in a minimum amount of space. Note the three
frames in the picture below: the Navigator, the Application and the Status area.



Screen Overview 15

© 2009 Bold Technologies Ltd.

Notice the push pins  on the upper right corner of each frame.  These push pins allow
users with lower resolution screens to maximize their use of Manitou and prevent scrolling

from right to left often.  Simply click the pushpin so it changes to the turned pin  and
move the mouse away from that frame.  The frame then scrolls away. 

To bring back the frame, hover the mouse over the left edge of the application to get the
Navigator back, the lower edge to get the Status bar back and the right edge to get the
Customer navigator back, then click the pushpin to "secure" the frame back into place.

The bottom portion of the application contains the Status Bar or Status Pane.  This shows the
current status of the Operator's monitored alarms and Broadcast messages.  

The alarm counts show the Operator which items need attention within the Manitou Alarm
Queue, and how many alarms are new, suspended, deferred or actioned.  The Broadcast
Messages share important information with the entire Operator group.  These Broadcast
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messages offer three importance levels;  green  - generic information, amber  - needs attention
soon,  red  - needs immediate action.  
 
The colors that help manage the system are White, Amber and Red.  The colors are based on
the age of the oldest alarm in the queue.  If the oldest alarm is less than 60 seconds old (in
most cases) the counts and the graphics will remain white.  After 60 seconds, the counts and
the graphics change to amber this shows the oldest alarm in the queue is now at warning
levels 1 and 2.  After 90 seconds, the counts and graphics change to red showing the oldest
alarm has reached the critical warning levels of 3 and 4.

Toolbar

Users have the option to utilize the quick-launch toolbar in the Operator Workstation. This
toolbar is located directly under the menus in the upper quadrant of the screen. Hovering the
mouse over each button will display its function.

Add or Remove a Toolbar Button

Users have the option to Add or Remove Toolbar buttons and may customize the Toolbar
display. This function is unique to each user. Once the user saves his or her toolbar, it will
load each time the user logs in to the Operator Workstation. 

Add or Remove buttons
1. Open the Operator Workstation.

2. Locate the arrow next to a Toolbar button.

3. Click on the arrow to bring up the Add or Remove Buttons box.

4. Click on the Add or Remove Buttons box.

5. To Remove a button, click on the check mark next to the button.

6. To Add a button, click to the left of the button. A check mark will appear, indicating the
button will be added to the Toolbar. 

Customize the Toolbar

Users may customize the toolbar to his or her liking and may do so quickly by opening the
Customize Toolbar window and select or deselect the desired toolbar buttons. 

1. Open the Customize Toolbar window by clicking on the arrow next to a toolbar button or
by right-clicking anywhere on the toolbar. 

Right-click on the Toolbar to bring up the Toolbar list. 
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2. Select Customize from the list. The Customize Toolbar window will appear:

The Toolbars tab will appear by default. The Toolbars tab lists all toolbar buttons currently
displayed. Checking or un-checking next to a toolbar name will add or remove it from the
toolbar. For example, un-checking the File toolbar removes the Save and Print buttons from
the Toolbar. 

The Tools Tab allows users to click, drag and drop tools buttons to the toolbar.  The Tools are
divided into categories and contain a brief description when highlighted and clicking on the
Description button. 
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The Options Tab lists customizable options available to each user. Users may choose to have
the toolbar display recently used tools first, show menus after a short delay, use large icons,
show the name of the button when hovering the mouse pointer over the button, show shortcut
keys or change the animation features for the menus. 

Toolbars Tab

The Toolbars Tab is used primarily for adding, renaming and deleting sections to the Quick-
Launch toolbar. Each Toolbar listed in the directory are created by default and contain default
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buttons. For example, the File portion of the toolbar may contain the Print or Save buttons:

Add a New Toolbar Button

1. Click on the New button located in the Toolbars Tab. 

2. Enter a name for the new Toolbar.
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3. Click OK. The new toolbar section will appear on the Quick-Launch Toolbar. 

4. Select the Tools Tab.

5. Select a category.

6. Select a tool from the Tools list. 

7. Click and drag the desired tool to the new toolbar button.

8. When finished adding new tools, click Close to close the customization box. 

Rename a Toolbar

1. Open the Customize Toolbar window by right-clicking anywhere on the toolbar. 

2. Select Customize from the list. The Customize Toolbar window will appear.

3. Select the Toolbar to be renamed from the Toolbars list. 
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4. Click on the Rename button. A Rename box will appear:

5. Click OK. The Toolbar is now renamed. 

Delete a Toolbar

1. Open the Customize Toolbar window by right-clicking anywhere on the toolbar. 

2. Select Customize from the list. The Customize Toolbar window will appear.

3. Select the Toolbar to be deleted from the Toolbars list. 

4. Click the Delete button. A Delete dialogue box will appear: 

5. Click OK to confirm the delete. The toolbar and its components are now deleted. 

Options Tab

· Menus show recently used tools first
This option will order the menus by the most recently used functions. If the user wishes for
the menu to expand to show the full list after a short period of time, select the "Show Full
Menus after Short Delay" option. 

· Reset my usage data
Resetting the usage data will reset the most recently used functions to their default settings
and the menu will no longer show the most recently used tools first. 

· Large Icons
Selecting the Large icons option will enable the toolbar to display larger icons: 
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· Show ScreenTips on toolbars
Choosing the Show ScreenTips on toolbars option will display the function of a button when
hovering the mouse pointer over a particular button:

· Show shortcut keys in ScreenTips
When the Show ScreenTips option is selected, the Show shortcut keys in ScreenTips option
will be enabled. Selecting this option will display the shortcut keys command when the
ScreenTips appear while hovering the mouse pointer over a specific button. 

· Menu animations
The menu animations function changes the display feature of the file menus. For example, the
FadeIn option will cause the menu display to fade into displaying the full menu. 

Tools Tab

The Tools Tab function is used to drag and drop various tools to the Quick-Launch Toolbar.
Tools are divided into appropriate categories and contain brief descriptions. 
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Add a Button to the Toolbar
1. Under the Tools tab, Select a category.

2. Select a tool from the Tools list. 

3. Click and drag the desired tool to the new toolbar button.

4. When finished adding new tools, click Close to close the customization box. 

File Menu

The following options are accessible from the File menu:

· New
· Open
· Close
· Close all
· Save
· Edit
· Delete
· Print
· Properties
· Change Password
· Lock Station
· Logout
· Exit

New

The new command is a convenient way to create a new record of the 

The sub-menu currently allows any of the following record types to be created:

· Customer
· Dealer
· Branch
· Authority
· Agency
· Global Keyholder

On selection of a sub-menu option, Manitou will display a blank record to enable you to enter
details for the record.

For information on how to create specific records, please refer to the appropriate section of
this Reference Guide.
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Open

The Open command allows Operators to open a record of the type selected in the sub-menu
that appears when a user hovers the mouse over the Open option. 

The sub-menu command allows any of the following record types to be opened:

· Customer
· Dealer
· Branch
· Authority
· Agency
· Global Keyholder

On selection of a sub-menu option, Manitou will display a blank record to enable the Operator
to search for a specific record of the type selected.

Close

The Close command closes the current displayed record or form. For example, if an Operator
is updating data for a Customer, the Operator may choose the close command to close the
form once the data is updated. Upon selecting this command, a prompt will appear, asking the
user to save changes before closing. Click Yes. 

Close All

The Close All command will close all currently opened records listed in the Current section
of the Manitou Navigator. If changes have been made to any of the currently opened records
and have not been saved, Manitou will prompt the user to save changes before closing the
form. This action may be especially useful if the Operator wishes to close a batch of records
previously accessed during a session instead of closing each record individually. 

Save

The Save and Save As commands save changes that the Supervisor has made to the currently
displayed record. Both  functions be found by clicking on the File Menu, then Save or Save
As. The option to "Save" or Save As will appear grayed out unless the current record has been
edited. This command is also found by clicking on the Save icon located in the quick-launch
toolbar. 

Edit

Accessing the Edit command in the File menu by clicking on File, then Edit, will allow the
user to edit the currently displayed record. This command can also be found in a record or



File Menu 25

© 2009 Bold Technologies Ltd.

form.

Delete

The Delete command will delete the currently displayed record. This command is only
available if the current user has authorized access to delete records. The delete button located
on the quick launch toolbar also provides the same function.

Delete a Record
1. Click on the File drop-down menu.
2. Select Delete.
3. A box prompting the user to confirm the delete request will appear. 
4. If prompted, enter the user password.

Note: Deleting a record is a permanent action and cannot be reversed. 

Print

Printing the current displayed record:

1. Click on the File Menu.
2. Select Print.
3. In the print dialogue box, select the appropriate printer.

Print Dialogue Box

4. Click on the Entire Form radio button to print the entire form, or
5. Click on the Active Form radio button to print the current page. 
6. Click OK to begin printing.

Properties

The Properties command enables the user to configure certain behaviors of the Operator
Workstation. This configuration is user-specific, meaning only the currently logged on user
will be affected by configuration. 

1. Click on the File Menu.

2. Select Properties.

3. Check the appropriate for configuration in the Operator Workstation Properties box.

Operator Workstation Properties
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Descriptions of Configuration Properties
· Enable Debugging Mode. This option should be used only if instructed by Bold support

personnel. This function is used as a diagnostic tool for system problems. This option will
automatically de-select on logging out of the Operator Workstation. Please refer to the
Configuration Parameters chapter in the Supervisor Workstation manual to set the box to
stay checked upon logout from the Operator workstation.

· Use Internal RTF Viewer. This option enables reports to be viewed without using
Microsoft Word or Microsoft WordPad. Most users should check this option so that reports
are formatted correctly. 

· Select All on Get Focus. This function is currently not available.

· Show Access Permissions change dialog - Check this box to allow the Client to display a
dialog upon permissions changing for any user.

Change Password

Periodically, users may wish to change their password for the Supervisor Workstation. This
enables a more secure environment and it is recommended to change the password every 4
months. 

Change a Password
Note: When the Change Password option is selected, the password is being changed for the
user currently logged in to Supervisor Workstation.

1. Click on the File menu.

2. Select Change Password. A Change Password window will appear:
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3. Enter the current password for the user currently logged into the system.

4. Enter the new password.

5. Confirm the  new password.

6. Click OK.

Tips for changing a password
It is recommended that any password have the following criteria:

· At least 8 characters long;
· A mixture of upper case, lower case letters, digits and punctuation;
· Do not use a common dictionary word, name string of numbers, or the Manitou login ID. 

Lock Station

The Lock Station command will temporarily disable the operation of the workstation,
preventing it from being accessed by an unauthorized user. 

1. Click on the File drop-down menu.

2. Select Lock Station.

A password dialogue box is displayed and the session is now locked. When locked, the
current display will remain active and can be viewed, but keyboard and mouse input will be
ignored.

Locked Session
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Enter the password to unlock the session.

Logout

The Logout command will log a user out of the Operator Workstation at the end of a session.
Once selected, the user will be prompted to confirm the request. Any open records will then
be closed. If records have been modified but not saved, Manitou will prompt the user to save
the changes to the record before continuing. Click Yes to save changes, or No to discard any
changes.

To cancel the logout process, click on the Cancel button when prompted to confirm the logout
request. 

Exit

Clicking on the Exit command will log the user out of the Operator Workstation, as well as
close the Client.  The Exit command is different than the Log Out command in that it does not
provide a log on dialogue box in the Windows desktop to enable a user to log in again. 

Once the Exit command is confirmed, any currently opened records will be closed. If the
records have been modified and not yet been saved, Manitou will prompt the user to save
changes before exiting. 

If the Exit command is selected by accident, click on the Cancel button to cancel the
command.

View Menu

From the View Menu, users may display several windows:

· Navigator
· Status
· Event Maps
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Navigator

The Operator Workstation Navigator is similar to the Navigator in the Supervisor
Workstation. It provides a convenient means of quickly displaying forms and records that
have recently been viewed. 

The Navigator command will toggle the display of the Manitou Navigation Frame box. This
command is a default command and will automatically be displayed when logging into
Operator Workstation.

Display Navigator Window
1. Click on the View menu.

2. Select Navigator.

When selected, the Navigation Frame will be located on the left hand side of the display.
Users may also display the Navigator window by pressing F2 on the keyboard. 

Navigator Window
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Tab Views
The Navigator Frame also provides access to the Operator’s Notes and the Instant Messaging
function (if enabled for use). These additional facilities are accessible by means of the tabs
located at the base of the Navigator.

Other Navigator Window Options

Wrap Text
The Wrap Text option allows the user the choice to wrap text in the main Navigator window
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by adding a second line on which text appears in the Navigator. This function does not affect
any other text displays in Notepad or the Instant Message function.

Wrapped Text

Unwrapped Text

Pin Navigator Window
The Pin Window option allows users to hide the Navigator window by clicking on the
pushpin icon. To display the Navigator window again, click on the View menu, then select
Navigator.  

Operator Notepad

The Notepad function provides a way to store and display personal notes, reminders and
appointments. Information in the notepad is not shared or accessible by other users. 

Display the Notepad
1. Open the Navigator window.

2. Click on the Notes tab located at the bottom of the window.

This feature can also be accessed by pressing F3 on the keyboard. 

Notepad
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Initially, the Notepad for the current day will be displayed. 

Change Display Dates

1. Open the Notes tab in the Navigator window.

2. Click on the drop-down arrow located in the upper left portion of the window. The current

date is circled in red. 

3. Select the appropriate date to display by clicking on the date. 

4. If dates other than the current month need to be displayed. click on the left or right arrows
next to the month to display the appropriate month. 

5. Once the date is selected, use the scroll buttons to view entries for a specific time. 
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Add a Notepad Entry

1. To add a Notepad entry, such as an appointment or reminder, find the appropriate date in
the Notepad.

2. Double-click on the appropriate time. The Enter Note window will appear:

 

3. Enter the note, appointment or reminder in the Enter Note window. The Description is used
a title for the note. 

4. Enter the reminder by adding minutes to the Remind Minutes Before box.

5. When finished, save the note by clicking OK. 

View and Edit an Entry

1. To view a previously saved note, select the date.

2. Double-click on the note.

Users may now edit the note description as desired. 

Set Reminders

Users can set a reminder for Manitou to alert the user when an entry is due. Reminders are
displayed as the deadline arises or when the user next logs in to the Supervisor Workstation.

Receiving and Acknowledging Reminder Alarms
If a reminder has been set, a reminder pop-up window will be presented to the user at the
specified time. 
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The reminder pop-up provides details of the note or reminder and the due time. To
acknowledge the reminder, click the OK button. This action also removes the dialogue box
from the screen, as well as the note from the Notepad. 

Display a list of Entries

To display a list of all future notes that have been entered into the Notepad, click on the
Manage button located at the top right corner of the Notepad window. This will display the
Manage Notes window.

In the Manage Notes window, users may mass delete notes by checking the Delete box next to
the appropriate note. Select OK to confirm the delete. 
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Delete an Entry

1. Display the list of Notepad entries by clicking on the Manage button, located at the top

right of the Notepad window. 

2. Locate the entry to be deleted from the Notepad.

3. Check the Delete box next to the appropriate entry.

4. Click OK.

Instant Message

The Instant Messaging function provides online users (users who are currently logged in to
Supervisor Workstation or the Manitou Operator Client) with the means and sending and
receiving internal messages. This function makes use of Manitou's local or wide area
networking infrastructure.

To select Instant Messaging (IM), click on the IM tab located at the bottom of the Notepad
window, or press F7 on the keyboard. 

To Send a Message to a User or Group of Users
1.  Select the recipient(s) by clicking on the user's name or the group of users from the
Online/Offline users window.

2.  Position the mouse cursor into the Typed Messages Area and enter the text of the
message. 

3.  Click the Send button or hit Enter on the keyboard.

The message will now be transmitted to the selected user or group of users. A copy of the
message will also appear in the Received Messages Window. Messages, unless marked
private, will also appear in the Message Banner of the Status Bar.  
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Online/Offline Users
When the Instant Messaging function is selected, the IM window displays a Users Tree which
contains a list of all users that are currently online. The tree also lists users who are currently
offline. Messages can only be sent to users who are online, as Manitou cannot store messages
for later delivery to users when they next log in.

Received Messages Window
Below the Online/Offline Users is the Received Messages window. This window displays the
text of each message as it is received, as well as the sender's name.  

Typed Messages Area
To type a message to an online user, use the Typed Messages window to enter the text of the
message to be sent. 
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Note: Dealer-restricted users may only see and instant message other users who have first
instant messaged with them.

Message Options

The following options may be selected prior to transmitting the message:

· Auto-Switch to Last Sender - When checked, the IM will direct any new messages to the
sender of the last received message. This provides a "conversation mode" option whereby
replies can be sent without it first being necessary to select the recipient from the online
users list.

· Show on Banner - When checked, the IM will display the message in the Alerts Message
window. 

· Low Priority - For non-private messages, the message is displayed at recipient’s
workstations with a green background.

· Medium Priority - For non-private messages, the message is displayed at the recipient's
workstation with a yellow background. 

· High Priority - For non-private messages, the message will be displayed with a red
background.

· Erase Button - When clicked, will clear the Received Messages Window. 

· Send Button - The Send button sends the text held in the Typed Messages Area to the

selected user or group. 

· Emoticon Button - This function allows the user to add an emotion icon to a message prior

to transmission.  

Status

The Status view will toggle the display of the Manitou Status Bar. When selected, the
Manitou Status Bar will appear at the bottom of the Manitou screen and provides a summary
display, showing current alarm information. Additionally, any current system messages are
displayed in the scrolling message banner, located at the bottom of the Status bar. 
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By clicking on the  button located next to the total message counts, users can expand or
collapse the status portion of the window. When collapsed, the status section will only show
the message banner with the current message displayed. When expanded, users will see the
entire status section, including the alarm count, message banner, and signal actions.

Below the Message Banner, users can change the time zone by simply clicking on the down
arrow to bring up a list of time zones. Selecting a different time zone will automatically
change the time associated with receiving alarms and signals. 

By clicking on the  button located next to the Message Banner, users can pull up old
events and signals that have been received by Manitou. 

Clicking on the  button located next to the Message Banner will speed up the process of
scrolling Watchdog messages,  while clicking on the Clear button will clear the messages in
the Message Banner. 

Alarm Count

The Alarm Count displays the current total number of alarms in the Alarm Queue. The
alarms are separated by priority number. For priorities one through nine, Manitou displays the
number of each alarm for each different priority. For alarms with a priority of 10 and above, a
single total is displayed. 

When a new alarm is received, the number displayed in the counter will flash. The
information displayed is also color coded to reflect the status of the alarm. Please refer to the
Alarm Queue section for a description of alarm color codes. 

· Suspended Alarms - Alarms that are currently suspended by Operators. 

· New Alarms - The number of new alarms that have not yet been viewed or actioned by
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Operators.

· Viewed Alarms - The number of alarms that have been viewed.

· Actioned Alarms - The number of alarms in which at least one action pattern item has been
executed. 

Note: All count information relates to the monitoring group to which the current user belongs
and not to the system as a whole (unless all users share a single monitoring group).

Message Banner

The Message Banner displays important system-generated messages, including
housekeeping, operational broadcast, and non-private instant messages sent within the
monitoring group. Messages will scroll from left to right across the banner area. Messages are
also color coded to indicate priority and/or severity. 

· Green indicates "general information."
· Yellow indicates "priority."
· Red indications "critical."

Message Banner Button

Message Display - Displays a list of all messages currently held in the banner queue.  

Counter - Displays the number of messages currently held in the banner queue. 

Clear - Clears the current message from the banner line.

 To stop messages from scrolling across the message banner area, simply
right-click on a message and then select "Don’t Scroll Messages." 

Event Maps

Displaying the Event Maps will provide a table with definitions of Event Codes as used
within the Manitou system. For a full explanation on how to set up Event Codes and Event
Maps, please refer to the Supervisor Workstation Manual.

Operators may use this feature to view a "plain English" definition of any Event Code that
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might appear in a Manitou screen. This function is particularly useful to identify codes that
are less frequently encountered. 

Event Maps is a read-only display. Users may select a Protocol from the Protocol format list
and view Event Maps associated with that particular Protocol. 

Tools Menu

From the Tools menu, users can access a list of logs, generate manual signals, change
customer IDs and use the Phone Dialer. 

System Log

The System Log provides users with details of Operator login and logout activity. Users can
also view activities with the Report Server, Publisher, and Watchdog Messages. 

Open the System Log
1. Go to the Tools Menu.
2. Select System Log.

The screen will display the current day's activities up to 300 entries. If more than 300 entries
are available, the More button, located next to the Refresh button, will be enabled. Clicking
on the More button will display additional entries. 
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Search and Filter Log

Users may base activity searches on specific filters, such as:

· Categories
· Activities corresponding to a particular Operator (user initials)
· Specific period of time or time zone
· Qualifier

To access filter options, click on the Filter tab located at the bottom of the window next to the
Logs tab. 

Filter Window
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Date and Time Searches

Date and Time parameters can be set using the drop down boxes in the date and time area of
the filter display. 

Search for a Date and/or Time
1. To restrict the search results to a certain date or time, select the date and/or time from the

drop-down calendar. 
2. Check the "Time Range" box.
3. Click on the Search button.

Exclude a Date and/or Time
1. Select the date or time to be excluded in the search.
2. Check the "Except Time" box.
3. Click on the Search button. 

Reverse Search Results
The Reverse check box is by default checked. This will display the most recent activity at the
top of the list. To list the oldest activity first, uncheck the Reverse box. 

Time Zone Searches

Central stations which have operations spanning several time zones may wish to use the Time
Zone search to search for activity in a certain time zone. Any Daylight Savings time settings
are automatically updated by the Manitou system clock. 

Other Searches

Users may also specify certain types of activity, qualifiers or Operators in the search criteria. 

Selecting a Category will change the options listed in the Qualifier drop-down menu. For
example, selecting the Report Scheduler in Category yields a single option of "Messages" in
the Qualifier drop-down menu. However, selecting User Messages in the Category menu
gives the user "Broadcast," "User" or "User Group" search options in the Qualifier menu. 

Users can also search for a specific Operator's activity by entering the Operator's initials into
the User Initials field. 

To exclude a certain search criteria, check the Except checkbox next to the search field. 

Raw Data Log

The Raw Data Log displays details of all alarms and other signals received by Manitou from
the alarm receivers connected to the system. The data is displayed in the original format as
received by the Front End Processors (FEPs). The Raw Data Log is primarily used for
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diagnostic purposes, but can be useful in the event that it is necessary to trace a particular
signal or group of signals from a particular customer. 

Initially, all raw data received by FEP 1 during the current date is displayed. Up to 300 entries
will be displayed and may be viewed by scrolling up and down using the scroll bar. In the
event that more than 300 records are available, the More button will be enabled. Clicking on
the More button will display additional entries. 
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Date and Time Searches

Date and Time parameters can be set using the drop down boxes in the date and time area of
the filter display. 

Search for a Date and/or Time
1. To restrict the search results to a certain date or time, select the date and/or time from the

drop-down calendar. 
2. Check the "Time Range" box.
3. Click on the Search button.

Reverse Search Results
The Reverse check box is by default checked. This will display the most recent activity at the
top of the list. To list the oldest activity first, uncheck the Reverse box. 

FEP List

A FEP list similar to the Navigator window appears to the left of the log display. This window
lists all FEPs and the corresponding receivers (REC) and enables the user to determine the
source of data displayed from all available raw data acquired by the system. Criteria may be
as broad as an individual FEP or as narrowed down as a specific receiver line (RL). To select
a parameter for a raw data search, simply click on the appropriate FEP, receiver or receiver
line. 

Users may only search with one parameter at a time. For example, only one FEP may be
selected for a search; users may not select both FEPs for a search.  

Time Zone Searches

Central stations which have operations spanning several time zones may wish to use the Time
Zone search to search for activity in a certain time zone. Any Daylight Savings time settings
are automatically updated by the Manitou system clock. 

Receiver Line Prefix and TX ID Searches

Users may specify a particular Receiver Line Prefix or a Transmitter ID (TX ID) to search for
in the raw data. Select the Receiver Line Prefix from the pre-populated drop-down menu, or
enter the Transmitter ID into the text field. Click the Search button to execute the search. 

Manual Signal

The Manual Signal function enables a user to send a simulated signal to Manitou of an alarm
or event as though the signal had actually been received from a customer or other external
source. A Manual Signal is most often used for testing Manitou's response to various types of
signals, event programming and alarm handling. Manual Signal can also be used to manually
enter and record an event that has been reported to the Central Station via a phone call or
following the observation of an event on a CCTV monitor. The Central Station supervisor
will inform the Operator of specific procedures that may apply to the Central Station
concerning the use of Manual Signal under such circumstances. 
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Select the Manual Signal function by first clicking on the Tools menu and selecting "Manual
Signal." The Manual Signal form will appear:

1. To begin generating a Manual Signal, first enter the Customer ID into the Customer ID
field. If the Customer ID is not known, click on the magnifying glass to search for the
Customer ID. Once it is located, click Load to load the Customer ID. The name of the
customer will automatically fill into the Name field.

2. Once the Customer ID is loaded, the Transmitters for that account will also load. Select the
appropriate Transmitter to use by clicking on the Transmitter in the Transmitters form.

3. Specify the Date and Time for the Manual Signal. If the current time is to be used, select
"Use Current Time." Use the "Specify Time" option to change the time stamp to a past
time when sending the manual signal. This option has no affect if is changed to a future
time. Users may only backdate the time in the specify time option for there to be any affect
on the manual signal.

4. In the Manual Signals form, ensure the correct Monitoring Group is entered. 

5. Click in the Event cell to bring up the drop-down arrow. 

6. Select the Event from the drop-down menu. The Description of the Event will
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automatically load into the Description field.

7. If the Event should be in a specific Area, select that Area from the drop-down menu.

8. If the Event should occur in a specific Zone, select the Zone from the drop-down menu.

9. When the selections have been made, click on the Send Signal button at the bottom of the
form, or hit F5 on the keyboard. Manitou will confirm that the signal has been sent and the
Event will appear in the Alarm Queue as though it had been generated directly by the
customer's equipment. In the customer logs, it will be identified as a manually generated
signal. 

FEP Manual Signal

The FEP Manual Signal tab allows manual signals to be sent through the FEP for testing and
troubleshooting purposes.

1. Select the FEP number from the FEP No: drop-down menu.

2. Select a Receiver number.

3. Enter the timeout (in seconds).

4. Enter a signal to send to the FEP.

5. Click Send Signal or hit F5 on the keyboard. The signal will now be sent to the FEP.

Customer Logs

The Customer Logs form in the Manual Signal window displays the Customer's recent
activity. It is used as a quick way to view the Manual Signal once it has been generated and
received by Manitou. Once it is received, the Manual Signal will appear in the log. To refresh
the log view, simply click on the Refresh button located above the logs. 
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Change Customer ID

The Change Customer ID function provides the ability to quickly change the customer ID
(or contract number) of an existing customer without creating a new account.
1. Select the Tools option from the menu at the top of any Manitou screen.

2. Within the drop-down menu select Change Customer ID. The Change Customer Contract
No. screen will display:

3. If the Customer ID is known, enter it into the Customer ID field. If the ID is unknown,
click on the magnifying glass next to the Customer ID field to search for the customer. The
Find Customer screen will display:

4. Within the Search Criteria section of the screen, select a Search Key from the drop-down
menu and enter in a Value. If search values are unknown, enter an asterisk (*) into the
search field. 

5. Click the Search button. Customers that meet the search criteria will display under the
Search Results area of the screen

6. Search the list of customers and click on the customer name. 

7. Click the Load button. The Change Customer Contract No. screen will display with the
selected customers ID and name.

8. To change the Customer Contract Number/Customer ID, enter in the new customer ID into
the New Customer ID field at the bottom of the Change Customer Contract No. screen.

9. Click the Change button.

10.Verify the password and click OK.

11.Confirm the Customer ID change by clicking OK on the Confirm Customer ID change
box.
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If the New Customer ID number was not successfully changed, an error screen will appear.
Press the OK button and the Change Customer Contract No. screen will display. Enter in a
different New Customer ID and press the Change button. Possible errors may be caused by
not entering in a unique customer ID or if an alarm is queued for the customer.

Phone Dialer

If Manitou is connected to the phone system at the Central Station, Operators may use the 
Phone Dialer (also called the Auto-Dialer) function to call a contact manually by entering
and then dialing the phone number using the Auto-Dialer keypad. The Auto-Dialer function is
also used when executing certain types of Action Patterns in alarm handling. Further
information on using the Auto-Dialer during alarm handling can be found in the Alarm
Handling section of this manual. Please note that if the dialer is not configured, the dialog will
not attempt to auto-dial. The Auto-Dialer can be configured by clicking on the "Config"
button located in the top portion of the form.

1. Open the Phone Dialer by first selecting the Tools menu, and then selecting Phone Dialer.
The Phone Dialer will appear:

2. Enter the phone number of the contact using the numeric keys displayed in the Phone
Dialer window. Users may either use the number keypad on the keyboard or click on the
actual number buttons to enter the phone number. The number currently being entered will
appear in the number field of the call status window.

3. Once the phone number is entered, click on Dial. Note: Do not hit Enter on the keyboard to
dial the call, as this will close out the Phone Dialer. 
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The phone number will now be dialed as entered. The status of the call and its duration are
displayed in the call status window.

4. Once the call is completed, click on the Finish button. The call will be terminated and the
line disconnected. If finished using the Phone Dialer, hit enter or click on the Finish button
to close the Phone Dialer.

Note: Clicking the "Dial" button will log the call in the customer log, but the user will not be
able to hang up until the Finish button is clicked, which will then force a hang up.

Dealer Takeover

Dealer Takeover allows one Dealer to take over all of the customers (and sub-Dealers) of
another Dealer. If successful, the taken-over Dealer will be deleted. Information such as
transmitter types allowed, control panels allowed, and reverse protocols will be moved to the
inheriting Dealer. If the inheriting Dealer does not have a system account and the taken-over
Dealer does, the inheriting Dealer will inherit the system account. If both Dealers have a
system account, the take-over Dealer’s system account will simply be deleted. However, the
last week of alarm and signal activity will be copied to the inheriting Dealer’s system account.
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In order for Dealer Takeover to be active, the correct permissions must first be set up in the
Supervisor Workstation profiles. In the Supervisor Workstation, select Maintenance > Setup
> Permissions. From here, determine what profiles (Administrator, Operator, etc.) should be
allowed to utilize Dealer Takeover. Set the permissions to Visible/Enabled, and save the
changes. Note: Users must log out and log back in to the Operator Workstation in order for
changes to take place. 

Back in the Operator Workstation, select Dealer Takeover from the Tools menu. The Dealer
Takeover form will appear: 

Enter the user's password, and press Enter. This will enable the user to search for source and
destination Dealers. 

Select the Source Dealer (the Dealer that is being taken over). Then, select the Destination
Dealer (the Dealer that is taking over the inactive Dealer's accounts). 
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Click the Takeover button to begin taking over the Source Dealer's accounts. A warning
will appear: 

Click OK to continue the takeover. 

Verify Password

Password verification is found easiest by clicking on the Tools menu and selecting "Verify
Password." The Password Verification button is enabled when there is a customer context in
the following forms:

· Customer
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· Manual Signal
· Paged Contacts
· Pre-cancel
· Temporary Comments
· Temporary Schedule

Note: In the alarm form, this triggers the Actions > Validate Password menu item.

Users may also utilize the Question/Answer mode as an alternative to having to provide a
password.  Only customer contacts, agencies, and agency contacts are allowed to have
questions; this means that the question mode is only enabled for the Customer (Keyholder),
Technician, Agency, and Unknown verification options. This is displayed in the log as
“VERIFICATION – Customer Question Answered Correctly”. The new Verify Password
toolbar button is also enabled when there is an entity loaded on the Agency, Branch,
Company, Dealer, and Global Keyholder forms, allowing the operator to directly validate
these entities’ contacts as well.

Customers that appear on other customers' contact lists can now be validated in the Verify
Password dialog, either via their general/duress passwords or the passwords of their contacts. 
They may also now have their own set of access permissions and valid date ranges, which are
merged with those of their contacts, similar to what is already done for Agency contacts.

Operations Menu

The Operations Menu contains all functions and actions for alarm handling, including
viewing the Alarm Queue, setting up temporary schedules, and putting the system into
Disaster Mode. 

Alarm Handling

From the Alarm Handling screen, the Operator can process an alarm using pre-programmed
action patterns as well as additional information, such as contact lists or special notes for an
account. Though the Alarm Handling screen is accessible from the Operations menu, it is
more likely that the Operator will access the Alarm Handling screen from the Alarm Queue
by double-clicking on an alarm that enters the Alarm Queue. 

There are two ways to access the Alarm Handling screen:

1. If an alarm becomes available in the Alarm Queue, Operators can double-click on the
alarm, which will bring them tot he Alarm Handling.

2. Operators may bring up the Alarm Handling screen by clicking on the Operations menu and
selecting Alarm Handling. 
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Note: If an alarm becomes available while viewing the Alarm Handling screen, a pop-up
window alerting the user of the new alarm will appear. To accept the alarm, click Yes. The
alarm information will be presented on the Alarm Handling screen. 

Normal Alarm Handling Screen

Alarm Handling Screen when Alarm is Displayed
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By storing information about Customers, Dealers, Authorities, Call Lists, Action Patterns,
Receivers, Transmitters and Signal Programming, Manitou is able to provide crucial
information in the Alarm Handling screen. This enables Operators to handle alarms efficiently
while providing the system with enough data to automate alarm processing. 

There are several ways Manitou and Operators can handle alarms. For example, Manitou can
automatically run Action Patterns when a specific alarm is received into Manitou. However,
many other types of alarms require Operator action. While Manitou speeds up the processing
of these alarms by displaying pertinent information, ultimately alarm handling falls onto the
responsibility of the Operator. 

There are two main screens involved in Alarm Processing:

· Alarm Queue
· Alarm Handling screen

The Alarm Handling screen displays alarm and customer information, action patterns, a
customer activity log, and other informational pieces used to process alarms. As previously
mentioned, Operators can process alarms from the Alarm Queue. When an alarm is made
available (or a signal is received), it will appear in the Alarm Queue. For a further description
of the Alarm Queue, see the Operations: Alarm Queue section of this manual. 

Once an alarm or signal is received, Operators can manually select alarms by double-clicking
on the individual alarm. Note: The Operator Workstation may be set to Auto-Get alarms so
that available Operators automatically receive new alarms as they arrive. 
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Alarm Handling Options

When an alarm arrives in the Alarm Queue, the Operator has several options to handle the
alarm:

· Auto Get Alarms
· Defer
· Suspend
· Defer to Auto-Client
· Tracking
· Action Patterns

Auto Get Alarms

When this option is set and an alarm appears in the queue, the alarm is automatically
presented to the Operator if he or she is available. If the Operator is busy handling another
alarm, the next available Operator will receive the new alarm. 

1. To set Manitou to Auto Get Alarms, open the Alarm Handling screen, and click on the
Operations menu:

1. Select Alarm Handling Options. The Alarm Handling Options box will appear: 
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2. Check the Auto Get box under "Get Next Alarm." Auto Get Alarms is now set. 

Defer

If an alarm is presented to an Operator who cannot handle it at that time, the Operator may 
defer the alarm back to the Alarm Queue, making it available for other Operators to handle.
Select the Hold menu on the Alarm Handling screen:

Select Defer. The alarm will now be sent back to the Alarm Queue. This option is only
available when the Operator wishing to defer the alarm has already accepted the alarm from
the Alarm Queue.

Suspend

If a signal, such as a trouble restore is received and the Operator wishes to see if the signal
resolves itself, he or she may suspend the alarm for a number of seconds, minutes or hours. 

1. Click on the Hold menu in the Alarm Handling Screen. 
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2. Select Suspend. A Suspend Alarm window will appear: 

3. Enter the number of seconds, minutes or hours to suspend the alarm. If the alarm's priority
must change, set the alarm priority.

4. Click OK. The alarm will show as suspended in the Alarm Queue. 

Users may also choose to suspend the alarm until a specified date and time. Please note that
selecting this option will cause duplicate alarms to also be suspended until the set expiration
date. Additional duplicate alarms will not unsuspend the suspended alarm, as is the case with
the "Select interval" suspend option.

Defer to Auto-Client

When Defer to Auto-Client is chosen, this option sends the alarm to be processed by the
Auto Client application based on pre-configured rules and handling procedures. Select
Auto-Client by first selecting the Hold menu, then selecting "Defer to Auto-Client." 

Confirm the defer. The alarm will now be handled by Auto-Client. 

Tracking

The Tracking form enables an Operator to direct all alarms for a particular customer to the
Operator for a period of time. For more information on tracking, see the Operations: Tracking
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section of this manual. 

Action Patterns

Typically, Action Patterns are most often used to handle alarms. For more information on
action patterns, see the Operations: Process an Alarm section of this manual. 

Alarm Handling Menus

When displayed, the Alarm Handling screen contains several menus located at the top of the
screen. These menus can be used to process and complete alarm handling. The menus can be
accessed either by clicking directly on the menu to display available menu options or by using
keystrokes. Underlined letters indicate available keystrokes for each menu. Using keystrokes
may speed up the alarm handling process. 

Operations Menu

· Paged Contacts - Displays a list of all individuals paged regarding the current alarm on the
Alarm Handling screen. 

· Pre-Cancel - Allows the Operator to enter Pre-Cancel information from the alarm record.
For more information on Pre-Canceling alarms, see the Operations: Pre-Cancel section of
this manual. 

· Tracking - Operators can track alarms for specific customers. For more information on
alarm tracking, see the Operations: Tracking section of this manual.

· On Test - Occasionally, it may be necessary to place an account out of service from the
Alarm handling screen. Selecting On Test will bring the Operator to the On Test screen,
where On Test information can be entered. For instructions on placing accounts out of
service, see the Operations: On Test section of this manual. 

· Alarm Handling Options - Selecting Alarm Handling Options will bring up the Options
window, allowing the Operator to set preferences for th e way alarms are presented in
Manitou. These settings should be based on Central Station needs and preferences. 

o In the Get Alarm Type section, select the option most appropriate for the Central
Station. If the Operator should only receive new alarms, select "New Alarms." If the
Operator can access Viewed alarms (which includes suspended and deferred
alarms), select "Viewed." If the Operator can access both, select "Both." 

o If the Central Station requires available Operators to take and process alarms
immediately, check the Auto-Get Alarms checkbox. This forces Operators to handle
alarms as quickly as possible after the signals arrive in the Alarm Queue.

Service Menu

This function is not yet available. 
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Actions Menu

· Do - The Do command (also accessed by typing "d" on the keyboard) initiates processing
the selected item in Action Patterns. This command also opens the prompt or dialer window
associated with that action. Selecting "Do" a second time will proceed with the action. After
the action item has been completed, the Do command may be used to record
return-communications from the customer. 

· Action - The Action command ("a" on the keyboard), opens the Actions drop-down menu.
Clicking Actions again will proceed with the action on the open Action Pattern item, such
as dialing the phone, sending a page, etc. If an action needs to be performed again after
completion, the Action command can be used again. For example, if a customer needs to be
called again, click "a" or "Action" to re-action the item. 

· Ignore - The Ignore command ("i" on the keyboard) allows the Operator to skip an action
item during alarm handling. The action will turn gray when ignored. 

· Call In - The Call In command ("c" on the keyboard) allows the Operator to indicate that a
contact called the Central Station. This will appear in an entry in the Customer Activity
Log. 

· View All Contacts - The View All Contacts command (or "v"on the keyboard) is used to
change the view from the Action Pattern to the entire list of the customer's contacts. 

· Validate Customer Password - This command ("p" on the keyboard) brings up the
password validation screen. The customer or contact must give the name and password, and
it should be entered into the validation form. Enter any pertinent notes and click OK to
close the form and continue handling the alarm. Additionally, some action items may
automatically bring up the password validation screen. 

· Add Comment - The Add Comment command ("m" on the keyboard) can be used to enter
a comment about the current alarm. The comment will be logged into the Customer Activity
Log with the rest of the alarm activity information.

· Add Temporary Comment - This command ("t" on the keyboard) is used to enter a
temporary comment for the customer record. Indicate the duration of the temporary
comment using the date and time fields. The temporary comment will appear in the notes
tab of any further alarms for the customer during the duration set for the comment. 

· Reverse - Use the Reverse command ("r" on the keyboard) in connection with the Reverse
Channel command. This allows the Operator to send a signal from Manitou to the
transmitter to test communication.

· View Customer - The View Customer command ("v" on the keyboard) will open the
customer record for viewing only.
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· Edit Customer - This command ("e" on the keyboard) will open the customer record for
viewing and editing. 

· Add Temporary Schedule - This option ("s" on the keyboard) will add a temporary
schedule to the customer. Selecting this option will bring the user to the Temporary
Schedule screen. See the Operations: Temporary Schedule section of this manual for more
information on setting up temporary schedules. 

Hold Menu

· Defer - This command returns the open alarm to the Alarm Queue to be handled by the next
available Operator

· Suspend - The Suspend command puts the open alarm on hold but unavailable to other
Operators.

· Defer to Auto-Client- This command sends the alarm to the processed by the Auto Client
application based on pre-configured ruls and handling procedures. 

Finish Menu

· Close - This command ("c" on the keyboard) should be used after all actions in the action
pattern have been completed. 

· Operator Cancel - The Operator Cancel command ("o" on the keyboard) will cancel an
alarm. This command may be used, for example, if an engineer sends a test signal from a
customer site. Enter a resolution code and pertinent notes regarding why the alarm was
canceled. 

· Customer Cancel - This command ("c" on the keyboard) will cancel an alarm if the
customer calls to say the alarm was false. 

· Forward - This command allows the Operator to forward the alarm to another specified
Operator rather than deferring the alarm back to the Alarm Queue or suspending the alarm. 

Process an Alarm
1. When an alarm appears in the Alarm Queue, double-click on the alarm to open the Alarm

Handling screen. The Alarm Handling screen shows the customer's current status in the
upper right corner. 

2. In the Action pattern area, launch the first action. If necessary, Operators can ignore a
particular action by right-clicking on the action line and selecting "ignore."

There are three ways to launch the action:
· Press the ‘d’ key on the keyboard (for “do”)
· Use the mouse to select ‘Do’ from the tool bar. 
· Double-click the first line of the action pattern.
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3. Choose one of these three items to launch the first action.

4. Depending on the type of action, another screen may appear, such as a prompt window
with notes or the Auto-Dialer, showing the phone number being dialed by the Auto-Dialer
feature.

5. Click through each action and complete all list of items.

6. To close the alarm, click finish at the top right of the application view, and select the type
of alarm to close from the list. 

7. Enter any comments that may be pertinent to the alarm into the comments window. 

8. Select the appropriate resolution code (or codes) from the drop-down lists.

9. If prompted, enter the Operator or Customer password and validate the password. 

10.Click OK to close the alarm

Note: If the system is set to forced alarm handling the next available alarm will appear for the
Operator to process. If not, return to the Alarm Queue and select the next alarm in the Queue. 

Example: Processing a Fire Alarm

1. Select the fire alarm from the Alarm Queue.

2. Double-click on the first action in the Action Pattern. The first action is "contact customer
using Call List Customer Fire." Double-clicking on this action opens a sub-list with three
actions:

· Contact Customer
· Contact Fire Department
· Contact Primary Keyholder

3. Double-click on the first action (Contact Customer) opens the Auto-Dialer, dialing out to
make the first contact. The customer tells the Operator that the Fire Alarm signal was a
false alarm, and gives the password to validate this information

4. Click Finish to close the Auto-Dialer.

5. Enter the customer's password into the Validate field.

6. Enter comments into the comment field.
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7. Check the boxes for Cancel Alarm and Close Alarm.

8. Use the drop-down fields to select a Resolution Code (in this case, "FA" for False Alarm."

9. Click Validate. The alarm has now been processed and closed. All comments are entered
into the Customer Activity Log and the Operator is returned to the Alarm Handling screen. 

In situations where there are multiple contacts or actions to perform, each contact will be
handled similarly until every contact or action in the action pattern has been completed. If a
contact is unreachable, the Operator will note this before moving on to the next action. If
necessary, the Operator may use the View All Contacts button, located next to Action
Patterns, to select other contacts or get alternate numbers. 

If the alarm is not handled within the required time-out period (which varies for each alarm
type), Manitou will prompt the Operator that the alarm will be deferred. A deferred alarm
returns to the Alarm Queue and is forwarded to the next available Operator. An Operator who
is busy may choose to manually defer an alarm and allow another Operator to handle the
alarm. 

An Operator may also choose to suspend an alarm while performing other tasks. Selecting the
Hold menu and then selecting "Suspend" will bring up a dialogue box. Select the time period
to suspend the alarm. When that time expires, Manitou will prompt the Operator again to
handle the alarm. 

Maintenance Issues While Handling Alarms
If in the event an unresolved maintenance issue displays when handling the alarm, users may
close the maintenance issue dialog by pressing the "Esc" key, or by clicking OK.

Processing Different Types of Action Pattern

The Action Pattern is the main processing center for handling alarms. When handling alarms,
it will be necessary to handle specific Action Patterns based on the alarm that arrives in the
system. 

· Keyholder Contact Action Patterns - Some contacts in the Action Pattern on an alarm
may be Keyholders for the account. This Action Pattern is is handled exactly like regular
contacts. With the action highlighted, double-click on the Keyholder. The Auto-Dialer will
appear. Click Dial to initiate the call. When the action is completed and a resolution has
been validated, close the alarm.

· Authorities Action Patterns - If an action pattern involves contacting an Authority, it is
required to enter whether the Authority has been Dispatched or Not Dispatched. Click on
the appropriate button.

· Dealer Contact Action Patterns - Handling Dealer Contact Action Patterns is the exact
same as any other action pattern with the exception that Dealer Action Patterns are
configured to be specific to the Dealer record. When a Dealer is associated with a customer
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record, the Dealer Action Pattern becomes available to associate with event types in that
customer record.

· Branch Action Patterns - Handling Branch Action Patterns is the exact same as any other
action pattern with the exception that Branch Action Patterns are configured to be specific
to the Branch record. When a Branch is associated with a customer record, the Branch
Action Pattern becomes available to associate with event types in that customer record. 

· Log Action Patterns - A Log Action Pattern does not require that calls be made or any
Authority be dispatched. It simply shows up as part of the Action Pattern on an alarm and is
entered into the Customer Activity Log. It does not require any specific attention or action. 

Retransmission

Retransmission is the act of forwarding alarm information to a receiver through a Manitou
action pattern utilizing the FEP.  The receiver may then forward this information to interested
authorities, persons, agencies, etc.  In the following examples, the Bold XML receiver driver
is illustrated since it does not enforce any validation for reverse commands; what it gets, is
what it sends.  Retransmission commands, however, are not limited to the Bold XML driver.

Service Provider Devices

The service provider device links a contact point to the reverse command for transmission. 
This is done in the Supervisor Workstation under  Maintenance à Setup à Service Provide
Devices.
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The following values are required:
· Protocol:  this must be set to ‘R’ (Retransmission).
· Reverse Protocol:  this defines the type of reverse command requested, which

identifies the actual commands available.
· Reverse Command:  the reverse command to be transmitted.
· Reverse Route:  the location of the FEP driver to use.

Output Device Types

The output device type facilitates the retransmission contact point setup to link to a service
provider device.  Furthermore, it can tie a default script message if a script message is not
linked to a specific contact point.  This is done in the Supervisor Workstation:  Maintenance 
à Setup à Output Device Types.

The following values are required:
· Attribute:  this must be set to ‘R’ (Retransmission).
· Type:  this must be set to ‘R’ (Retransmission).
· Protocol:  this must be set to ‘R’ (Retransmission).
· Service Code Required:  this must be set to facilitate linking a contact point to a

service provider device.

The following value is optional:
· Script Message:  defines a default script message for transmission.  Note:  the

associated reverse command must include the script message as a parameter in order
for the script message to be sent.
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Reverse Commands

The reverse command specifies the data to send, as well as, the protocol, or format, the data is
in so that receiver will understand it.  To set up a reverse command, go to the Operator
Workstation and select Maintenance à Monitoring Company – Reverse Commands.

Value descriptions:
· Type:   this is the protocol type.  Bold XML, in this case.
· Group:  retransmission commands do not specify a group.
· Command:  this is any command mnemonic understood by the receiver to identify the

request.  ALM for this example.
· Description:  a meaningful description of the command
· User Group:  defines what class of user (and above) have access to the command
· Response Type:  currently, all FEP reverse commands are asynchronous (delayed)
· Response Delay:  defines the number of seconds the FEP should wait for a response to

the command from the receiver until it considers it timed out.
· Command Level:  must set to Customer.
· Command Detail:  determines how specific the reverse channel route needs to be to

send the command
· Availability:  retransmission is for alarms only, so Alarm Only must be checked.
· Attributes:  Retransmission must be checked.
· Optional Parameters:  many optional parameters may be included.  The Contact Point
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and Script Message database parameters are illustrated since they can only be used in
conjunction with a retransmission command.
o Contact Point:  this is the contact point associated with the retransmission (may

point to a pager, email address, etc)
o Script Message:  this is the script message attached to the contact point, or the

default script message attached to the output device type.

Contact Point

Retransmission contact points may be added directly for a customer, customer persons, etc. 
When adding the contact point, select the retransmission contact point type set up in the
Supervisor Workstation.  Retransmission contact points must be set up using the Contact
Point Properties dialog.

The following values are required:
· Output Device Type:  output device type set up in the Supervisor Workstation
· Service Provider:  service provider device set up in the Supervisor Workstation
· Retransmission Point:  pager number, email address, etc.  This links to the Contact

Point reverse command database parameter.

The following value is optional:
· Script:  script message to include in the transmission.  This links to the Script Message

reverse command database parameter.

Sending Retransmission

During alarm handling, the retransmission may be incorporated into an action pattern by using
the contact point as part of a contact action.  Additionally, actioning the contact point in the
View All Contacts tree will also send the retransmission.

Alarm Queue

The Alarm Queue is a display of all incoming signals received and processed by Manitou.
The color of the background and text of each alarm represents its priority and status as well,
as displayed to the right, above the queue. This display is often set to the default display. Each
alarm that is received in the system will initially appear on this screen. Operators can monitor
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and select alarms for handling from the Alarm Queue. The Queue also provides a filter
function that Operators may use to locate particular types of alarms currently in the Queue. 

Open the Alarm Queue by clicking on the Operations menu, and selecting Alarm Queue. The
Queue will appear: 

The Alarm Queue displays all the active alarms within the system.  The Alarms are
color-coded based on their age and type.  New alarms arrive with a white background and
black writing.  A serious alarm such as a Fire alarm is displayed in bright pink/purple with
white text.  After 1 minute the alarm status changes to Warning level 1 & 2 and the
background color changes to amber.  After 1 minute thirty seconds the status then changes to
Warning level 3 & 4 and the background color changes to red while the text changes to white.
Alarms should be acknowledged by this time.  Suspended alarms are displayed with a white
background and navy blue text.  If the alarm is unavailable the background is white with light
gray text.  An alarm may be unavailable for many reasons including that it is being handled by
another Operator.
 
If the Alarm Handling screen is set to Auto-Get Alarms (checkbox selection under Alarm
Handling>>Operations>>Alarm Options) the Operator, whenever available, will be presented
with each new alarm (new or viewed) automatically.  This situation is known as "forced alarm
handling".
 
If Manitou is not in "forced alarm handling" mode Operators may open and process alarms
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from the Alarm Queue or receive them automatically in the Alarm Handling Screen.  When
an alarm is available a prompt window will appear asking whether the Operator would like to
handle it.  Alternatively, double-clicking on any alarm in the queue opens it in Alarm
Handling.  There the call list, action patterns and various alarm details are displayed.
 
The buttons above the Alarm Queue may be used to display drop-down menus with different
options.  Those options are also available through keystrokes, as are the file menu options.
The difference between the keystrokes for the Alarm Queue drop-down lists, and the file
menu drop-down lists is that within the Alarm Queue you can just click the underlined letter
(without clicking the ALT key). Right-clicking some areas will pull up menus with the same
and/or additional options as file menus.
 
The Filter tab on the alarm queue allows an Operator to search through a large number of
queued alarms by criteria – alarm type, customer account, etc.
 
To select and handle an alarm, double-click on one of the items in the queue, or highlight the
alarm and click A (Action) then D (do).  This brings you into the Alarm Handling Screen. 

Each time an alarm is received, it will display in the Alarm Queue. The Alarm Queue displays
the following information:

· Time the alarm was received
· Priority level of the alarm
· Customer ID
· Customer name
· Code
· Event

If applicable, the Alarm Queue will also display information for:

· Area
· Zone
· User
· Availability
· Status
· Suspend Time
· RLP
· Transmitter ID (TXID)
· P/F/M
· Point ID

The Alarm Queue columns can be sorted by alarm time with the exception of the Actions,
Area, Zone and Point ID columns. 

Description of Alarm Information
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· Time - The date and time of the alarm's arrival in Manitou.

· Priority - The designated priority number assigned to the alarm.

· Contract Number - The contract number for the associate customer.

· Customer - The customer's name as entered in Manitou.

· Code - The Event Code is a two-letter code that is deciphered when a signal is received and
translated into the Manitou system. For example, a BA is a Burglary Alarm. This code may
appear in SIA format. 

· Event - The Event is a description of the signal received into the Manitou System . For
example, if a LO code is received, the description displayed is "Late-To-Open."

· More Activity - The More Activity column indicates if more activity has been received for
the customer since the alarm was last viewed by a user.  Users are further notified with a
dialog when opening an alarm that has had more activity, or when working an alarm when
the additional activity is received.  This flag is set to “Yes” when an alarm or signal is
received for the customer in question.  The flag is cleared (set to “No”) when a user
acknowledges the dialog notification.

· Area - A larger location, system or object than a Zone.  For example, the third floor of an
office building might be Area 3.  Within that area there might be multiple zones, each
having it’s own infrared detection device, or video camera. The area number is determined
in the Manitou Operator client when setting up a new customer. Typically, a residence will
only have one area. 

· Zone - An area, system or object that has some sort of detection device within it. Each area
is broken down into zones. The zones are determined and coded in the Operator Client
when setting up a new customer. Zones may refer to a specific room in a house, such as the
master bedroom or a certain window, or a specific business. 

· User - The Operator's initials that is handling the alarm. 

· Availability - The status of the alarm availability. For example, an alarm that is being
handled by an Operator will appear as "Unavailable." Available alarms will appear as
"Available." 

· Status - The Status refers to the current action that is taking place on the alarm. For
example, if an Operator is handling the alarm, the Status will display "Actioned." 

· Suspend Time - If an Operator chooses to suspend the alarm, the suspend time will display
in this field. 
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· Receiver Line Prefix - The receiver which has received the alarm is the Receiver Line
Prefix and will be displayed in this field. 

· TXID - The Transmitter ID which has processed the alarm is displayed in the TXID field. 

· P/F/M - Police/Fire/Medical. If an Authority has been dispatched for the alarm, the P/F/M
field will display "Yes." If an Authority has not been dispatched, the field will display "No."

· Point ID - The Point ID identifies the area in which the alarm is coming from. For example,
if the alarm on the back door of a house is set off, the Point ID will display "back door." 

Alarm Toolbar

The Alarm Toolbar is displayed along the top edge of the Queue. Buttons are made available
according to the action the Operator is taking, thus many buttons may be grayed out at certain
times. 

Operations
· Paged Contacts - The Paged Contacts function provides a list of any customers that have

recently been paged. 

· Pre-Cancel - The Pre-Cancel function provides a display of all alarms that have been
pre-canceled by an Operator. Pre-canceling an alarm requires instructions that any received
alarms from a particular customer be ignored. Note: There may be a period of up to ten
seconds after the timeout, where the following may occur: If a new alarm comes in for a
customer whose pre-cancel is expiring, within ten seconds of the expiration of the original
pre-cancel, a new pre-cancel may not be allowed. This is because the overdue checker
(which cleans up expired pre-cancel information from the database), only runs once every
ten seconds. In the very rare cases where an alarm comes in within the ten second period
following expiration of a pre-cancel timeout, a new pre-cancel will not be allowed to be
added.

· Review Pre-Cancel - This function allows the user to view any pre-cancels that have been
entered. 

· Tracking - Selecting the Tracking function will bring the user to the Tracking Setup form.
This allows the Operator to track or direct alarms for a specified customer for handling.
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This form can also be displayed by selecting the Operations menu and selecting "Alarm
Tracking."

· On Test – Selecting the On Test function will bring the user to the On Test form, which
enables the Operator to display any equipment that has been placed on test. From this form,
it is also possible to place equipment on test or bring it back into operation. 

· Alarm Handling Options –Selecting Alarm Handling Options will bring up the Options
window, allowing the Operator to set preferences for th e way alarms are presented in
Manitou. These settings should be based on Central Station needs and preferences. 

o In the Get Alarm Type section, select the option most appropriate for the Central
Station. If the Operator should only receive new alarms, select "New Alarms." If the
Operator can access Viewed alarms (which includes suspended and deferred
alarms), select "Viewed." If the Operator can access both, select "Both." 

o If the Central Station requires available Operators to take and process alarms
immediately, check the Auto-Get Alarms checkbox. This forces Operators to handle
alarms as quickly as possible after the signals arrive in the Alarm Queue.

Service
The functions under this button are not yet available.

Do
The Do button will allow the Operator to execute the current (top) action pattern item.
Clicking this button has the same effect as double-clicking the top action pattern item.

Actions
· Do - The Do function allows the Operator to execute the current (top) action pattern item.

This is identical to the function of the Do button described above.

· Action – This function allows the Operator to repeat the action pattern processing,
beginning with the first action pattern item in the sequence.

· Ignore – This function allows the Operator to omit the currently selected action pattern
item. 

· Call-in – The Call-in enables the Operator to create an entry in the customer’s log
indicating that a customer contact called the central station. 

· View All Contacts – This displays the complete list of contacts for this customer. This is
identical to selecting the "view all contacts" radio button displayed on the alarm handling
screen.
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· Validate Customer Password – Selecting this function will provide a form that enables the
Operator to validate a contact that has contacted the central station.

· Add Comment – This function allows the Operator to insert a comment into the customer
log.

· Add Temporary Comment – This function allows the Operator to insert a temporary note
into the notes for the customer. 

· Reverse – Provides access to any reverse channel commands that are available for use in
connection with the premises.  This is identical to selecting the Reverse Channel tab
displayed at the base of the alarm handling screen.

· View Customer – This allows the Operator to view the customer record.

· Edit Customer – This allows the Operator to view the customer record and edit the
information as required.

· Add Temporary Schedule – This function allows the Operator to add a temporary Open /
Close schedule for the customer. 

· Confirm Alarm – This function allows the Operator to confirm the alarm. This is required
when video or audio confirmation is used to verify that the alarm is genuine.

  
Hold
· Defer – This returns the alarm to the queue, making it accessible to another Operator for

processing.

· Suspend – This action returns the alarm to the queue, marked as suspended, for a period of
time specified by the Operator. It is also possible to program a priority change for the alarm
when the time expires.

Finish
· Close – This allows the Operator to close the alarm, usually after having taken appropriate

response actions via the alarm handling screen.

· Operator Cancel – This provides a way of cancelling the alarm without carrying out
response actions. This is useful in the case of various alarms generated, for example, as a
result of a known technical issue. A password will normally be required.

· Customer Cancel - This provides a way of cancelling the alarm without carrying out
response actions. This option differs from the previous one in that a record is made of a
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request by the customer to cancel the alarm, perhaps as a result of accidental triggering of
the alarm.

· Forward – not currently implemented.

Alarm Queue Filter

Users have the option to filter the alarm queue by specified criteria. This criteria is set by first
clicking on the Filter tab at the bottom of the Alarm Queue display:

Users can filter the alarm queue display by the following criteria:

· Postal Code
· Customer ID
· Priority Level
· Alarm Age (in minutes)
· Contacted Authority
· Event Category
· Dealer
· Branch
· Police
· Event Definition
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· Alarm Type

Once the search criteria has been selected, click the Select button to filter the alarm queue. As
a reminder, the currently selected filters are displayed in the Current Filter box under the
Filter tab:

To reset the filters, click the Reset button located next to the Select button. 

Back at the Alarm Queue screen, if a filter is currently on, the Filter On button will be green:

If there is no filter currently on, the button will be red. 

To remove the current filter, simply click the Remove Filter button.

Refresh

From time to time, the user may want to refresh the Alarm Queue to display any changes
made to alarms currently in the queue. To do so, simply click on the Refresh Queue button;
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however, the Alarm Queue will refresh automatically in a given timed interval.

Users also have the option to refresh the queue manually by selecting the Manual Refresh
button. This will only refresh the Alarm Queue if the Refresh Queue button is clicked. The
Alarm Queue will not refresh automatically.

When checked, a prompt will appear asking the user to confirm the request to manually
refresh the queue. Click Yes or No to confirm or disconfirm the request.

Monitoring Group

Users have the option to filter the Alarm Queue to display signals received that are sent to a
specific Monitoring Group. A Monitoring Group is used to distribute certain signals to
particular groups of Operators based on a set criteria. Initially, a default Monitoring Group of
0 will be set upon installation of Manitou software. Should no other Monitoring Groups be
added, no specific distribution of signals will be enabled.  Should Monitoring Groups be
added, certain customer records can be directed to a specific Monitoring Group, allowing
Operators using specific workstations belonging to that Monitoring Group will receive signals
from those customers. Thus, the Monitoring Groups are assigned to workstations and not
Operators. 

To filter the Alarm Queue by Monitoring Group, select the Monitoring Group from the
drop-down menu:

Color Codes

The Color Codes located on the Alarm Queue screen alert the user as to what priority level a
signal is when it is received into the Alarm Queue. For example, a Danger Level alarm may
be color coded red, while a warning level alarm may be color coded yellow. 

To change the color of alarm priorities, see the Tools: Options portion of the Supervisor
Workstation manual. 
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Select an Alarm from the Queue

To begin processing an alarm held in the Alarm Queue, move the mouse cursor into the line
containing the appropriate alarm.
Double-click on the alarm. This action will bring up the Alarm Handling screen and full
details of the selected alarm. Please refer to the section Operations menu: Alarm Handling for
further instructions on handling alarms. 

Pre-Cancel Alarms

The Pre-Cancel Alarms form allows the Operator to maintain a list of alarms that have been
pre-canceled following notification by a customer that an alarm has been generated
accidentally at the customer premises. For example, a customer calls to stay they were unable
to get to the alarm panel in time and the alarm has not yet arrived in the Alarm Queue. The
Operator can verify the customer's password, gather information about the alarm, and add the
alarm to the Pre-Cancel list. Once the alarm arrives and an Operator opens the alarm, he is
alerted that there is a Pre-Cancel for this alarm. The Operator can then make an informed
decision as to how to handle the alarm. The form columns can be sorted, with the exception of
the Time Called In, Comments and Instructions columns.

The Operator Client displays the tracking information on the Pre-Cancel form in a small grid
since multiple tracking entries may exist for a customer.  The grid will display all active
tracking for the loaded customer.

The Adopt Tracking button will attempt to adopt all tracking for the customer that the
operator is eligible for. It does not attempt to adopt a single tracking entry in the grid.
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Tracking

The Tracking form enables an Operator to direct all alarms for a particular customer to the
Operator for a period of time. For example, if an Operator is handling an alarm for ABC
Company and knows that the customer site will be sending periodic alarms or signals
throughout the day, the Operator can opt to track all alarm and signals received and handle
them accordingly. Once the alarm is handled, the Operator will be prompted to discontinue
tracking alarms for that customer. Selecting "No" means that future alarms from ABC
Company will be routed to the Operator until the Operator chooses to discontinue tracking or
the Operator logs out. 

The default time tracking is 30 minutes, but can be configurable within the Supervisor
Workstation. Once this time period expires, the tracking instructions will be canceled. 

The lower section of the form enables the Operator to display all alarms that are currently
tracked to him / her, to a particular monitoring group or within the system as a whole. The
Tracking screen is viewable at any time, but only editable while in Alarm Handling mode. 
While in Alarm Handling mode, an Operator may add to the list of tracked customer
accounts.  Automatic Tracking may be switched on by selecting Operations>>Tracking.  The
customer account in the alarm being handled by the Operator will also appear in the list of
Tracked accounts and does not need to be manually added.  
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Tracking Display

Alarms tracked to an Operator will appear in a similar fashion to previous versions of
Manitou, where tracking is displayed in the navigation toolbar.  All customer alarms will
display as usual, however, any alarms that the operator is ineligible to handle will display in
grey.  If the user clicks on a grey, or disabled, alarm, the client will not attempt to allocate that
alarm.

The Broker tracking structure included the priority range, as well as, the alarm state.  The
Operator Client displays this new information on the Alarm Tracking form.

If a priority value is omitted, this means that no limit applies. In the above example, the
Operator is tracking priority 3 through (no limit).  This display is consistent with the priority
range setup for Users in the Supervisor Workstation. See the Supervisor Workstation manual:
Users for more information on setting up the priority range.

All Sessions
If the All Sessions box is checked, the Alarm Tracking form will show tracking entries for the
current user from all current sessions. The user must be logged into Manitou from more than
one client in order to get more than one session at the same time. The user could be handling
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an alarm for more than one client, in which case, this would show the tracking for all of the
users's session.

Additionally, when exiting the Operator Workstation while in alarm handling mode (and
tracking alarms). The Operator will be prompted with "Would you like to keep your alarm
tracking?" If the Operator answers "yes," their tracking entries will be recovered when the
Client is run again within the timeout period specified in the MOptions. Previously in 1.5.0,
these limbo tracking entries are only recovered when using File > Logoff and logging back in,
instead of between separate runs of the Client. 

Add Tracking
1. Put the Operator Workstation into Alarm Handling mode by first selecting the Operations

menu.

2. Select Alarm Handling. The Operator may only edit items on the Tracking screen while in
Alarm Handling mode. Otherwise, this screen is information only. 

3. From the Operations button on the Alarm Handling screen, select Tracking to display the

Tracking screen. 

4. Enter the Customer ID or use the search icon to search for the Customer account and load

it from the search form.

5. Click the Add button to load the Customer account information into the Tracking list. 

6. Indicate the tracking type by selecting the appropriate radio button:

7. User (Operator) - The account will be tracked by  the Operator currently logged into the

Manitou system.

8. Monitoring Group

9. System - The account will be tracked by the Manitou system.

10.Once the tracking type is selected, the tracked account information will appear in the gride

below the tracking type area.

Adopt Tracking
1. To take over to tracking for another Operator, find the appropriate customer account in the

tracking list, and click on the Adopt button. 

Things to Remember
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An operator adopting tracking may not have the same level of permissions as the previous
operator.  As such, adopting tracking will behave as follows:

Priority:
· If the previous operator’s priority range matches the takeover operator’s priority range,

the entry is adopted.
· If the previous operator’s priority range does not match the new operator’s priority

range, but the new range fully encompasses the previous’ range, the entry is adopted
and the priority range is expanded (i.e., priority range 4-6 adopted by a user with range
2-7 – range becomes 2-7).

· If the two ranges do not match and the adopting range does not fully encompass the
previous, the original tracking is left as is.

Alarm State (phase):
· If the previous and adopting users’ alarm states match, the tracking entry is adopted.
· If the previous’ state is New or Viewed and the adopter’s state is Both, the entry is

adopted and the tracking alarm state is changed to Both.
· If the previous’ state is Both and the adopter’s state is New or Viewed, the entry is

adopted and the tracking alarm state is changed to New or Viewed (adopter’s value).
· If the Previous’ state is New or Viewed and the adopter’s state is also New or Viewed,

but they do not match (i.e., previous’ is New, adopter’s is Viewed), then the original
tracking is left as is.

Remove Tracking
1. To remove tracking, select the appropriate customer account by clicking on it. 

2. Click on the Remove button. A prompt will appear, asking the Operator to confirm the

removal. 

3. Click Yes. 

4. To remove all tracked accounts in the list, click on the Remove All button. Confirm the

removal. 

Reminder: Tracking expires at the end of the Operator's session, when the Operator logs out
of Manitou.

New Alarm Notification

All operators with tracking for a given customer will receive notifications that a new alarm is
available.  The Operator Client’s behavior will, however, is dictated by the user’s priority
range.

If an operator is handling an alarm, a higher priority alarm is received, and the operator is
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capable of handling that alarm, they are asked if they wish to defer the current alarm in favor
of the new alarm (same as previous to v1.5).

If the user chooses to defer in favor of the new alarm, the client will allocate the new alarm
before deferring the current.  This is done in case multiple operators are handling alarms for
the customer and are eligible to take the new alarm.  In this circumstance, a race condition
exists – the first operator wins – so we do not want the “losing” operator to defer their current
alarm if they can not get the new one.

Lastly, if the operator is not eligible to handle the newly received alarm because of their
priority range, they are still notified that a new alarm has occurred but they are not given the
option to handle it.

Michael Mohr

Concurrent Alarm Handling

When allocating an alarm, the Operator Client will notify the user if any other alarm handlers
are working alarms for the same customer.
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New Tracking Entry

The Broker will only create a new tracking entry if the alarm is not already covered by another
tracking entry. For example, consider two users:  A and B.  User A handles alarms of priority
4-7, where user B handlers alarm priorities of 1-5.  

User A is working a priority 4 alarm and has the customer tracked.  When user B allocates a
priority 5 alarm, no new tracking is created for user B since the priority 5 alarm is already
covered by user A’s priority range of 4-7.

Now consider user A working a priority 4 alarm with the customer tracked.  When user B
allocates a priority 2 alarm, a new tracking entry is created since priority 2 does not fall into
user A’s tracking range of 4-7.  In this case, both users are tracking the same customer (A for
alarm priorities 4-7, and user B for alarm priorities 1-5), and overlap occurs for priorities 4-5.

Alarm Tracking

The Broker tracking structure includes the priority range, as well as, the alarm state.  The
Operator Client displays this information on the Alarm Tracking form:

If a priority value is omitted, this means that no limit applies (see Priority Low in the above
image).  In the above example, user CBM is tracking priority 3 through <no limit>.  This
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display is consistent with the priority range setup for Users in the Supervisor Workstation.

Paged Contacts

The Paged Contacts screen allows an operator to view the contacts that have recently been
paged. From this screen an operator can also handle the alarm, send notifications to other
operators or remove the page from the list. Columns in the Paged Contacts form can be sorted
with the exception of Call Time and Pager Message. 

1. To view only the paged contacts for a specific account/customer enter the customer
identification number in the Customer ID field or select the magnifying glass next to the
Customer ID field. The Find Customer screen will display by clicking on the magnifying
glass.

2. When using the Find Customer lookup option, locate the Search Criteria section of the
Find Customer screen and select a Search Key from the drop-down menu and enter in a
Value. If you do not know what to search by select Customer ID for the Search Key 1 field
and enter an asterisk (*) for the Value field.

3. Once the search criteria is entered at the bottom of the Find Customer screen, press the
Search button. All of the customers that met the search criteria will display under the
Search Results area of the screen.

4. Search the list of customers and click on the customer name which will turn the row blue. 

5. At the bottom of the Find Customer screen press the Load button. The Find Customer
screen will close automatically and the Paging Contacts screen will display.

6. The list of pages for the customer will display.

7. To view all of the recent pages for every customer click the Clear button on the right side
of the Contact Name field.

8. The recent paged contacts will display in the table at the bottom of the Paging Contacts
screen. The Customer ID, Customer Name, Customer Address, Contact Name, Call Time,
Status, Alarm Status, User and Pager Message information are all included within the
screen.

9. The Handle button in the middle of the Paging Contacts screen will allow an operator to
select, handle and complete an alarm with a valid Alarm Status. The Handle button is
grayed out/unusable until the following steps are completed.

10.To select an alarm from within the paging list double click on the line with the desired
page. The Verify Password screen will display.

11.Validate the password and press the OK button. The Verify Password screen will close
automatically and the Paging Contacts screen will display.
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12.The Contact Information area at the top of the Paging Contact screen will automatically
populate with the Customer ID information.

13.To handle the alarm, click on the row with the contact name and information desired. The
Handle button will now be available.

14.Click on the Handle button to handle the alarm. 

15.The Paged Contact Call In screen will display. Fill in the Contact Name and Comment
field and click the OK button.

16.The Paging Contacts screen will be replaced with the Alarm Handing screen. The alarm
can be completed.

17.The Send Notification button in the middle of the Paging Contacts screen can be used to
notify other operators about an alarm.The [Send Notification] button will be grayed
out/unusable until the following events occur.

18.An alarm in the paging list at the bottom of the Paging Contacts screen must be at an
Unavailable Status and there has been no action on the alarm for a specified amount of
time.

19.The Send Notification button will become available only when these events have occurred.

20.Click the Send Notification button and the Paged Contact Call In screen will display.
Select the On Location or Clear button and type a comment in the Comment field and click
the OK button. The comment will be entered into the Activity Log.

21.The Remove button on the right side of the Paging Contacts screen can be used to remove
the paging information from the Paging Contacts screen.

22.Click on the Remove button, the Paged Contact Call In screen will display.

23.Enter a comment in the Comments field and click the OK button.

24.All the pages related to the alarm will be removed from the Paging Contacts screen and
list.

On Test Inquiry

The On Test Inquiry provides the Operator with a display of all on test entries that are on
record in the Manitou system. This display is a read-only screen. 

1. Select the Operations menu.

2. Select On Test Inquiry. The form will appear: 
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The following information is displayed:
 

· Contract No. - the customer's Contract Number
· Name - the customer's or company's Name
· Type - the Type of On Test period - Temporary or Permanent
· From - the beginning date and time of the on test period
· To - the ending date and time of the on test period
· Details - information about which parts of the system are on test (or "Whole System")

Current On Test accounts are shown in red, while expired accounts are shown in grey. Future
On Test accounts are displayed in green. Customer ID, Name and Type columns can be
sorted, and dates are presented in customer local times. 

To refresh the list, click on the Refresh button. 

On Test

On Test enables the Operator to place all or a part of a customer’s alarm equipment outside
the alarm notification and handling system for a temporary period, usually because of a fault
or while maintenance is being undertaken at the customer premises. Operators can place
equipment on test immediately or for a period of time for a future date. 
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1. Open the On Test form by clicking on the Operations menu.

2. Select On Test.

3. Enter the Customer ID or use the search tool to locate and open the Customer record. Users
may also load the customer by Receiver Line prefix and Transmitter ID by clicking on the

Load Customer button: 

4. Validate the password. 

5. Click on the Add button.

6. In the Duration section of the screen, select whether the On Test is Temporary or
Permanent.

7. Enter a reason into the Reason field for putting the Customer's system on test.

8. If the On Test is temporary, enter the number of days, hours or minutes the system should
be on test. 
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9. Enter the From and To dates the system will be on test. 

10.Indicate whether the whole system or only specific components will be on test. 

11.If the on test applies to specific system components, click on the  button to bring up
applicable components for the following fields: 

· Transmitter - Select a particular transmitter if it is to be put on test.
· Event Category - Allows the Operator to limit the on test condition to a particular category

of event, for example, all environmental alarms.
· Event Code - Allows the Operator to limit the on test condition to a particular event type,

such as any panic alarm.
· Area - Allows the Operator to limit the on test condition to a particular area of the customer

premises.
· Zone - Allows the Operator to limit the on test condition to a particular zone within the

customer premises.

12.If the signals should be kept for VRT access, check the Keep Signals for VRT Access box,
and select the appropriate engineer from the drop-down menu.

13.Click Save. The On Test order will now appear under the Customer section of the screen.
Current On Test accounts are shown in red, while expired accounts are shown in grey.
Future On Test accounts are displayed in green. 

14.To update the On Test screen, click on the Update button. The page will refresh, reflecting
the current status of the accounts.

Remove Account

1. To remove an account that is expired, click in the table next to the account to highlight the
line.

2. Click on the Remove button.

3. Confirm the delete. The account has now been removed.

Remove All Accounts

1. To remove all accounts, click on the Remove All button. 

2. Confirm the removal.

Notes on the On Test form
· When the system changes, the TX, Area, and Zone fields will automatically clear.
· Zones will always show wildcard zones (zones with an area of "*") for the selected system,
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regardless of the selected area.
· If anything other than exactly one system is selected, the browse buttons for TX, area and

zone will be disabled. 

Temporary Schedule

A Temporary Schedule will replace a customer's normal Open/Close schedule with a
different, temporary schedule that  is effective for a specified time period. This is particularly
useful during holidays or shutdown periods for customers. 

A normal Open/Close schedule must have been configured for the customer prior to setting up
a temporary schedule. To configure a normal Open/Close schedule, please see the 
Maintenance: O/C Schedules portion of this manual.

The Temporary Schedule form is split into three areas: customer, the name of the temporary
schedule, and the relevant day and time of the schedule. 
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1. Load the customer information by entering the Customer ID or by selecting the search tool
and loading the customer into the Customer ID form. 

2. Once the customer is loaded, any Open/Close schedules associated with the customer will
appear in the Schedule drop-down menu.

3. Click on the Edit button to put the screen into edit mode.

4. Validate the customer's password. 

5. Select the appropriate schedule from the Schedule drop-down menu.

6. Enter the date of the temporary schedule. The default date is the current date. Only one date
may be selected at a time. 

7. In the Temporary Schedule window, adjust the time or action for the Temporary Schedule.

8. If the Temporary Schedule should apply to more than one date, select the date from the
Temporary Date drop-down menu and make necessary changes to the Temporary
Schedule.

9. Click Save. 

Modify or Delete a Temporary Schedule
1. Load the customer record by entering the Customer ID or searching for the customer ID

using the search function. 

2. Click on the Edit button.

3. Enter the date of the Temporary Schedule that should be edited or deleted.

4. To edit the schedule, click in the relevant fields of the Temporary Schedule table and edit

or add rows as necessary.

5. To delete a row, click next to the row to be deleted:

6. The row will be highlighted. Press the delete key on the keyboard. 
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7. Confirm the delete.

8. Continue deleting necessary rows. Once the temporary schedule has been deleted, the

permanent schedule will appear.

9. Click Save to save all changes. 

Comment

The Comments area in customer maintenance allows users to view, enter, or edit temporary,
current, future, and special instruction for a customer. The area also offers users access to
view expired comments about a customer.

1. Open the Comments section by clicking on the Comments button in the Jump To menu.

2. Select the Edit tab to put the screen into edit mode. 

3. The Verify Password screen will display. Verify all the information is correct and click
OK.

4.  The Customer Comment screen will automatically display. If the customer (key holder)
does not have access to edit the account, the Verify Password screen will not allow the
Operator into the Edit area of the Comment screen. Click the Cancel button to return to the
View Comments screen if access is not allowed.

5. Click the Add button to add a comment into the tree menu and onto the customers account.
The Add Comment screen will display.

6. Select the Comment Type by clicking the circle that fits the type of comment that will be
added.

7. Type the comment description in the Description field or select a description from the
drop-down menu to the right of the Description field if available.

8. Click on the OK button when completed. The additional comment will display within the
tree menu.

9. Locate the Comment area of the screen. If a Standing Comment has been added to the
account, begin typing the comment into the blank white area on the right side of the screen.
If a Temporary comment has been added to the account, enter in a date and time within the
Valid From and Valid To areas then begin typing comments.

10.Click Save when the task is complete. 
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View Comments
1. Select the View tab at the top of the Comment screen.

2. On the left side of the screen click on the Temporary, Standing, or Special Instructions
options within the tree menu. The tree menu will expand to display subsections of the tree
menu.

3. After locating the desired comment from the tree menu click on the comment. The
comment information will display on the right side of the screen under the Comment area.
If the comment has a valid date, it will display under the title within the Comment area of
the screen. 

Remove a Comment
1. To remove a comment from an account, first ensure the screen is in edit mode by clicking

on the Edit button.

2. Click on the comment that needs to be removed from the tree menu. 

3. Click on the Remove button above the tree menu to remove the selected comment.

4. Click Save. 

Reverse Channel

The Reverse Channel function allows an Operator to send certain commands to alarm panels
and other equipment located at the customer site. This function is commonly used to remotely
reset an alarm panel. Reverse Channel commands can also be issued to test or make changes
to transmission equipment at the customer site. 
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1. Select a Reverse Channel Type from the drop-down menu. This is the Transmitter type that

the signal will be sent to.

2. Once a Type is selected, Reverse Commands that are available will appear below. 

3. Highlight which command to send, and click the Send button. A Reverse Command

Parameters box will appear:

4. Based on the Transmitter type selected, various parameters will be available in the Reverse

Command Parameters box. 

5. Enter the Transmitter ID and any other parameters required by the Transmitter Type.
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6. Click OK

7. The command will now be sent to the Transmitter.

8. When the Transmitter receives the command sent from Manitou, a summary will appear in
the Command Summary portion of the window. 

Disaster Mode

At times, a Central Station may run into problems that affect the ability to perform necessary
duties. Such problems may be severe weather which affects the monitoring area and causes
problems with false alarms sent at a rapid rate. Setting Manitou to Disaster Mode allows the
Central Station to change the way alarms are received and processed, and will allow the
Operators to reassign priorities for event alarms, customize the system to log certain signals,
filter the signals from the affected monitoring area to a specific  Operatoror group of
Operators or suspend activity.

Set up Disaster Mode in Supervisor Workstation

In the Supervisor Workstation, the following areas must be changed to begin Disaster Mode:

Event Categories
1. Open the Event Categories by first clicking on the Maintenance menu.

2. Select Events.

3. Select Event Categories.

4. In the Disaster Mode portion of the screen, flag the signal as part of a disaster event.

5. Configure suspend time if needed.

6. Offset the priority if needed. 

7. Repeat these steps for any additional Event Categories that should be set to Disaster Mode.

8. Click Save. 

Event Codes
1. Open the Event Categories by first clicking on the Maintenance menu.

2. Select Events.

3. Select Event Codes.

4. Click on the Disaster tab at the bottom of the screen. 
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5. Find the appropriate Event Codes in the Event Codes list.

6. Flag the signal as Disaster Mode from the Disaster Mode Type drop-down menu. 

7. Configure suspend time if needed.

8. Offset the priority if needed. 

9. Repeat these steps for any additional Event Codes that should be set to Disaster Mode. 
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Set up Disaster Mode in Client Workstation
1. Open the Client (Operator) workstation.

2. Open the Operations menu.

3. Select Disaster Mode. The default Disaster Mode window will appear:

4. Click on the Edit button.

5. Click on the Add button. An Add New Disaster Event window will appear:
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6. Designate if the event is a Warning or a Watch. Setting the event to a Watch does not
trigger any action and is mainly used for reference purposes. A Waring will generate
actions based on Disaster Mode settings.

7. Enter a brief description into the Description field.

8. Enter any comments into the comment field. 

9. Ensure the Monitoring Group is set to the default Monitoring Group 0. 

10.Enter the number of days, hours and minutes for this event.

11.If the starting time is the current time, set the time for the current time. This option is
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useful if the Watch or Warning is for several states or zip codes.

12.Select how to list the Post Codes, either manually or selecting cities from the Post Codes
list.

13.Once the list is populated, click OK.

14.Click Save. 

Note: Customer logs do not log the signals as "Disaster." It is necessary for an Operator to
double-click the individual lines in the Log to view the Disaster flag. 

Maintenance Menu

The Maintenance Menu is the center of data entry for the Operator Workstation. In the
Maintenance Menu, Users can enter new customers, maintain existing records, and set up
Dealers, Agencies, Authorities, Monitoring Companies, Keyholders, and more. 

Customer

The Customer window, which can be accessed by clicking on the Maintenance menu, then
selecting Customer, provides the means to view or edit an existing customer record. Once
displayed, any page of the customer record may be accessed by selecting a page from the
Jump To menu located to the right of the record. 
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On initial display, the record will be blank. Once a customer record is loaded, the default
display will show basic customer details, including the name, type of account (residential or
commercial), address, and status of the account. 

Account Status
The Account Status portion of the screen shows what services are active, inactive or need
attention. The Status form is a drill-down screen that can be expanded by double-clicking on a
service. 

Locate a Customer Record
1. If the Customer ID is known, enter the number into the Customer ID field and press Enter.

The desired record will now be displayed.

2. If the Customer ID is not known, click on the magnifying glass button to the right of the
Customer ID field. This will display the Search window:

3. In the Search Key fiend, select a search parameter such as Customer ID or Street Name. 

4. Enter the search terms, such as the Street Name, into the Value field.

5. Click on the Load button or hit Enter on the keyboard. The search results will then appear
in the table below the search criteria fields. 

6. Locate the customer record and double-click on it to load the customer record. 

Browse a Customer Record

Once the Customer record is displayed, browsing the record is simply a matter of selecting a
page using the Jump To buttons located to the right of the customer record. To browse the
pages in a record, click on the appropriate radio button in the Jump To menu. The appropriate
page will be displayed. 

Edit a Customer Record

Sometimes, changes must be made to a customer record, such as a new phone number or a
change in address. To edit a customer record, locate the appropriate record and click on the
Edit button to put the record into Edit mode. Make any necessary changes, and click Save to
save the record. 

Add New Customer

1. To add a new customer in the Operator Workstation, first click on the Maintenance menu.

2. Select Add Customer. A New Customer wizard will appear:
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3. Select the type of customer to create by selecting either Create a New Customer or Create a
New Customer based on an existing Customer from the Customer Type list. 

4. In the Customer Information Entry form, enter a Customer ID. The Customer ID naming
convention should be previously determined by a Central Station.

5. If the Customer should be linked to an accounting company, select the A/R company from

the drop-down menu.

6. Enter the A/R (Accounts Receivable) number.

7. Enter the Customer name.

8. Select the premises type: Residential or Commercial.

9. Select the Country where the customer is located.

10.Select the primary language the Customer uses. 

11.Select the time zone the Customer is located in.

12.Click next. 
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Address

Once the initial Customer details have been entered, an Address form will appear:

1. Enter the Customer's address into the address fields, beginning with the street number and
street name. Once the user begins typing, a New Address form will appear:

2. Continue entering the street name, city, state, and zip code. Note: Do not use punctuation
or atypical abbreviations in these fields. 

3. Click OK. A Post Codes Lookup box will appear:
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4. Confirm the correct city and region, and click Select. The address form will now be filled
in with the appropriate text. 
5. Enter any additional optional information, such as a cross street or subdivision for the
Customer. 

Details

Once the Customer address has been entered, users may choose areas from the Jump To list
located on the right side of the screen. To continue adding customer details, select Details
from the Jump To list. The Details list contains contact information for the Customer,
including phone number, e-mail, Dealer, Branch and Authority information. 
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1. Enter the Site phone number for the Customer. If the Site phone number is not the primary
number to call for this customer, use the down arrow to the right of the number title to
select the correct type for the first number to call, such as cell or business phone. 

2. Click in the text field for the phone number and enter the number, beginning with the area
code. 

3. To enter additional details, click on the notepad icon to the left of the phone number field.
A Contact Point Properties window will appear:

4. Select Properties.

5. Enter an extension if applicable.
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6. If a script is associated with this phone number (applicable in the case of numeric PIN
numbers or codes), select the script from the drop-down menu. 

7. Click OK to return to the Details window. Repeat the above steps for all Customer contact
numbers. 

Private Phone Numbers

To make a contact point private, go to its Properties dialog and check the Private checkbox.  

Check the "Private" checkbox to make the number private:

The phone number will now display as private:

The number will appear as asterisks everywhere in the Manitou client, including activity logs,
reports, and so forth.  The actual value of the contact point is still stored in the database, and
can still be used by the Auto-dialer dialog.  The only way to reveal a private phone number is
by clicking the "Show" button on the Auto-dialer dialog, which will display the number and
also log in the System Log the fact that the number has been revealed. The ticket printer is the
exception and always prints out the actual values of contact points, regardless of their private
status.
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Private Phone Numbers and Reports
When a report fails to publish, the System Log entry created replaces hidden destination
addresses with “******”.  The address is saved in the database for auditing purposes, but not
revealed via the clients.

Exposed Private Numbers
There are a few remaining places where private contact points may be exposed:

· Contact points that are synchronized with accounting systems (Navision, Sedona,
Quickbooks).  The contact points are still hidden in Manitou, but may be visible in the
accounting software.

· Contact search dialog: results are hidden when returned, but if the Operator can guess
the value of a private contact point, this could be used to verify that their guess was
correct.

· The monitoring company’s callback number for pages (Options setting) is linked to a
company’s Contact Point. This means that if this number is marked private, it can still
be viewed in the Options form in the Supervisor Workstation.

· Retransmission reverse commands can embed contact points in their parameter values.
The resulting signals are logged by the FEP in the system application log and in FEP
debug files.

E-mail

1. Click in the e-mail address field and enter the entire e-mail address for the Customer. Users
may wish to enter e-mail address in the event that reports need to be e-mailed to a
Customer on a weekly basis. Currently, reports are e-mailed in PDF format. 

2. Click on the notepad icon next to the e-mail field to bring up the E-mail Contact Point
Properties window:

3. The E-mail Contact Point Properties may be used to specify scripts E-mailed to the
customer in the event a certain type of signal is received. 

4. Select the Output Device Type.
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5. Select the Service Provider.

6. Select the Script from the drop-down menu. These properties will be pre-defined in the
Supervisor Workstation. 

7. Click OK.

8. To enter more than one e-mail address, click on the down arrow to the left of the E-mail
field and select E-mail 2 or E-mail 3.

9. Repeat the above steps to enter additional e-mail addresses. 

Web

1. Click in the Web address field to enter a Web address for this customer. Manitou will
automatically copy the text after the @ symbol in the E-mail address and adds "www" to
auto-fill the Web address. If there is no Web address, delete the entry. 

2. If a different URL is necessary, enter the correct Web address. By default, the Web address
is highlighted for correction or removal. 

Dealer, Branches and Authority

1. In the Dealer field, click the drop-down arrow to the right of the Dealer field and select the
applicable Dealer for the account. For more information on setting up Dealer accounts, see
the section Operator Workstation: Dealers in this manual. 

2. Click the drop-down arrow to the right of the Branch field and select the applicable Branch
for the account. For more information on setting up Branches, see the section Operator
Workstation: Branch in this manual.

3. Click the drop-down arrow to the right of the Police field and select the applicable Police
department for this account. For more information on setting up Authorities, see the
section Operator Workstation: Authority in this manual.

4. Click the drop-down arrow to the right of the Fire field to select the applicable Fire
department.

5. Click the drop-down arrow to the right of the Medical Service field and select the
applicable Medical branch for this account. 

6. Review all items for accuracy and click Save. 

Options

The Options page contains all information not classified elsewhere, including Passwords,
Codes, Options, Account IDs, and Customer level Pager messages. The following instructions
detail how to complete sections within the Options page.
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1. Select Options from the Jump To menu. The Options page will appear: 

2. Enter the main password the Customer has specified for the account. This password will be
used to verify cancelling alarms when the Central Station contacts the customer. Note:
Keyholders may or may not have separate passwords. 

3. Click in the Duress Password Field.

4. Enter a Duress password. This password should be easy to remember, as well as innocuous
to prevent tipping off an assailant in the event that the Central Station contacts the
customer and an Authority should be dispatched to the premises. 

5. In the Group Code field, click the drop-down arrow to reveal a list of Group codes which
are previously defined in the Supervisor Workstation. Group Codes are used within
Manitou to help categorize and report on categories of businesses that might have multiple
branches or locations.  It is helpful to give these groups a system of Codes for reporting
and tracking purposes. To set up and define Group Codes, please refer to the Maintenance:
Codes section in the Supervisor Workstation manual. 

6. Select the appropriate Group Code for this account if applicable. 
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7. Click the drop-down arrow next to the Class Codes field to reveal the list of Class Codes
which are previously defined in the Supervisor Workstation. Class Codes refer to a broad
level of categorizing Customer accounts. For example, a grocery store chain may be
assigned to a single Group Code to categorize the stores at a group level. At the next level,
Class Codes are assigned to all grocery stores, regardless of a specific grocery store chain.
To set up and define Class Codes, please refer to the Maintenance: Codes section in the
Supervisor Workstation manual. 

8. Select the appropriate Class Code for this account if applicable. 

9. Click the drop-down arrow next to the Monitoring Group field to reveal a list of
Monitoring Groups. Monitoring Groups are previously defined in the Supervisor
Workstation. A Monitoring Group is used to distribute certain signals to particular groups
of Operators based on a set criteria. Initially, a default Monitoring Group of 0 will be set
upon installation of Manitou software. Should no other Monitoring Groups be added, no
specific distribution of signals will be enabled.  Should Monitoring Groups be added,
certain customer records can be directed to a specific Monitoring Group, allowing
Operators using specific workstations belonging to that Monitoring Group will receive
signals from those customers. Thus, the Monitoring Groups are assigned to workstations
and not Operators. To set up and define Class Codes, please refer to the Maintenance:
Setup: Monitoring Groups section in the Supervisor Workstation manual. 

10.Select the appropriate Monitoring Group from the drop-down list. 

Options
11.If necessary for this account, check the Ignore Aborts checkbox. When Event Codes are set

up in the Supervisor Workstation, certain signal processing attributes may allow an
Operator to cancel an alarm which will ignore all other alarms associated with that account.
Checking the Ignore Aborts checkbox will still allow the signals to be processed. 

12.If necessary, check the Auto-Cancel checkbox. This command allows a signal to be
canceled or aborted when the appropriate cancel signal arrives. This signal is defined in the
Transmitter Programming Commands in the Supervisor Workstation. 

13.If this account should generate unexpected restores, click the Generate Unexpected

Restores checkbox.

14.Check the Verify Panel User No. checkbox if necessary.

15.In the Area Fill section, select the appropriate action.

16.In the Zone Fill section, select the appropriate action. 

17.Select the Time Format from the drop-down menu.
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18.Click into the top blank box and begin to write the default account Pager Message. When
it is necessary to add an element from the Pager Message listing click the appropriate item
then click Add. Repeat this process until the Pager Message is complete and reads
normally in the lower view box. The pager message field is unlimited text. 

19.Review all items on this page to verify the information is correct and accurate.

20.Click Save. 

Systems

The System structure contains four different types of Systems: Event Monitoring, Access
Control, GPS and Other (user defined). Each System contains the following attributes:

Event Monitoring
· Transmitter
· Programming
· Areas
· Zones
· Devices
· User IDs

Access Control
· Transmitters
· Programming
· Sectors
· Readers
· Devices
· Cards
· Modules
· Reader Groups
· Elevator Access Groups
· Elevator Groups
· Access Levels
· Card Sets
· Output Groups
· Programs

Customer System Screen Shot
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Each system may have multiple transmitters. Additionally, each Event type system can have
its own control panel type.

Drag and drop (move) and copy capability can be used in the new System form for moving
and copying transmitter, transmitter programming, event programming, area, zone, sector and
device information. The selected information can be moved or copied to another system of the
same type ( Event to Event, for example). 

Note: A transmitter will be considered to belong to a GPS system if it is not a VertX
transmitter and its Remote Address looks like a phone number.

For customers integrated with an accounting system, Manitou Systems will be tied to
accounting systems as well. 

Benefits 

When adding services in previous Manitou versions, Users needed to first add the service in
the Services form before adding the actual service, such as Open/Close schedules. With the
Systems form, once a service is set up, it is automatically added and takes away the need to
add the service separately. The Systems form compiles everything needed to perform a service
into one form instead of having to jump from form to form, as done in previous Manitou
versions.

Additionally, it will be easier for Operators to see what Systems the customers have since the
breakdown is visible in the main customer form for GPS, Access Control, Event Monitoring
and other user-defined services. 



Manitou Client 1.5.2110

© 2009 Bold Technologies Ltd.

Event Monitoring

1. Click on the Edit button to put the screen into Edit mode.

2. Click on the Add button located above the System tree. An Add System box will appear:

3. Enter the System Number.

4. Enter a brief description of the system into the Description field. For example, if this is a

Burglary system, enter Burglary.

5. Select Event Monitoring from the System Type drop-down menu if it is not already

selected.

6. Select the Monitoring Type. Monitoring Types are defined in the Supervisor Workstation
under Maintenance: Monitoring Types. Please refer to the Monitoring Types section in the
Supervisor Workstation manual for further information and instruction on adding and
configuring Monitoring Types. 

7. Click OK.

8. Back at the main Customer System screen, enter the System ID.

9. Select the Panel Type from the drop-down menu. Based on the Panel Type selected, the
maximum number of transmitters may be lower than the maximum amount set in the
Monitoring Types form in the Supervisor Workstation. If this occurs, Manitou will use the
lower number of transmitters allowed. 

10.Based on the type of Event Monitoring added, additional forms may appear, such as
Transmitters, Programming, Transmitter Linking, Areas, Zones, Devices and Users. If
these forms are available, please see the following sections for additional setup.
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 Drag and Drop
Users can drag and drop (move and copy) transmitter information, transmitter programming,
area, zone, sector and device information. The selected information can be moved or copied
to another system of the same type (Event to Event, for example). 

Sub-accounts will have a special "pseudo transmitter" created for each Event monitoring
system that represents the signal activity directed to it form its main customer. This allows for
the normal programming of events that would occur at the sub-account level such as
Late-To-Open. For received signal activity, only the transmitter programming of the main
customer will be used, while transmitter programming at the sub-account level will only be
used for internally generated signals of the sub-account. The event programming of the
sub-account will be used for all of its signal activity. Main and internally generated-will not
use any event programming of the main customer. This pseudo transmitter also allows for the
configuring of Late-to-Test at the sub-account level. A test interval can be set for this pseudo
transmitter. Sub-accounts can have their own Access Control, GPS and Other type systems
(not redirected from its main customer).

Transmitters

Transmitters allow routing of signals from the receiver to the Manitou Client, and then to the

correct customer information. In Manitou version 1.5.0 and beyond, transmitters are located

under the Systems form. Each system may have multiple transmitters. Additionally, each

Event type system can have its own control panel type.

Start by clicking on the Add button to add a transmitter to the system. The Add transmitter

dialog will appear:

The first available transmitter number will load automatically into the Transmitter No. field.

This is an ordinal number, and not to be confused as a transmitter identifier. For example,

Transmitter 1 is the first transmitter on the customer account. In most situations, it is the only

transmitter. However, there may be times when there is more than one transmitter linked to

the account. 

If needed, enter a transmitter description. This is recommended as it makes it easier to identify

one transmitter from another. Best practice is to use the field as a description of the type of

category. In this example, it is an Event Category (Burglary) transmitter, so best practices
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would dictate naming the Transmitter “Burglary” or “Fire” depending on the type of Event

Monitoring. Click OK once the description has been added, and to return to the Transmitter

form.

Once back at the main Transmitter form, select the Transmitter Type from the drop-down list.

Transmitters are added and configured in the Supervisor Workstation. After selecting the

Transmitter, select the Receiver Line Prefix for the Transmitter. The Receiver Line Prefix is

the identifier that differentiates the Transmitter IDs coming in on the same Receiver. 

In the Transmitter ID field, enter the ID. If using Transmitter ranges, clicking the Next (arrow)

button will automatically populate the field with the next available account number. If no

ranges are available, the Operator must manually enter the Transmitter ID. 

If applicable, enter in any Caller ID or Remote Address information.

Offsets



Maintenance Menu 113

© 2009 Bold Technologies Ltd.

Offsets are added to whatever area the signal is received on, so an offset of 1 will make a
signal sent on Area 1 present to Area 2. Similarly, an offset of F will make a signal sent on
Area 1 present as Area 10. Multiple transmitters must be set up on a system, otherwise the
offsets will not be enabled. The Offsets are hexadecimal, accepting characters 0-9 and A-F.  

The offset fields are of differing lengths:
· Area is 4 digits
· Zone is 5 digits
· Sensor is 12 digits

Programming applies to the area/zone/sensor after the offset is applied, so any programming
must account for the offset if relying on a specific input area/zone/sensor.

Transmitter Options
Several options are available with Transmitters and may be used in a number of ways. 

· Generate Restore Overdues – This option allows for the programming of time-out periods

for events that restore event programming required. If no restore is received within the

time-out period, a new alarm is generated called “Restore Overdue.” 

· Any Activity Satisfies Test – This option indicates that if the Transmitter receives any event

(such as an open, close, burglary, fire or other event), the event will satisfied the test

requirements for the interval. This option is only available when a Service for Transmitter

Test is also selected. 

· Extended Signaling – Setting this flag will state that this Transmitter sends in an Extended

format. This does not trigger a wait time on signals received from the Transmitter. The

Receiver driver will recognize the event based on its format as extended signaling and will

wait for the secondary signal in the designated wait period. The wait period is previously

defined and cannot be changed or configured by an end user. 

· Regular Activity Expected – Checking this option signifies that activity (events) are

expected to be received on a regular basis. 

· Do not use Dealer programming – This will prevent the Manitou client from checking the

customer’s Dealer record for w hat to do when a specific alarm is received. Dealer

programming is set up in the Dealer programming form. 

· Generate L-T-T only when closed – This will generate a Late-to-Test event when the site is

closed (armed). 

· Audio/Video Capable - These two check boxes are only enabled when the Audio and/or

Video Monitoring Services are selected for the account.  They simply flag the transmitter is
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capable of sending audio and/or video signals.

· Raw Event Programming – This allows the ability to program raw signals instead of how
they are translated either though the receiver drivers or within Event Maps.  This is often
turned on when a site is converting from an older system into Manitou.  However, it is most
often not necessary on new accounts added into the Manitou system.

· Monitored Transmission Path – This sets a flag on the transmitter that the transmitter keeps
an open path of communication alive and when severed the transmission path will generate
an alarm and show the status red or green for error or okay, respectively.

If Transmitter Test is needed, click or tab into the Interval field and enter the interval number
or use the up/down arrows to the right of the field. Adding a Transmitter Test on the
Transmitters form will automatically add the service to the Services form. 

Tab or click into the Remote Address field and enter the Remote Address information
(non-required field).

If the account has more than one more Transmitter, click Add and repeat the above steps for
all additional Transmitters.

Click Save. 

Note: A transmitter will be considered to belong to a GPS system if it is not a VertX
transmitter and its Remote Address looks like a phone number.

Programming

In order to guarantee proper signal processing, Programming is required for every system.
Programming defines and decodes information received from the transmitters through the
receivers. For instance, a transmitter may send a generic message that an alarm sounded in a
specific area or zone. The receiver passes this message on to the application. However, the
system is unable to decipher what activation in the area/zone means without the proper
programming. The programming then exists to translate the activation on that area/zone to a
burglary, fire, or other alarm. Programming will also allow for the definition of specific
actions to complete on the alarm, such as call police and then Keyholder on the account. 
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1. Open the Programming form by clicking on Programming button in the Systems list.

2. Click on the Edit button to put the screen into Edit mode. A blank line will appear in the
Transmitter Programming form.

3. Click into the empty cell under the TX cell. A drop-down arrow will appear. 

4. Click on the drop-down arrow and select the Transmitter from the drop-down menu.

5. Tab into the DES (Description) cell and click on the drop-down arrow.

6. Select a description of the incoming item. For example, if this is a Burglary Verified, select
BV from the list. 

7. Tab into the Area cell and click on the drop-down arrow.

8. Select an area if applicable.

9. Tab into the Zone cell and click on the drop-down arrow. 

10.Select a Zone if applicable.

11.Tab into the Sensor cell and click on the drop-down arrow.

12.Select a Sensor if applicable. 
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13.Tab into the Event cell and click on the drop-down arrow.

14.Select an Event from the list if applicable.

15.Enter a brief description into the Description cell of the Event.

16.Enter the Area, Zone and Senor if appropriate.

17.Enter a Point ID (a description of the area) if appropriate. 

18.Click Save.

Event Actions Programming

1. Click in the Event cell and select an event from the drop-down list.

2. Tab into the TX (Transmitter) cell and select a TX from the drop-down menu. 

3. In the Track ID area, enter the Asset Tracking ID if applicable.

4. In the Area and Zone cells, select an Area and Zone from the drop-down menu.

5. In the Alarm cell, select Yes, No or Default from the drop-down menu. Selecting yes will
sound an alarm every time the parameters are met. Selecting No will not sound an alarm
when the parameters are met. Selecting Default will set the system to execute its
programming based on the parameters. 

6. In the Actions cell, select an Action if appropriate. 

7. In the Instructions cell, click on the ellipses button to bring up the Customer Specific
Signal Instructions box:
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8. Enter any specific instructions pertaining to the Customer. The instructions entered here
will appear on the Notes tab of the Alarm Handling screen.

9. Click OK.

10.Once finished, review all items for accuracy. 

11.Click Save. 

Multiple Test Timers

Multiple test timers are first set up in the Supervisor Workstation > Event Codes. Users must
take the code that is coming in and change it to a code with the soft programming attribute of
"t". This lets the system know that the test signal should not be applied to the main
transmitter.

Back at the Operator Workstation, programming must be set up at the customer Transmitter
Programming level to redirect the incoming signal:

In this example, #E602 on Zone 0 is redirected to a code "RP1" on Zone SY2. Users cannot
specific zero as the zone; it must be left blank as Manitou will strip zeros. You may also use
an asterisk ( * ) instead of a blank zone, but caution that if different panels exist and all may
be sending an E602 signal, but with different zone numbers. Using an asterisk will take
precedence over all other programming lines when used with raw programming. 

Click on the Transmitters form under Systems and enter the transmitter test interval:
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Last, set up the transmitter linking in the primary system. This linking is based off of the
zones that were redirected in transmitter programming:

Transmitter Linking

When a second system is added to Event Monitoring, Transmitter Linking becomes available.
Transmitter Linking is used with sub-accounts and is used to direct signals to other systems of
the same customer or to other systems of a sub-account. This allows for more control of
signal redirection. For example, Zone 1 signals from Transmitter 1 of System 1 can be
redirected, but Zone 1 signals from Transmitter 2 of the same System can be left alone.

Transmitter Linking with a Sub-Account
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Transmitter linking can also be used to map messages to a different event monitoring system
within the same account (e.g., separate Fire and Burglary systems are set up but the messages
are physically received from the same transmitter). 

Sub-account directing is no longer on the Area and Zone grids. A new grid exists at the
transmitter level that is used to direct signals to other systems of the same customer or to
other systems of a sub-account. This replaces the transmitter linking grid that is no longer
needed. This allows for more control of signal redirection. For example, Zone 1 signals from
Transmitter 1 of System 1 can be redirected, but Zone 1 signals from Transmitter 2 of the
same System can be left alone.

Zones and Areas

Areas and Zones are places inside the residence or site where monitoring may be established
and used to direct customers or Authorities to specific areas that alarms are sending a signal.
Zones are a smaller unit and several Zones can fit inside one Area. 
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Add a Zone
1. Put the screen in Edit mode.

2. In the top left Zone cell, enter a Zone number. The Zone number may be specified by the

customer during initial setup.

3. In the Signal cell, select "Received a Signal" if a test of the monitoring device has received

a signal from that Zone.

4. Enter a brief description of the Zone into the Description cell.

5. To enter another Zone, tab into the next cell, and repeat the above steps as necessary.

Add an Area
1. In the left Area cell, enter the Area number into the Area cell.

2. Enter a brief Description. This description should include the Zones in the Area.

3. The Status will show as Unknown until a System test is performed and a signal is received.
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 Zones can be deleted as a group instead of having to delete each zone

individually. 

All Access Schedules
Because of changes to Manitou 1.5 that forces services based upon data entry, All Schedules
allows a system to send opening and closing signals for the sole purpose of logging the
signals. While Manitou 1.4.9 allowed users to add an Open/Close service even if no area had
a schedule attached, Manitou 1.5 does not allow this. By attaching an All Access schedule to
an area, it will now force a Monitoring Service which will trigger additional billing for the
Opening/Closing activity. This eliminates the Central Station from having to enter a dummy
"All Access" schedule on each customer record whenever they needed to allow an Open/Close
service without an attached area, such as residential systems that send opening and closing
signals so that the Central Station will know if the system is armed or not. 

To select an All Access schedule, simply click in the Schedule field of the Areas form and
select "All Access":

System and Query Tests

System and Query tests may be performed once a Zone and/or Area has been set up. The
System test will test the Zones/Areas to see if a signal has been received. Once the signal is
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received, the Signal Status will change to "Received Signal." If a signal has not been received,
the status will change to "Signal Not Received." 

1. To perform a System Test, simply click on the "Begin System Test" button located above
the System Zones area. 

2. Click Yes to begin the System Test. 
3. If the System is Active, a prompt will appear, asking to continue. Click Yes. 

If the Zone system is active, the Signal Status will change. If it is not active, the Signal Status
will remain red.

Query System Test
The Query System Test tool can be used to see how many Zones received a signal and how
many Zones have not received a signal. The user can also complete a System Test from the
Query Test as well. 

To perform the Query test, click on the Query System Test button. The results (Zones
received and Zones not received) will appear in the Query Test box. To perform a System
Test, check the "Perform System Test" box and click OK.

Devices

Devices can be used for additional monitoring and may be configured for cameras,
microphones, control/sensor, URL or doors. These items can be put on a Plan and actioned if
a connect or control device is added. 

Devices form
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Add a Device to Event Monitoring
1. Once a system, such as a burglary system, has been added to Event Monitoring, select

Devices from the Event Monitoring tree:

2. Click on the Add button located above the tree. An Add Device box will appear:
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3. Enter the Device ID. This is a 12 character ID uniquely identifying the device.  For devices
attached to an access control system, the Device ID is automatically set for the use when
creating it.  This is necessary so that the Signal Handler can match messages received with
the appropriate device.

4. Select the Device Type from the drop-down menu: video, audio, input, output, URL or

door. 

5. Enter a brief description into the Description field.

6. Click OK.

7. Back at the main Devices form, refer to the Manitou Audio/Video Configuration document
to enter the following parameters:

· Unit ID
· Unit Sub-ID
· Address
· Options

8. These parameters change depending on the type and model of device selected.

9. Enter the Area and Zone linked to the Device.

10.Select the Link ID if applicable.

11.Select the Reverse Route if applicable.

12.Select the Video Type from the drop-down menu.

13.Click Save. 

Users

Users are tied into the Contact List. When a new contact is set up for a customer, a User ID
may be assigned to the contact under the Details tab. For more information on assigning User
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IDs, see the Maintenance: Contact List section of this manual.

Once a User ID has been assigned to a Contact, the contacts will automatically appear in the
Users form under Systems.  

Though this screen is read-only, access details can be changed by double-clicking on a User
ID and editing the Details form:

From here, users can allow access, specify areas, and enter/edit User IDs. Once changes are
made, click Save.

Reminders

Please see the Reminders topic for further information.

Access Control

1. Click on the Edit button to put the screen into Edit mode.

2. Click on the Add button located above the System tree. An Add System box will appear: 
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3. Enter the System Number.

4. Enter VertX into the Description field. 

5. Select Access Control from the System Type drop-down menu if it is not already selected.

6. Select the Monitoring Type. Monitoring Types are defined in the Supervisor Workstation
under Maintenance: Monitoring Types. Please refer to the Monitoring Types section in the
Supervisor Workstation manual for further information and instruction on adding and
configuring Monitoring Types. 

7. Click OK.

8. Back at the main Customer System screen, enter the System ID.

9. Select the Panel Type from the drop-down menu. Based on the Panel Type selected, the
maximum number of transmitters may be lower than the maximum amount set in the
Monitoring Types form in the Supervisor Workstation. If this occurs, Manitou will use the
lower number of transmitters allowed. 

10.Based on the type of Event Monitoring added, additional forms may appear, such as
Transmitters, Programming, Transmitter Linking, Areas, Zones, Devices and Users. If
these forms are available, please see the following sections for additional setup.

Transmitters

After the initial set up, a VertX access controller is added to the system as a transmitter. Some
information needed to complete transmitter set up will be collected during the customer
hardware installation. 

1. Select Transmitters from the Access Control tree and click on the Add button. The Add
Transmitter box will appear.

2. Enter a brief description for the transmitter and click OK.

3. Back at the Transmitter form, select the appropriate transmitter type, V1K or V2K, from
the Transmitter Type drop-down menu.
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4. Select the receiver line prefix of the Bold IP Receiver from the drop-down menu.

5. Enter the right six character of the VertX access controller's MAC address in the
Transmitter ID field. Remove any leading zeros from the address. If any letters in the
address exist, enter them using capital letters.

6. In the Remote Address field, enter the VertX Public IP address followed by ":4050". The
number 4050 is the TCP port number that is used to connect to the VertX access controller.

7. Check VertX Access Control Device in the Options section of the form. This will enable
the Access Control section of the Jump To menu.

8. Enter a transmitter test interval. The VertX access controller has a maximum test interval
of one day. 

Programming

In order to guarantee proper signal processing, Programming is required for every system.
Programming defines and decodes information received from the transmitters through the
receivers. For instance, a transmitter may send a generic message that an alarm sounded in a
specific area or zone. The receiver passes this message on to the application. However, the
system is unable to decipher what activation in the area/zone means without the proper
programming. The programming then exists to translate the activation on that area/zone to a
burglary, fire, or other alarm. Programming will also allow for the definition of specific
actions to complete on the alarm, such as call police and then Keyholder on the account. 
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1. Open the Programming form by clicking on Programming button in the Systems list.

2. Click on the Edit button to put the screen into Edit mode. A blank line will appear in the
Transmitter Programming form.

3. Click into the empty cell under the TX cell. A drop-down arrow will appear. 

4. Click on the drop-down arrow and select the Transmitter from the drop-down menu.

5. Tab into the DES (Description) cell and click on the drop-down arrow.

6. Select a description of the incoming item. For example, if this is a Burglary Verified, select
BV from the list. 

7. Tab into the Area cell and click on the drop-down arrow.

8. Select an area if applicable.

9. Tab into the Zone cell and click on the drop-down arrow. 

10.Select a Zone if applicable.

11.Tab into the Sensor cell and click on the drop-down arrow.

12.Select a Sensor if applicable. 
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13.Tab into the Event cell and click on the drop-down arrow.

14.Select an Event from the list if applicable.

15.Enter a brief description into the Description cell of the Event.

16.Enter the Area, Zone and Senor if appropriate.

17.Enter a Point ID (a description of the area) if appropriate. 

18.Click Save.

Event Actions Programming

1. Click in the Event cell and select an event from the drop-down list.

2. Tab into the TX (Transmitter) cell and select a TX from the drop-down menu. 

3. In the Track ID area, enter the Asset Tracking ID if applicable.

4. In the Area and Zone cells, select an Area and Zone from the drop-down menu.

5. In the Alarm cell, select Yes, No or Default from the drop-down menu. Selecting yes will
sound an alarm every time the parameters are met. Selecting No will not sound an alarm
when the parameters are met. Selecting Default will set the system to execute its
programming based on the parameters. 

6. In the Actions cell, select an Action if appropriate. 

7. In the Instructions cell, click on the ellipses button to bring up the Customer Specific
Signal Instructions box:
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8. Enter any specific instructions pertaining to the Customer. The instructions entered here
will appear on the Notes tab of the Alarm Handling screen.

9. Click OK.

10.Once finished, review all items for accuracy. 

11.Click Save. 

Sectors

Sectors can be used to track where persons are located. For example, an office building may
have three sectors. The first sector may be set up for outside of the building, while the second
sector is the inside of the building, and the third sector is executive offices. When a person
uses their access card to gain entry into the building, Access Control will record that a person
went from outside the building to inside the building based on the sectors set up on the
Reader. 

Add a Sector
1. Put the screen into Edit mode by clicking on the Edit button.

2. In the Sector field, enter the number of the sector. This is used for identification purposes.
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3. Enter a brief description into the Description field. 

4. Enter any additional sectors by repeating the process.

5. When finished, click Save. 

Readers

Readers pertain to the actual hardware reader that is installed near entries and exits and is
used to swipe an access card to gain access to a door. The reader is connected to a module.
Each module can have two readers: one reader on the 0 (zero) port and one on the 1 port.
Depending the type of hardware used, such as cards only or pin pads, the options entered into
Manitou on the reader form may vary. 

Before a Reader may be added to the customer account, the type of Reader must be added to
the Access Control for the customer account. See the Maintenance Menu: Access Control
section of this document for further instruction on adding Access Control to an account.

Once the Reader has been added and configured, it will automatically display in the Readers
section of the Access Control System Setup. The form will display the Reader number,
description, the transmitter associated with the reader, and the module:

Devices

Devices can be used for additional monitoring and may be configured for cameras,
microphones, control/sensor, URL or doors. These items can be put on a Plan and actioned if
a connect or control device is added. 

Devices form
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Add a Device to Event Monitoring
1. Once a system, such as a burglary system, has been added to Event Monitoring, select

Devices from the Event Monitoring tree:

2. Click on the Add button located above the tree. An Add Device box will appear:
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3. Enter the Device ID. This is a 12 character ID uniquely identifying the device.  For devices
attached to an access control system, the Device ID is automatically set for the use when
creating it.  This is necessary so that the Signal Handler can match messages received with
the appropriate device.

4. Select the Device Type from the drop-down menu: video, audio, input, output, URL or

door. 

5. Enter a brief description into the Description field.

6. Click OK.

7. Back at the main Devices form, refer to the Manitou Audio/Video Configuration document
to enter the following parameters:

· Unit ID
· Unit Sub-ID
· Address
· Options

8. These parameters change depending on the type and model of device selected.

9. Enter the Area and Zone linked to the Device.

10.Select the Link ID if applicable.

11.Select the Reverse Route if applicable.

12.Select the Video Type from the drop-down menu.

13.Click Save. 
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Cards

Cards are initially set up in the Contact List. Once a contact has been added and the Access
Control System with a transmitter has been added to the System, a new Access Control Cards
tab will appear in the Contact List form.

Once cards have been entered into the Contact List, the card information will automatically
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show up in the Cards section of the Access Control system:

Users can double-click on a card to bring up the Access Control Cards tab in the Contact List.
From there, information can be edited and saved.

Add a Card

1. Once the basic Access Control system and transmitter have been added, select Contact List

from the Jump To list.

2. Select the appropriate contact from the Contacts tree.

3. Click on the Access Control Cards tab to open the form.

4. Click on the Add button to bring up the Add Access Control Card box:

5. Select the Transmitter from the drop-down menu if it has not already been selected.

6. Select the Card Set from the drop-down menu.

7. Enter the Card Number and Card ID. These two numbers must match.

8. Click OK

9. Back at the main form, enter the PIN number associated with the card if applicable. A PIN
code of "0" (zero) means there is no PIN code associated with the card.

10.Select the Access Type from the drop-down menu. This is the type of access granted by the
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card.

11.Select the Escort Card associated with the card if applicable.

12.Enter the Reuse Time. This is the time in minutes before an alarm is generated. 

13.Select the Access Levels, if any, that the card belongs to. There may be a maximum of
eight access levels that assign and limit access.

14.Select the Elevator In-Sched Group from the drop-down list if the card belongs to a

schedule within an elevator group.

15.Select the Elevator Out-Sched Group from the drop-down list. This is an elevator group
that the card belongs to when out of a schedule, such as after hours.

16.Check the Pin Cmds Allowed box if the card holder is allowed to implement PIN

commands.

17.Check the Extended Access box if extended access is on, such as longer grant access time
for a physically handicapped person.

18.Check the Passback Allowed box if the card should be exempt from anti-passback.

19.When finished, click Save.

Access Card Lookup
Users may add a card list of un-decoded cards in raw hex value only. From this form, users
can also convert a raw hex number into a card by clicking on the Convert button. Once the
Convert box appears, change the Card Number and Card ID to the appropriate values. 

Reminders

Please see the Reminders topic for further information.
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GPS

Transmitters

The Transmitters form allows Operators to install and customize Transmitters for a specific
Customer account. Prior to saving a new Customer account, Operators must enter a minimum
of one Transmitter. 

1. If the screen is not currently in Edit mode, click on the Edit button.

2. Select Transmitters from the GPS tree.

3. Click on the Add button. An Add Transmitter box will appear: 

4. If the Transmitter number is other than the default (1), use the drop-down arrow to enter
the Transmitter Number into the Transmitter No: field. 

5. Enter a brief description of the Transmitter into the Description field. 

6. Click OK to return to the Transmitter form.



Manitou Client 1.5.2138

© 2009 Bold Technologies Ltd.

7. Select the Transmitter Type from the drop-down menu. 

8. Click the drop-down box to the right of the Receiver Line Prefix field. Select the
appropriate value from the list. This is the line number that will appear in signals and
alarms within Manitou, allowing the Operator to track details about a particular alarm or
signal. 

9. Enter the Transmitter ID.

10.Select the Transmitter Protocol Type from the TX Protocol Type drop-down menu. For
more information on Transmitter Protocol Types, see the Supervisor Workstation Manual
section Maintenance: Setup: Transmitter Protocol Type. 

11.In the Transmitter Dates section, click in the Path-Enabled Date field, and click on the
drop-down arrow to the right of the field.

12.Select a date from the calendar.
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13.Select a Connect Date and a Termination Date if applicable. The Operator may choose to
leave the Termination Date field blank.

14.Under the Options section, check Generate Restore Overdues.

15. Check Extended Signaling if applicable.

16.Check Do not use Dealer Programming if applicable.

17.Check Generate L-T-T Only When Closed if applicable. 

18.Check Raw Event Programming if applicable.

19.Check Monitored Transmission Path if applicable.

20.If Transmitter Test is needed, click or tab into the Interval field and enter the interval
number or use the up/down arrows to the right of the field. Adding a Transmitter Test on
the Transmitters form will automatically add the service to the Services form. 

21.Tab or click into the Remote Address field and enter the Remote Address information
(non-required field).

22.If the account has more than one more Transmitter, click Add and repeat the above steps
for all additional Transmitters.

23.Click Save. 

Programming

In order to guarantee proper signal processing, Programming is required for every system.
Programming defines and decodes information received from the transmitters through the
receivers. For instance, a transmitter may send a generic message that an alarm sounded in a
specific area or zone. The receiver passes this message on to the application. However, the
system is unable to decipher what activation in the area/zone means without the proper
programming. The programming then exists to translate the activation on that area/zone to a
burglary, fire, or other alarm. Programming will also allow for the definition of specific
actions to complete on the alarm, such as call police and then Keyholder on the account. 
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1. Open the Programming form by clicking on Programming button in the Systems list.

2. Click on the Edit button to put the screen into Edit mode. A blank line will appear in the
Transmitter Programming form.

3. Click into the empty cell under the TX cell. A drop-down arrow will appear. 

4. Click on the drop-down arrow and select the Transmitter from the drop-down menu.

5. Tab into the DES (Description) cell and click on the drop-down arrow.

6. Select a description of the incoming item. For example, if this is a Burglary Verified, select
BV from the list. 

7. Tab into the Area cell and click on the drop-down arrow.

8. Select an area if applicable.

9. Tab into the Zone cell and click on the drop-down arrow. 

10.Select a Zone if applicable.

11.Tab into the Sensor cell and click on the drop-down arrow.

12.Select a Sensor if applicable. 
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13.Tab into the Event cell and click on the drop-down arrow.

14.Select an Event from the list if applicable.

15.Enter a brief description into the Description cell of the Event.

16.Enter the Area, Zone and Senor if appropriate.

17.Enter a Point ID (a description of the area) if appropriate. 

18.Click Save.

Event Actions Programming

1. Click in the Event cell and select an event from the drop-down list.

2. Tab into the TX (Transmitter) cell and select a TX from the drop-down menu. 

3. In the Track ID area, enter the Asset Tracking ID if applicable.

4. In the Area and Zone cells, select an Area and Zone from the drop-down menu.

5. In the Alarm cell, select Yes, No or Default from the drop-down menu. Selecting yes will
sound an alarm every time the parameters are met. Selecting No will not sound an alarm
when the parameters are met. Selecting Default will set the system to execute its
programming based on the parameters. 

6. In the Actions cell, select an Action if appropriate. 

7. In the Instructions cell, click on the ellipses button to bring up the Customer Specific
Signal Instructions box:
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8. Enter any specific instructions pertaining to the Customer. The instructions entered here
will appear on the Notes tab of the Alarm Handling screen.

9. Click OK.

10.Once finished, review all items for accuracy. 

11.Click Save. 

Asset Tracking

Asset Tracking provides individuals or an asset, such as an armored vehicle, the ability to
check-in on a regular basis with the monitoring company. Check-in signals can include GPS
information so that the individual or asset's movement can be plotted on a map.

Check-in

The Check-in function allows the Central Station to provide a service for periodic or
scheduled check-ins by an individual or asset. Check-ins can occur through a variety of ways,
such as a cell phone. For example, an individual may call into the Voice Response module of
the Bold MediaGateway to perform their check-in by navigating through the MediaGateway's
menus and providing identifying information that satisfies certain parameters set up by the
customer. When available, the cell phone may also provide GPS coordinates in order to plot
the location onto a map. The MediaGateway would then submit a signal into the core Manitou
system to complete the operation. 

Most users will utilize the check-in functionality through the use of a schedule or on an ad-
hoc basis. If using schedules, it will define the days and times the check-in service is active as
well as the interval in which check-in signals are expected. On an ad-hoc basis, however, the
individual will initiate contact by delivering a "Start Check-in" signal. Ad-hoc tracking still
requires a proper tracking entry for the individual or asset with an appropriate General
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Schedule. Manitou will continue to provide the service until a "Stop Check-in" signal is
received.  

Tracking Entries

Tracking entries are added in the customer Systems form through the GPS system. The Asset
Tracking form displays the customers tracking grid for the system:

The Asset Tracking grid is broken down into four sections: Configuration, Status, Current
Check-in Cycle and Next Check-in Cycle. Please note that if a system monitoring type's asset
tracking limit is set to zero, the asset tracking form will not display for the system. Monitoring
Types may be configured in the Supervisor Workstation.

Configuration

· ID - This is the unique identifier within the system and is defined by the user. For example,
the numbers 1, 2 and 3 may be used to identify the asset that is currently being tracked. 

· Ad Hoc - Checking this box will indicate that the check-in will occur on an ad-hoc basis.
Please note that a general schedule is still required for ad-hoc entries.

· Name/Description - This field contains the individual's name or a description of the asset,
such as "Wells Fargo Truck."

· Linked to - This is a read-only field that marks whether or not the entered contact name is
linked to a contact.

· Schedule - This field is used to add a schedule to the asset tracking in which the check-in
must occur. These schedules are set up in the General Schedules form.

· Interval - The interval field sets the minutes between check-ins. This value is pre-populated
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to the general schedule interval values when a general schedule is assigned to the asset.
However, users can change the value for intervals if needed. Intervals may not be less than
five minutes.

Status

· Last Status - This read-only field displays the current tracking status and are used to
determine if a late-to-check-in has occurred.

· Last Location - This field displays the last GPS coordinates received for an active tracking
entry. The field will be cleared when the tracking status is changed to "stopped." 

Current Check-in Cycle

· Check-in Late - This field indicates the end date and time for the current expected check-in
signal window.

· Cycle End - This field displays when the current tracking cycle will end. If the asset
tracking record is not ad-hoc, users may adjust this value to end a tracking session early or
to extend it later. For example, if a schedule protecting an individual ends at 17:00, the
person can notify the monitoring company that they need to be monitored until 21:00. 

Next Check-in Cycle

The Next Check-in Cycle items allow an Operator to modify the next check-in cycle
manually. Unless an Operator manually uses the Next Check-in Cycle items, they will be left
blank. Ad-hoc configurations cannot make use of the Next-Check-in Cycle options. 

· Check-in Start - This is the start date and time for the next expected check-in signal
window. 

· Check-in Late - This field indicates the end date and time for the next expected check-in
signal window.

· Cycle End - This field displays when the next tracking cycle will end. This allows the user
to adjust the next tracking cycle if it is not ad-hoc. For example, if a schedule specifies
08:00-17:00 M-F and on Friday, the contact notifies the monitoring company that they will
work from 08:00-17:00 on Saturday and need tracking, the monitoring company can make
the necessary changes. 
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Users may delete tracking entries by highlighting the asset row and pressing the delete button.

Transmitter Programming

Transmitter programming for Asset Tracking is found in the Track ID column. This column
links each line of programming to a matching asset entry. GPS programming lines that omit
the Track Id are not associated with tracking functionality, even if it is a tracking event code
(or includes soft programming attributes). 

General Schedules

Manitou utilizes General Schedules as the schedule for check-in services. The schedule is
created like other General Schedules, but users must select "Check-in" from the Type drop
down menu:

From there, enter the appropriate schedule parameters and set the Check-in Interval (in
minutes):
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The Start1/End1 columns in the schedule establish both the start time and the window in which a
check-in can occur.  For example, setting a Start1/End1 combination of 09:00 and 09:10 both sets
the start time at 09:00 and establishes a check-in window of 10 minutes, allowing check-ins between
09:00 and 09:10.  Outside that window, check-ins will be unexpected.  Depending on the interval,
the current check-in cycle’s check-in window will be the previous check-in window plus the interval.
Generally, the window should be smaller than the interval, otherwise the check-in and c heck-in late
behavior will not be correct. A possible side effect of a larger window will cause the next check-in to
be progressively pushed out until it hits the end of the window. If this occurs, unexpected check-ins
will not occur until the check-in is pushed out as far as it can be pushed. With an interval of 60
minutes and a Start1/End1 combination of 09:00 and 09:10, a check-in occurring between 9:00 and
9:10 will cause the subsequent check-in window to start at 10:00 (not displayed in the client,
though) and the check-in late to be 10:10.

The Start 2/End 3 columns govern the window in which the final check-in will occur. 

Contact LIst

Removing persons from the contact list will also remove any asset tracking entries that are
linked to the individual. When a user removes a tracking entry, the Manitou client removes all
transmitter and event programming for that tracking ID. 

Reminders

Reminders provide a way for the monitoring company to perform one time or periodic
actions/checks as a service to their customers. The Overdue Checker picks up reminders that
are due and generate an internal message to create an alarm for the reminder. Each reminder
must specify a standard alarm code, which the Signal Handler uses to assign an appropriate
action pattern. The reminder may include help text (notes) attached to the alarm for the
Operator's use. Users must have a Reminder Service set up in the Monitoring Types form in
order for the reminders option to perform properly. 

Reminders are added through Event Programming, Access Control or GPS systems, and
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individual reminders appear underneath a reminder's parent node:

When adding a Reminder, select the event from the event codes list, and a pre-defined
description will appear:

The description field (limited to 20 characters) may be edited if needed. Click OK, and the
main Reminders form will appear:
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· Event - This is the standard alarm event code for the generated reminder alarm, and allows
event programming to assign an action pattern.

· Description - A text description of the reminder.

· Area - This is the area of where the reminder is occurring. Area is used for event type
systems only.

· Zone/Asset - Apply a Zone or Asset Tracking ID to the reminder if applicable. This is
dependent on system type.

· Point ID - This field is the location description.



Maintenance Menu 149

© 2009 Bold Technologies Ltd.

· Schedule - Select a general schedule to attach to the reminder.

· Next Reminder - Set the next date and time of the reminder alarm to occur.

· Randomize - Checking the randomize box will randomize the intervals, which will render
them unpredictable. For example, if a schedule is set to record video footage every half hour
between 11 a.m. and 2 p.m., the randomize button will randomly assign a buffer time based
on calculations to record the footage. Therefore, the video will record at random times
inside of the schedule.

· Start Minus - This is the number of minutes preceding the beginning of the schedule
window where the first reminder will occur. 

· Interval Minus - This is the number of minutes preceding the next reminder within a
schedule window where the reminder may occur.

· End Plus - This is the number of minutes past the end of the schedule window where the
last reminder may occur.

· Interval Plus - This is the number of minutes past the next reminder within a schedule
window where the reminder may occur.

· Interval - Select the number of minutes, hours or days between reminders.

· Count - This field indicates the number of reminders to generate. 

· Expiration - This is the expiration date of the reminder. 

· Auto Purge - Checking this box will indicate that the Overdue Checker should
automatically purge the reminder when it is expired or the number of occurrences is
complete. 

· Notes - Use this field to enter any helpful notes or comments. These comments will be
attached to the alarm through the transmitter programming notes mechanism. Note that  if
the event created by the reminder matches a line of transmitter programming with notes, the
transmitter programming notes will take precedence.

General Schedule

Manitou utilizes General Schedules as the schedule for reminder services. The schedule is
created like other General Schedules, but users must select "Reminder" from the Type drop
down menu:
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From there, enter the appropriate schedule parameters.

Other

The Other system is a catch-all to give Monitoring Companies a way to include other types of
systems that don't fall into Event Monitoring, Access Control, or GPS categories. By creating
an "other" system, users can tie it to a monitoring service which the central station can
automate billing for through accounting integration.

Services

The Services window lists all Monitoring Services applicable to the Customer. These services
may be Video monitoring, Alarms only, or Reports. 
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1. Select the Services form from the Jump To menu.

2. Click on the Add button to add a Service. An Add Monitoring Service window will appear.

3. Select the drop-down arrow to the right of the Monitoring Service field and select a service
from the list. 

4. If an Area is applicable, select the Area from the Area drop-down list. Areas are defined in
the Zones and Areas list and will need to be set up prior to adding a Service. To see how to
set up a Zone and Area, see the Maintenance: Zones and Areas section of this manual. 

5. Click OK. 

Note: An item can be marked or unmarked as "Chargeable" based on a permissions setting in
the Supervisor Workstation. Please see the Supervisor Workstation documentation for
Maintenance > Setup > Permissions for further instructions on permissions settings.

6. If this account service has a specific valid date range; click the drop-down arrow to the
right of the Start date and select the date from the calendar. Repeat this process for the End
date. If the end date is not known, this field may remain blank.

7. If this service is a fee-based service and the customer should be charged for the service,
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click the Chargeable checkbox.

8. Enter the Charge Code within the Code field. The Central Station administrator should
know the Charge Codes.

9. Review the items for accuracy and click Save. 

O/C Schedules

Scheduling can be very important to some customer accounts.  In order to best create the
customer schedule it is important to know what the customer wants.  If the customer wants to
not allow entry outside of the particular scheduled hours the Must statements are very
important.  Alternatively, if a customer doesn’t care about when their staff opens or closes,
after their opening/closing times, the location, changing the Must statements to No Activity
will ease processing.  Below are some suggestions and rules for proper scheduling. 

Determine what the customer needs are for the account:
· Does the customer require that they are notified whenever an unexpected or unscheduled

opening occurs?  
· Does the customer need to receive a call at each opening and/or closing?
· Does the customer only want to know if the business is closed early or late?

When a customer wants their schedule monitored and expects notification when there is a
violation of the schedule the following items should be entered:
· On the Services form of the Customer record the Service Open/Close and the qualifier

Monitor is required.
· When entering the schedule within the Schedules section of the customer record, ensure that

there is a Must Open and a Must Close with specific times. 

Permanent Schedule

The Permanent Schedules tab contains the default schedule information for a customer. This
is a customer-specific open/close schedule and is the default schedule the system uses when
no other schedules apply for the customer record. In other words, this is the day-to-day
schedule used by the customer site. 
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Services
1. Before beginning, an Open/Close schedule must be added in the Services form for the

customer. 

2. Select the Services form from the Jump To menu.

3. Click on the Add button to add a Service. An Add Monitoring Service window will appear.

4. Select the drop-down arrow to the right of the Monitoring Service field.

5. Select the Open/Close from the list. 

6. If an Area is applicable, select the Area from the Area drop-down list. Areas are defined in
the Zones and Areas list and will need to be set up prior to adding a Service. To see how to
set up a Zone and Area, see the Maintenance: Zones and Areas section of this manual. 

7. Click OK. 

8. If this service has a specific valid date range; click the drop-down arrow to the right of the
Start date and select the date from the calendar. Repeat this process for the End date. If the
end date is not known, this field may remain blank.

9. If this service is a fee-based service and the customer should be charged for the service,
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click the Chargeable checkbox.

10.Enter the Charge Code within the Code field. The Central Station administrator should
know the Charge Codes.

11.Review the items for accuracy and click Save. The Permanent Schedules form will now be
available.

Permanent Schedules
1. Click on the O/C Schedule button in the Jump To list.

2. Select the Permanent Schedule tab.

3. Click the Add button to bring up the Add Schedule window:

4. Enter a Schedule code. This code is limited to 4 characters. 

5. Enter a brief Description in the Description field. 

6. Select the Type of the Schedule from the Type drop-down menu.

7. Click OK.

8. Check the days of the week this schedule will apply to.

9. Click in the Start 1 cell and enter the first open time. This number should be in 24-hour
time.

10.Tab into the End 1 cell and enter the first close time. This number should be in 24-hour
time. 

11.Repeat the above process for additional open and close times. 

12.Click Save. 

Alternate Schedule

The Alternate Schedule tab allows a schedule for a specific date (or dates) to override the
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Permanent Schedule. For example, some businesses are closed the last week of the year.
Instead of changing the Permanent Schedule for one vacation week, the company might
simply use the Alternate Schedule to define the alteration of Open/Close hours for that week. 

1. Click on the O/C Schedule button in the Jump To list.

2. Select the Alternate Schedule tab.

3. Click the Add button to bring up the Add Schedule window:

4. Enter a Schedule code. This code is limited to 4 characters. 

5. Enter a brief Description in the Description field. 
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6. Select the Type of the Schedule from the Type drop-down menu.

7. Click OK.

8. Check the days of the week this schedule will apply to.

9. Click in the Start 1 cell and enter the first open time. This number should be in 24-hour
time.

10.Tab into the End 1 cell and enter the first close time. This number should be in 24-hour
time. 

11.Repeat the above process for additional open and close times. 

12.Click Save. 

Holiday Schedule

The Holiday schedule allows the entry of all observed holidays for a particular premises or
business. All Holidays are entered globally through the Global Holidays form.

1. Click or Tab into the Date cell then click the drop-down arrow to the right and select the
holiday to enter.

2. Tab into the Time cell and enter the opening or closing time for the holiday. If the
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business/location is closed on the holiday enter "00:00" for midnight.

3. Tab into the Action field then click the drop-down arrow to select an Action from the list.
If the business/location is closed on the holiday, select "No Activity." If the Operator
selects Open Window or Close Window the Open/Close times will calculate based on the
Schedule Window Code selected for the account.

4. Repeat the above steps for all holidays. 

Temporary Schedule

A Temporary Schedule will replace a customer's normal Open/Close schedule with a
different, temporary schedule that  is effective for a specified time period. This is particularly
useful during holidays or shutdown periods for customers. 

A normal Open/Close schedule must have been configured for the customer prior to setting up
a temporary schedule. To configure a normal Open/Close schedule, please see the
Maintenance: O/C Schedules portion of this manual.
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.

The Temporary Schedule form is split into three areas: customer, the name of the temporary
schedule, and the relevant day and time of the schedule. 

1. Load the customer information by entering the Customer ID or by selecting the search tool
and loading the customer into the Customer ID form. 

2. Once the customer is loaded, any Open/Close schedules associated with the customer will
appear in the Schedule drop-down menu.

3. Click on the Edit button to put the screen into edit mode.

4. Validate the customer's password. 

5. Select the appropriate schedule from the Schedule drop-down menu.

6. Enter the date of the temporary schedule. The default date is the current date. Only one date
may be selected at a time. 

7. In the Temporary Schedule window, adjust the time or action for the Temporary Schedule.

8. If the Temporary Schedule should apply to more than one date, select the date from the
Temporary Date drop-down menu and make necessary changes to the Temporary
Schedule.

9. Click Save. 

Modify or Delete a Temporary Schedule

1. Load the customer record by entering the Customer ID or searching for the customer ID

using the search function. 

2. Click on the Edit button.

3. Enter the date of the Temporary Schedule that should be edited or deleted.

4. To edit the schedule, click in the relevant fields of the Temporary Schedule table and edit

or add rows as necessary.

5. To delete a row, click next to the row to be deleted:
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6. The row will be highlighted. Press the delete key on the keyboard. 

7. Confirm the delete.

8. Continue deleting necessary rows. Once the temporary schedule has been deleted, the

permanent schedule will appear.

9. Click Save to save all changes. 

Window Codes

Window Codes are set up in the Supervisor Workstation and are used to add a specific
amount of time to allow a schedule more flexibility. For example, a customer may wish to
allow a five minute "buffer" to the schedule to allow for an early open or a late close. Thus,
the window code would allow an open to occur anywhere between 7:55 a.m. and 8:05 a.m.

In the example below, before and after times have been set to 15 minutes and given the
description of "Plus or Minus 15 Minutes." First, the code is added to the Supervisor
Workstation:

Users can create a schedule using a Window Code in the Client Workstation. The example
below uses a Window Code of five minutes (plus or minus). Using the Window Code, the
generated schedule shows the may/must open and close times five minutes before or after the
hour. The hours of 0800 and 1700 are defaults that pre-fill the form and can be changed if
necessary while preserving the window code. 
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The window code can also be used without the schedule wizard. On the data entry screen, the
plus or minus 15 minutes window is selected. When the Day and Time have been entered and
the "open window" option is selected for the Action column, the screen will appear as
follows:

The end result is that the window has been applied to the time in the previous screenshot, plus
or minus fifteen minutes. 

Contact List

Contact Lists are used to provide detailed information about Keyholders, Dealers, Agencies,
Branches Authorities and Customers that relate to a particular customer account. 
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The Contact List is divided into four Tabs: Contact Tab, the User ID Tab, Contact Details
Tab, and Notes Tab.

· The Contact Tab, which is the default tab, displays general information regarding the
Contact, such as the Type of contact (e.g. Keyholder), job title, Access, passwords, and the
date the contact is valid. 

· The User ID Tab provides access to many areas with the same or different panel user IDs
for contacts.

· The Contact Details Tab includes all contact information (phone numbers, e-mail address
and street address).

· The Notes Tab provides any special notes pertaining to that particular Contact. 

· If Access Control is enabled, the Access Cards Tab will appear, providing access to many
areas with the same of different panel user IDs.

Contacts

Contacts Tab

1. Select Contacts from the Contact List navigator. 

2. Click on the Add button located above the Contact List. An Add Keyholder box will

appear:
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Keyholder
1. If the contact is a Keyholder, select Keyholder. 

2. Enter the name of the Contact into the Name field.

3. Select the Country, Language and Time Zone for the Keyholder.

4. Enter the Contact phone numbers into the appropriate fields (Site, Home, Business or

Mobile).

5. Click on the Notepad next to the number fields to enter any phone extensions or Scripts.

6. Click OK.

Global Keyholder
1. If the Contact is a Global Keyholder, select Global Keyholder instead of Keyholder.

2. Enter the Contact ID (Customer ID) into the Contact ID field or click on the eyeglass
search button to locate the correct Contact ID number. 

3. The name of the Contact ID should auto-fill upon entry of the Contact ID.

4. Click OK.

Note: If the Keyholder is Global, much of the information on the following screens will not
be editable, since the Keyholder's record is already entered into Manitou.

Once the keyholder has been added, users will return to the main contact details form:

Contact Details Form
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Contact
1. If the Keyholder is addressed by a Title, use the drop-down menu to select a Title from the

list.

2. If the Keyholder has a Suffix with their name, use the drop-down menu to select a Suffix
from the list.

3. Enter a Job Title, if necessary, for the Keyholder.

4. Enter a Birthday for the Keyholder if necessary.

5. To associate a photo with this Keyholder's record, right-click within the gray portion of the
picture frame to the right of the name fields. 

6. Click Find.
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7. Browse to the image file (.jpeg or .gif) on the computer and open the file. 

8. Check the Suppress checkbox if the contact should be prevented from showing up in the
contact list tree in th call list, action pattern, alarm and report destinations forms. This field
is defaulted to a checked box when the contact has no contact points.

Access
1. Use the checkboxes to indicate the Keyholder's access levels. Note that there are some

items that are mutually exclusive of one another. If both items are selected, an error will
appear. 

Passwords
1. If the Customer wishes each Keyholder to have a unique password , click on the Password

field and enter the password. 

2. Enter a Web Access ID and select a Web Profile from the drop-down menu. Please note,
these fields will not appear if BoldNet is not licensed and installed.

3. Enter a VRT ID if this contact will log in via VRT. Please note, this field will not appear if

VRT is not licensed.

4. If the password is associated with a specific Area, select the Area from the drop-down

menu.

Max Test Time
By default, Max Test Time is grayed out. However, if a password is entered along with a VRT
ID or Web ID, then the field becomes available. This is the maximum test time, in minutes,
that this contact may put the account on test.

Availability
1. Enter a Valid From date to indicate when this Keyholder will be a valid contact.

2. If applicable, enter a Valid To date to indicate when the Keyholder will become an invalid

contact.

3. If the Keyholder will be inactive during a certain date, enter the date into the Inactive from

and Inactive To fields. 

A Note About Birthdays
In the birthday field, the year selection cannot be moved below the year 2000. This is because
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it is technically a birth day and not "birthdate," meaning only the month and day. 

User ID Tab

Contacts can be given access to many areas with the same of different panel user IDs. This
information is entered in the Details Tab for the contact which, when data is entered, shows a
grid filled with all of the event systems and their areas. An entire system can be selected (with
or without a panel user ID) or individual areas of the system can be selected (each with or
without a panel user ID) or individual areas of the system can be selected (each with or
without a panel user id). 

Note: Details for a user may only be given once a system is first set up in the Systems tab. For
more information on setting up a system, see the Maintenance Menu: Systems section of this
manual.

Once a system has been added, check the Allow box to allow the contact access to the system.
A unique User ID may also be entered into the User ID field:

Contact Details

1. Click on the House icon (Contact Information Tab) to the right of the Contacts form to
display the Contact Information screen.

2. Enter the Site phone number for the Contact. If the Site phone number is not the primary
number to call for this Contact, use the down arrow to the right of the number title to select
the correct type for the first number to call, such as cell or business phone. 

3. To enter additional details, click on the notepad icon to the left of the phone number field.
A Contact Point Properties window will appear:

4. Select Properties.
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5. Enter an extension if applicable.

6. If a script is associated with this phone number (applicable in the case of numeric PIN
numbers or codes), select the script from the drop-down menu. 

7. Click OK to return to the Details window.

8. Enter an  E-mail address for the Contact if applicable. 

9. Enter a Web address if applicable. Manitou will automatically fill in the text after the @
symbol if an E-mail address is previously entered. If there is no Web address, highlight the
text and delete it from the text field. 

10.In the Address portion, check the Mailing Address box if this address should be used for
mailing purposes. 

11.Click on the arrow next to the Home field to select if the address is the Home, Work, or
Mailing address for the Contact.

12.Enter the Contact's address into the address fields, beginning with the street number and
street name. Once the Operator begins typing, a New Address form will appear:

13.Continue entering the street name, city, state, and zip code. Note: Do not use punctuation
or atypical abbreviations in these fields. 

14.Click OK. A Post Codes Lookup box will appear:
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15.Confirm the correct city and region, and click Select. The address form will now be filled
in with the appropriate text. 

16.Enter any additional optional information, such as a cross street or subdivision for the
Contact. 

Notes Tab

To enter Notes about this contact, click the Note Pad tab on the right of the Application View
and enter any notes that pertain to the Keyholder. 

Access Cards Tab

Contacts can be given access to many areas with the same of different panel user IDs. This is
entered on the Access Cards tab in the Contact List. This tab shows a grid filled with all of the
event systems and their areas. 

An entire system can be selected (with or without a panel user ID) or individual areas of the
system can be selected (each with or without a panel user ID) or individual areas of the system
can be selected (each with or without a panel user ID). A selected area without a panel user ID
gives this person On Test access to the area, assuming the user has On Test permission. An
area must be selected in order to give it a panel user id. Thus, the contact will have On Test
ability on any area that they have a panel user ID configured.
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Please note that Access Control must first be set up in order to enable the fields in the Access
Control Tab. Access Control can be set up using directions found here. Once Access Control
has been established, return to the Access Control Tab on the Contact List form and click on
the Add button to bring up the Add Access Control Card dialog:

Select the Transmitter and Card Set before indicating the Card number and Card ID. Once
these fields are entered, click OK to return back to the main Access Control Tab. The added
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card will now appear in the form:

From here, users may enter a PIN number, Escort Card, or select Elevator groups. 

· Card ID: This is the physical card number.  The Card Number and Card ID values must
match.

· PIN: The PIN code associated with the card.  A PIN code of “0” indicates there is no PIN
code.

· Access Levels: These are the access groups this card belongs to (maximum of 8) which
assigns/limits access.

· Elevator In-Sched Group: This is the elevator group the card belongs to when in schedule.

· Elevator Out-Sched Group: This is the group the card belongs to when out of schedule,
such as after hours, or only the garage and lobby floors so the person can exit the building,
but no longer have access to any other floors. 
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· Pin Cmds Allowed: This indicates if the card holder is allowed to implement PIN
commands.

· Passback Allowed: When checked, the card is exempt from anti-passback.

· Extended Access: This indicates if the extended access is on (i.e., longer grant access time
for a physically challenged person).

The Access Card Lookup provides a card list of un-decoded cards (raw hex value only).

Web Membership Tab

The Web Membership tab is used to manage BoldNet users by allowing addition of accounts,
edits or deletion of accounts, or by temporarily locking users out of BoldNet access. All of the
user accounts are associated with the Contact List person(s). 

With the Manitou Client in Edit mode, click on the Add button to bring up the Web
Membership User dialog:
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Enter a username and the full name and contact E-mail for the new user account. Any
comments about the account can be entered into the Comment field. The User Account
Security Details fields are used to log in to the BoldNet client. In this example, the username
to log in to the client will be "cturk" and the password given in this form. Security questions
may be added in the event that the customer has forgotten their password. This question will
appear in the BoldNet client when the customer clicks on the "forgot password?" link. By
answering the security question with the answer given in the Manitou Web Membership form,
the customer will then have their username and password sent to them to the E-mail address
provided in the Web Membership User form. They will then be able to reset their password
via the link given in the E-mail.

At times, a customer may need to be temporarily locked out from accessing the BoldNet
client. Clicking on the Locked Out checkbox will perform this action. When their access is re-
instated, uncheck the box to allow access back into the web Client. 

The Manitou Credentials portion of the form displays what Manitou account (including the
Web profile, which is the customer's Web permissions) the Web membership is tied to. In this
example, when the customer logs into BoldNet, he will be tied to the Web Access ID of
"5553388." 
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For more information on BoldNet usage, please request additional documentation for the
BoldNet User's Guide. 

Dealers

The Dealer contact list will be pre-populated based on the data entered into the Customer
Details form. 

1. Enter a Valid From date to indicate when this Dealer will be a valid contact.

2. If applicable, enter a Valid To date to indicate when the Dealer will become an invalid

contact.

3. If the Dealer will be inactive during a certain date, enter the date into the Inactive from and

Inactive To fields.

Agencies

Agencies are businesses that access secure business locations or private residences and offer
some sort of service. Some of the agencies would be Guarding, Cleaning or Janitorial
companies, Key services or cash transportation. It is necessary to include these companies as
they pertain to the customer account.
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1. Highlight Agency in the Contact List navigator.

2. Click the Add button to bring up the Add Agency screen:

3. Enter the Agency Contract Number button to find the Agency or use the search function to
locate the Agency. 

4. Verify the selection is correct then click OK to return to the Contact Information screen.

5. Select the appropriate permissions from the Access checkboxes. 

6. In the passwords portion of the screen, enter a password for the Agency into the Password

field. 



Manitou Client 1.5.2174

© 2009 Bold Technologies Ltd.

7. If the agency is only allowed access to a single specific area, use the drop-down arrow to
the right of the Area field to select the area from the list.

8. If there is a specific User Number associated with this agency, enter it into the User No.
field. 

9. Enter a temporary open time (in minutes).

10.Set the Valid and Inactive dates by clicking the drop-down arrow to the right of the field
and selecting the dates from the calendar.

11.Click the House tab to the right of the Application View. 

12.All information should be defaulted into their applicable fields. This page is not editable.

13.Click the Notepad tab to the right of the Application View.

14.Enter any Notes about this Agency as are pertinent to this customer. 

15.In the Verification Question field, enter a question that the Agency contact would have to
answer to verify identity.

16.Tab or click into the next field and enter the Verification Answer.

17.Repeat the above steps for all Agencies associated with this customer account.

Branch

The Branch contact list will be pre-populated based on the data entered into the Customer
Details form. 

1. Enter a Valid From date to indicate when this Branch will be a valid contact.

2. If applicable, enter a Valid To date to indicate when the Branch will become an invalid

contact.

3. If the Branch will be inactive during a certain date, enter the date into the Inactive from and



Maintenance Menu 175

© 2009 Bold Technologies Ltd.

Inactive To fields.

Authorities

The Authorities contact list will be pre-populated based on the data entered into the Customer
Details form. 

1. Enter a Valid From date to indicate when this Branch will be a valid contact.

2. If applicable, enter a Valid To date to indicate when the Branch will become an invalid

contact.

3. If the Branch will be inactive during a certain date, enter the date into the Inactive from and

Inactive To fields.

Customers

In some cases, customer accounts may be linked together as contacts for each other. 
Sometimes different accounts are tied together, for example, a single Keyholder may be
responsible for several accounts.  

1. Click Customer to highlight it in the Contact List navigator.

2. Click Add. An Add Customer box will appear:

3. Enter the Customer Contract Number or click the Search icon to find the Customer.

4. Click OK.

5. Back at the main screen, set the Valid From and Valid To dates using the drop-down arrow
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to the right of the fields to select the dates from the calendar:

6. If this customer will have a period of inactivity due to office closure or vacation schedule,
for example, use the drop-down arrows to the right of the Inactive From and Inactive To
fields to select the dates from the calendar.

7. Click the House tab to the right of the Application View to view contact information for
this Customer. This screen is not editable as all of the values are auto-filling from an
existing Customer record.  If any information needs to be edited do so to the Customer
record directly.

8. Click the Notepad tab to the right of the Application View.  Enter any pertinent notes about
this Customer record.

9. Repeat this process for all Customer Keyholders related to this Customer account.
 

Call Lists

A Call List for a Customer contains details for all the people, Agencies, Authorities, Dealers
and/or Branches requiring contact for a given alarm. Call Lists are especially useful for
commercial sites that may have differing shifts based on the time of day. A Call List provides
the ability to rotate the members of a list. Rotation lists are often placed in order to ensure that
one Keyholder is not the only Keyholder contacted each time an alarm occurs. 
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1. Open the Call List for the customer by clicking on the Call List button in the Jump To
menu.

2. Click on the Add button.

3. Enter the Call List name or code into the first field. This name or code should be
determined by the Central Station administrator.

4. Tab into the Description field and enter a short description of the Call List.

5. If the list is a Main Call List, select Main. If it is a Sub List of a Main list, select Sub List.

6. Click Add to Matrix. The Call List will be added to the Customer's account.

7. Click OK.

8. Back at the Call List form, select the item or items from the Contacts list that should
appear in the Call List. Contacts appearing in the list should be previously added in the
Contacts form of the customer record. 

9. Move the Contacts over to the Call List by clicking on  . The Contacts will now appear
in the Call List.
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10.Move list items up and down based on priority by clicking on the up/down arrows to the
right of the Call List. 

11.If the Call List rotates, check the Rotation List Active checkbox. The contact at the top of
the list will automatically be the head of the list, indicated by an icon that appears when the
Rotation List Active checkbox is checked. This contact will be first in rotation. 

12.Indicate the Next Rotation date by selecting the correct date from the calendar. The start
date defaults to the current day.

13.Set the rotation interval by clicking on the up/down arrows to set the number of days each
rotation is active before rotating.

14.If a Contact on the list is a Must Contact or Does not Rotate, select the appropriate Contact
and check the applicable boxes. 

15.Once all date is entered, click Save. 

Previously, Operator cancel allowed the alarm to be closed regardless of if incomplete Must
Contacts were present.  Now, the operator is warned of this, and must override to close the
alarm.
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The Customer Option (MOPTION) for Must Contact Required still exists. If an alarm is
canceled, and the above MOPTION is true, customer cancel will no longer close the alarm:

The MOPTION for Action Pattern is Optional does not affect Must Contact – users must still
contact them.  If they don’t want this behavior, then don’t check Must Contact when setting
up the call list. Any action after a CLOSE command is optional (standard behavior).  This is
still true for Must Contact as well.

Attentions

Attentions are used for the sole purpose of printing and mailing paper copies of reports run
through Manitou. If an Attention is entered, Manitou will print that attention prior to printing
out the physical address of the recipient. 

1. Enter an attention into the appropriate field by first clicking on the Edit button to put the
screen into edit mode.

2. Click in the appropriate field.

3. Select the contact from the drop-down menu. (Note: For Contacts to appear, they must first
be entered into the Contact List).

4. Click Save. 

Permits

The Permits form lists all permits held by security companies and other protective services
like the Police, Fire and Medical Services. Additionally, Permit forms detail the types of
alarm each company handles as well as the active dates and expiration dates for each Permit.
Information on this form depends on the Permit Type information which should have been
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previously entered under Maintenance: Permit Types. 

The instructions below detail entering information for Authority Permits. 

1. Open the Permits screen by clicking on Permits in the Jump To menu.

2. If the screen is not already in Edit mode, put it into Edit mode by clicking on the Edit
button. A blank Authority Permit line will appear:

3. Click in the Permit No. column and enter the Permit number. The Central Station
administrator may need to be contacted for numbering instructions.

4. Click in the Authority/Permit Type column and use the drop-down arrow to select the
Permit Type from the list. The Permit Types should already be entered in the Maintenance:
Permit Types portion of the Operator Workstation. 

5. Tab into the Status field and use the drop-down menu to select the Status from the list. The
Status levels indicate the number of allowable False Alarms for the account. Unknown
indicates that the number of allowed false alarms is unknown and it is unknown if
Authorities are able to respond. Normal indicates the normal number of allowed false
alarms, while May Respond indicates that Authorities may respond to the customer site.
No Response indicates that Authorities may not respond to the customer site. 

6. Tab into the Status date and enter the date on which the Permit is active. Numbers may
only be entered in this field and dashes (-) or slashes (/) are prohibited. 

7. Tab into the Exp Date cell and enter the date on which this Permit will expire. Numbers
may only be entered in this field and dashes (-) or slashes (/) are prohibited. Note: The
Expiration Date may not exceed the Status Date, so a date must be entered into this field.

8. Once the information is entered correctly, click Save. 

Comments

The Comments area of the software allows users to view, enter, or edit temporary, current,
future, and special instruction for a customer. The Comment area also offers users access to
view expired comments about a customer.
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The Comments form is divided into four sections: Comment tree, description, alert and actual
comment. 

View Comments

1. Load the customer and select Comments from the Jump To menu.

2. On the left side of the screen click on the Temporary, Standing, or Special Instructions
options within the tree menu. The tree menu will expand to display subsections of the tree
menu.

3. After locating the desired comment from the tree menu click on the comment. The
comment information will display on the right side of the screen under the Comment area.
If the comment has a valid date it will display under the title within the Comment area of
the screen. This completes how to view comments.

Edit Comments

1. Select the Edit tab at the top of the Comment screen.

2. The Verify Password screen will display. Verify all the information is correct and click the
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OK button. The Customer Comment screen will automatically display. If the customer (key
holder) does not have access to edit the account the Verify Password screen will not allow
the Operator into the Edit area of the Comment screen. Click the Cancel button to return to
the View Comments screen if access is not allowed.

3. Above the tree menu there are three buttons Add, Remove, and Refresh. Select the Add
button to add a comment into the tree menu and onto the customers account. The Add
Comment screen will display.

4. Select the Comment Type by clicking the circle that fits the type of comment that will be
added.

5. Type the comment description in the Description field or select a description from the
drop-down menu to the right of the Description field if available.

6. Click on the OK button when completed. The additional comment will display within the
tree menu.

7. Locate the Comment area of the screen. If a Standing comment has been added to the
account begin typing the comment into the blank white area on the right side of the screen.
If a Temporary comment has been added to the account enter in a date and time within the
Valid From and Valid To areas then begin typing comments.

8. To remove a comment from an account click on the comment that needs to be removed
from the tree menu the comment will turn blue when it has been selected.

9. Click on the Remove button above the tree menu to remove the selected comment.

10.To save the changes click on the Save tab at the top of the screen. After the save has been
completed the software will automatically return to the View tab.

Action Patterns

Action Patterns are a vital part of alarm handling and processing. They act as a set of
instructions the Operator will follow during Alarm Handling so the Operator knows exactly
what to do upon receiving a specific type of Alarm. 

Action Patterns may be set up at various levels, such as Global, Dealer, etc.; however,
Customer Action Patterns are the most specific. When adding customer programming for
particular alarms, unique action patterns may be selected rather than more general Global
Action Patterns. Action Patterns should in part be determined by the customer, especially if it
is a commercial site and several types of alarms (such as a Freezer Alarm) may be received. 

1. Selection Action Patterns from the Jump To list.

2. If the screen is not already in Edit mode, click on the Edit button.
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3. Click on the Add button located above the Action Patterns list. An Action Pattern
Properties box will appear:

4. Indicate whether the Action Pattern is New, New based on Global, or New Based on
Dealer. An Action Pattern based on a Global or Dealer Action Pattern is still editable, but
uses a pre-existing Action Pattern as a template.

5. Enter a brief Action ID.

6. Enter a brief Description of the Action Pattern.

7. Click OK.

8. Select the newly created Action Pattern from the Action Patterns list.
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Note:  Action Patterns added to the Central Station are Global Action Patterns and are
therefore available when viewing Customer and Dealer records.   

Keep this in mind when configuring Monitoring Company action patterns.  These should be
applicable to a category of alarms.  For example:  The action pattern for a Burglary Alarm
might be similar for many customers so the sequence of events can be defined by a Global
Action Pattern rather than creating separate Action Patterns for each Customer.  The
following instructions cover how to add Action Patterns to the Central Station record:

1. Scroll down the navigation list, select Customer Action Patterns and Click Add. 

2. Click into the Action ID field and Enter a brief code for the Action Pattern.

3. Click into the Description field and enter a short description of the Action Pattern.

4. Click OK to return to the main Action Patterns screen.

5. Select the type of Action to execute in the Command drop down menu:
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· Contact - Add contacts to Action Patterns to guide the Operators in calling, paging and/or
emailing relevant individuals:

1. Select the Contact to add to the Action Pattern from the list.
2. Click the Add button located just above the Action Pattern pane, to add the Contact to

the list.
3. Repeat this process for all persons requiring contact with this Action Pattern.
4. Use the Up and Down arrows to the left of the pane to adjust whom to contact first,

second, etc.
5. If a contact was added in error, remove by selecting the list item and clicking the "X"

button located just outside the lower left corner of the Action Pattern pane.

· Remark - Add a remark to the Action Pattern to insert a comment or reminder for the
Operator:

1. Tab or Click into the Remark pane.
2. Type the Remark to be added to the Action Pattern.
3. Click the Add button located just above the Action Pattern pane, to add the Remark to

the list below.
4. Repeat this process for all remarks tied to this Action Pattern.
5. Use the Up and Down arrows to the left of the pane to adjust exactly when in the

Action Pattern the remark should be executed.
6. If a remark was added in error, select it from the list and click the "X" button located

just outside the lower left corner of the Action Pattern pane to remove the item.

· Log Line - a Log Line action will be added to the Customer Log for each alarm to which
it's added:

1. Tab or Click into the Log Line pane.
2. Type the information that will appear in the Customer Log.
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3. Click the Add button located just above the Action Pattern pane, to add the Log Line
to the list.

4. Repeat this process for all Log Lines tied to this Action Pattern.
5. Use the Up and Down arrows to the left of the pane to adjust when the Log Line

should be executed within the Action Pattern.
6. If a Log Line was added in error, select it from the list and click the "X" button located

just outside the lower left corner of the Action Pattern pane to remove the item.

· Show - Add this type of Action to display the help text directly from the Event Category,
Event Definition, etc. as part of the Action Pattern:

1. Select an applicable option to show Help Text about one of the following: Event
Category, Event Definition, Event Programming, Transmitter or Script.

2. If selecting Script, click the drop-down arrow to the right of the field just below the
Script radio button and select the script to display.

3. Click the Add button located just above the Action Pattern pane, to add the Show item
to the Action Pattern.

4. Use the Up and Down arrows to the left of the pane to adjust when the Show item
should be executed within the Action Pattern.

5. If a Show item was added in error, select it from the list and click the "X" button
located just outside the lower left corner of the Action Pattern pane to remove the
item.

· Attention - Add an Attention line for the purpose of emphasizing information, or to fulfill
UL requirements about Alarm ticket information.

1. Tab or Click into the Attention pane.
2. Type the text to be added to the Action Pattern.
3. Click the Add button located just above the Action Pattern pane, to add the Attention

line to the list below.
4. Repeat this process for all Attention actions tied to this Action Pattern.
5. Use the Up and Down arrows to the left of the pane to adjust exactly when in the

Action Pattern the Attention line should be executed. 
6. If an Attention line was added in error, select it from the list and click the "X" button

located just outside the lower left corner of the Action Pattern pane to remove the
item.

· Suspend - Add this type of action to Suspend the Alarm for an allotted period of time at
some point in the Action Pattern:

1. Click the up/down arrows or enter the time to suspend the Alarm.
2. Select if the time unit is in Seconds, Minutes or Hours by clicking the applicable radio

button.
3. Click the Add button located just above the Action Pattern pane, to add the Suspend

command to the list.
4. Repeat this process again if more than one suspend is necessary for this Action

Pattern.
5. Use the Up and Down arrows to the left of the pane to adjust when the Suspend should

be executed within the Action Pattern.
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6. If the Suspend was added in error, select it from the list and click the "X" button
located just outside the lower left corner of the Action Pattern pane to remove the
item.

· Close - Add this type of action to prompt for Closing the Alarm with Resolution Codes
automatically entered by the action at the end of the Action Pattern:

1. Click the drop-down arrow to the right of the Resolution Code field.
2. Select a Resolution Code from the list.
3. Click the Add button located just above the Action Pattern pane, to add the Close

Resolution Code to the list.
4. Use the Up and Down arrows to the left of the pane to adjust when the Close

Resolution Code should be executed within the Action Pattern.
5. If a Close Resolution Code was added in error, select it from the list and click the "X"

button located just outside the lower left corner of the Action Pattern pane to remove
the item.

After selecting the Command, select a contact from the contacts displayed in the contact box,
and click on the Add Command button. This will add a contact action command:

Select the Contact Point Type (such as the site number or business number) from the
drop-down menu. These contact point types are added on the Contacts form. The Suspend
Until Valid checkbox will give the Operator the option to suspend an alarm for the amount of
time until an out-of-schedule contact point or call list becomes back in schedule. This option
is not allowed for ad-hoc keyholder or agency call lists, since they are dynamically created at
run time and cannot have a schedule attached to them. Click OK to finish adding the action to
the action pattern. The command will then appear in the action pattern:
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Repeat the necessary steps to add additional items to the action pattern. Last, repeat the
process for all additional Global Action Patterns required for the Central Station. 

A Note About Temporary Contacts in Action Patterns

Temporary contacts that are unavailable - that is, their valid to/from date has expired - will
still appear highlighted green in an action pattern. The Application Server does not determine
whether the contact is valid or not until the Operator attempts to action it in an action pattern.
This saves time pre-analyzing all of the possible actions not knowing whether any will be
called upon or not.  It will, however, fail (come back as 'Ignored') if the operator tries to action
the contact. 

General Schedules

The General Schedules tab contains the default schedule information for a customer. This is
a customer-specific open/close schedule and is the default schedule the system uses when no
other schedules apply for the customer record. In other words, this is the day-to-day schedule
used by the customer site. 

Services
1. Before beginning, an Open/Close schedule must be added in the Services form for the

customer. 

2. Select the Services form from the Jump To menu.
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3. Click on the Add button to add a Service. An Add Monitoring Service window will appear.

4. Select the drop-down arrow to the right of the Monitoring Service field.

5. Select the Open/Close from the list. 

6. If an Area is applicable, select the Area from the Area drop-down list. Areas are defined in
the Zones and Areas list and will need to be set up prior to adding a Service. To see how to
set up a Zone and Area, see the Maintenance: Zones and Areas section of this manual. 

7. Click OK. 

8. If this service has a specific valid date range; click the drop-down arrow to the right of the
Start date and select the date from the calendar. Repeat this process for the End date. If the
end date is not known, this field may remain blank.

9. If this service is a fee-based service and the customer should be charged for the service,
click the Chargeable checkbox.

10.Enter the Charge Code within the Code field. The Central Station administrator should
know the Charge Codes.

11.Review the items for accuracy and click Save. The General Schedules form will now be
available.

General Schedules
1. Click on the General Schedules button in the Jump To list.

2. Click the Add button to bring up the Add Schedule window:

3. Enter a Schedule code. This code is limited to 4 characters. 

4. Enter a brief Description in the Description field. 

5. Select the Type of the Schedule from the Type drop-down menu.

6. Click OK.

7. Check the days of the week this schedule will apply to.
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8. Click in the Start 1 cell and enter the first open time. This number should be in 24-hour
time.

9. Tab into the End 1 cell and enter the first close time. This number should be in 24-hour
time. 

10.Repeat the above process for additional open and close times. 

11.Click Save. 

Plans

Add a Plan
1. Select the Edit button to put the account into edit mode. 

2. Click on the Add button in the Plan Control section of the window. An Add Plan dialog

box will appear.

3. Enter the description of the plan, such as "House" or "Ground level." 

4. Click OK. 

Once a Plan Description is added, a Section/Layer image file is uploaded. When the image
file appears, Operators may use the toolbar buttons located to the right of the plan image file. 

   Zoom In

Zoom Out

Select Zoom Area

Full – Maximize Plan to Form

Sections/Layers

After a plan description has been added, Areas and Sections/Layers are added next. While a
plan is an overall description of the layers associated with the plan, the layer or "sections"
contain it's own description, number and actual image. 

Add Layers to a Customer Record
1. Click the Add button located in the Section/Layer Control portion of the window to open

the Add Layer dialogue box. 

2. Use the drop-down arrow to choose a Layer No., or type in a number value.  There must
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be a Layer No. 0 for the system to correctly save this layer information.  

3. Type a description of the Layer diagram into the Description field.

4. Click the Picture button to browse to the image file selected for a Layer. The image must

be in .bmp, .jpg or .gif format. 

5. Highlight the file and click Open to return to the Add Layer dialogue box.

6. Click on OK to save this information and to close the Add Layer window.

7. Repeat steps 1 through 6 for each diagram belonging to this Customer record.

The Plans tab displays electronic floor plans of the premises including the locations of
cameras, sensors and contacts.  The following instructions cover how to add edit and a plan
including the placement of zones where they are located on the plans.

Edit a Layer
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1. Use the Layer Control drop-down arrow to select the layer for editing from the list.

2. Relocate or remove any zones for the layer.

Remove a layer
1. Use the Layer Control drop-down arrow to select the layer to remove.

2. Click the Remove Layer button.

3. Confirm the deletion.

Review all changes to ensure the accuracy of the information changed or added and Save the
record. Enter any notes if necessary then click OK.  

Zones

After linking one or more image files to the Customer record with the steps above, Zones may
be indicated as desired on each diagram. 
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1. Use the Layer Control drop-down field to select the Layer image. 

2. In the Zones box, click on one of the items listed and drag it over the diagram below. 

3. Release the mouse-button when the Zone icon appears at the correct location on the

diagram. 

4. To remove a Zone icon from the diagram, right-click the icon and select Remove.

5. Repeat steps 1 through 3 as needed to add each Zone to the Layer diagrams. 

Area

An Area allows the user to associate existing areas with the previously made plan.

Restrictions on drawing areas
· Areas must be normal, closed polygons, with no line segments intersecting.  Basically, they

must enclose only one area (like a octagon) and not multiple (like a figure-eight).

· No two areas may intersect each other.

· No area may exist within another area.

· The drawing editor will beep if you attempt to place a vertex that violates any of these rules.

Drawing areas on a plan
1. Put the screen into Edit mode. 

2. Select Areas from the toolbar.

3. Select Add from the mode toolbar

4. The plan view will now change so that all existing areas are highlighted, so you know can

avoid overlapping areas.

5. Click on the plan where you want the first vertex to be.

6. The Add Area dialog appears.  Type a description, select an area, and choose a color for the
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area.

Once OK is clicked the user is now in drawing mode.  A line will follow the mouse cursor
with one end attached to the last vertex clicked, and the other end attached to the mouse.

7. To add a point, click the mouse.

Drawing Actions
· Left-click - select Add a vertex

· Right-click - Finishes the polygon by drawing a line from the last vertex to the first vertex,
and exits drawing mode.  If this action will violate any of the rules above, the computer will
beep and the action will not be committed.

· ESC key - Removes the last placed vertex.  Each successive ESC key press will remove
another vertex.  If the ESC key is pressed with only one vertex placed, drawing mode will
be exited, and the plan area creation will be aborted.

Editing or deleting an area 
1. Put the screen in Edit mode. 

2. Select Areas from the toolbar.

3. Choose Select from the mode toolbar.

4. Move the  mouse on top of the area to be deleted or edited and right click to reveal the

context menu:
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Selecting Edit will reveal the Edit Plan Area dialog, which is similar in functionality to the
Add Plan Area dialog.

The Plan area can now be edited.

Note: Selecting Delete from the context menu will prompt for verification of the delete.

Navigating areas 
1. Select Areas from the toolbar.

2. Choose Select from the mode toolbar.  This will be the only option available in View

mode.

3. Moving the mouse over an area will highlight the area in its color and a tooltip will follow
the mouse pointer with the name of the area.

Locating a specific area 
1. Select Areas from the toolbar.

2. Choose Select from the mode toolbar.  This will be the only option available in View
mode.

3. Right-click anywhere on the plan.  A context menu will be revealed.  

4. Choose the Locate option.  This will be the only option available if the user is in View
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mode, or is not currently hovering over a plan.

The locate dialog will be revealed:

5. Choose a plan area from the dialog.  The view will switch (if necessary) to the plan/layer of
the area, then flash the area in its color a few times.

Objects

Objects can be added by right-clicking on the plan and selecting one of the options provided
on the right-click menu.  

Several objects are available to add:
· Zones – As defined on the Zones & Areas section.
· Devices (which can include Cameras, Microphones, Readers, Sensors, etc.) 
· Links – Create links on a plan layer that allow for easy layer navigation.
· Labels – Create labels on the plan to identify rooms or other plan image items.

The "Add Plan Item" dialog which appears when adding a zone, device, or link plan item will
list the available items of the selected type which have not yet been placed on the current plan
layer. 
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· Add button – Adds the currently selected item(s) to the plan.
· Add All button – Adds all listed items to the plan.
· Available Icons List - Allows the user to change the icon for the plan item(s) they are

adding.

Reverse Command

Reverse Commands are used to send signals back to the customer's panel in order to test to
see if the panel is working properly. Reverse Commands also allow the Operator to interact
with hardware in the field, such as requesting a picture from a surveillance camera or telling a
door with Access Control.

User Defined

The User Defined option is for the specific use of each Central Station. Within the Supervisor
Workstation, User Defined fields may be added to store additional necessary information
about the customer.  Examples of this additional information might be salesperson
information or internal accounting information  

1. With the screen in Edit mode, enter data into the fields on this screen.  Since these fields
are defined by the Central Station, data entry is dictated by what has been added and by the
procedures in place at your location.
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2. Review all changes to ensure the accuracy of the information changed or added then Save
the record.

3. Enter any notes if necessary then click OK.  

Reports

From the Customer Reports screen, Users can add and schedule reports to be periodically
generated and sent from Manitou to the Branch. 

1. Click on the Add New button. The System Reports screen will appear. 

2. Select the desired report from the reports list.

3. Check the Priority level of the report. Manitou will use this number to determine which
reports in the report queue to print first - the lower the number, the higher the priority.
Unless urgent, this number should be set to 6.

4. Enter any relevant search criteria.

5. Click Next.

6. On the Distribution page, select the distribution method and destination for the report.

A number of options are available. Uses can:

· View it on screen, using the preview facility.

· Print it locally (in the central station), with an option to preview first.

· Send it to a nominated customer or dealer, with an option to review first. 

· Send it to any individual (whether on the system database or not) by email or fax, also
with an option to preview.

Destination Window
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For more information on printing, sending and previewing reports, see the Reports: Run a
System Report section of this manual. 

On Test

The On Test form on the customer record provides the Operator with a display of all on test
entries for this particular account that are on record in the Manitou system. This display is a
read-only screen. 

1. Select the Operations menu.

2. Select On Test Inquiry. The form will appear: 
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The following information is displayed:
 

· Contract No. - the customer's Contract Number
· Name - the customer's or company's Name
· Type - the Type of On Test period - Temporary or Permanent
· From - the beginning date and time of the On Test period
· To - the ending date and time of the On Test Period
· Details - information about which parts of the system are On Test (or "Whole System")

Current On Test accounts are shown in red, while expired accounts are shown in grey. Future
On Test accounts are displayed in green. 

To refresh the list, click on the Refresh button. 

Zone Status

The Zone Status on a customer record shows a list of any unrestored zones currently for that
customer account. This is a view-only screen and can be refreshed by clicking the refresh

button. 

Activity Log

The Customer Activity Log screen simply shows a log of all activity on the customer's
account. From this screen, Operators may add a comment, add a resolution code, or filter the
log to show a specific activity for record purposes. 
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Users may right-click on the Activity Log to select a view format - Standard, Report Normal
or Report Detail. Selecting a view setting will also change the view settings of other forms
that use the Activity Log grid, such as Manual Signal, Alarm form, and Customer form. 

Log Date
The Log Date, which appears in the customer activity log, will hold the date that the alarm or
signal event was added to the log. The Event Date is the effective date of the event. Details of
an alarm event will have the same Event Date and be located physically in the same table as
the alarm event, but the Log Date will show when the detail item actually occurred. For alarm
and signal events, the Log Date will show when the event was processed. 

1. To add a new comment, click on the Comment button. An Add Customer Log Comment
box will appear:
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2. Select either Insert New Comment or Add to Selected Event. If adding a comment to a
selected event, ensure the event is selected from the activity log by clicking on it to
highlight the event.

3. Enter a brief summary of the comment.

4. Enter the actual comment into the Comment field.

5. If the comment should be hidden, check the Hidden box.

6. Click OK. The comment is now added to the Customer Activity Log.

View Details of a Comment
To view details of an activity, double-click on the comment. The Log Details screen will
appear:
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Depending on the type of activity, certain fields may or may not appear. Once the details have
been viewed, click OK to return to the Customer Activity Log.  

Refresh the Customer Activity Log

To refresh the log, simply click on the refresh icon. 

Filter the Log
1. Click on the Filter tab located at the bottom of the screen.

2. On the Filter screen, choose the search parameters to filter the logs. Logs may be filtered
by:

· Date and Time
· Log Record Type
· Standard Event Types
· Associated Objects
· Event Categories
· Other (Transmitter, Area, Zone, etc.)
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3. Once the parameters are set, click on the Search button. 

Resolution Code
1. If an event appears in the Customer Activity Log that requires a resolution code, firs

highlight the event by clicking on it.

2. Click on the Resolution Code button. The Update Resolution Code box will appear: 

3. Select the Resolution Code from the drop-down menu.

4. Click OK. The Customer Activity Log is now updated. 

Maintenance Issues

The Maintenance Issues form is similar to the global Maintenance Issues form; however, only
maintenance issues for the customer are displayed on the local Maintenance Issues form.
Since only the customer's issues are displayed, the filtering tab is not needed. 

Additionally, all resolved and unresolved issues are displayed.  Adding, editing, and clearing
of the issues is similar to the global form, but this functionality is locked out when editing the
customer since the maintenance issues do not participate in locking scheme for the customer.
when editing and saving an entity with outstanding maintenance issues, the operator is
prompted for each issue to determine if it was resolved, and for the operator to resolve, purge
or update the issue:
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Note: Maintenance lists may be sorted with the exception of the Description and Notes
columns. 

Access Control

Modules

Modules in Manitou correspond to the physical modules that are installed at the customer’s
site. Three types of modules are available: the V100 access module, V200 input module, and
the V300 output module. The modules added to Manitou must match the information
collected during the customer hardware installation on the data collection worksheet.

1. Select Modules in the Access Control section of the Jump To menu.

2. Click Edit and then click Add to add a new module.

3. Enter the Module Number. This number must match the address set during the hardware
installation or the module will not function.

4. Enter a description for the module, select the appropriate module type from the Type
drop-down menu, and then click OK.
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5. Type the file name of the EEPROM firmware in Parameter 1. The correct file name
depends on the revision of the software loaded on the VertX access controller. File names
can be found in Appendix A, Software Compatibility Chart.

6. Type “38400” in Parameter 2. 

7. Repeat steps 1 through 6 for each module.

Reader Groups

Card readers can be grouped to allow for different levels of access. For example, a business
may give everyone access to the exterior doors but limit access to an interior office. Create as
many groups as you need to provide the different levels of access that you want.

1. Select Reader Groups from the Jump To menu.

2. Click Add to add a new reader group.

3. Enter the next available reader group number in Reader Group. Begin with the number one.

4. Enter a description for the group and then click OK.

5. Repeat steps 1 through 3 for each reader group.

Readers

Each card reader must be defined in Manitou. Reader configuration specifies the type of
hardware and the access method used. 

Readers form
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1. Select Readers from the Jump To menu.

2. Click Add to add a new reader in the Add Reader dialog box.

3. Enter the next available reader number in Reader No. Begin with the number one.

4. Enter a description for the reader.

5. Choose the module that the reader is connected to from the Module drop-down menu.

6. Enter the port number that the reader is connected to in Port. The left side port is number

0 and number 1 is on the right.

7. If this reader is copying from another reader, select the appropriate reader from the Copy

From menu.
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8. Click OK

9. Back at the main form, choose an Access Method from the drop-down menu. 

a. None – reader is disabled

b. Open Door – users can gain access without a card or pin

c. Card Only – users can gain access by presenting a valid card, a PIN is ignored

d. PIN Only – users can gain access by keying in a valid pin, a card is ignored

e. Card and PIN Required – user can gain access by presenting a card and keying in the

associated pin

f. Card or PIN Allowed – user can gain access by presenting a card or keying in the

associated pin

10. Select whether the Anti-Passback Type is Off, Timed, or Real.

11. Select the Entry and Exit Sector if applicable. Sectors are set up in the Systems section of

the customer form.

12. Select a Device from the drop-down list if applicable. 

13. Select a Reverse Route from the Reverse Route drop-down list. 

14. In the Reader Group section, select a Reader Group for the Reader. A Reader must belong
to a reader group before the function will enable. 

15. Select a Reverse Command from the drop-down list if applicable. 

16. Repeat steps 1 through 9 for each reader. Users may copy a reader that has already been
configured by choosing it in the Copy From drop-down menu in the Add Reader dialog
box.



Maintenance Menu 209

© 2009 Bold Technologies Ltd.

Elevator Access Groups

Elevator Access Groups allow or disallow access to certain floors in a building. When an
Elevator Access Group is created, users can give access to a card holder by selecting the
access group from the Elevator In-Sched Group and Elevator Out-Sched Group drop-down
menus in the Access Control Cards tab under the Contact List form.

To add an Elevator Access Group, simply click on the Add button to name the group. This group will then appear in
the Eleve
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Elevator Groups

Elevator Groups allow access to certain areas once a specific floor is reached based on the
restrictions given, as well as contains details describing the physical relays in the group. 

Once an Elevator Group is initially added, the following details may be entered:

· Module No:  The module number the elevator group detail (relay) is on
· Relay No: The relay number on the module
· Button Description: A brief description of the button
· Elevator Access Group: The Access Group the elevator group belongs to
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Holiday Groups

Holiday Groups are a useful way to set up groups that may be allowed special access to an
area  or building during holidays. 

Once the initial holiday group is created, the following details must be added:

· Month - the month in which the holiday occurs
· Day - the day of the month which the holiday occurs
· Year - the year in which the holiday occurs (optional). If the year is left empty, then the

holiday occurs on the same day every year (such as December 25th). For holidays with
floating dates (such as Labor Day), then a year must be entered for every year the holiday is
to be observed.

Access Levels

An access level is the combination of a schedule and a reader group. It determines the times
of day and days of week that a particular set of readers will grant access. The first step in
creating an access level is to create the schedule. Access control schedules are entered as
General Schedules on the customer.

1. Click on Back in the Jump To menu to return to the main menu.

2. Select General Schedules from the Jump To menu.

3. Click Add to add a new general schedule.

4. Enter the next available schedule number in Code. Access control schedule codes must be
numeric and should begin with the number one.

5. Enter a description for the schedule.

6. Select “Access Control” from the Type drop-down menu and then click OK. 
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7. Check the days of week during which access will be granted. 

8. Type the time in 24-hour format that access will begin and end in Start 1 and End 1. Two
ranges of time may be entered for each set of days. If the time range varies on different
days you may add as many lines as necessary (Figure 12) to create your schedule.

9. Repeat steps 1 through 8 for each schedule.

Access Levels can be created now that the schedules and reader groups have been defined.

1. Click Access Control on the Jump To menu to return the access control configuration.

2. Select Access Levels from the Jump To menu.

3. Click Add to add a new Access Level. An Add Access Level box will appear: 

4. Enter the next available Access Level number in Access Level. The first level should begin
with the number one.

5. Enter a description for the Access Level and then click OK. 

6. Select a Reader Group that will be granted access under Reader Group. Select the schedule
that will determine when access is granted under Schedule. Repeat this step for each
combination of Reader Group and schedule that make up this Access Level. 

Added Access Levels
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7. Repeat steps 1 through 6 for each Access Level.

Card Sets

Card sets define the format for a group of cards. The format of the card determines how
information is stored on the card. Add a card set of each type of card that will be used.

1. Select Card Sets from the Jump To menu.

2. Click Add to add a new Card Set. An Add Card Set box will appear:

3. Enter the next available Card Set number in Card Set Number. The first Card Set should
start with the number one.

4. Enter a description for the Card Set.

5. Select the proper card format from the Format drop-down menu and click OK. Card
formats are loaded in Manitou by Bold Technologies. If a card format is not listed, contact
Manitou technical support. 

6. Click OK.

7. Back at the Card Set screen, enter the parameters into the parameters field:

Each format may have up to eight fields, A-H, of additional information. The information in
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these fields must be defined in the Card Set for the VertX access controller to properly read
the cards. For example, SIA 26 bit cards contain an 8 bit facility code. The facility code is
stored in the first field. It is entered in Parameters as “A:XX” (field name followed by a colon
followed by the value of the field) where XX is the facility code. 

8. When finished, click Save. 

9. Repeat steps 1 through 6 for each Card Set.



Maintenance Menu 215

© 2009 Bold Technologies Ltd.

Output Groups

Output Groups provide a way to group multiple commands together so that they can be
actioned as a single command. In  other words, users can add several commands to a single
access control point that will tell the system what command to perform in the event of a
specific function. For example, if the function is to grant access to Door 1, the action will
initiate granted access. However, if the function is deny access to Door 1, the action will
initiate denied access. 

1. Add an Output Group ID by first clicking on the Edit button to put the screen in Edit mode.

2. Click on the Add button located under the Transmitter No.

3. In the Add Output ID box, select the Output Group ID number from the scroll window.

4. Enter brief description of the Output Group ID into the Description field (e.g. Exterior

Doors). 

5. Click OK.

6. Back at the main Output Group ID screen, ensure the appropriate Output Group ID is
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selected from the list by clicking on it.

7. Click on the Add New button to bring up the Add/Update Output Group ID Detail box:

8. Select the Module from the drop-down menu. This is the module that the function will

execute on.

9. Select the Function Code. This is the function that should be performed, such as Reader 1

beeper.

10.Select the State. The available state options will vary based on function previously

selected.

11.Click OK. The command has now been added:

Field Descriptions

· Module – the module to execute the function on.

· Device – text description of the device the function will act against (if set up and associated
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in the Device configuration).
· Function – what function to perform (i.e., Door 1 Strike Relay).
· Action – what action to perform on the function (i.e., turn relay on).

Users can move the position of the commands by selecting a command and clicking on the
up/down arrows. Commands can also be deleted by highlighting the command and clicking

on the  button.

Programs

Programs provide the ability to create messages or drive outputs based on condition changes,
schedules, or timers. Each program item consists of three parts:

· Comment - a brief description of the program line's function

· Action - any of the following actions that can occur:
o Drive Output - drives an output, such as changes to a relay state
o Drive Output Momentary - momentarily drives an output
o Drive Output Group - runs an output group
o Send Event Message - creates a message
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o Set Timer - create a timer so it can be used in subsequent rules
o Set Logical Bit - set the value of a logical input so it can be used in subsequent

rules

· Condition - conditions that trigger the action, such as:
o Drive Output, Drive Output Momentary, Drive Output Group and Send Event

Message can only be triggered by a Logical bit (unless overridden);
o Set Timer can be triggered by an Input (e.g. sensor) or by a schedule; and
o Logical Bits can be triggered by an Input, Schedule or Timer.

Card Status

This section has not yet been documented.

Unlocking doors based on a schedule using Access Control

Create a General Schedule with a numeric name, and type of Access Control. The schedule
should be based upon when the door should remain open. Tip – if you create a schedule the
door will remain open until the last minute has finished. In other words, if the schedule ends
at 17:00, the door will remain open until 17:01.

Access the Output Groups option from the Jump To menu (under Access Control) and setup a
new output group to unlock the doors. The user will need to add the output group first and
then add the modules that need to be controlled. In the example below, the user has set the
west front door strike relay to be on. This depends on how the system has been configured.
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Access the Programs option from the Jump To menu, then program a logical bit (set a
variable) based upon the schedule created in the beginning by setting the Action to “Set User
Flag” and setting a User Flag Number. In this example, the user has  used 11 only because
there was one setup for a separate process already. This flag is then based on the schedule that
the user set up earlier called “Door Unlock”

Access the Programs option from the Jump To menu. The user will now create a program
based on the logical bit to use the output group that was created earlier. 

Add a new program. Set the Action to Drive Output Group. Set the output Group to the group
created earlier and set the User Flag to the flag created earlier as well.
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Once the program has been downloaded to the panel, the doors should now unlock.

Deleted Customers

The Deleted Customers form displays customers that have recently been deleted from the
Manitou system but have not yet been purged from the database. The function also enables the
Operator to view and filter the deleted customer's logs. 
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The Deleted Customers form is divided into three sections: Details, Logs, and Filter. Each
section may be selected from the appropriate tabs at the bottom of the Deleted Customers
form. 

Details

The Details Page is automatically loaded when the Deleted Customers form is selected. This
page consists of a date range area with an optional Customer ID field and a Search button. By
entering search parameters, users may find specific deleted customers within a date range or
by Customer ID. Once the search is completed, a list of customers will appear in the Deleted
Customer list located to the left of the form. 
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Select a customer from the Deleted Customer list. The customer's information will be
displayed in the fields to the right of the list. 

Logs

The Logs form displays the customer logs pertaining to the particular customer selected on
the details form. This information is complete up until the time the customer was deleted. The
deleted customer's log is stored in order to comply with UL standards and will remain in the
system until the record is purged. 

Users may add a comment tot he deleted customer's log. To add a comment, click on the
comment button and enter the details in the dialogue box. 

Filter

Users can filter through the Deleted Customers list by clicking on the Filter Tab and entering
search parameters. Users can filter deleted customers by:

· Date and Time
· Log Record Type
· Standard Event Type
· Associated Objects
· Event Categories
· Other (Transmitter, Point ID, User Initials, etc.)
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Once the parameters are entered, click Search to filter the deleted customers. Customers that
meet the filter parameters will be displayed on the main Deleted Customers screen. 

Dealer

The Dealer form allows the user to create and maintain a database of Dealers that the Central
Station may need to contact or call out in the even of an alarm or other emergency. Dealers,
once created, may also be added to action patterns and call lists as needed. Deleting an
inactive dealer will provide a dialog to delete all customers of the dealer as well as the dealer
itself.

To Find an Existing Dealer Record 
1.  On the Dealer form, click the magnifier button to the right of the Dealer ID field. This will
bring up the Find Dealer window. 
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2.  Type an ‘*’ in the value field adjacent to the Dealer ID field and then click the Search
button.

3.  Choose the record that you wish to view and then click Load.

The selected record will now be displayed. 

Note: When the Use Master box is checked on a sub-dealer's master file, the Master dealer's
name and address information is displayed on the alarm screen for accounts that belong to the
sub-dealer. 

Create a Dealer Record
1. Select Dealer from the Operations menu.

2. Click on the New button located at the top of the screen. An Add Dealer box will appear:
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3. Enter a unique Contract ID into the Contract ID field. Dealer IDs are specific to Central

Station standards. 

4. Enter the Name of the Dealer into the Name field.

5. Select the Country, Language and Time zone from the drop-down menus.

6. Click OK.

7. Back at the main screen, enter the address, city, state and zip code into the appropriate

fields.

8. Enter the phone numbers into the appropriate fields.

9. Enter an e-mail address if applicable.

10.Enter a Web address if applicable.

Dealer Options

1. Click the Options Tab and put the screen in Edit mode.

2. If Customers are allowed to take jobs on test, click the check box. This would allow the
customer to be able to put their account on test in the event that the customer would like to
test their service. 

3. Click the drop-down arrow to the right of the Engineer Security Level field and select the

applicable level.

4. Click the drop-down arrow to the right of the Monitoring Group field and select the

applicable group.

5. Review each item for accuracy.
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6. Click Save or click on another tab to continue editing this Dealer record.

Dealer Contact List

The Dealer Contact List contains contact information for Dealers and contacts alike. Most
entries will be made under Contacts. 

1. On the Main Contact List screen, put the screen into Edit mode by clicking on the Edit
button.



Maintenance Menu 227

© 2009 Bold Technologies Ltd.

2. Click on the Add button. An Add keyholder window will appear: 

3. Select whether the contact is a Keyholder or Global Keyholder.

4. Enter the name of the contact into the Name field.

5. Select the Country, Language, and Time Zone of the contact.

6. Enter the Contact's site, home, business and/or mobile phone numbers.

7. Click OK.

8. Back at the main screen, enter a title and/or suffix for the contact.

9. Enter the Job Title of the contact into the Job Title field.

10.Select the birthday of the contact from the calendar. 

11.To add a picture to the contact, right click on the gray box located next to the Contact's
information. Select Find, and choose a picture file.

12. Select the Access permissions for this Dealer in the Access box. 

13.Enter a Password, Web Access ID and/or VRT ID into the appropriate fields. 

14.Enter a maximum amount of test time a Dealer may put an account on test. 

15.If applicable, click or tab into the Valid To field and use the drop-down arrow to select a
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date from the calendar.

16.If the Contact will be inactive for a period of time, indicate that with the Inactive From and
Inactive To fields.  Use the drop-down arrows to select dates from the calendar for each
field.

Contact Information Tab
1. Click the House tab on the right side of the Application view. 

2. Use the drop-down arrow located to the left of the top telephone number field to select a
telephone number type from the list.

3. Click the notepad icon to the left of the first telephone number field and select Properties.

4. Enter the area code, phone number and extension (if applicable) into the fields available.

5. Use the drop-down arrow to the right of the Email label to select the Email address to enter
(Email, Email 2 or Email 3). 

6. Click into the E-mail address field and type in the entire Email address.

7. Repeat the above three steps for up to three Email addresses.

8. Tab or click into the Web Address field.  Manitou automatically copies the text after the @
symbol in the Email address and adds 'www' to auto-fill the Web address.  By default the
Web address is highlighted for removal or overwriting.  If there is no Web address delete
that entry.  If a different URL is necessary, enter the correct Web address.  

9. Use the drop-down arrow to the left of the "This is the Mailing Address" title, to select an
address type.

10.Click or Tab into the Street 1 field and enter the first line of address information for this
Contact

11.Click or Tab into the Street 2 field and enter any additional address or suite information.

12.Click or Tab into the City field and enter the City/County name.

13.Click or Tab into the State field and use the drop-down arrow to the right of the State field
to select the applicable state.

14.Click or Tab into the Zip code field and enter the Zip code.

15.Check the checkbox if the address is also the mailing address.

16.Move on to the Notes tab.
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Notes Tab
1. Click the Note Pad Tab on the right of the Application View to open the Notes screen.

2. Enter any notes that pertain to the Contact.

3. Save the record or click on another tab to enter more Monitoring Company information.

 Add a secondary Dealer associated with the Main Dealer record
1. Click the Dealer in the Contact List navigator.

2. Click the Add button above the Contact List.
3. In the Add Dealer window enter the Dealer Contract Number OR use the Search button 

 to find the Dealer.  The Name will auto-fill based on the Contract No..

4. Verify the selection is correct then click OK.

5. Set the Valid and Inactive dates using the drop-down arrow to the right of the field to select
dates from the calendar.

6. Click the House tab to the right of the Application View.

7. All information should be defaulted into their applicable fields.  Most of the Dealer
Contact record is not editable because it is a pre-existing record.  If changes need to be
made they should be made to the dealer record itself - not through this Contact interface.

8. Click the Notepad tab to the right of the Application View.

9. Enter any Notes about this Dealer Contact as pertaining to the Dealer record.

10.Review all additions to ensure the accuracy of the information added, click Save, enter any
notes if necessary and click OK.  

11.Alternately, click on another tab to continue editing this Dealer record. 

Dealer Call Lists

Call Lists for Dealers contain the details of all the people requiring contact for a given alarm
type. Rotation lists are often in place to ensure that one Keyholder is not the only Keyholder
contacted each time there is an alarm. Call Lists are lists of contact, grouped and ordered
based on alarm-types and priority.  

1. Select Call Lists from the Dealer Jump To menu. The Call List screen will appear: 
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2. Click on the Add button. An Add Call List window will appear: 
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3. Enter a four-character code in the Name field. 

4. Enter a brief description into the Description field. 

5. Select Main List or Sub List from the Type drop-down menu. Main Lists may contain other
call lists while Sub Lists cannot include other call lists. 

6. Click on Add to Matrix.

7. Click OK.

8. If the list is a Main Call List, select Main. If it is a Sub List of a Main list, select Sub List.

9. Click Add to Matrix. The Call List will be added to the Customer's account.

10.Click OK.

11.Back at the Call List form, select the item or items from the Contacts list that should
appear in the Call List. Contacts appearing in the list should be previously added in the
Contacts form of the customer record. 

12.Move the Contacts over to the Call List by clicking on  . The Contacts will now appear
in the Call List. 
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Note: Clicking on the contact's phone number or e-mail address and adding it to the Call List
will only add that specific number or e-mail to the Call List. Select the contact's name and
adding it to the Call List will add all contacts available for that Contact (varying phone
numbers, e-mail, fax, etc.) Select only the specific phone number to add to the list if only one
number should be contacted. If all forms of contact should be used, select the Contact's name,
and add it to the list. 

13.Move list items up and down based on priority by clicking on the up/down arrows to the
right of the Call List. 

14.If the Call List rotates, check the Rotation List Active checkbox. The contact at the top of
the list will automatically be the head of the list, indicated by an icon that appears when the
Rotation List Active checkbox is checked. This contact will be first in rotation. 

15.Indicate the Next Rotation date by selecting the correct date from the calendar. The start
date defaults to the current day.

16.Set the rotation interval by clicking on the up/down arrows to set the number of days each
rotation is active before rotating. For example, if it is set to 1, the list will rotate every day. 

17.If a Contact on the list is a Must Contact or Does not Rotate, select the appropriate Contact
and check the applicable boxes. If "Does Not Rotate" is selected, the person must be
contacted regardless of the rotating schedule.

18. Once all contacts are added, click Save. 

Dealer Attentions

Dealer Attentions are used for the sole purpose of printing and mailing paper copies of
reports run through Manitou. If an Attention is entered, Manitou will print that attention prior
to printing out the physical address of the recipient. 

1. Enter an attention into the appropriate field by first clicking on the Edit button to put the
screen into edit mode.

2. Click in the appropriate field.

3. Select the contact from the drop-down menu. (Note: For Contacts to appear, they must first
be entered into the Contact List).
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4. Click Save. 

Dealer TX Types

The Dealer Transmitter Types tab allows the selection and removal of all Transmitters the
Dealer services. The list under Available Transmitters displays all of the Transmitters entered
into Manitou. 

1. With the screen in Edit mode click the Transmitter tab, located at the bottom of the
Application View.  The Dealer Transmitters screen displays two columns.  The Available
Transmitters are on the left and the Selected Transmitters are on the right.

2. To add to the list of this Dealer's Selected Transmitters, click to highlight one in the
Available Transmitters list in the left column and click either the ">" to move one at a
time, or the ">>" to move all the control panels to the Selected Transmitters list on the
right.

3. Use the "<" and "<<" arrows to remove panels from the "Selected" column and return them
to the "Available" column.

4. Review all the items and click the Save button. 

Dealer TX ID Ranges

Transmitter Ranges determine which transmitter IDs are allocated to a Dealer for use with
that Dealer's accounts.  When adding new Customer accounts to the system, consider that the
Customer's Transmitter ID should be within the Transmitter Range of it's associated Dealer. 
The purpose of assigning a range of Transmitters to Dealer records is that more information
about incoming signals is immediately available.  When a signal is received with a TXID
(Transmitter ID) within a particular Dealer's range it is clear that the signal is from one of that
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Dealer's accounts.  This gives the Operator more information when handling alarms.
 
 

Add Transmitter Ranges
1. Open a Dealer account to add Transmitter Range information.  

2. Click the TX Ranges Tab and put the screen into Edit mode.

3. Tab or Click into the Receiver Line Designation cell at the upper left.  

4. Use the drop-down arrow at the right of the Receiver Line Designation cell and select the
applicable Receiver Line from the listing.  This information should be available from the
Administrator or Manager of the Central Station.  It is important to know which Customers
and Dealers are assigned to which Receivers and RLDs.

5. Tab into the TX ID (Transmitter ID) From field and enter the starting number of the TX
Range.  

6. Tab into the TX ID To field and enter the ending number of the TX Range.  

7. Tab into the Next TX ID field and enter the next Transmitter ID to use for this Dealer
record.  

8. Tab into the TX ID Type field and use the drop-down arrow to indicate the format of the
Transmitter ID (Decimal, Hex (Include A), Hex (Exclude A)).  This is based on the TX ID
format used by your Central Station and/or that Dealer.  

9. Tab into the Range Full field and click the checkbox if the Transmitter ID range is full at
this time.  This is sometimes used to block out a particular number of transmitter ID’s to be
utilized by a specific account.  

10.Tab into the Restart cell and click the checkbox if, once completely through the list of
ranges, it is okay to start again looking for empty Transmitter ID numbers.  

11.Repeat this process for all Transmitter Ranges allowable for the Dealer.  

12.Review all entries to ensure the accuracy of the information and Save the record.  Enter
any notes if necessary then click OK.  

13.Alternately click on another tab to continue editing this Dealer record. 
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Dealer Programming

The Dealer Programming section within the Dealer interface contains all the Dealer-level
items that trigger Action Patterns.  This is a simpler interface than the Programming Screen
associated with Customer records because Dealer Programming only deals with Action
Patterns, not signal reassignment.  
 
Add Programming
 

1. Open the Dealer Form by clicking the Dealers Shortcut, Shortcut Icon or by clicking

Maintenance then Dealer.

2. Click the Search icon.

3. Locate the Dealer and open dealer information.

4. Click the Edit Button located at the top of the Application View.

5. Click the Event Programming tab located at the bottom of the Application View. 

6. Click into the top left empty cell and use the drop-down arrow to the right of the Event cell
to select an Event Code from the list.

7. The Description cell will fill automatically based on the Event Code selected.  Tab into the
Alarm cell and use the drop-down arrow to the right to select the applicable value for
Alarm.  This tells the system whether or not this Event will trigger an alarm or just show
up in the log as a signal.  The "Default" value tells the system to treat the event as whatever
the system default is.  For example, a BA would always be an Alarm unless otherwise
defined; so, left at default value BA continues to always trigger an alarm.  Change the
value to "No" and BA will only be logged as a signal instead of being displayed and
handled as an alarm.

8. Tab into the Actions cell and use the drop-down arrow to the right of the cell to select the
applicable Action Pattern - Global or Dealer level Action Patterns will be available in the
list.

9. Tab into the Instructions cell, click the [...] button and enter specific instructions for the
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Event into the text-entry window. 

10.Click OK.  The instructions appear in the Help cell.

11.Review all changes to ensure the accuracy of the information and Save the Programming. 
If entering many lines of programming, Save after every few entries to avoid losing data.  

12.Enter any notes if necessary then click OK.  
 

Dealer Comments

The Dealer Comments area allows users to view, enter, or edit temporary, current, future,
and special instruction for a customer. The Comment area also offers users access to view
expired comments about a customer.

1. Select the Edit tab at the top of the Comment screen.

2. Above the tree menu there are three buttons Add, Remove, and Refresh. Select the Add
button to add a comment into the tree menu and onto the customers account. The Add
Comment screen will display.
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3. Select the Comment Type by clicking the circle that fits the type of comment that will be
added.

· Temporary - A Temporary note will only appear within a duration set by the Operator.
1) Click the Add button above the list of Note types.

2) In the prompt box verify that the correct radio button is selected - Temporary.

3) Type a name to identify this Temporary Note and click OK to return to the main Notes
screen.

4) Use the drop-down arrows to select a Valid From and To date from the calendar
interface; and use the up/down roll arrows to indicate the Valid From and To times. 
The Temporary Note will only be associated with this record for the duration specified
by these date and time parameters.

5) Type the body of the note into the large text area beneath the date/time fields.

6) Save the record or make other changes to the notes Tab.
 
· Standing - A Standing note is always true for the Customer record (until edited or deleted).

1) Click the Add button above the list of Note types.

2) In the prompt box verify that the correct radio button is selected - Standing

3) Type a name to identify this Standing Note and click OK to return to the main Notes
screen.

4) Type the body of the note into the large text area beneath the date/time fields.  Since
this is a more permanent note type, there are no date and time parameters.  This note is
valid until edited or deleted.

5) Save the record or make other changes to the notes Tab.
 
· Special Instructions - Special Instructions are selected from a drop-down.  The list items

are entered on the Notes tab of the Central Station record.
1) Click the Add button above the list of Note types.

2) In the prompt box verify that the correct radio button is selected - Special Instructions.

3) Using the drop-down arrow select one of the Special Instructions Notes from the list.

4) The associated note appears automatically in the text field.  This note is valid until

edited or removed.
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5) Save the record or make other changes to the notes Tab.

 
· In House - In House Notes are only visible to the Central Station.  They are not available to

the Dealer when logged into Manitou remotely. 
1) Click the Add button above the list of Note types.

2) In the prompt box verify that the correct radio button is selected - Special Instructions.

3) Using the drop-down arrow select one of the Special Instructions Notes from the list.

4) The associated note appears automatically in the text field.  This note is valid until
edited or removed.

5) Save the record or make other changes to the notes Tab.

Dealer Action Patterns

Dealer Action Patterns speed the processing of specific alarms by telling the Operator who
to call and what actions to take on each and every alarm.  
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1. Scroll down the navigation list, select Dealer and Click Add.

2. Click into the Action ID field and Enter a brief code for the Action Pattern.

3. Click into the Description field and enter a short description of the Action Pattern.

4. Click OK to return to the main Action Patterns screen.

5. Select the type of Action Command in the first pane to the right of the Add and Remove

buttons.

· Contact - Add contacts to Action Patterns to guide the Operators in calling, paging and/or
emailing relevant individuals:

1) Select the Contact to add to the Action Pattern from the list.

2) Click the Add button located just above the Action Pattern pane, to add the Contact to

the list.

3) Repeat this process for all persons requiring contact with this Action Pattern.

4) Use the Up and Down arrows to the left of the pane to adjust whom to contact first,

second, etc.

5) If a contact was added in error, remove by selecting the list item and clicking the "X"
button located just outside the lower left corner of the Action Pattern pane.

· Remark - Add a remark to the Action Pattern to insert a comment or reminder for the
Operator:

1. Tab or Click into the Remark pane.

2. Type the Remark to be added to the Action Pattern.

3. Click the Add button located just above the Action Pattern pane, to add the Remark to

the list below.

4. Repeat this process for all remarks tied to this Action Pattern.

5. Use the Up and Down arrows to the left of the pane to adjust exactly when in the
Action Pattern the remark should be executed.

6. If a remark was added in error, select it from the list and click the "X" button located
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just outside the lower left corner of the Action Pattern pane to remove the item.

· Log Line - a Log Line action will be added to the Customer Log for each alarm to which
it's added:

1. Tab or Click into the Log Line pane.

2. Type the information that will appear in the Customer Log.

3. Click the Add button located just above the Action Pattern pane, to add the Log Line

to the list.

4. Repeat this process for all Log Lines tied to this Action Pattern.

5. Use the Up and Down arrows to the left of the pane to adjust when the Log Line
should be executed within the Action Pattern.

6. If a Log Line was added in error, select it from the list and click the "X" button located
just outside the lower left corner of the Action Pattern pane to remove the item.

· Show - Add this type of Action to display the help text directly from the Event Category,
Event Definition, etc. as part of the Action Pattern:

1. Select an applicable option to show Help Text about one of the following: Event
Category, Event Definition, Event Programming, Transmitter or Script.

2. If selecting Script, click the drop-down arrow to the right of the field just below the
Script radio button and select the script to display.

3. Click the Add button located just above the Action Pattern pane, to add the Show item
to the Action Pattern.

4. Use the Up and Down arrows to the left of the pane to adjust when the Show item
should be executed within the Action Pattern.

5. If a Show item was added in error, select it from the list and click the "X" button
located just outside the lower left corner of the Action Pattern pane to remove the
item.

· Attention - Add an Attention line for the purpose of emphasizing information, or to fulfill
UL requirements about Alarm ticket information.

1. Tab or Click into the Attention pane.

2. Type the text to be added to the Action Pattern.

3. Click the Add button located just above the Action Pattern pane, to add the Attention
line to the list below.
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4. Repeat this process for all Attention actions tied to this Action Pattern.

5. Use the Up and Down arrows to the left of the pane to adjust exactly when in the
Action Pattern the Attention line should be executed. 

6. If an Attention line was added in error, select it from the list and click the "X" button
located just outside the lower left corner of the Action Pattern pane to remove the
item.

· Suspend - Add this type of action to Suspend the Alarm for an allotted period of time at
some point in the Action Pattern:

1. Click the up/down arrows or enter the time to suspend the Alarm.

2. Select if the time unit is in Seconds, Minutes or Hours by clicking the applicable radio
button.

3. Click the Add button located just above the Action Pattern pane, to add the Suspend
command to the list.

4. Repeat this process again if more than one suspend is necessary for this Action
Pattern.

5. Use the Up and Down arrows to the left of the pane to adjust when the Suspend should
be executed within the Action Pattern.

6. If the Suspend was added in error, select it from the list and click the "X" button
located just outside the lower left corner of the Action Pattern pane to remove the
item.

· Close - Add this type of action to prompt for Closing the Alarm with Resolution Codes
automatically entered by the action at the end of the Action Pattern:

1. Click the drop-down arrow to the right of the Resolution Code field.

2. Select a Resolution Code from the list.

3. Click the Add button located just above the Action Pattern pane, to add the Close
Resolution Code to the list.

4. Use the Up and Down arrows to the left of the pane to adjust when the Close
Resolution Code should be executed within the Action Pattern.

5. If a Close Resolution Code was added in error, select it from the list and click the "X"
button located just outside the lower left corner of the Action Pattern pane to remove
the item.
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6. After configuring the Action Pattern, repeat the process for all additional Global Action
Patterns required for the Central Station.

7. Verify all items for accuracy and Save the record or click on another tab to add more
Central Station information.

Dealer Billing Charges

Dealers can set up billing cycles and charges through the Operator Workstation. Dealer
Billing can be by Class Code or by Monitoring Service billing code, which is entered in the
Monitoring Type form in the Supervisor Workstation. Additionally, an Activity-based billing
utility for a Dealer is available for Sedona and Quick Books accounting systems. The amounts
are determined by the information entered into the Dealer's billing charges form. The new
system option for billing by Class Code or Monitoring Service billing code will control how
the charges are generated for this process.

1. First, select a class code for this Dealer. 

2. Enter the Active Price for all active accounts.

3. Enter an Inactive Price for all inactive accounts.

4. Enter the Accounting Billing Code.

5. Enter the Signal Limit. This is in case the Dealer is charged per number of signals received

from their accounts.

6. Enter the Alarm Limit.

7. Enter the Total Limit.

8. Enter the Signal, Alarm and Total Price.

9. Enter a Limit Billing Code if applicable.

10.Click Save. 
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Dealer General Schedules

Dealer General Schedules define the availability of Keyholders, schedules, and when the
Dealer can put his or her accounts on test. 

1. Click on General Schedules in the Jump To menu. 

2. Click on the Add button. An Add Schedule box will appear:

3. Enter a brief four-letter code into the Code field.

4. Enter a brief description into the Description field. 

5. Select a Type from the drop-down menu. 

6. Click OK to return to the main General Schedules screen. 

7. Select the days of the week to be included in the General Schedule by checking the
appropriate checkboxes. 

8. In the Start 1 and End 1 cells, enter the first Start and End time. If applicable, enter a
second Start and End time. For example, there may be some times when a keyholder is
available during regular business hours, however they may be unavailable during a
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commute home. This is when two start and end times would be utilized. 

9. In the From and To date cells, enter the the dates which this schedule is applicable. Enter
only numbers, as Manitou will automatically insert the date separators. 

10.Repeat as necessary to add any additional schedules. 

11.Click Save. 

On Test General Schedule
This general schedule is intended to provide a window during which a Dealer will be allowed
to put accounts out of service, assuming he or she is initiating the out of service. This means
that if an "On Test" general schedule exists on the Dealer account for 9 a.m. to 5 p.m. on
weekdays, and a dealer logs into VRT or BoldNet to put the account on test outside of the
schedule, they will not be allowed to. At this point, they will be required to call in to the
Central Station to have an Operator place an account on test. Each dealer account is only
allowed a single On Test schedule. 

Dealer Control Panels

Dealer Control Panels allows the selection and removal of all panels that the Dealer
services.

1. Open the Dealer record and click the Edit button located at the top of the Application
View.

2. Click the Control Panels tab, located at the bottom of the Application View.
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3. The Control Panels interface has two columns.  The Available Control Panels are on the
left and the Selected Control Panels are on the right.

4. To move a Control Panel list from the Available list to the Selected Control Panels list,
click to highlight one of the Available Control Panels on the left and click either the ">" to
move one at a time, or the ">>" to move all the control panels at once. 

5. Use the "<" and "<<" arrows to remove one or all panels from the "Selected" column and
return them to the "Available" column.

6. Select each Control panel in the Selected Control Panels view one-at-a-time and make any
changes to the Maximum Areas, Transmitters, Zones, and/or Users values.  Most often, the
defaults should be correct.  This screen provides the ability to change those values if they
differ for some reason.

7. Review all the items within the view then Save the changes.
 

Dealer Reverse Protocols

This information has not yet been documented.

Dealer Reverse Commands

Reverse Commands for Dealers can be used to send a command back to a panel to test to
see if it is working properly. 
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This information has not yet been documented.

Dealer Reports

From the Dealer Reports screen, Users can add and schedule reports to be periodically
generated and sent from Manitou to the Dealer. 

1. Click on the Add New button. The System Reports screen will appear. 

2. Select the desired report from the reports list.

3. Check the Priority level of the report. Manitou will use this number to determine which
reports in the report queue to print first - the lower the number, the higher the priority.
Unless urgent, this number should be set to 6.

4. Enter any relevant search criteria.

5. Click Next.

6. On the Distribution page, select the distribution method and destination for the report.



Maintenance Menu 247

© 2009 Bold Technologies Ltd.

A number of options are available. Uses can:

· View it on screen, using the preview facility.

· Print it locally (in the central station), with an option to preview first.

· Send it to a nominated customer or dealer, with an option to review first. 

· Send it to any individual (whether on the system database or not) by email or fax, also
with an option to preview.

Destination Window

For more information on printing, sending and previewing reports, see the Reports: Run a
System Report section of this manual. 

Dealer Statistics

Dealer Statistics are a quick and easy to view customer statistics in the Manitou Client or
from the Web. The Statistics form is a read-only menu, with the option of drilling down into
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each statistic for additional information. Users may also select to include Sub Dealers in the
statistics. Checking this option will add the Sub Dealer counts to the main Dealer's counts. 

Two options control several aspects of the Statistics. The first determines the number of
customers for be shown for "Top x" statistics, where x is 1-50. The second controls the
number of days of activity to be considered for activity related statistics. Several new statuses
are maintained at the customer level. They are "Low Battery", "Late to Test" and "No Event
Programming." These can be seen on the Zone Status form of the customer and in the
customer status forms. 

Statistics are provided for the following areas:

Customer Counts
· Active Customers - All active customers for a specific dealer
· Inactive Customers - All inactive customers for a specific dealer
· Pending Customers - Currently pending customers for the dealer
· Deactive Customers - Deactivated customers for the dealer

Customer Status Summary
· Currently In Alarm - All alarms in the Alarm Queue that belong to the specified dealer or

sub dealer
· Currently On Test - All alarms for the specified dealer or sub dealer that are on test
· Dispatched Alarms in the Last 24 Hours - Number of alarms in the last 24 hours for

customers belonging to the dealer that authority has been dispatched on
· New Maintenance Issues - Number of maintenance issues that have not been modified
· Unresolved Maintenance Issues - Number of unresolved maintenance issues for the dealer
· With Expired Permits - Number of customers belonging to the dealer with expired authority

permits
· Watch List - Number of customers on a watch list. A watch list is a group of accounts that is

meant to be easily accessible. For example, if a high profile customer needs to be watched,
the watch list is a shortcut to the customer without having to search for the customer each
time. Customers may be added to the watch list by simply double-clicking on the Watch
List line in the statistics form to bring up the customer Watch List window:
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Click on the Add button and enter the Customer ID to add to the watch list. Once the
customer is added, click Save. 

· Top Alarm Activity over 30 Days - Customer with the most alarm activity over the past 30
days

· Top False Alarm Activity over 30 Days - Customer with the most false alarm activity for the
past 30 days

Customer Transmitter Summary
· In Alarm - Number of current transmitters with an alarm in the Alarm Queue
· In Fault
· In Line Fault
· With Low Battery - Number of transmitters with a low battery
· With Late-to-Test - Number of transmitters showing Late-To-Test signals
· Missing Event Programming -Number of transmitters missing event programming
· Transmitters Not on File in the Last 24 Hours - Number of customers with no transmitters

associated with the account
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Users have the option to select a 24-hour, 48-hour or 72- hour time period to display statistics.

Maintenance Issues

The Maintenance Issues form is similar to the global Maintenance Issues form; however, only
maintenance issues for the Dealer are displayed on the local Maintenance Issues form. Since
only the Dealer's issues are displayed, the filtering tab is not needed.

Additionally, all resolved and unresolved issues are displayed.  Adding, editing, and clearing
of the issues is similar to the global form, but this functionality is locked out when editing the
Dealer since the maintenance issues do not participate in locking scheme for the Dealer.
When editing and saving an entity with outstanding maintenance issues, the Operator is
prompted for each issue to determine if it was resolved, and for the operator to resolve, purge
or update the issue:
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Note: Maintenance lists may be sorted with the exception of the Description and Notes
columns. 

Edit a Dealer Record
1.  Find and then display the appropriate record as described above.

2. Click the Edit button.

3. Move the mouse cursor to the field that needs to be modified and click into the field.

4.  Modify the contents of the field, as required. 

5. Make any changes to additional fiends that should be modified 

6. Use the radio buttons located to the right of the form to move to the various pages of the
record.

7. When finished editing the Dealer record, click Save to store the changes in the database
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Delete a Dealer Record

Dealers must first have an inactive status in order to delete the dealer's record. Users may first
wish to read the instructions on Dealer Takeover to ensure that all current customers are
associated with a new Dealer before deleting the Dealer's account. Otherwise, when deleting a
Dealer record, users will be prompted to delete all of the customers associated with the Dealer
record. If so, continue with the delete process. 

Dealer and Third-Party Billing

The following section details how to set up Dealer and Third Party billing in Manitou.
Accounting company integration is required in order for some of these options to work
properly.

System Options

Before Dealer Billing can be utilized, several options must be set in the Supervisor
Workstation. Under the Tools menu, select Options. The Options form will appear:
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Select the System menu and expand the menu options. The following options will be
available:

· Dealer billing by monitoring service
· Dealer billing prorating
· Dealer billing standard annual cycle
· Dealer billing standard quarter cycle
· Dealer billing standard semi-annual cycle
· Dealer billing summary billing

Dealer billing by monitoring service will bill the customers by monitoring service rather
than class code. Selecting "Yes" will license enhanced billing, which will then enable non-
monthly billing cycles, pro-rate charges, table-based pricing, time-based pricing and deferred
income tracking. This option must be set to Yes.
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If the "Dealer billing by prorating" option is enabled, data entry changes that affect billing
will cause pro-rated charges to be created based on when services start and/or end. If there is
no start date entered and the service is marked as chargeable, the service will begin at the time
of entry. If a start date is specified, the service will start on that date. Please note that the date
cannot be set prior to the current date.  Users may also start or end a service by making
changes in the chargeable status or choosing a different monitoring type code. Additionally,
changes in a customer's status will cause pro-rated adjustments for all active services to be
created. For instance, if a customer with a "pending" status is changed to an "active" status,
will trigger the pro-rated billing as of the active date. 

This also applies to a customer's Dealer setting by stopping billing for the original dealer and
start billing for the new dealer unless it is detected that the new dealer is within the same
master dealer and the sub-dealers are being billed at the same master level. 

The Dealer billing by standard annual, standard quarter, and standard semi-annual
cycle options control when the annually, quarterly and semi-annually "standard" cycles should
occur. Users can select which months to generate recurring charges of that type. For example,
if the user sets the quarterly billing cycle to start in January, the customers will be billed in
January, April, July and October. Setting this option to "Any" indicates that there are no
standard cycles for non-recurring charges, such as overage charges. These charges are billed at
the next billing cycle. 

The Dealer billing summary billing option specifies whether or not the dealer billing report
will be in summary format. This applies to recurring charges only. This may be helpful in the
event that a dealer has multiple recurring charges each month. 

After setting these preferences, locate the "Next dealer billing cycle to generate" option.
Select the year and month for the next billing cycle to start. In this example, the billing cycle
will begin in April 2009:

When finished, click Save. 

Accounting Companies

The next step is to ensure that the accounting company software is properly set up in the
Supervisor Workstation. Select the Maintenance menu > Accounting Companies to open the
Accounting Company form:
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Begin by clicking on the Edit button, and then the Add button to bring up the Add Accounting
Company form:

Enter the Company ID (here, "QUICKBOOKS"), and select the interface type from the drop-
down menu. The Dealer Billing interface type is for dealer billing-only companies. Selecting
this option will only show accounting companies of this new type on the existing Dealer's A/
R company field. It will also exclude the dealer billing-only companies from the customer's
A/R field. The Dealer Billing interface acts in exactly the same way as the push from Manitou
to Accounting, meaning that Manitou will be pushing information to the accounting company
software. 

Select the application (here, "Quickbooks") and the name of the monitoring company. Note
the warning that if no names appear in the Name field, the system has not been integrated
with an accounting system. Please contact Bold Technologies if this occurs. Otherwise, click
OK.

Back at the Accounting Company form, several fields must now be filled in for final set up to
be complete. Enter the Username and Password into the appropriate fields. This username and
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password are the same logins used in the accounting software. Finally, enter the server IP
address that the accounting software is located on. 

Accounting Company Options

Here, users have the option to select to update common fields, require an Account ID, force
the Account ID to be unique during the linking process, force services to be one-to-one with
recurring, and push customer changes. 

If the "Update Common fields" box is unchecked, name and address changes made in
Manitou will not be pushed to the accounting software. Additionally, if "Force services to be
one-to-one with recurring" is checked, linked customers cannot be created, stored or imported
unless all services are completely matching. 

This means that for every monitoring service that is in Manitou, it must also contain a
recurring item in the accounting software, which includes the quantity of each recurring item.
For example, if a recurring item represents an open/close and contains four open/close
services in Manitou, there must be four open/close recurring items listed under the same
system in the accounting software. This is ideal for most Central Stations, but some may wish
to roll-up charges for accounting and don't wish to unroll and itemize individual items. If this
is the case, leave the "Force services to be one-on-one with recurring" box unchecked.

Note: If the accounting company is set for unique services and the direction is Accounting to
Manitou, Manitou will verify that the services and recurring appear to match whenever a
customer is made active, and any changes are made that affect services of an active customer.

The "Push Customer Changes" option will allow users to make edits in Manitou and push the
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information (data entry changes) into the accounting software. 

Monitoring Types

For billing purposes, the Monitoring Types form will allow Central Stations to modulate
every item for billing and reporting purposes with one main form. For example, if the Central
Station wishes to impose a one-time setup fee, it can do so by adding the charge code to the
appropriate Monitoring Type form which will automatically apply to the Service in the Client
Workstation. 

Like the Systems form in the Client Workstation, the Monitoring Types form consolidates
several separated forms and allows easier setup for services in one controlled area. Any
service, billable or not, that is specific to a Central Station can be customized to the Central
Station's liking by adding parameters, such as the maximum and minimum amount of
transmitters.

Monitoring types includes templates for monitoring services and can be accessed through
Maintenance Setup options in the Supervisor Workstation. On each monitoring type form,
billing code and add code fields are available for codes to be added to the monitoring service.
This monitoring service is linked to the customer's record in Manitou. 
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Billing Codes
Users can add a billing code by physically typing it into the billing code field or by looking up
the billing code from the accounting company. To add a code from the accounting system,
click on the magnifying glass icon and select the accounting system from the drop-down
menu: 
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Once the accounting system is selected, the recurring monitoring types that are already in the
accounting system will appear. Select the code and apply it to the billing code field. 

Operator Workstation

Dealer Setup

Dealers can be set up in the Maintenance > Dealers form. Click on the New button at the top
of the form to bring up the Add Dealer form:

Enter the Dealer's ID, the Dealer Name and select the A/R company from the drop-down
menu. Selecting an A/R company and an A/R Number indicates that the Dealer will be billed
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instead of third-party billing (meaning, the monitoring company will send the bill directly to
the customers instead of the Dealer). Select the Country, Language and Time Zone, and click
OK.

Fill in the address, contact information, and additional details such as the E-mail and Web
address on the main form. With the A/R Company and A/R Number defined sub-dealers with
an empty A/R Number will be included under the master dealer. Any dealer that does not
have an A/R company defined cannot enter anything in the Billing Charges form. 

To set up third-party dealing, select the Options form from the Jump To menu:
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If the A/R Company and A/R Number are set in the Third-Party Billing section, it will
indicate that third party dealer billing is in effect for the Dealer's customers. This means that
the monitoring company will bill customers on behalf of the Dealer. Click Save to save any
changes made to this form.

Assign Customers to a Dealer

Assign customers to a Dealer by clicking on the Customer's Details tab in the Jump To form:

Click on the drop-down menu in the Dealer section and select the appropriate Dealer. Click
Save to save the changes. 

Add Services to a Customer

The next step is to add services to a customer. These services are chargeable items that were
set up and defined in the Supervisor Workstation under Monitoring Types. When a System is
added to a customer, services are automatically added that correspond to the system. In this
example, a burglary Event Monitoring system was added, which then automatically generated
a Monitoring Type of Alarms Only:



Manitou Client 1.5.2262

© 2009 Bold Technologies Ltd.

The important part of this form is the Administration section, which signifies whether or not
this service is chargeable. Since this Monitoring Type was already set up in the Supervisor
Workstation with a billing code, it is marked as chargeable. Users may also set the Start and
End date if this service happened to be a temporary service. If the pro-rating option is enabled,
data entry changes will cause pro-rated charges to be created based on when services start
and/or end. If there is no start date entered and the service is marked as chargeable, the service
will begin at the time of entry. The date cannot be set prior to the current date. Users may also
start or end a service by making changes in the chargeable status, or by choosing a different
monitoring type code. 

To make a service non-billable, uncheck the Chargeable box. This is a permissions option and
can be changed in the Supervisor Workstation. Additionally, users can pick a Monitoring
Type that has a zero price attached to it. User should note that setting a service attached to a
system as "not chargeable" does not affect any other services that may be underneath that
same system (such as transmitter test or Open/Close). They each must be marched as not
chargeable if that is the intent.

Invalid Items
Services available to customers are filtered by the Dealer associated with the account. The end
result is that "invalid" items will appear on a customer's services if they are not included at the
Dealer level. This is cosmetic and was done so that the Manitou user can easily see if there are
any data entry issues with an account by looking for invalid items.

Below, a valid service has been set up at the Dealer level and then added to the customer. In
the Monitoring Type field, the full description of "Gold Service Account" appears:
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When selecting the Bronze Service Account, an invalid item appears in the Monitoring Type
field. This is because the Dealer does not have this service within their billing codes:

Checking the "All" checkbox next to the Monitoring Type field will temporarily display the
description again. The invalid item will appear again when the user clicks Save or Cancel.
This "All" checkbox appears in other areas for Dealer billing. Users will need to check this
box to add certain other services, such as Open/Close.

When saving the services changes and a service is not available for the Dealer, an error will
appear, stating the service with the problem:

When this error appears, click OK. Another dialog will appear for the specific service type to
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be added. This is where the "All" checkbox is needed so that one of the available services can
be selected that may not be tied to the Dealer:

This will also be true for items like Transmitter Test. As long as the "All" checkbox is
checked, users can still add the correct service for the account. However, the Monitoring Type
field will state "Invalid" unless the service is attached to the Dealer. 

Set up Billing Rates

The new Billing Rates form allows a rate table to be attached to an item price and/or time
price. In the Billing Charges form, these rate tables are used to calculate rates based on certain
requirements. For instance, if a service exists for monitoring basic alarms, the monitoring
company may create a rate table based on the number of alarms:

Here, for 0-50 alarms received, the monitoring company charges a $5.00 rate. For an alarm
count of 51-99 alarms, the rate is $4.50.  

Dealer and Customer Calculation Types
Dealer and Customer Calculation types will change which rate table is used to calculate
charges. For example, if Dealer Dave has two customers, A and B, and Customer A receives 5
signals over the limit in the last month, and Customer B receives 6 signals over the limit. If
the rate table associated with the billing charge for those signal overage is using the Dealer
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Calculation, then all 11 signals would be charged to Dealer Dave at the rate for 11 signals
specified in the table. However, if the rate table associated with the billing charge is the
Customer Calculation type, then Dealer Dave would be charged for 5 signals at the rate for 5
signals, and charged for 6 signals at the rate of six signals. 

The following rate table is another example of how rate tables may be used:

In this scenario, the monitoring company wishes to asses a fee of $5.00 for false alarms.
When more than two false alarms have been processed, an additional charge of $10.00 is
assessed to the customer. 

Set up Billing Charges

Billing Charges may be set up on a Recurring, Add, Signals or Time basis. 

Recurring
Users may wish to set up a Recurring charge if the service occurs every month. In the
example below, the recurring charges are set up for alarm monitoring:

With an active price, a $10.00 charge is assessed every month for alarm monitoring. Users
may change the frequency of the charges (in this example, every month), and also charge for
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an inactive account. For example, if the account is inactive, but the monitoring company is
still monitoring the site, the inactive rate may be applied. Remember, in the Billing Code
field, add the Billing Code for the service that is defined in the Monitoring Types form in the
Supervisor Workstation. This must also match the billing code in the accounting software.

Add
An Add charge is added in circumstances where a one-time charge may be applied, such as a
setup fee: 

In the Add Rate drop-down box, use the <use price> option to enter the Add Price manually.
Other pre-defined rates may be used if appropriate. 

Signals
Using the Signals Charges form allows the monitoring company or dealer to bill based on the
number of overage signals received in a given time period. Here, users may enter
specifications based on the total price, or by signal and alarm price:

In the example above, the monitoring company is choosing to charge customers $1.00 for
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every signal that exceeds the limit in a given time period, and $3.00 for every alarm that
exceeds the limit. The Signal and Alarm limits are set, and the Billing Code is entered into the
appropriate field. In the Signal Rate and Alarm Rate fields, users can select which rate to use:

Selecting <use price> will use the price entered into the Signal Price and alarm Price fields.
Selecting 1 - Basic Alarms will use the price for basic alarms, and selecting 2 - False Alarms
will use the rate based on false alarms. These rates are determined in the Billing Rates form.

Time Charges
Lastly, the Time Charges form allows for time-based billing items. In the example below, a
time price of $1.00 is used for every 10 minutes (600 seconds) spent on an alarm. The Time
Increment value determines the value that each specific time charge (per signal event) will be
rounded to. For example, if the time spent on an alarm is 6 minutes and 45 seconds, the time
will be rounded to 7 minutes.
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Time-based billing is used in conjunction with soft programming attributes that are attached
to event codes. This programming attribute is "q" and can be set in the Supervisor
Workstation under Events > Event Codes. The signal processing system will recognize the
new attribute and set a new flag on the Customer Activity record to indicate that time-based
billing is active for the event. 

Crediting an Account

Generally, credits are taken for the portion of the already billed period that is being canceled.
For example, if at 10 days into March, a service is canceled, and assuming it was billed
through the end of March already (on a monthly frequency), 21 out of 31 days of the total
invoiced will be credited. It is the remaining days (not including the day of the change)
divided by the total days of that specific period that will be credited. Rate tables have no
bearing on credits, as they are used to calculate charges. Actual billed days is used to calculate
credits. 

Reports

The initial Dealer and Third-Party Billing set up is complete. Now, monitoring companies
may utilize several report options, including posting the billing to accounting software.

Dealer Billing Deferred Revenue

The Dealer Billing Deferred Revenue will be tracked when enhanced billing is licensed. The
report will display the necessary deferred revenue adjustments that ned to be made. The
adjustments must be entered manually into the accounting software. 

Dealer Billing Generate

The Dealer Billing Generate report will report on all billing discrepancies, which can then be
resolved in Manitou. In the example below, the report was run for all existing Dealers:
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The first messages for DLR001 indicate that no billing charge codes were found at the Dealer
or Monitoring Company Billing Charges form for the item code "DRL1FIRE." To remedy
this, the appropriate billing charge code must be added to either the Dealer or the Monitoring
Company. Other messages indicate that some dealers are not linked to accounting.

These messages are simply warnings, indicating that the charges will not be posted to the
accounting software. Rectifying these issues will allow for the charges to be posted. 

Dealer Billing Preview

The Dealer Billing Preview report will list all transactions that are ready to be posted to the
accounting system for dealer billing. This preview can be run as many times as needed, and
should be the last report run before running the Dealer Billing Post. Users have several
options for this report. For instance, the monitoring company may wish to send out the report
to each individual Dealer by selecting a specific Dealer ID. More notable options include
Dealer Options and Grand Totals Options. The Dealer Options checkboxes allow the user to
select whether the report should include all details, or should be summarized by charge type
and/or billing code. The Grand Totals Options will display a total amount of charge types or
billing types, or may be used to just show the charge type summary or the billing code
summary. 
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In this example, the Dealer Billing Preview report was run for DLR001 with the Details and
Total Amount options checked. These options will display the customer ID and Customer
Name, the charge types associated with the customer, the services, billing codes, and the dates
that the services are enabled. Additionally, all charges are added up and totaled at the end of
the report. 

Dealer Billing Post

Once the Dealer Billing Preview report has been run, the Dealer Billing Post report is the final
step in order to post the billing to the accounting system. The only editable fields in this report
is the Report Description and the Invoice Date. Checking the Invoice Date box will post the
billing to that exact date in the accounting software.
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The invoice line item description is generated by Manitou. It is the monitoring type
description plus various other items depending on what is being billed. For example, for a
pro-rate line, the dates of the service will be shown. In accounting software, the customer ID
and name are shown.

Authority

The Authority form allows the user to create and maintain a database of police, fire and other
emergency services that the Central Station might need to contact in the even of an alarm or
other emergency. Once created, Authorities may be added to the action pattern and call lists
for a customer as needed. 
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Find an Authority Record 
1. Select the Maintenance menu.

2. Select Authority. A default Authority form will appear: 

3. On the authority form, click the magnifier button to the right of the Authority ID field. 

4. Type an ‘*’ in the value field adjacent to the Authority ID field and then click the Search
button.

5. Choose the record then click Load. The selected record will now be displayed.

Create an Authority Record
1. Select Authorities from the Operations menu.

2. Click on the New button located at the top of the screen. An Add Authority box will

appear:
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3. Enter a unique Contract ID into the Contract ID field. Authority IDs are specific to Central

Station standards. 

4. Enter the Name of the authority into the Name field.

5. Select the Type of authority from the Type drop-down menu.

6. Select the Country, Language and Time zone from the drop-down menus.

7. Click OK.

8. Back at the main screen, enter the address, city, state and zip code into the appropriate

fields.

9. Enter the phone numbers into the appropriate fields.

10.Enter an e-mail address if applicable.

11.Enter a Web address if applicable. 

Authority Options

The Authority Options section contains additional information containing details on permits,
false alarm tracking and dispatch charges. It is important to have this information verified
when entering Authority records as it can affect how alarms are handled when an Authority
needs to be dispatched. 
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1. If a permit is required, check the Permit Required box. 

2. Based on the Authority's policies about false alarms, select whether the False Alarm
Tracking is a Sliding Window, Calendar Period, or Forever (never resets). 

3. Based on the previous selection, the options below may be made available:

· False Alarm Limit
· False Alarm Period
· False Alarm Starting Month

4. Enter the appropriate numbers into the specified fields. 

5. If a Charge Code is applicable, enter it into the Charge Code field. 

6. Click Save. 

Authority Contact List

The Authority Contact list contains contact information for authorities and contacts alike.
Most entries will be made under Contacts. It is possible to associate another Authority as a
contact for an Authority record. For example, the Fire Authority  might be associated with the
Police Authority to prepare for complex emergency situations. 

1. On the Main Contact List screen, put the screen into Edit mode by clicking on the Edit
button.

2. Click on the Add button. An Add keyholder window will appear: 
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3. Select whether the contact is a Keyholder or Global Keyholder.

4. Enter the name of the contact into the Name field.

5. Select the Country, Language, and Time Zone of the contact.

6. Enter the Contact's site, home, business and/or mobile phone numbers.

7. Click OK.

8. Back at the main screen, enter a title and/or suffix for the contact.

9. Enter the Job Title of the contact into the Job Title field.

10.Select the birthday of the contact from the calendar. 

11.If applicable, click or tab into the Valid To field and use the drop-down arrow to select a

date from the calendar.

12.If the Contact will be inactive for a period of time, indicate that with the Inactive From and
Inactive To fields.  Use the drop-down arrows to select dates from the calendar for each
field.

13.Select the Contact Information tab (the house icon). 

14.Enter any additional information into the E-mail, Web address and mail address fields.
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15.Select the Notes tab (the notepad icon).

16.Enter any notes that pertain to the contact.

17.Click Save. 

Authority Call Lists

Call Lists for Authorities contain the details of all the people requiring contact for a given
alarm type. Rotation lists are often in place to ensure that one Keyholder is not the only
Keyholder contacted each time there is an alarm. Call Lists are lists of contact, grouped and
ordered based on alarm-types and priority.  

1. Select Call Lists from the Authority Jump To menu. The Call List screen will appear: 

2. Click on the Add button. An Add Call List window will appear: 
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3. Enter a four-character code in the Name field. 

4. Enter a brief description into the Description field. 

5. Select Main List or Sub List from the Type drop-down menu. Main Lists may contain other
call lists while Sub Lists cannot include other call lists. 

6. Click on Add to Matrix.

7. Click OK.

8. If the list is a Main Call List, select Main. If it is a Sub List of a Main list, select Sub List.

9. Click Add to Matrix. The Call List will be added to the Customer's account.

10.Click OK.

11.Back at the Call List form, select the item or items from the Contacts list that should
appear in the Call List. Contacts appearing in the list should be previously added in the
Contacts form of the customer record. 

12.Move the Contacts over to the Call List by clicking on  . The Contacts will now appear
in the Call List.
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13.Move list items up and down based on priority by clicking on the up/down arrows to the
right of the Call List. 

14.If the Call List rotates, check the Rotation List Active checkbox. The contact at the top of
the list will automatically be the head of the list, indicated by an icon that appears when the
Rotation List Active checkbox is checked. This contact will be first in rotation. 

15.Indicate the Next Rotation date by selecting the correct date from the calendar. The start
date defaults to the current day.

16.Set the rotation interval by clicking on the up/down arrows to set the number of days each
rotation is active before rotating.

17.If a Contact on the list is a Must Contact or Does not Rotate, select the appropriate Contact
and check the applicable boxes. 

18. Once all contacts are added, click Save. 

Authority Attentions

Authority Attentions are used for the sole purpose of printing and mailing paper copies of
reports run through Manitou. If an Attention is entered, Manitou will print that attention prior
to printing out the physical address of the recipient. 

1. Enter an attention into the appropriate field by first clicking on the Edit button to put the
screen into edit mode.

2. Click in the appropriate field.

3. Select the contact from the drop-down menu. (Note: For Contacts to appear, they must first
be entered into the Contact List).

4. Click Save. 

Authority Comments

The Authority Comments area allows users to view, enter, or edit temporary, current, future,
and special instruction for a customer. The Comment area also offers users access to view
expired comments about a customer.
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1. Select the Edit tab at the top of the Comment screen.

2. Above the tree menu there are three buttons Add, Remove, and Refresh. Select the Add
button to add a comment into the tree menu and onto the customers account. The Add
Comment screen will display.

3. Select the Comment Type by clicking the circle that fits the type of comment that will be
added.

· Temporary - A Temporary note will only appear within a duration set by the Operator.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Temporary.
3. Type a name to identify this Temporary Note and click OK to return to the main Notes

screen.
4. Use the drop-down arrows to select a Valid From and To date from the calendar

interface; and use the up/down roll arrows to indicate the Valid From and To times. 
The Temporary Note will only be associated with this record for the duration specified
by these date and time parameters.

5. Type the body of the note into the large text area beneath the date/time fields.
6. Save the record or make other changes to the notes Tab.
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· Standing - A Standing note is always true for the Customer record (until edited or deleted).

1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Standing
3. Type a name to identify this Standing Note and click OK to return to the main Notes

screen.
4. Type the body of the note into the large text area beneath the date/time fields.  Since

this is a more permanent note type, there are no date and time parameters.  This note is
valid until edited or deleted.

5. Save the record or make other changes to the notes Tab.
 
· Special Instructions - Special Instructions are selected from a drop-down.  The list items

are entered on the Notes tab of the Central Station record.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Special Instructions.
3. Using the drop-down arrow select one of the Special Instructions Notes from the list.
4. The associated note appears automatically in the text field.  This note is valid until

edited or removed.
5. Save the record or make other changes to the notes Tab.

 
· In House - In House Notes are only visible to the Central Station.  They are not available to

the Dealer when logged into Manitou remotely.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Special Instructions.
3. Using the drop-down arrow select one of the Special Instructions Notes from the list.
4. The associated note appears automatically in the text field.  This note is valid until

edited or removed.
5. Save the record or make other changes to the notes Tab.

Authority General Schedules

Authority General Schedules define the availability of Keyholders, schedules, and hours of
executive protection. 
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1. Click on General Schedules in the Jump To menu. 

2. Click on the Add button. An Add Schedule box will appear:

3. Enter a brief four-letter code into the Code field.

4. Enter a brief description into the Description field. 

5. Select a Type from the drop-down menu. 

6. Click OK to return to the main General Schedules screen. 

7. Select the days of the week to be included in the General Schedule by checking the
appropriate checkboxes. 

8. In the Start 1 and End 1 cells, enter the first Start and End time. If applicable, enter a
second Start and End time. For example, there may be some times when a keyholder is
available during regular business hours, however they may be unavailable during a
commute home. This is when two start and end times would be utilized. 

9. In the From and To date cells, enter the the dates which this schedule is applicable. Enter
only numbers, as Manitou will automatically insert the date separators. 
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10.Repeat as necessary to add any additional schedules. 

11.Click Save. 

Maintenance Issues

The Maintenance Issues form is similar to the global Maintenance Issues form; however, only
maintenance issues for the Authority are displayed on the local Maintenance Issues form.
Since only the Authority's issues are displayed, the filtering tab is not needed.

Additionally, all resolved and unresolved issues are displayed.  Adding, editing, and clearing
of the issues is similar to the global form, but this functionality is locked out when editing the
Authority since the maintenance issues do not participate in locking scheme for the Authority.
When editing and saving an entity with outstanding maintenance issues, the Operator is
prompted for each issue to determine if it was resolved, and for the operator to resolve, purge
or update the issue:

Note: Maintenance lists may be sorted with the exception of the Description and Notes
columns. 
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Edit or Remove an Authority Record

Edit an Authority

1. Click the Search icon  to the right of the Authority ID field.

2. Scroll through the list of authorities to locate and select the desired Authority ID. 
Double-click on that record, or click Load at the bottom of the screen.

3. Click the Edit button located at the top of the Application view.

4. Tab or Click into the applicable field to change and make all necessary edits.

5. Review all changes for accuracy, then click Save.

Remove an Authority
1. Click the Search icon to the right of the Authority ID field.

2. Locate and select the Authority ID.

3. Click Delete.

4. Confirm the deletion.

5. There is no Undo function when Deleting Authority records.  If the wrong record is deleted
it must be re-entered as a new Authority.

Agency

Agencies are companies that assist the Central Station in business-related areas, such as
facility maintenance, alarm equipment providers, IT support consultants, and others. Any time
you would have to use a contact point on a multiple account.  The Following sections detail
how to add, edit and delete Agency information:
 

Add an Agency
1. Select Agency from the Operations menu.

2. Click on the New button located at the top of the screen. An Add Branch box will appear:
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3. Enter a unique Contract ID into the Contract ID field. Branch IDs are specific to Central

Station standards. 

4. Enter the Name of the Branch into the Name field.

5. Select the Type of Branch from the Type drop-down menu.

6. Select the Country, Language and Time zone from the drop-down menus.

7. Click OK.

8. Back at the main screen, enter the address, city, state and zip code into the appropriate

fields.

9. Enter the phone numbers into the appropriate fields.

10.Enter an e-mail address if applicable.

Agency Options

The Agency Options tab contains additional information regarding the verification of the
Agency, as well as charge codes for dispatch.



Maintenance Menu 285

© 2009 Bold Technologies Ltd.

1. Click Edit at the top of the Application view to put the screen into Edit mode.

2. Type in a Verification Question that the Agency representative should answer to verify

identity.

3. Type in the expected Answer to the Verification Question.

4. Enter the Charge Code into the Charge Code field. 

5. Save the record or click on another tab to enter more Agency information.

Agency Contact List

The Agency Contact list contains contact information for agencies and contacts alike. Most
entries will be made under Contacts. 



Manitou Client 1.5.2286

© 2009 Bold Technologies Ltd.

1. On the Main Contact List screen, put the screen into Edit mode by clicking on the Edit
button.

2. Click on the Add button. An Add keyholder window will appear: 
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3. Select whether the contact is a Keyholder or Global Keyholder.

4. Enter the name of the contact into the Name field.

5. Select the Country, Language, and Time Zone of the contact.

6. Enter the Contact's site, home, business and/or mobile phone numbers.

7. Click OK.

8. Back at the main screen, enter a title and/or suffix for the contact.

9. Enter the Job Title of the contact into the Job Title field.

10.Select the birthday of the contact from the calendar. 

11. Select the Access permissions for this Agency in the Access box. 

12.Enter a Password, User No. and Temp Open Time into the appropriate fields. 

13.If applicable, click or tab into the Valid To field and use the drop-down arrow to select a

date from the calendar.

14.If the Contact will be inactive for a period of time, indicate that with the Inactive From and
Inactive To fields.  Use the drop-down arrows to select dates from the calendar for each
field.
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Contact Information Tab
1. Click the House tab on the right side of the Application view. 

2. Use the drop-down arrow located to the left of the top telephone number field to select a
telephone number type from the list.

3. Click the notepad icon to the left of the first telephone number field and select Properties.

4. Enter the area code, phone number and extension (if applicable) into the fields available.

5. Use the drop-down arrow to the right of the Email label to select the Email address to enter
(Email, Email 2 or Email 3). 

6. Click into the Email address field and type in the entire Email address.

7. Repeat the above three steps for up to three Email addresses.

8. Tab or click into the Web Address field.  Manitou automatically copies the text after the @
symbol in the Email address and adds 'www' to auto-fill the Web address.  By default the
Web address is highlighted for removal or overwriting.  If there is no Web address delete
that entry.  If a different URL is necessary, enter the correct Web address.  

9. Use the drop-down arrow to the left of the "This is the Mailing Address" title, to select an
address type.

10.Click or Tab into the Street 1 field and enter the first line of address information for this
Contact

11.Click or Tab into the Street 2 field and enter any additional address or suite information.

12.Click or Tab into the City field and enter the City/County name.

13.Click or Tab into the State field and use the drop-down arrow to the right of the State field
to select the applicable state.

14.Click or Tab into the Zip code field and enter the Zip code.

15.Check the checkbox if the address is also the mailing address.

16.Move on to the Notes tab.

Notes Tab
1. Click the Note Pad Tab on the right of the Application View to open the Notes screen.

2. Enter any notes that pertain to the Contact.
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3. Save the record or click on another tab to enter more Monitoring Company information.

Note: In order for Agencies to have the ability to authorize a schedule change for a customer,
the "Can Edit Customer" button must be checked in the Agency contact's Permissions list. 

Agency Call Lists

Call Lists for Agencies contain the details of all the people requiring contact for a given
alarm type. Rotation lists are often in place to ensure that one Keyholder is not the only
Keyholder contacted each time there is an alarm. Call Lists are lists of contact, grouped and
ordered based on alarm-types and priority.  

1. Select Call Lists from the Branch Jump To menu. The Call List screen will appear: 

2. Click on the Add button. An Add Call List window will appear: 
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3. Enter a four-character code in the Name field. 

4. Enter a brief description into the Description field. 

5. Select Main List or Sub List from the Type drop-down menu. Main Lists may contain other
call lists while Sub Lists cannot include other call lists. 

6. Click on Add to Matrix.

7. Click OK.

8. If the list is a Main Call List, select Main. If it is a Sub List of a Main list, select Sub List.

9. Click Add to Matrix. The Call List will be added to the Customer's account.

10.Click OK.

11.Back at the Call List form, select the item or items from the Contacts list that should
appear in the Call List. Contacts appearing in the list should be previously added in the
Contacts form of the customer record. 

12.Move the Contacts over to the Call List by clicking on  . The Contacts will now appear
in the Call List.
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13.Move list items up and down based on priority by clicking on the up/down arrows to the
right of the Call List. 

14.If the Call List rotates, check the Rotation List Active checkbox. The contact at the top of
the list will automatically be the head of the list, indicated by an icon that appears when the
Rotation List Active checkbox is checked. This contact will be first in rotation. 

15.Indicate the Next Rotation date by selecting the correct date from the calendar. The start
date defaults to the current day.

16.Set the rotation interval by clicking on the up/down arrows to set the number of days each
rotation is active before rotating.

17.If a Contact on the list is a Must Contact or Does not Rotate, select the appropriate Contact
and check the applicable boxes. 

18. Once all contacts are added, click Save. 

Agency Attentions

Agency Attentions are used for the sole purpose of printing and mailing paper copies of
reports run through Manitou. If an Attention is entered, Manitou will print that attention prior
to printing out the physical address of the recipient. 

1. Enter an attention into the appropriate field by first clicking on the Edit button to put the
screen into edit mode.

2. Click in the appropriate field.

3. Select the contact from the drop-down menu. (Note: For Contacts to appear, they must first
be entered into the Contact List).

4. Click Save. 

Agency Comments

The Agency Comments area allows users to view, enter, or edit temporary, current, future,
and special instruction for a customer. The Comment area also offers users access to view
expired comments about a customer.
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1. Select the Edit tab at the top of the Comment screen.

2. Above the tree menu there are three buttons Add, Remove, and Refresh. Select the Add
button to add a comment into the tree menu and onto the customers account. The Add
Comment screen will display.

3. Select the Comment Type by clicking the circle that fits the type of comment that will be
added.

· Temporary - A Temporary note will only appear within a duration set by the Operator.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Temporary.
3. Type a name to identify this Temporary Note and click OK to return to the main Notes

screen.
4. Use the drop-down arrows to select a Valid From and To date from the calendar

interface; and use the up/down roll arrows to indicate the Valid From and To times. 
The Temporary Note will only be associated with this record for the duration specified
by these date and time parameters.

5. Type the body of the note into the large text area beneath the date/time fields.
6. Save the record or make other changes to the notes Tab.
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· Standing - A Standing note is always true for the Customer record (until edited or deleted).

1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Standing
3. Type a name to identify this Standing Note and click OK to return to the main Notes

screen.
4. Type the body of the note into the large text area beneath the date/time fields.  Since

this is a more permanent note type, there are no date and time parameters.  This note is
valid until edited or deleted.

5. Save the record or make other changes to the notes Tab.
 
· Special Instructions - Special Instructions are selected from a drop-down.  The list items

are entered on the Notes tab of the Central Station record.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Special Instructions.
3. Using the drop-down arrow select one of the Special Instructions Notes from the list.
4. The associated note appears automatically in the text field.  This note is valid until

edited or removed.
5. Save the record or make other changes to the notes Tab.

 
· In House - In House Notes are only visible to the Central Station.  They are not available to

the Dealer when logged into Manitou remotely.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Special Instructions.
3. Using the drop-down arrow select one of the Special Instructions Notes from the list.
4. The associated note appears automatically in the text field.  This note is valid until

edited or removed.
5. Save the record or make other changes to the notes Tab.

Agency General Schedules

Agency General Schedules define the availability of Keyholders, schedules, and hours of
executive protection. 
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1. Click on General Schedules in the Jump To menu. 

2. Click on the Add button. An Add Schedule box will appear:

3. Enter a brief four-letter code into the Code field.

4. Enter a brief description into the Description field. 

5. Select a Type from the drop-down menu. 

6. Click OK to return to the main General Schedules screen. 

7. Select the days of the week to be included in the General Schedule by checking the
appropriate checkboxes. 

8. In the Start 1 and End 1 cells, enter the first Start and End time. If applicable, enter a
second Start and End time. For example, there may be some times when a keyholder is
available during regular business hours, however they may be unavailable during a
commute home. This is when two start and end times would be utilized. 

9. In the From and To date cells, enter the the dates which this schedule is applicable. Enter
only numbers, as Manitou will automatically insert the date separators. 
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10.Repeat as necessary to add any additional schedules. 

11.Click Save. 

Maintenance Issues

The Maintenance Issues form is similar to the global Maintenance Issues form; however, only
maintenance issues for the Agency are displayed on the local Maintenance Issues form. Since
only the Agency's issues are displayed, the filtering tab is not needed.

Additionally, all resolved and unresolved issues are displayed.  Adding, editing, and clearing
of the issues is similar to the global form, but this functionality is locked out when editing the
Agency since the maintenance issues do not participate in locking scheme for the Agency.
When editing and saving an entity with outstanding maintenance issues, the Operator is
prompted for each issue to determine if it was resolved, and for the operator to resolve, purge
or update the issue:

Note: Maintenance lists may be sorted with the exception of the Description and Notes
columns. 
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Edit or Remove an Agency Record

Edit an Agency
1. Click the Search icon to the right of the Agency ID field.

2. Locate and select the Agency ID.  

3. Tab or Click into the applicable field(s) to change and make all necessary edits.

4. Review all changes for accuracy, then click Save.

 
Remove an Agency
1. Click the Search icon to the right of the Agency ID field.

2. Locate and select the Agency ID.

3. Click Delete.

4. Confirm the deletion.

5. Ensure the correct items were removed then click Save.  If the wrong item was removed,

click Cancel and start again.

Branch

1. Select Branch from the Operations menu.

2. Click on the New button located at the top of the screen. An Add Branch box will appear:

3. Enter a unique Contract ID into the Contract ID field. Branch IDs are specific to Central

Station standards. 

4. Enter the Name of the Branch into the Name field.
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5. Select the Type of Branch from the Type drop-down menu.

6. Select the Country, Language and Time zone from the drop-down menus.

7. Click OK.

8. Back at the main screen, enter the address, city, state and zip code into the appropriate

fields.

9. Enter the phone numbers into the appropriate fields.

10.Enter an e-mail address if applicable.

Branch Contact List

The Branch Contact list contains contact information for authorities and contacts alike. Most
entries will be made under Contacts. 

1. On the Main Contact List screen, put the screen into Edit mode by clicking on the Edit
button.

2. Click on the Add button. An Add keyholder window will appear: 

3. Select whether the contact is a Keyholder or Global Keyholder.

4. Enter the name of the contact into the Name field.

5. Select the Country, Language, and Time Zone of the contact.
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6. Enter the Contact's site, home, business and/or mobile phone numbers.

7. Click OK.

8. Back at the main screen, enter a title and/or suffix for the contact.

9. Enter the Job Title of the contact into the Job Title field.

10.Select the birthday of the contact from the calendar. 

11. Select the Access permissions for this branch in the Access box. 

12.If applicable, click or tab into the Valid To field and use the drop-down arrow to select a

date from the calendar.

13.If the Contact will be inactive for a period of time, indicate that with the Inactive From and
Inactive To fields.  Use the drop-down arrows to select dates from the calendar for each
field.

14.Select the Contact Information tab (the house icon). 

15.Enter any additional information into the E-mail, Web address and mail address fields.

16.Select the Notes tab (the notepad icon).

17.Enter any notes that pertain to the contact.

18.Click Save. 

Contact Information Tab
1. Click the House tab on the right side of the Application view. 

2. Use the drop-down arrow located to the left of the top telephone number field to select a
telephone number type from the list.

3. Click the notepad icon to the left of the first telephone number field and select Properties.

4. Enter the area code, phone number and extension (if applicable) into the fields available.

5. Use the drop-down arrow to the right of the Email label to select the Email address to enter
(Email, Email 2 or Email 3). 

6. Click into the Email address field and type in the entire Email address.

7. Repeat the above three steps for up to three Email addresses.
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8. Tab or click into the Web Address field.  Manitou automatically copies the text after the @
symbol in the Email address and adds 'www' to auto-fill the Web address.  By default the
Web address is highlighted for removal or overwriting.  If there is no Web address delete
that entry.  If a different URL is necessary, enter the correct Web address.  

9. Use the drop-down arrow to the left of the "This is the Mailing Address" title, to select an
address type.

10.Click or Tab into the Street 1 field and enter the first line of address information for this
Contact

11.Click or Tab into the Street 2 field and enter any additional address or suite information.

12.Click or Tab into the City field and enter the City/County name.

13.Click or Tab into the State field and use the drop-down arrow to the right of the State field
to select the applicable state.

14.Click or Tab into the Zip code field and enter the Zip code.

15.Check the checkbox if the address is also the mailing address.

16.Move on to the Notes tab.

Notes Tab
1. Click the Note Pad Tab on the right of the Application View to open the Notes screen.

2. Enter any notes that pertain to the Contact.

3. Save the record or click on another tab to enter more Monitoring Company information.

Branch Call List

Call Lists for Branches contain the details of all the people requiring contact for a given
alarm type. Rotation lists are often in place to ensure that one Keyholder is not the only
Keyholder contacted each time there is an alarm. Call Lists are lists of contact, grouped and
ordered based on alarm-types and priority.  

1. Select Call Lists from the Branch Jump To menu. The Call List screen will appear: 
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2. Click on the Add button. An Add Call List window will appear: 
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3. Enter a four-character code in the Name field. 

4. Enter a brief description into the Description field. 

5. Select Main List or Sub List from the Type drop-down menu. Main Lists may contain other
call lists while Sub Lists cannot include other call lists. 

6. Click on Add to Matrix.

7. Click OK.

8. If the list is a Main Call List, select Main. If it is a Sub List of a Main list, select Sub List.

9. Click Add to Matrix. The Call List will be added to the Customer's account.

10.Click OK.

11.Back at the Call List form, select the item or items from the Contacts list that should
appear in the Call List. Contacts appearing in the list should be previously added in the
Contacts form of the customer record. 

12.Move the Contacts over to the Call List by clicking on  . The Contacts will now appear
in the Call List.



Manitou Client 1.5.2302

© 2009 Bold Technologies Ltd.

13.Move list items up and down based on priority by clicking on the up/down arrows to the
right of the Call List. 

14.If the Call List rotates, check the Rotation List Active checkbox. The contact at the top of
the list will automatically be the head of the list, indicated by an icon that appears when the
Rotation List Active checkbox is checked. This contact will be first in rotation. 

15.Indicate the Next Rotation date by selecting the correct date from the calendar. The start
date defaults to the current day.

16.Set the rotation interval by clicking on the up/down arrows to set the number of days each
rotation is active before rotating.

17.If a Contact on the list is a Must Contact or Does not Rotate, select the appropriate Contact
and check the applicable boxes. 

18. Once all contacts are added, click Save. 

Branch Attentions

Branch Attentions are used for the sole purpose of printing and mailing paper copies of
reports run through Manitou. If an Attention is entered, Manitou will print that attention prior
to printing out the physical address of the recipient. 

1. Enter an attention into the appropriate field by first clicking on the Edit button to put the
screen into edit mode.

2. Click in the appropriate field.

3. Select the contact from the drop-down menu. (Note: For Contacts to appear, they must first
be entered into the Contact List).

4. Click Save. 

Branch Comments

The Branch Comments area allows users to view, enter, or edit temporary, current, future,
and special instruction for a customer. The Comment area also offers users access to view
expired comments about a customer.
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1. Select the Edit tab at the top of the Comment screen.

2. Above the tree menu there are three buttons Add, Remove, and Refresh. Select the Add
button to add a comment into the tree menu and onto the customers account. The Add
Comment screen will display.

3. Select the Comment Type by clicking the circle that fits the type of comment that will be
added.

· Temporary - A Temporary note will only appear within a duration set by the Operator.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Temporary.
3. Type a name to identify this Temporary Note and click OK to return to the main Notes

screen.
4. Use the drop-down arrows to select a Valid From and To date from the calendar

interface; and use the up/down roll arrows to indicate the Valid From and To times. 
The Temporary Note will only be associated with this record for the duration specified
by these date and time parameters.

5. Type the body of the note into the large text area beneath the date/time fields.
6. Save the record or make other changes to the notes Tab.
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· Standing - A Standing note is always true for the Customer record (until edited or deleted).

1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Standing
3. Type a name to identify this Standing Note and click OK to return to the main Notes

screen.
4. Type the body of the note into the large text area beneath the date/time fields.  Since

this is a more permanent note type, there are no date and time parameters.  This note is
valid until edited or deleted.

5. Save the record or make other changes to the notes Tab.
 
· Special Instructions - Special Instructions are selected from a drop-down.  The list items

are entered on the Notes tab of the Central Station record.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Special Instructions.
3. Using the drop-down arrow select one of the Special Instructions Notes from the list.
4. The associated note appears automatically in the text field.  This note is valid until

edited or removed.
5. Save the record or make other changes to the notes Tab.

 
· In House - In House Notes are only visible to the Central Station.  They are not available to

the Dealer when logged into Manitou remotely.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Special Instructions.
3. Using the drop-down arrow select one of the Special Instructions Notes from the list.
4. The associated note appears automatically in the text field.  This note is valid until

edited or removed.
5. Save the record or make other changes to the notes Tab.

Branch General Schedules

Branch General Schedules define the availability of Keyholders, schedules, and hours of
executive protection. 
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1. Click on General Schedules in the Jump To menu. 

2. Click on the Add button. An Add Schedule box will appear:

3. Enter a brief four-letter code into the Code field.

4. Enter a brief description into the Description field. 

5. Select a Type from the drop-down menu. 

6. Click OK to return to the main General Schedules screen. 

7. Select the days of the week to be included in the General Schedule by checking the
appropriate checkboxes. 

8. In the Start 1 and End 1 cells, enter the first Start and End time. If applicable, enter a
second Start and End time. For example, there may be some times when a keyholder is
available during regular business hours, however they may be unavailable during a
commute home. This is when two start and end times would be utilized. 

9. In the From and To date cells, enter the the dates which this schedule is applicable. Enter
only numbers, as Manitou will automatically insert the date separators. 
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10.Repeat as necessary to add any additional schedules. 

11.Click Save. 

Branch Reports

From the Branch Reports screen, Users can add and schedule reports to be periodically
generated and sent from Manitou to the Branch. 

1. Click on the Add New button. The System Reports screen will appear. 

2. Select the desired report from the reports list.

3. Check the Priority level of the report. Manitou will use this number to determine which
reports in the report queue to print first - the lower the number, the higher the priority.
Unless urgent, this number should be set to 6.

4. Enter any relevant search criteria.

5. Click Next.

6. On the Distribution page, select the distribution method and destination for the report.

A number of options are available. Uses can:

· View it on screen, using the preview facility.

· Print it locally (in the central station), with an option to preview first.

· Send it to a nominated customer or dealer, with an option to review first. 

· Send it to any individual (whether on the system database or not) by email or fax, also
with an option to preview.

Destination Window
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For more information on printing, sending and previewing reports, see the Reports: Run a
System Report section of this manual. 

Branch Statistics

Branch Statistics are a quick and easy to view customer statistics in the Manitou Client or
from the Web. The Statistics form is a read-only menu, with the option of drilling down into
each statistic for additional information. 

Two options control several aspects of the Statistics. The first determines the number of
customers for be shown for "Top x" statistics, where x is 1-50. The second controls the
number of days of activity to be considered for activity related statistics. Several new statuses
are maintained at the customer level. They are "Low Battery", "Late to Test" and "No Event
Programming." These can be seen on the Zone Status form of the customer and in the
customer status form. 

Statistics are provided for the following areas:
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Customer Counts
· Active Customers - All active customers
· Inactive Customers - All inactive customers
· Pending Customers - Currently pending customers
· Deactive Customers - Deactivated customers

Customer Status Summary
· Currently In Alarm - All alarms in the Alarm Queue
· Currently On Test - All alarms that are on test
· Dispatched Alarms in the Last 24 Hours - Number of alarms in the last 24 hours that

authority has been dispatched on
· New Maintenance Issues - Number of maintenance issues that have not been modified
· Unresolved Maintenance Issues - Number of unresolved maintenance issues
· With Expired Permits - Number of customers with expired authority permits
· Watch List - Number of customers on a watch list; customers may be added to the watch list

by simply double-clicking on the Watch List line in the statistics form to bring up the
customer Watch List window:

Click on the Add button and enter the Customer ID to add to the watch list. Once the
customer is added, click Save. 

· Top Alarm Activity over 30 Days - Customer with the most alarm activity over the past 30
days

· Top False Alarm Activity over 30 Days - Customer with the most false alarm activity for the
past 30 days

Customer Transmitter Summary
· In Alarm - Number of current transmitters with an alarm in the Alarm Queue
· In Fault
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· In Line Fault
· With Low Battery - Number of transmitters with a low battery
· With Late-to-Test - Number of transmitters showing Late-To-Test signals
· Missing Event Programming -Number of transmitters missing event programming
· Transmitters Not on File in the Last 24 Hours - Number of customers with no transmitters

associated with the account

Users have the option to select a 24-hour, 48-hour or 72- hour time period to display statistics.

Maintenance Issues

The Maintenance Issues form is similar to the global Maintenance Issues form; however, only
maintenance issues for the Branch are displayed on the local Maintenance Issues form. Since
only the Branch's issues are displayed, the filtering tab is not needed.

Additionally, all resolved and unresolved issues are displayed.  Adding, editing, and clearing
of the issues is similar to the global form, but this functionality is locked out when editing the
Branch since the maintenance issues do not participate in locking scheme for the Branch.
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When editing and saving an entity with outstanding maintenance issues, the Operator is
prompted for each issue to determine if it was resolved, and for the operator to resolve, purge
or update the issue:

Note: Maintenance lists may be sorted with the exception of the Description and Notes
columns. 

Monitoring Company

The Monitoring Company screen displays all of the specifics about the Central Station
running Manitou.  The Central Station record is created upon the initial installation of the
system.  The record details should be entered as soon after implementation as possible. 
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The Company tab contains basic contact information including Address, Telephone, Email
and Web Address details.  Below are instructions for entering this information.
 
1. With the screen in Edit mode, review the Company name and make any necessary changes.

2. Tab or Click into the Street 1 field and add or update the street address of the Central

Station.

3. Tab or Click into the Street 2 field and add or update, if applicable, the additional street

address information.

4. Tab or Click into the City field and enter or update the city name.

5. Tab or Click into the State field and enter or update the state name.  

Hint: by hitting the first letter of the state name on the keyboard the application automatically
looks for the states starting with that name.

6. Tab or Click into the Zip Code field and enter or update the central station's zip code.
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7. The Country, Time Zone, and Language fields are set up at system load and are not

editable.

8. Use the drop-down arrow to the right of the first telephone number title to select the
applicable type of phone number - Site, Home, Mobile, etc.

9. Click the Notepad icon  and select Properties. 

10.Enter the area code, phone number and extension (if applicable) into the fields available.

11.If there is a script associated with this phone number (applicable in the case of numeric
pager PIN numbers or codes), select that from the drop-down list.  

12.Click OK to return to the Name tab, and repeat the above steps for all telephone numbers.

13.Use the drop-down arrow to the right of the word Email to select the Email address to

enter (Email, Email 2 or Email 3). 

14.Click into the Email address field and type in the entire Email address.

15.If the Email address field will be used to contact a pager, click on the notepad icon to
select an applicable Output Device, Service Provider and Script from the drop-down lists
available.

16.Repeat the above three steps for up to three Email addresses.

17.Tab or click into the Web Address field. Manitou automatically copies the text after the @
symbol in the Email address and adds 'www' to auto-fill the Web address. If there is no
Web address delete that entry.  If a different URL is necessary, enter the correct Web
address.  By default the Web address is highlighted for removal or overwriting.

18.Save the record or click on another tab to enter more Monitoring Company information.

Monitoring Company Contact List

The Contact List tab of the Monitoring Company record contains information about relevant
Contacts, their schedules, availability, addresses, phone numbers and all essential contact
information. All Monitoring Company contacts should be entered on this tab.  Some
Monitoring Company Contacts may be Global Keyholders and should be already entered
under Maintenance>Global Keyholders.
 
1. With the screen in Edit mode click the Contact List Tab

2. Highlight Contacts in the navigator.  

3. Click the Add button above the Navigation area. An Add Keyholder window will appear:
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4. Enter the Name of the contact into the Name field.

5. Select the Country, Language and Time Zone for the keyholder. 

6. Enter the appropriate contact numbers into the phone number fields. 

7. Click OK.
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8. If the Contact is addressed by a Title, use the drop-down arrow to the right of the Title field

and select a Title from the list.

9. If the Contact has a Suffix with their name, use the drop-down arrow to the right of the

Suffix field to select it from the list.

10.Tab or Click to the Job Title field and type in the Contact's Job Title - Engineer,

Supervisor, etc.

11.Use the drop-down arrow to the right of the Birthday field to select the Keyholder's

Birthday from the calendar.

12.To associate a photo with this Contact's record, right-click within the gray picture frame to



Maintenance Menu 315

© 2009 Bold Technologies Ltd.

the right of the name fields and click Find.

13.Browse to the image file (jpeg or gif) on the computer hard drive and select it.

14.In the Access box, use the checkboxes to indicate the Contact's access levels.  Note that
there are some items that are mutually exclusive of one another, therefore, if both are
selected, an error will appear.

15.Tab or click to the Password filed and enter this Contact's Password.

16.If this Contact will have Web Access to Manitou, tab or click to the Web Access ID field
and type in a unique Login ID.

17.If this Contact will have VRT access (remote phone login capability) to Manitou, tab or
click to the VRT ID field and type in a unique, numeric ID with which the contact will log
in to Manitou using VRT.

18.Click or tab into the Valid From field and use the drop-down arrow to select a date from

the calendar.  

19.If applicable, click or tab into the Valid To field and use the drop-down arrow to select a

date from the calendar.

20.If the Contact will be inactive for a period of time, indicate that with the Inactive From and
Inactive To fields.  Use the drop-down arrows to select dates from the calendar for each
field.

Contact Information Tab
1. Click the House tab on the right side of the Application view. 

2. Use the drop-down arrow located to the left of the top telephone number field to select a
telephone number type from the list.

3. Click the notepad icon to the left of the first telephone number field and select Properties.

4. Enter the area code, phone number and extension (if applicable) into the fields available.

5. Use the drop-down arrow to the right of the Email label to select the Email address to enter
(Email, Email 2 or Email 3). 

6. Click into the Email address field and type in the entire Email address.

7. If the Email address field will be used to contact a pager, click on the notepad icon to select
an applicable Output Device, Service Provider and Script from the drop-down lists
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available.

8. Repeat the above three steps for up to three Email addresses.

9. Tab or click into the Web Address field.  Manitou automatically copies the text after the @
symbol in the Email address and adds 'www' to auto-fill the Web address.  By default the
Web address is highlighted for removal or overwriting.  If there is no Web address delete
that entry.  If a different URL is necessary, enter the correct Web address.  

10.Use the drop-down arrow to the left of the "This is the Mailing Address" title, to select an
address type.

11.Click or Tab into the Street 1 field and enter the first line of address information for this
Contact

12.Click or Tab into the Street 2 field and enter any additional address or suite information.

13.Click or Tab into the City field and enter the City/County name.

14.Click or Tab into the State field and use the drop-down arrow to the right of the State field
to select the applicable state.

15.Click or Tab into the Zip code field and enter the Zip code.

16.Check the checkbox if the address is also the mailing address.

17.Move on to the Notes tab.

Notes Tab
1. Click the Note Pad Tab on the right of the Application View to open the Notes screen.

2. Enter any notes that pertain to the Contact.

3. Save the record or click on another tab to enter more Monitoring Company information.

Monitoring Company Call List

The Monitoring Company Call List contains contact information for authorities and
contacts alike. Most entries will be made under Contacts. 

1. On the Main Contact List screen, put the screen into Edit mode by clicking on the Edit
button.

2. Click on the Add button. An Add keyholder window will appear: 
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3. Select whether the contact is a Keyholder or Global Keyholder.

4. Enter the name of the contact into the Name field.

5. Select the Country, Language, and Time Zone of the contact.

6. Enter the Contact's site, home, business and/or mobile phone numbers.

7. Click OK.

8. Back at the main screen, enter a title and/or suffix for the contact.

9. Enter the Job Title of the contact into the Job Title field.

10.Select the birthday of the contact from the calendar. 

11.If applicable, click or tab into the Valid To field and use the drop-down arrow to select a

date from the calendar.

12.If the Contact will be inactive for a period of time, indicate that with the Inactive From and
Inactive To fields.  Use the drop-down arrows to select dates from the calendar for each
field.

13.Select the Contact Information tab (the house icon). 

14.Enter any additional information into the E-mail, Web address and mail address fields.
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15.Select the Notes tab (the notepad icon).

16.Enter any notes that pertain to the contact.

17.Click Save. 

Monitoring Company Comments

The Monitoring Company Comments area allows users to view, enter, or edit temporary,
current, future, and special instruction for a customer. The Comment area also offers users
access to view expired comments about a customer.

1. Select the Edit tab at the top of the Comment screen.

2. Above the tree menu there are three buttons Add, Remove, and Refresh. Select the Add
button to add a comment into the tree menu and onto the customers account. The Add
Comment screen will display.

3. Select the Comment Type by clicking the circle that fits the type of comment that will be
added.
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· Temporary - A Temporary note will only appear within a duration set by the Operator.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Temporary.
3. Type a name to identify this Temporary Note and click OK to return to the main Notes

screen.
4. Use the drop-down arrows to select a Valid From and To date from the calendar

interface; and use the up/down roll arrows to indicate the Valid From and To times. 
The Temporary Note will only be associated with this record for the duration specified
by these date and time parameters.

5. Type the body of the note into the large text area beneath the date/time fields.
6. Save the record or make other changes to the notes Tab.

 
· Standing - A Standing note is always true for the Customer record (until edited or deleted).

1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Standing
3. Type a name to identify this Standing Note and click OK to return to the main Notes

screen.
4. Type the body of the note into the large text area beneath the date/time fields.  Since

this is a more permanent note type, there are no date and time parameters.  This note is
valid until edited or deleted.

5. Save the record or make other changes to the notes Tab.
 
· Special Instructions - Special Instructions are selected from a drop-down.  The list items

are entered on the Notes tab of the Central Station record.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Special Instructions.
3. Using the drop-down arrow select one of the Special Instructions Notes from the list.
4. The associated note appears automatically in the text field.  This note is valid until

edited or removed.
5. Save the record or make other changes to the notes Tab.

 
· In House - In House Notes are only visible to the Central Station.  They are not available to

the Dealer when logged into Manitou remotely.
1. Click the Add button above the list of Note types.
2. In the prompt box verify that the correct radio button is selected - Special Instructions.
3. Using the drop-down arrow select one of the Special Instructions Notes from the list.
4. The associated note appears automatically in the text field.  This note is valid until

edited or removed.
5. Save the record or make other changes to the notes Tab.

Monitoring Company Action Patterns

Monitoring Company Action Patterns speed the processing of specific alarms by telling the
Operator who to call and what actions to take on each and every alarm.  
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Note:  Action Patterns added to the Central Station are Global Action Patterns and are
therefore available when viewing Customer and Dealer records.   

Keep this in mind when configuring Monitoring Company action patterns.  These should be
applicable to a category of alarms.  For example:  The action pattern for a Burglary Alarm
might be similar for many customers so the sequence of events can be defined by a Global
Action Pattern rather than creating separate Action Patterns for each Customer.  The
following instructions cover how to add Action Patterns to the Central Station record:

1. Scroll down the navigation list, select Customer Action Patterns and Click Add.

2. Click into the Action ID field and Enter a brief code for the Action Pattern.

3. Click into the Description field and enter a short description of the Action Pattern.

4. Click OK to return to the main Action Patterns screen.

5. Select the type of Action to execute in the first pane to the right of the Add and Remove

buttons.
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· Contact - Add contacts to Action Patterns to guide the Operators in calling, paging and/or
emailing relevant individuals:

1. Select the Contact to add to the Action Pattern from the list.

2. Click the Add button located just above the Action Pattern pane, to add the Contact to

the list.

3. Repeat this process for all persons requiring contact with this Action Pattern.

4. Use the Up and Down arrows to the left of the pane to adjust whom to contact first,

second, etc.

5. If a contact was added in error, remove by selecting the list item and clicking the "X"
button located just outside the lower left corner of the Action Pattern pane.

· Remark - Add a remark to the Action Pattern to insert a comment or reminder for the
Operator:

1. Tab or Click into the Remark pane.

2. Type the Remark to be added to the Action Pattern.

3. Click the Add button located just above the Action Pattern pane, to add the Remark to

the list below.

4. Repeat this process for all remarks tied to this Action Pattern.

5. Use the Up and Down arrows to the left of the pane to adjust exactly when in the
Action Pattern the remark should be executed.

6. If a remark was added in error, select it from the list and click the "X" button located
just outside the lower left corner of the Action Pattern pane to remove the item.

· Log Line - a Log Line action will be added to the Customer Log for each alarm to which
it's added:

1. Tab or Click into the Log Line pane.

2. Type the information that will appear in the Customer Log.

3. Click the Add button located just above the Action Pattern pane, to add the Log Line
to the list.

4. Repeat this process for all Log Lines tied to this Action Pattern.
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5. Use the Up and Down arrows to the left of the pane to adjust when the Log Line
should be executed within the Action Pattern.

6. If a Log Line was added in error, select it from the list and click the "X" button located
just outside the lower left corner of the Action Pattern pane to remove the item.

· Show - Add this type of Action to display the help text directly from the Event Category,
Event Definition, etc. as part of the Action Pattern:

1. Select an applicable option to show Help Text about one of the following: Event
Category, Event Definition, Event Programming, Transmitter or Script.

2. If selecting Script, click the drop-down arrow to the right of the field just below the
Script radio button and select the script to display.

3. Click the Add button located just above the Action Pattern pane, to add the Show item
to the Action Pattern.

4. Use the Up and Down arrows to the left of the pane to adjust when the Show item
should be executed within the Action Pattern.

5. If a Show item was added in error, select it from the list and click the "X" button
located just outside the lower left corner of the Action Pattern pane to remove the
item.

· Attention - Add an Attention line for the purpose of emphasizing information, or to fulfill
UL requirements about Alarm ticket information.

1. Tab or Click into the Attention pane.

2. Type the text to be added to the Action Pattern.

3. Click the Add button located just above the Action Pattern pane, to add the Attention

line to the list below.

4. Repeat this process for all Attention actions tied to this Action Pattern.

5. Use the Up and Down arrows to the left of the pane to adjust exactly when in the
Action Pattern the Attention line should be executed. 

6. If an Attention line was added in error, select it from the list and click the "X" button
located just outside the lower left corner of the Action Pattern pane to remove the
item.

· Suspend - Add this type of action to Suspend the Alarm for an allotted period of time at
some point in the Action Pattern:
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1. Click the up/down arrows or enter the time to suspend the Alarm.

2. Select if the time unit is in Seconds, Minutes or Hours by clicking the applicable radio

button.

3. Click the Add button located just above the Action Pattern pane, to add the Suspend

command to the list.

4. Repeat this process again if more than one suspend is necessary for this Action

Pattern.

5. Use the Up and Down arrows to the left of the pane to adjust when the Suspend should
be executed within the Action Pattern.

6. If the Suspend was added in error, select it from the list and click the "X" button
located just outside the lower left corner of the Action Pattern pane to remove the
item.

· Close - Add this type of action to prompt for Closing the Alarm with Resolution Codes
automatically entered by the action at the end of the Action Pattern:

1. Click the drop-down arrow to the right of the Resolution Code field.

2. Select a Resolution Code from the list.

3. Click the Add button located just above the Action Pattern pane, to add the Close

Resolution Code to the list.

4. Use the Up and Down arrows to the left of the pane to adjust when the Close
Resolution Code should be executed within the Action Pattern.

5. If a Close Resolution Code was added in error, select it from the list and click the "X"
button located just outside the lower left corner of the Action Pattern pane to remove
the item.

6. After configuring the Action Pattern, repeat the process for all additional Global Action
Patterns required for the Central Station.

7. Verify all items for accuracy and Save the record or click on another tab to add more
Central Station information.
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Monitoring Company General Schedules

Monitoring Company General Schedules define the availability of Keyholders, schedules,
and hours of executive protection. 

1. Click on General Schedules in the Jump To menu. 

2. Click on the Add button. An Add Schedule box will appear:

3. Enter a brief four-letter code into the Code field.

4. Enter a brief description into the Description field. 

5. Select a Type from the drop-down menu. 

6. Click OK to return to the main General Schedules screen. 

7. Select the days of the week to be included in the General Schedule by checking the
appropriate checkboxes. 

8. In the Start 1 and End 1 cells, enter the first Start and End time. If applicable, enter a
second Start and End time. For example, there may be some times when a keyholder is
available during regular business hours, however they may be unavailable during a
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commute home. This is when two start and end times would be utilized. 

9. In the From and To date cells, enter the the dates which this schedule is applicable. Enter
only numbers, as Manitou will automatically insert the date separators. 

10.Repeat as necessary to add any additional schedules. 

11.Click Save. 

Monitoring Company Reverse Command

This information has not yet been documented.

Monitoring Company TX ID Ranges

Transmitter Ranges determine which transmitter IDs are allocated to a Monitoring Company
for use with that Monitoring Company's accounts.  When adding new Customer accounts to
the system, consider that the Customer's Transmitter ID should be within the Transmitter
Range of it's associated Monitoring Company.  The purpose of assigning a range of
Transmitters to Dealer records is that more information about incoming signals is
immediately available.  When a signal is received with a TXID (Transmitter ID) within a
particular Monitoring Company's range it is clear that the signal is from one of that
Monitoring Company's accounts.  This gives the Operator more information when handling
alarms.
 
 

Add Transmitter Ranges
1. Open a Dealer account to add Transmitter Range information.  

2. Click the TX Ranges Tab and put the screen into Edit mode.

3. Tab or Click into the Receiver Line Designation cell at the upper left.  

4. Use the drop-down arrow at the right of the Receiver Line Designation cell and select the
applicable Receiver Line from the listing.  This information should be available from the
Administrator or Manager of the Central Station.  It is important to know which Customers
and Dealers are assigned to which Receivers and RLDs.

5. Tab into the TX ID (Transmitter ID) From field and enter the starting number of the TX
Range.  

6. Tab into the TX ID To field and enter the ending number of the TX Range.  
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7. Tab into the Next TX ID field and enter the next Transmitter ID to use for this Monitoring
Company record.  

8. Tab into the TX ID Type field and use the drop-down arrow to indicate the format of the
Transmitter ID (Decimal, Hex (Include A), Hex (Exclude A)).  This is based on the TX ID
format used by your Central Station and/or that Monitoring Company.  

9. Tab into the Range Full field and click the checkbox if the Transmitter ID range is full at
this time.  This is sometimes used to block out a particular number of transmitter ID’s to be
utilized by a specific account.  

10.Tab into the Restart cell and click the checkbox if, once completely through the list of
ranges, it is okay to start again looking for empty Transmitter ID numbers.  

11.Repeat this process for all Transmitter Ranges allowable for the Monitoring Company.  

12.Review all entries to ensure the accuracy of the information and Save the record.  Enter
any notes if necessary then click OK.  

13.Alternately click on another tab to continue editing this Monitoring Company record. 
 

Monitoring Company Reports

From the Monitoring Company Reports screen, Users can add and schedule reports to be
periodically generated and sent from Manitou to the Branch. 

1. Click on the Add New button. The System Reports screen will appear. 

2. Select the desired report from the reports list.

3. Check the Priority level of the report. Manitou will use this number to determine which
reports in the report queue to print first - the lower the number, the higher the priority.
Unless urgent, this number should be set to 6.

4. Enter any relevant search criteria.

5. Click Next.

6. On the Distribution page, select the distribution method and destination for the report.

A number of options are available. Users can:

· View it on screen, using the preview facility.

· Print it locally (in the central station), with an option to preview first.
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· Send it to a nominated customer or dealer, with an option to review first. 

· Send it to any individual (whether on the system database or not) by email or fax, also
with an option to preview.

Destination Window

For more information on printing, sending and previewing reports, see the Reports: Run a
System Report section of this manual. 

Monitoring Company Statistics

Monitoring Company Statistics are a quick and easy to view customer statistics in the
Manitou Client or from the Web. The Statistics form is a read-only menu, with the option of
drilling down into each statistic for additional information. Users may filter the statistics by
choosing all customers, customers with no dealer, or customers with no branch from the drop-
down menu.

Two options control several aspects of the Statistics. The first determines the number of
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customers for be shown for "Top x" statistics, where x is 1-50. The second controls the
number of days of activity to be considered for activity related statistics. Several new statuses
are maintained at the customer level. They are "Low Battery", "Late to Test" and "No Event
Programming." These can be seen on the Zone Status form of the customer and in the
customer status form. 

Statistics are provided for the following areas:

Customer Counts
· Active Customers - All active customers
· Inactive Customers - All inactive customers
· Pending Customers - Currently pending customers
· Deactive Customers - Deactivated customers

Customer Status Summary
· Currently In Alarm - All alarms in the Alarm Queue
· Currently On Test - All alarms that are on test
· Dispatched Alarms in the Last 24 Hours - Number of alarms in the last 24 hours that

authority has been dispatched on
· New Maintenance Issues - Number of maintenance issues that have not been modified
· Unresolved Maintenance Issues - Number of unresolved maintenance issues
· With Expired Permits - Number of customers with expired authority permits
· Watch List - Number of customers on a watch list; customers may be added to the watch list

by simply double-clicking on the Watch List line in the statistics form to bring up the
customer Watch List window:

Click on the Add button and enter the Customer ID to add to the watch list. Once the
customer is added, click Save. 



Maintenance Menu 329

© 2009 Bold Technologies Ltd.

· Top Alarm Activity over 30 Days - Customer with the most alarm activity over the past 30
days

· Top False Alarm Activity over 30 Days - Customer with the most false alarm activity for the
past 30 days

Customer Transmitter Summary
· In Alarm - Number of current transmitters with an alarm in the Alarm Queue
· In Fault
· In Line Fault
· With Low Battery - Number of transmitters with a low battery
· With Late-to-Test - Number of transmitters showing Late-To-Test signals
· Missing Event Programming -Number of transmitters missing event programming
· Transmitters Not on File in the Last 24 Hours - Number of customers with no transmitters

associated with the account

Users have the option to select a 24-hour, 48-hour or 72- hour time period to display statistics.
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Maintenance Issues

The Maintenance Issues form is similar to the global Maintenance Issues form; however, only
maintenance issues for the Monitoring Company are displayed on the local Maintenance
Issues form. Since only the Monitoring Company's issues are displayed, the filtering tab is not
needed.

Additionally, all resolved and unresolved issues are displayed.  Adding, editing, and clearing
of the issues is similar to the global form, but this functionality is locked out when editing the
Monitoring Company since the maintenance issues do not participate in locking scheme for
the Monitoring Company. When editing and saving an entity with outstanding maintenance
issues, the Operator is prompted for each issue to determine if it was resolved, and for the
operator to resolve, purge or update the issue:

Note: Maintenance lists may be sorted with the exception of the Description and Notes
columns. 

Global Keyholder

A Global Keyholder is normally a person who is associated with the Central Station, not a
specific customer, but is an available resource that can be called to respond to events and
alarms associated with any of the monitored customers. Once created, a Global Keyholder
may be added-in to the call list of any customer on the system to be used within an action
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pattern. 

On initial display, a blank Global Keyholder contact record will be displayed in View Mode.
The record has a number of pages; these can be accessed using the labeled tabs to the right or
base of the Global Keyholder form. 

Find an Existing Global Keyholder Record 

1.  On the authority form, click the magnifier button to the right of the Global Keyholder ID
field. This will bring up the Find window. 

2.  Type an ‘*’ in the value field adjacent to the Keyholder ID field and then click the Search
button.

3.  Choose the record that you wish to view and then click Load. The selected record will now
be displayed.
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Create a new Record

1. Click the New button. This action will bring up the Add Global Keyholder dialogue box.

2.  Click into the Contract No field and enter a suitable Keyholder ID number.

3. Click into the Name field and enter the name of the keyholder. 

4. Check the entries in the remaining fields of the Add window and then click OK. The new
record will now be created and displayed on the screen.

5. If the Contact is addressed by a Title, use the drop-down arrow to the right of the Title field

and select a Title from the list.

6. If the Contact has a Suffix with their name, use the drop-down arrow to the right of the

Suffix field to select it from the list.

7. Tab or Click to the Job Title field and type in the Contact's Job Title - Engineer,

Supervisor, etc.

8. Use the drop-down arrow to the right of the Birthday field to select the Keyholder's

Birthday from the calendar.

9. To associate a photo with this Contact's record, right-click within the gray picture frame to
the right of the name fields and click Find.

10.Browse to the image file (jpeg or gif) on the computer hard drive and select it.

11.Tab or click to the Password filed and enter this Contact's Password.

12.If this Contact will have Web Access to Manitou, tab or click to the Web Access ID field



Maintenance Menu 333

© 2009 Bold Technologies Ltd.

and type in a unique Login ID.

13.If this Contact will have VRT access (remote phone login capability) to Manitou, tab or
click to the VRT ID field and type in a unique, numeric ID with which the contact will log
in to Manitou using VRT.

14.Click or tab into the Valid From field and use the drop-down arrow to select a date from

the calendar.  

15.If applicable, click or tab into the Valid To field and use the drop-down arrow to select a

date from the calendar.

16.If the Contact will be inactive for a period of time, indicate that with the Inactive From and
Inactive To fields.  Use the drop-down arrows to select dates from the calendar for each
field.

Contact Information Tab
1. Click the House tab on the right side of the Application view. 

2. Use the drop-down arrow located to the left of the top telephone number field to select a
telephone number type from the list.

3. Click the notepad icon to the left of the first telephone number field and select Properties.

4. Enter the area code, phone number and extension (if applicable) into the fields available.

5. Use the drop-down arrow to the right of the Email label to select the Email address to enter
(Email, Email 2 or Email 3). 

6. Click into the Email address field and type in the entire Email address.

7. If the Email address field will be used to contact a pager, click on the notepad icon to select
an applicable Output Device, Service Provider and Script from the drop-down lists
available.

8. Repeat the above three steps for up to three Email addresses.

9. Tab or click into the Web Address field.  Manitou automatically copies the text after the @
symbol in the Email address and adds 'www' to auto-fill the Web address.  By default the
Web address is highlighted for removal or overwriting.  If there is no Web address delete
that entry.  If a different URL is necessary, enter the correct Web address.  

10.Use the drop-down arrow to the left of the "This is the Mailing Address" title, to select an
address type.
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11.Click or Tab into the Street 1 field and enter the first line of address information for this
Contact

12.Click or Tab into the Street 2 field and enter any additional address or suite information.

13.Click or Tab into the City field and enter the City/County name.

14.Click or Tab into the State field and use the drop-down arrow to the right of the State field
to select the applicable state.

15.Click or Tab into the Zip code field and enter the Zip code.

16.Check the checkbox if the address is also the mailing address.

17.Move on to the Notes tab.

Notes Tab
1. Click the Note Pad Tab on the right of the Application View to open the Notes screen.

2. Enter any notes that pertain to the Contact.

3. Save the record or click on another tab to enter more Monitoring Company information.

Edit a Record

1.  Find and then display the appropriate record as described above.

2.  Click the Edit button.

3.  Move the mouse cursor to the field that you wish to modify and click into the field.

4.  Modify the contents of the field, as required. 

5.  Make any necessary changes to all fields that you wish to modify. 

Use the tabs at the base and side of the form to move to the various parts of the record.

6.  When you have finished editing the Global Keyholder record, click Save to store the
changes in the database.

General Schedule

Global Keyholder General Schedules define the availability of Keyholders, schedules, and
hours of executive protection. 
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1. Click on General Schedules in the Jump To menu. 

2. Click on the Add button. An Add Schedule box will appear:

3. Enter a brief four-letter code into the Code field.

4. Enter a brief description into the Description field. 

5. Select a Type from the drop-down menu. 

6. Click OK to return to the main General Schedules screen. 

7. Select the days of the week to be included in the General Schedule by checking the
appropriate checkboxes. 

8. In the Start 1 and End 1 cells, enter the first Start and End time. If applicable, enter a
second Start and End time. For example, there may be some times when a keyholder is
available during regular business hours, however they may be unavailable during a
commute home. This is when two start and end times would be utilized. 

9. In the From and To date cells, enter the the dates which this schedule is applicable. Enter
only numbers, as Manitou will automatically insert the date separators. 



Manitou Client 1.5.2336

© 2009 Bold Technologies Ltd.

10.Repeat as necessary to add any additional schedules. 

11.Click Save. 

Maintenance Issues

The Maintenance Issues form is similar to the global Maintenance Issues form; however, only
maintenance issues for the Keyholder are displayed on the local Maintenance Issues form.
Since only the Keyholder's issues are displayed, the filtering tab is not needed.

Additionally, all resolved and unresolved issues are displayed.  Adding, editing, and clearing
of the issues is similar to the global form, but this functionality is locked out when editing the
Keyholder since the maintenance issues do not participate in locking scheme for the
Keyholder. When editing and saving an entity with outstanding maintenance issues, the
Operator is prompted for each issue to determine if it was resolved, and for the operator to
resolve, purge or update the issue:

Note: Maintenance lists may be sorted with the exception of the Description and Notes
columns. 
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Transmitter Types

The Transmitter Types screen allows Users to create a list of communicator types that are in
common use throughout the Central Stations customer base. Creating and maintaining a list
greatly simplifies the setting up of new customers and dealers since information contained in
this list is made available to the Operator when creating a new customer or dealer record. 

A transmitter is a device located at a customer premises that communicates with the alarm
communications receivers connected to the system. The specific transmitter is identified
within the customer record, along with associated details such as the protocol that it is using.

On the left of the screen is the Transmitter Type tree. It is a list of transmitters currently
entered into the system. To select a transmitter, simply click on the transmitter name. The
details of the transmitter will then be displayed in the fields to the right of the tree. 

Add a Transmitter Type
1. To add a Transmitter Type, first put the screen into edit mode by clicking on the Edit

button.

2. Click on the Add button located above the Transmitter Type list. An Add Transmitter Type
box will appear:
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3. Enter the transmitter ID or reference code for the type of equipment. 

4. Enter a brief description into the Description field.

5. Click OK.

6. Back at the Transmitter Type screen, select the Protocol Type if applicable. This is the
communications protocol normally used by the transmitter device.

7. In the Reverse Command Protocol drop-down menu, select the protocol that will identify
how reverse commands are handled by Manitou for this transmitter. 

8. In the Transmitter Input ID section, indicate the Minimum and Maximum values of Group
1, Group 2 and Group 3 (as applicable) using the up/down roll arrows to the right of each
field.

9. Tab or Click into the Transmitter Output ID field and enter a Transmitter Output ID.

Attributes

· Audio Capable – Check this box if the transmitter is capable of transmitting audio signals
for alarm confirmation. 

· Audio Type – Select the audio technique or technology employed by the device, selected
from a list of types.

· Video Capable - Check this box if the transmitter is capable of transmitting video signals
for alarm confirmation.

· Video Type - Select the video technique or technology employed by the device, selected
from a list of types.

· Pin Based Only - Check this box if the transmitter is only capable of sending data in Pin
format.

· Raw Event Programming – When checked, indicates that raw event programming is
possible for this transmitter type.
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· Monitored TX Path - Check if the communications path between transmitter and central
station is monitored, for example, in the case of BT Red Care.

· L-T-T Only When Closed – Check if Manitou will generate a late to test alarm ONLY
when the premises are closed. 

Transmitter Programming

Programming is required for every system in order to guarantee proper account processing.
The Programming items define and decode the information coming in from the transmitters
through the receivers.  For example, some transmitters send a generic message that an alarm
sounded in a specific area or zone.  The receiver then passes this message to the application. 
However, the system doesn't know what that activation on that area or zone means without the
programming. The programming is there to translate the activation on that zone to a burglary
or fire or other alarm on that zone.   Also, programming will allow for the definition of
specific actions to complete on the alarm, such as; call the police and then the Keyholder on
the account.

 
1. To enter programming for a particular transmitter, first select the transmitter from the

Transmitter Types tree. 

2. Select the Event Programming tab at the bottom of the screen. 

The Input section tells Manitou which type of signals should be associated with this
programming entry. The information here should be entered very carefully and will vary from
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account to account. 

1. In the Input section, type or select the Event Code (DES) from the drop-down menu to
select a code for the incoming signal. 

2. Tab into the Area cell and type in an Area.

3. Tab into the Zone cell and type in a Zone.

4. Tab into the Sensor cell and type in a Sensor.

The Output section tells Manitou what the incoming (Input) signal information means. This is
mainly used for non-intelligent signal formats. 

1. Tab into the Event cell and type in an Event Code or select one from the drop-down menu. 

2. The Description will fill in automatically based on the Event Code selected; however, it

may be overwritten 

3. Tab into the Area cell and type in an Area.

4. Tab into the Zone cell and enter a Zone.

5. Tab into the Sensor cell and enter a Sensor. 

6. Enter a Point ID in the Point ID cell if necessary. 

Lastly, the Specific Programming section details are used to enter programming commands.
Clicking on the  button will display a list of all transmitter programming commands.
Tabbing over to the next field, the  button will display a field to enter programming help
text:
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Note:  The asterisk ( * ) acts as a wild-card character. Using an asterisk in the Event, Area,
Zone or TX cells tells Manitou to consider ALL of that item's values - i.e.: All Transmitters,
or All Areas, etc.

Transmitter Programming Commands

Transmitter programming commands can be located by clicking on the Maintenance menu
and selecting "Transmitter Types." Click on the Event Programming tab, and scroll to the
right to locate the Specific Processing section of the form. Click in the commands field to
bring up the  button:

Clicking on this button will bring up the Transmitter Programming Commands dialog. Here,
users can add programming commands to specific transmitters. 
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Audio

The Audio command indicates that the signal has audio capabilities as well as defines what
audio commands will be made available. When adding a Transmitter to a System, the Audio
Capable box must be checked in order to utilize this command. When the Audio command is
added to the programming, users may select between "Yes" and "Listen" in the Type drop-
down menu:

At times, an active customer may receive an audio signal which is not in test. When this
occurs, this programming command will force the signal to become an alarm so that
Operators may respond accordingly. 

Type: 
· Yes - Select "Yes" for two-way.
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· Listen - Select "Listen" if no talk mode is allowed

CanCancel

The CanCancel command allows a signal to be canceled (removed from the Alarm Queue and
logged) when a second qualifying cancel signal arrives. In order to enable this command, the
Auto-Cancel checkbox on the Options form must be checked:

Checking the Auto-Cancel box indicates that alarms may be canceled out of the Alarm Queue
without Operator interaction if a qualifying signal or alarm arrives within the specified
amount of time.

Once the CanCancel programming option has been added, users have several options to
choose from in the Type drop-down menu:
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Please note that in order for the CanCancel command to work, the expected cancel signal
must have "Cancel" capability from the Event Code, or by using the CanCancel command and
the signal containing the same transmitter and area. 

· Event - Select the Event Code that can cancel the alarm or '*' for any Event. The Event
system is looking to receive the signal on the output side of the programming. Therefore, if
an activation (*A) is translated to a restore (*R), the event will be the restore. 

· Zone - Select the Zone that the cancel signal should come from, '*' for any zone or '=' for
the current signal's zone. 

· Timeout - The timeout is the window in seconds that a cancel signal is allowed to cancel
the alarm. The alarm will be initially hidden for this timeout period.

· Abort - Checking the Abort box will force a close of the alarm if the signal arrives within
the timeout period. 

Please note that CanCancel keeps the event in a pre-alarm state and will not drop to the alarm
handling Operator until the time-out is complete. If this is set to the maximum number of
seconds (3600 seconds or one hour), the event will be an hour old before an Operator sees it if
the cancel event does not arrive to cancel it. 

Check to ensure these five parameters are set in order for CanCancel to work as desired:

q The event code that will be canceled;
q The event code that can do the canceling;
q The programming line indicating the event in a certain zone can be canceled by another

event;
q The canceling event saying it is the canceling event;
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q Setting permissions to Auto-Cancel at the customer level.

Cancel

The Cancel command gives the signal Cancel abilities so that it is capable of canceling
another signal. The canceling signal must have cancel properties in order for the cancel
programming command to work. If the event does not have cancel properties, the soft
programming (Signal Processing Commands) will only cancel a "CanCancel" event within 10
minutes of the alarm arrival. If the CanCancel is set for a timeout greater than 10 minutes
(600 seconds), the Cancel property must be attached to the canceling event, regardless of
whether or not the event has the property by default. 

Confirm

The Confirm command will change an event code from a signal to the event code specified in
this Confirm programming command. The second signal must be received within the timeout
period in order for this to occur. 

The first signal will be suspended for timeout seconds, waiting for a possible second signal. If
the second signal is received within the timeout period of the first signal, the first signal will
be logged and the second signal will become the event code that was specified. If a second
signal is not received within the timeout period, the first signal will be presented as a normal
Event. A Line Fault signal can be considered to be the first signal for any ID group and is
indicated by setting ID to '*'.

Line fault signals may be used as the first confirmation signal, regardless of the confirmation
ID. However, this will not be delayed or force logged as with other signals, but it will still
hold the alarm. The line fault signal must have this command specified with the confirm ID
set to '*'. Using an asterisk  indicates that the event code has no meaning for line fault signals.

· ID - This is the identifier to link together signals of the same confirm group. Use '*' for Line
Fault.
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· Event - This is the Event (code) that the signal becomes. This only applies if this is the
second signal to be received.

· Timeout - This is the delay time (in seconds) that the first signal will wait for a second
signal in the same group. 

Dual

The Dual command is used when there are two signals from two different transmitters
expected for the same event, and the signals should be paired together. These two signals
must have the same dual signal ID and same event category. 

The signals are marked as primary or secondary signals, with the primary signal needing to be
received first. A signal should be chosen as Primary if it has the most detail regarding the
event. The secondary is the signal with the least amount of detail. If the secondary signal is
received first, it will be delayed based on the amount of time set in the Supervisor
Workstation options. In the event that this occurs, a Missing Dual alarm is generated. 

Note that the Dual Signal monitoring service in the customer record must be checked in order
for this command to work properly. 

· ID – Identifier to link together signals of the same dual group.

· TX NO. – Transmitter number that will also send a signal for this same event.

· Type – Dual signal type: "Pri" = Primary; "Sec" = Secondary; "Dis" = Dispatchable
Secondary.

EntryExit(EntryType)

The Entry/Exit command is used when signals are sent prior to an Opening signal, and after a
Closing signal. Please note that the panel itself does not handle Entry/Exit delays.  

Entry/Exit Delay must be selected in the Transmitter Programming Commands form.  In
addition, the record must also have Open/Close service and the signals must be for the same
area. Entry Type is set to ‘1’ for the signal to be tripped at the start of the entry process. This
is also the last one to be tripped on the exit process.  Entry Type is set to ‘2’ for all other
signals or to ‘3’ if there are multiple entry/exit signals which may be the first/last signal. 4
ends an Exit cycle and can be used as an immediate signal, while 5 starts an Entry cycle or
ends an Exit cycle. 

The customer monitoring service for Open/Close is required and must be active for this
system and area. The monitoring service for Entry/Exit is also required and must be active for
this system or the command will be ignored.  This monitoring service specifies the timeout
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period for the entry or exit cycle.

The signals that will participate in this process to must also contain the Signal Processing
attribute of “m” and “n”.  The “m” attribute is not set on any events by default to ensure that
each company sets this based on their specific company practices and make a reasoned
decision before using this feature.  The “n” attribute, if ‘c,’ ‘d,’ or ‘e’ is true then this option
tells the signal handler to delete the alarm if it has been canceled when the alarm state is new
or new/suspended.  If the desired outcome is to remove this alarm from the alarm queue if the
opening or closing occurs within the prescribed time period then the n command is also
required.

IfClosed(Event,Alarm)

The IfClosed command is used to change a signal to a specified event code if the area
associated with the signal is closed when it is received. Customers must have an Open/Close
monitoring service in order for this command to work properly. 



Manitou Client 1.5.2348

© 2009 Bold Technologies Ltd.

· Event – Event (code) that the signal becomes if the area is closed.
· Alarm – Alarm indicator: ‘Yes’ = Signal is forced to be an alarm; ‘No’ – Signal is forced to

be logged; ‘Default’ = Alarm or Signal depending upon Event Programming or Event
default.

IfOpen(Event,Alarm)

The IfOpen command is used to change a signal to an event code if the area associated with
this signal is open when it is received. This is only allowed if an Open/Close monitoring
service is active. 

· Event – Event (code) that the signal becomes if the area is open.
· Alarm – Alarm indicator: ‘Yes’ = Signal is forced to be an alarm; ‘No’ – Signal is forced to

be logged; ‘Default’ = Alarm or Signal depending upon Event Programming or Event
default.

InSched(Sched No.,Event,Alarm)

This command is used to change a signal's event code to another specified event code if it is
received according to the acceptable times and days of the specified general programming
schedule indicated when it is received. Users may set up a programming schedule under
General Schedules as well.

· Sched No. – General (programming) Schedule to be used.
· Event – Event (code) that the signal becomes if the signal is scheduled.
· Alarm – Alarm indicator: "Yes" = Signal is forced to be an alarm; "No" – Signal is forced

to be logged; "Default" = Alarm or Signal depending upon Event Programming or Event
default.
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InTest(Event,Alarm)

This command is used to change a signal to an event code if the signal is On Test when it is
received. In other words, if a specified signal arrives and the customer's system is currently
On Test, the command will convert the original signal to the signal that is specified. This way,
the signal can be actioned by an Operator.

· Event – Event (code) that the signal becomes if the signal is in test.
· Alarm – Alarm indicator: ‘Yes’ = Signal is forced to be an alarm; ‘No’ – Signal is forced to

be logged; ‘Default’ = Alarm or Signal depending upon Event Programming or Event
default.

Pri(Priority)

The Priority command is used to change a signal's priority by overriding the default even
priority. This is only valid if the signal becomes an alarm. Users may override the priority by
selecting a priority number. 

RestCat(EvCat)

This command gives restore by event category qualities to the signal that may not otherwise
be known as a category restore. Users can choose the event category of signals to be restored. 

Restore()

The Restore command gives restore by event category qualities to the signal that may not
otherwise be known as a restore. 

ResRq(Event,Zone,Timeout)

This command is used to indicate that this signal requires a restore, but is not dependent on
whether or not the signal becomes an alarm. This may be of help if a Burglary Alarm on a
zone is mistakenly set off. The system should be sending a restore signal to restore the zone
back to a normal state. This way, the next time the alarm is tripped, it is not a secondary trip
of the same zone, but rather a first trip of the same zone.

 If Timeout is non-zero and the transmitter has "Generate Restore Overdues" enabled, a
Restore Overdue signal will be generated after Timeout minutes if an appropriate restore
signal is not received.

Note that the restores signal must have "restore" capability from the event code or by using
one of the restore type programming commands. If the programming commands are used, the
signal must be from the same transmitter and same area. 

· Event – Event (code) of the expected restore signal.
· Zone – Zone of the expected restore signal or ‘*’ if any zone of type Event is to restore this

signal, or ‘=’ for the current signal’s zone.
· Timeout – Delay time in minutes that this signal will wait for a restore signal before

generating a Restore Overdue event or 0 if no Restore Overdue is to be generated.
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Suspend(Timeout,Hidden)

This command will suspend and optionally hide alarms when first received.  If the signal is
hidden while on suspension, it will not be displayed on the alarm queue.  If the signal is not
hidden, it will display on the alarm queue with a status of ‘Suspended’  and will not be
auto-dispatched to an operator until suspend time has expired.  An operator can select the
alarm from the queue which would have the effect of canceling any remaining suspend time.

It is not recommend to combine this command with  any other command that performs an
initial hidden suspend, such as a Confirm command.

· Timeout – Delay time in seconds that this signal will be suspended.
· Hidden – Hidden indicator: ‘Yes’ = Signal is hidden while suspended; ‘No’ – Signal is not

hidden.

TempClose(Window)

The TempClose command creates a temporary close window when an Open signal is
received. Customers must have an Open/Close service in order for this signal to work
properly. The Window field indicates the time of the temporary close window in minutes. 

TwoTrip(ID)

This command will require two signals of the same ID to be received before considering the
event to be a real signal and generate an alarm.  Also, the customer must not have UL service
selected and the signal must be allowed through its Signal processing attributes to participate
in Two-trip delays. The timeout for expecting the second signal is a system parameter setting
in the Supervisor Workstation Options.  The first signal is ignored, but logged.  If a second or
following signal is received within the timeout period of the first signal, then the subsequent
signals are handled normally. The transmitter number and event category on the event code 
must be the same in order for two-trip to work. Monitoring service for two-trip must also be
active on a customer account, or the command will be ignored. 

The two-trip signal processing attributes must be applied to the output event codes, not the
input.  Therefore, if an activation on zone one translates to a burglary alarm, then the attribute
must be on the burglary alarm, not the activation.  The signal's event code must have the
"two-trip delay" attribute specified. 

· ID – Identifier to link together signals of the same two-trip group.

User(ID, Override)

This command sets the signal’s User ID information (effective panel user ID) if not already
supplied in the signal itself.  Generally, the ID would be sent in as part of the signal or as the
zone number when the signal is an open or a close type of event.

· ID – Panel User ID or ‘*’ if the signal’s zone is to be used as the User ID
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Video()

This command indicates that the signal has video capability. Video Monitoring must be
selected on the Services tab of the Customer record and Video Capable check box selected on
the Transmitter form in the customer record in order to utilize this command. 

This command will force the signal to become an alarm if the customer is active and the
signal is not in test. This is so the Operator can respond appropriately. 

1 - Function ignored if back-dated signal
2 - Function ignored if Manual signal

Maintenance Issues

Maintenance Issues allows a Manitou user to record details of any administrative issues with
particular system records as they are encountered. Items entered into the list can then be
addressed and resoled by a supervisor or system administrator. 

Create a Maintenance Issue

1. Click on the Maintenance menu.

2. Select Maintenance Issues.
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3. On the Maintenance Issues screen, click Create New. The New Maintenance Issue dialogue
box will be displayed:

4. Select the type of contact that the issue refers to using the Contact Type pick list. This list
includes all organization record types plus contacts (person).

5. If a contact is chosen, enter the contact’s number into the Contact ID field or use the Find
facility to choose the appropriate record.

6. Enter a brief description of the problem in the Description area.

7. When the form is complete, click Save Changes. Manitou will allocate an issue number to
the entry and details of the entry will appear in the Maintenance Issues list. 
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Edit a Maintenance Issue
1. Open the Maintenance Issue window by clicking on the Maintenance menu, then selecting

"Maintenance Issues."
2. Select the desired entry to edit by clicking on the entry.

3. Click on the Edit Selected button. The Edit Maintenance Issue box will appear:

4. Enter any changed details into the Change Description box.

5. Click "Save Changes" to save the changes, or "Cancel" to cancel the changes.

Resolve a Maintenance Issue Item

If an issue has been resolved, the user may enter details as well as clear the item from the
Issues list. 
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1. Open the Maintenance Issue window by first clicking on the Maintenance menu, then
selecting "Maintenance Issues."

2. Select the desired entry to resolve by clicking on the entry.

3. If no changes have been made to the entry, the user must first click on "Edit Selected" to
amend the description to include the resolution, and then click on the "Resolve" button.
Otherwise, an error will occur:

4. If changes have already been made to the issue, the user can highlight the entry to be
resolved, and click on the "Resolve Selected" button.

Delete/Purge Resolved Issues List

Periodically, it is a good idea to purge the Maintenance Issues list of resolved items. Purge
Selected  will this purge the currently selected record. Purge to Date will purge all resolved
issues up to the creation date that is specified. 

Purge Resolved Issues List
1. Bring up the Resolved Issues list by first clicking on the Filter tab at the bottom of the

Maintenance Issues screen.

2. Under the Resolution section, select Resolved.

3. Click Search. Back at the Maintenance Issues screen, a list of all resolved issues will

appear. 

4. Select the issues to be resolved by clicking in the column to the left of the Issue Number.

5. Click on Purge Selected. 

6. A Yes/No prompt will appear, asking the user to confirm the delete. Click Yes. The issues

have now been purged. 

Purge to Date
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1. Bring up the Resolved Issues list by first clicking on the Filter tab at the bottom of the

Maintenance Issues screen.

2. Under the Resolution section, select Resolved.

3. Click Search. Back at the Maintenance Issues screen, a list of all resolved issues will

appear. 

4. Click on the Purge to Date button. A Purge Resolved Maintenance Issues window will

appear:

5. Select the date from the drop-down menu. The date selected will purge all issues up to the

creation date that is specified.

Click OK. The issues have now been purged.

Maintenance Issue Filter Facility

The Maintenance Issues Filter Function allows users to display issues that meet a certain
search criteria. Users may search by Date/Time, Resolutions, Contact Types, Contact ID or
User. 

Maintenance Issues Filter Tab
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Users may also reverse the order of display by checking the Reverse Order box. Once the
search parameters have been set, click Search to bring up Maintenance Issues. 

Reports Menu

Reports can play a vital role at a Central Station. There are many customers that receive
reports on a weekly, monthly or periodic basis.  Additionally, for management purposes, each
company often runs reports on a daily, weekly and monthly basis as well. Report Functions
also include enabling one or more reports to be selected, queued, previewed on screen, printed
or sent to a nominated recipient by e-mail or fax.

The Reports function enables users to create reports on an as-needed basis, such as a request
from a customer or Dealer. The Reports function operates along the Report Scheduler and
Publisher applications in Manitou, which generates and distributes reports on an automatic
basis according to pre-determined criteria. 

The following options are accessible from the Reports Menu:

· System Reports
· Report Queue

Report Options
At times, users may wish to select Advanced Options for Reports. Please note that checking
all categories is the same as unchecking all categories. In order to keep the parameter list as
short as possible, when all items of a particular category are selected, the parameter sent to the
report server is empty (meaning "all" is requested). 

System Reports

The System Reports function is a tool used for running reports on various Manitou system
aspects, such as the number of customers added or deleted during a specific date range, or
customer activity. These reports can be scheduled to run a certain time intervals and have the



Reports Menu 357

© 2009 Bold Technologies Ltd.

option to be e-mailed, faxed or printed.  

Initially, when displaying the System Reports, the default page shows the first step in the
reports process. On the left hand side of the screen is a list of the available reports. After
selecting a report from the reports list, the search criteria and parameters available to each
report are shown on the right. 

Activity Reports

Alarm Cause Summary

The Alarm Cause Summary report provides details regarding a summary of what caused
alarms - i.e. burglary or false alarm during a set time period. The report ultimately provides a
listing of the event category, alarm causes (resolution codes) and the number of genuine and
false alarms. 

Users can enter various search criteria into the fields provided in the Alarm Cause Summary
window:
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The report may be run by Customer, Dealer, Authority, Branch, Group code, or Class code. It
may then require all or only one or two authority types. Subsequently, the report may be
selected by alarm resolution type of false or genuine and dispatched, not dispatched or both.
The report may also be grouped any of five ways: Customer, Dealer, Authority, Branch and
Event Category. 

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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The advanced search options are divided into four categories: Event Codes, Event Categories,
Resolution Codes and Customer Types. All options are checked by default and it is
recommended to leave all options as such. 

· Event Codes – use this to select only the events required.
· Event Categories – use this to narrow the scope of the events to the category of

alarm/signal events.
· Resolution Codes – will select the alarms with the specified resolution codes.
· Customer Types – will select only the customers of the selected type(s).

Once the search parameters are set, click Next to continue running the report. 

Alarm Detail

The Alarm Detail report contains the alarm activity details for a single or several customer
records. When this report is run with the defaults, the report groups by Customer and lists
each alarm in sequential order.
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Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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The advanced search options are divided into five categories: Event Codes, Event Categories,
UL Grades,  Resolution Codes and Customer Types. All options are checked by default and it
is recommended to leave all options as such. 

· Event Codes – use this to select only the events required.
· Event Categories – use this to narrow the scope of the events to the category of

alarm/signal events. 
· UL Grades - use this to select narrow down the results by UL Grade.
· Resolution Codes – will select the alarms with the specified resolution codes.
· Customer Types – will select only the customers of the selected type(s).

Once the search parameters are set, click Next to continue running the report. 

Report Results
· Customer information, including Contract number and Address.
· Alarm Number, this is a combination of the database serial number assigned to this record

and the sequence number of the alarm assigned to it when the alarm arrived.
· User ID information of the person that handled the alarm.
· Alarm date and time plus the reset date and time.
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· UL information when applicable.
· Activity from the alarm handling process.
· If persons or authorities were contacted during the alarm handling process the contact

details will list after the activity. This will detail the initial contact, the date and time when
the authority or person arrived on site and if/when the alarm was cleared.

Alarm Detail by Alarm Number

The Alarm Detail by Alarm Number report is a more specific version of the Alarm Detail
report. In order to correctly run this report, the Operator must know the alarm number. The
alarm number is a unique number assigned by Manitou which is a combination of the serial
number of the customer record from the database and the sequence number assigned to the
alarm by the database when the alarm arrived.

 When running this report, the first digits before the hyphen in the alarm report
number are actually the contract’s serial number and should not be used in the report number
field since it is already reference by entering the Contract number in the Contract Number
field.  Therefore, use only the digits after the hyphen when entering in the alarm report
number or numbers. Once the search parameters are set, click Next to continue running the
report. 

Alarm Resolution

The Alarm Resolution report produces the details and summary information about the alarms
that arrived and how they were resolved, including if the alarm was dispatched or not. The
report results also total the number of genuine and false alarms and the percentages of each
including the numbers and percentages of dispatched false alarms.

Users can enter various search criteria into the fields provided in the Alarm Resolution
window:
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Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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The advanced search options are divided into three categories: Customer Type to Include,
Event Codes and Event Categories. All options are checked by default and it is recommended
to leave all options as such. 

· Customer Types – will select only the customers of the selected type(s).
· Event Codes – use this to select only the events required.
· Event Categories – use this to narrow the scope of the events to the category of

alarm/signal events. 

Advanced Resolution Option Settings
Clicking on the Options button will allow users to include additional resolution options as
well as report options. Users may choose to include genuine alarms, false alarms, or both
types of alarms, as well as including or excluding specific type of authority (police, fire or
medical). Last, Users may choose report summary options: details only, details with summary
totals, or summary totals only:
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Once the search parameters are set, click Next to continue running the report. 

Alarm Response

The Alarm Response report produces activity and shows how long it took for the alarm to
receive its first contact action. 

The Response Type selection indicates what type of contact action was performed. A contact
action is an action that requires the  Operator to pick up the telephone and contact a
responsible party, customer, dealer or authority. By default, the report includes details as well
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as the alarms, Operator, the view time, first action time, and resolution time. Often, the first
action column may be empty. This is because there was no contact action on the action
pattern. Remember, the contact action requires an Operator to pick up the telephone and dial
another person. If a pager, fax, or email is used to contact a responsible party that is not
considered a true contact action.

Response Type
View to Action and Rcvd to Action are more or less the same function. The difference in the
two will be how long the alarm sat in the queue. If an alarm is generated and left in the queue
for 60 seconds, open it and perform a contact action, the View to Action will be 60 seconds
less than the Rcvd to Action. Users may choose whether to view the Response Type by either
the View to Action or Rcvd to Action.

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:

The advanced search options are divided into two categories: Event Codes and Event
Categories. All options are checked by default and it is recommended to leave all options as
such. 

· Event Codes – use this to select only the events required.
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· Event Categories – use this to narrow the scope of the events to the category of
alarm/signal events. 

Once the search parameters are set, click Next to continue running the report.

Customer Activity

The Customer Activity report is the most used and most detailed report for obtaining
customer account activity information.  This report contains all alarms and signals for
customer records, including the details of actions taken and comments added to the account. 
The report’s results are divided by the Customer Contract Number and then by the Alarm
Report Number.  The  Operatorcan select the Mailable option in order to get a report that will
fit neatly into a standard business-sized window envelope.

This report differs from the Alarm Detail report, which concentrates only on the alarm
activity. The Customer Activity report collects and returns information on the entire activity,
open, close, on test, comments, etc.  The standard Activity report run with no changes,
excepting perhaps narrowing the criteria by Customer or Dealer, produces a report showing
the alarms and signals and related details from the Customer log. The report excludes the
entries when someone opened the customer record for viewing or editing.

To run a report, enter the requested parameters to produce the correct customer or group of
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customers that receive a report.  Always make sure to select an appropriate date range for the
requested report as well as if all activity, only exception activity or only open/close activity is
required.

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:

The advanced search options are divided into five categories: Event Codes, Event Categories,
Customer Types, Resolution Codes and Log Record Types. All options are checked by default
and it is recommended to leave all options as such. 

· Event Codes – use this to select only the events required.
· Event Categories – use this to narrow the scope of the events to the category of

alarm/signal events.
· Customer Types – will select only the customers of the selected type(s).
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· Resolution Codes – will select the alarms with the specified resolution codes.
· Log record types – is a vital determining factor of what results appear on the finished

report. Manitou defaults some standard log record types for all reports. However, some
reports do not need all the defaults so it will be important to come to the Advanced dialog
and remove the unnecessary log record types.

Advanced Customer Activity Options
Clicking on the Options button will allow users to include additional report summary options.
Among other things, users may choose to suppress Operator initials or include customer
comments. The report output may be in long, normal, or detailed format, and can be grouped
by customer, dealer, branch or user ID. 

Once the search parameters are set, click Next to continue running the report. 

Daily Signals

The Daily Signals report produces similar results to the Customer Activity report with the
exception of how the results display.  While the Customer Activity report displays its results
by the Contract number and then by the Alarm Report number, the Daily Signals report
displays only by date.  The Daily Signals report has the same advanced options as the
Customer Activity report in order to narrow the results with the exception of the Log Record
Type.  Since this report does not list alarm details, there is no need for the option.

The Daily Signals report will list the signals for a day or date range based on the entered
criteria. The default results produces the signal date then list the signals by time with
customer ID the Signal type (A=Alarm, S=Signal), the Event Category, the Signal or Alarm
description and if the alarm was dispatched.
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Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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The advanced search options are divided into five categories: Event Codes, Event Categories,
Resolution Codes, Dispatch Types and Customer Types. All options are checked by default
and it is recommended to leave all options as such. 

· Event Codes – use this to select only the events required.
· Event Categories – use this to narrow the scope of the events to the category of

alarm/signal events.
· Resolution Codes – will select the alarms with the specified resolution codes.
· Customer Types – will select only the customers of the selected type(s).
· Dispatch Types - will select the type of dispatch sent to a customer site.

Once the search parameters are set, click Next to continue running the report. 

Handled Signals by Operator

The Handled Signals by Operator report is a useful management tool to view the number of
alarms Operators are handling. 
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The report results display the Operator’s User ID, Operator Name, the number of alarms
acknowledges and the total number of alarms closed by that Operator. The total number of
alarms could differ greatly from the number of alarms acknowledged if:
a) The ability to cancel alarms from the Alarm Queue is allowed; and
b) The Operator is able to close alarms of equal or lower priority along with the alarm they

just acknowledged and completed. 

Once the search parameters are set, click Next to continue running the report. 

An Acknowledged alarm is an alarm that had a contact action, an action that
required an Operator to call someone. Operators may handle an alarm fully and never pick up
the telephone to contact a person, and that would be considered a closed alarm but not
acknowledged.

Signal Count by Customer

The Signal Count by Customer report will produce a report detailing the number of signals,
alarms and ignored signals for each customer. An ignored signal is one that was ignored by
the system often when utilizing a programming feature such as Entry/Exit delay. The
Entry/Exit delay process will ignore any signals that were part of the Entry or Exit process if
followed or proceeded by an Open or Close signal.
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Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:

The advanced search options are divided into three categories: Event Codes, Event
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Categories, and Log Record Types. All options are checked by default and it is recommended
to leave all options as such. 

· Event Codes – use this to select only the events required.
· Event Categories – use this to narrow the scope of the events to the category of

alarm/signal events.
· Log record types – is a vital determining factor of what results appear on the finished

report. Manitou defaults some standard log record types for all reports. However, some
reports do not need all the defaults so it will be important to come to the Advanced dialog
and remove the unnecessary log record types.

Once the search parameters are set, click Next to continue running the report. 

Unrestored Signals

The Unrestored Signals report is a maintenance report and is typically run to verify if an
alarm received a restore signal or if the account requires maintenance in order to clear out the
closed, yet unrestored, alarms. The report lists all alarms that have Restore Required that are
not yet restored. Additionally if the Option setting of Track Additional Statuses is set to Yes
the additional panel statuses could also be unrestored. These additional panel statuses are not
restored by an alarm restore and therefore can load up and create restore overdue signals when
the alarm itself is restored.

When run on default settings, the report will find all unrestored signals that are unrestored for
greater than 10 minutes and sort the results by date. The report may be further limited or



Reports Menu 375

© 2009 Bold Technologies Ltd.

expanded by increasing or decreasing the minimum number of minutes the signals are
unrestored and by defining a Customer ID, Customer name, Dealer ID, Branch ID, Group or
Class Code or by date or date range.

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:

The advanced search options are divided into two categories: Event Codes and Status Types.
All options are checked by default and it is recommended to leave all options as such. 

· Event Codes – use this to select only the events required.
· Status Types - check any 

Once the search parameters are set, click Next to continue running the report. 
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User History

The User History report is designed to show Operator login and logoff information. 

Users may choose to include all history information, or limit the report to login or logoff
information. Once the search parameters are set, click Next to continue running the report. 

Custom Reports

Custom Reports are reports that one or more customer sites paid to have implemented within
the Manitou system. These reports end up benefiting the entire community as a result.

Customer Signal Count Generator

The Customer Signal Count Generator is an exception report used to find accounts that do
not contain class codes or other information that will enable the Dealer Signal Count report to
run and give accurate results. The report runs by default on the current date. The dates can be
adjusted to include a date range; however, most want to know these results as of today and
now not what the data was in the past.
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Once the search parameters are set, click Next to continue running the report. 

Dealer Billing Deferred Revenue (COPY)

The Dealer Billing Deferred Revenue will be tracked when enhanced billing is licensed. The
report will display the necessary deferred revenue adjustments that ned to be made. The
adjustments must be entered manually into the accounting software. 

Dealer Billing Generate (COPY)

The Dealer Billing Generate report will report on all billing discrepancies, which can then be
resolved in Manitou. In the example below, the report was run for all existing Dealers. Please
note that in the main report forms, the Prorate Date Limit field governs the date before which
charges are allowed.
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The first messages for DLR001 indicate that no billing charge codes were found at the Dealer
or Monitoring Company Billing Charges form for the item code "DRL1FIRE." To remedy
this, the appropriate billing charge code must be added to either the Dealer or the Monitoring
Company. Other messages indicate that some dealers are not linked to accounting.

These messages are simply warnings, indicating that the charges will not be posted to the
accounting software. Rectifying these issues will allow for the charges to be posted. 

Dealer Billing Preview (COPY)

The Dealer Billing Preview report will list all transactions that are ready to be posted to the
accounting system for dealer billing. This preview can be run as many times as needed, and
should be the last report run before running the Dealer Billing Post. Users have several
options for this report. For instance, the monitoring company may wish to send out the report
to each individual Dealer by selecting a specific Dealer ID. More notable options include
Dealer Options and Grand Totals Options. The Dealer Options checkboxes allow the user to
select whether the report should include all details, or should be summarized by charge type
and/or billing code. The Grand Totals Options will display a total amount of charge types or
billing types, or may be used to just show the charge type summary or the billing code
summary. 
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In this example, the Dealer Billing Preview report was run for DLR001 with the Details and
Total Amount options checked. These options will display the customer ID and Customer
Name, the charge types associated with the customer, the services, billing codes, and the dates
that the services are enabled. Additionally, all charges are added up and totaled at the end of
the report. 

Dealer Billing Post (COPY)

Once the Dealer Billing Preview report has been run, the Dealer Billing Post report is the final
step in order to post the billing to the accounting system. The only editable fields in this report
is the Report Description and the Invoice Date. Checking the Invoice Date box will post the
billing to that exact date in the accounting software.



Manitou Client 1.5.2380

© 2009 Bold Technologies Ltd.

Dealer Signal Count

The Dealer Signal Count report lists the number of signals for each customer based on the
dealer and the dealer’s billing settings.

Once the search parameters (Dealer IDs) are set, click Next to continue running the report. 

Maintenance Reports

The Maintenance report section contains the reports that apply to account and system
maintenance.

Access Control Card Lookup

The Access Control Card Lookup report provides a list of specific access control
cards detailed in one report. This list may be useful as a scheduled report customers
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who utilize Access Control to view when employees have accessed the building. 

Users may enter search criteria based on Customer ID, Customer Name, Dealer ID, Branch ID, Group
or Class. The report may also include the time the building was last accessed. Users can also limit the
search to a specific date and time period.

Once the search parameters have been set, click Next to continue running the report. 

Acces Control Cards/Pins

The Access Control Cards/Pins report provides a detailed list of customers at a site that ulitize Access
Control and may wish to view a master report of employees at the site with Access Control cards or pin
numbers. The report includes the Transmitter ID, the Card ID, the name of the person to whom the
card belongs, the Card ID and the Type of card. 
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Users may enter search criteria based on Customer ID, Customer Name, Dealer ID, Branch ID, Group
or Class. The report may also include the time the building was last accessed. Users can also limit the
search to a specific date and time period.

Once the search parameters have been set, click Next to continue running the report. 

Customer Add/Del

The Customer Add/Delete report produced two different sets of results depending if the
Include details checkbox is selected or not. The checkbox is selected by default. It is also set
to one day and all adds and deletions grouping by date by default as well.

Users may search by Dealer ID or Branch ID. Once the search parameters are set, click Next
to continue running the report. 

Customers with Transmitter Type

The Customers with Transmitter Type report is a useful Maintenance tool, as it produces
what customers have which transmitter types within the Manitou system. This can help with
the plan of moving customers from an older transmitter to newer and better equipment. The
report results may be expanded or reduced by entering the transmitter type, or selecting the
customer ID or name, Dealer or Branch ID, Group or Class code or Receiver Line Prefix. 



Reports Menu 383

© 2009 Bold Technologies Ltd.

Users may select or deselect the Receiver Line Prefix from the Rec Line Prefix menu. Once
the search parameters are set, click Next to continue running the report. 

Maintenance Issues

The Maintenance Issues report is designed to list maintenance issues that were entered into
the application through the Manitou Client or the Supervisor Workstation.  

There are two ways to run this report: with or without the Maintenance log information.
Running the report without the maintenance log information will give the Operator a quick
report of current outstanding Maintenance items within the system.  Running the report with
the maintenance log information gives the Operator the detailed notes that were entered into
the report.
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By default the report only lists the currently unresolved issues. This will report the same
information that is also available in the Manitou Client and Supervisor Workstation on the
Maintenance menu. By default the report does not include the full text of the Maintenance log
in order to conserve space. Filters include Types, Resolution (if the issue has been resolved)
and Operator initials. 

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:



Reports Menu 385

© 2009 Bold Technologies Ltd.

Users may opt to search by Agency ID, Authority ID, or Global Keyholder ID. Once the
search parameters are set, click Next to continue running the report. 

Permit Exception

A Permit Exception occurs when an Authority requires a permit and the customer cannot
produce the required permit. The default selections include inactive accounts. If the company
desires only the active accounts, it is necessary to uncheck that option upon initial load of the
report. This report may be ordered by Customer, Dealer or Branch and narrowed to a specific
Authority type or even run for one specific Authority.

Once the search parameters are set, click Next to continue running the report. 

Permit Expiration

The Permit Expiration report is designed to list all the police, fire, and medical permits that
have expired.  If a permit expires, the customer must renew it or they may not get service
from the authorities.  Each Central Station has a different policies and usage for permits,
therefore, each Central Station will have to decide if this report is necessary.
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This report produces the listing of permits that expire within the applicable date range, and
not just list the permits that are currently expired. This report may be further controlled by
selecting a date or date range or by entering Customer ID or name, Dealer or Branch IDs,
Group or Class codes. The results may be ordered by Expiration Date, Customer ID or
Authority Type. 

Once the search parameters are set, click Next to continue running the report. 

Where Used on Contact List

The Where Used on Contact List report will produce a listing of the customer, dealer,
branch, authority, agency, etc. records where the selected entity is listed on the Contact List. 

Entities that can be listed on a Contact List:
· Monitoring Company
· Dealer
· Agency
· Branch
· Authority
· Customer
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· Global Keyholder (Contact)

There may be several sites where a contact person is listed individually on multiple customer
records. This report will not be able to collect any information on those persons as they are
not global keyholders. Persons must have a Contact ID in order to be listed in the Where Used
on Contact List report. Once the search parameters are set, click Next to continue running the
report. 

Master File Reports

The Master File section not only contains the Customer Master File report, but also the
Master file reports for Dealer, Agency, Authority, Branch, Monitoring Company and every
other form housed within the Supervisor workstation that contains data.

Access Control Card Formats

The Access Control Card Formats report provides a list of Access Control cards
associated with a certain format. The only search criteria needed to run this report is
a format number. If no format number is entered, the report will list all Access
Control cards. 

Once the search parameters are met, click Next to continue running the report. 

Accounting Companies

The Accounting Companies report provides a report of all accounting companies linked to
the Manitou system, the direction it is linked (for instance, Accounting to Manitou), as well as
the DSN, username password and server associated with the particular accounting company. 
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Select a company ID from the drop down menu, as well as the accounting company type and
the direction of the interface to set the search criteria. Once the search parameters are met,
click Next to continue running the report. 

Agency Master File

The Agency Master File report lists the details of the Agencies within the Manitou database.
This report may include or exclude as much or as little information as desired. 

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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The advanced option allows for the selection or de-selection of sub-reports, contact lists, and
agency types to further narrow or expand the report results. To select none or all of the
advanced options, simply right-click within each section and either click the Select All or
Select None options. Once the search parameters are set, click Next to continue running the
report. 

Application Types

The Application Types report produces the same information that is available within the
Application Types form in the Supervisor Workstation. The report does not require any
user-entered criteria.

Authority Master File

The Authority Master File report lists the details of the Authorities within the Manitou
database. This report may include or exclude as much or as little information as desired. 
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Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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The advanced dialog allows for the selection or de-selection of sub-reports, contact lists, and
authority types to further narrow or expand the report results. To select none or all of the
advanced options, simply right-click within each section and either click the Select All or
Select None options. Once the search parameters are set, click Next to continue running the
report. 

Branch Master File

The Branch Master File report lists the details of the Branches within the Manitou database.
This report may include or exclude as much or as little information as desired. 

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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The advanced dialog allows for the selection or de-selection of sub-reports and contact lists to
further narrow or expand the report results. To select none or all of the advanced options,
simply right-click within each section and either click the Select All or Select None options. 
Once the search parameters are set, click Next to continue running the report. 

Cities

The Cities report lists the cities based on the entered criteria. The Region and Cities fields are
data entry fields and the data entry must match the spelling of the city and state/region as it
has been entered in the database.  
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 It is suggested to narrow the cities list by entering a region into the selection
criteria. For databases with cities for every region, running the report by the defaults could
impact the Report Server’s ability to run other reports.

Class Codes

The Class Codes report lists the Class Codes currently available within the database. It is not
necessary to enter or select any criteria to receive a listing of all the class codes within the
database. However, the user wishes to view class codes within a range, then criteria may be
entered into the From and To fields. 

Contact Point Types

The Contact Point Types report lists all the different Contact point types available within the
Manitou system. These include telephone numbers, emails addresses, pager and fax numbers,
and web addresses. There is no user entered criteria because the report only has one output.
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Control Panels

The Control Panels report lists the Control Panels within Manitou and their details. It is
possible to run this report with and without details, however users may enter search criteria in
the From and To fields if desired. 

Countries

The Countries report produces the Country details available in the Supervisor Workstation.
Most companies will only have one country, however this report may be limited to one or all
selected countries. The report output only displays the Country Options Telephone and Time
information and the Mailing Address Layout information.

Customer Master File

The Customer Master File report contains all the data housed within the Customer form.
Operators may adjust the report parameters to view as much or as little of the customer
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information as desired. The report is designed to have a reference if the customer data was
lost and it was necessary to enter the data back into Manitou. The report is not designed for
manual alarm handling. 

Explanation of Search Criteria
· Commission date – The date the account was activated.

· Create date – The date that the account was initially created within the database. This is
not a date easily located through the User Interface.

· Last updated date – The date the last data change occurred within the customer record. If
an Operator edits and saves the record without making any change to the customer data, this
does not update the last updated date.

· Marked for reprint – The checkbox on the customer save notes dialog that is checked “
Mark customer for reprint” sets this value and the report server then looks for the records
with this value. This value is reset when the "reset reprint" box is checked.

· Reset reprint flag after publishing to printer – This will reset the “Marked for reprint”
flag on all customer records included in this report’s parameters. This value is reset when
the "reset reprint" box is checked.
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· Suppress Passwords – This will change the passwords printed in this report to asterisks.

· Mail Format – This will output the reports in a format that is ready for folding and placing
in window envelopes. This option is not enabled unless the Page Breaks option is
unchecked. Mailing format assumes page breaks therefore there is no need for the additional
checkbox.

· Page Breaks – This checkbox will force page breaks between the group by options.

Advanced Search Options
Clicking on the Advanced button or the Options button at the bottom right corner of the
screen will bring up additional search options.

The Options window allows for the selection or de-selection of sub-reports and contact lists to
further narrow or expand the report results. Once the search parameters are set, click Next to
continue running the report. 

Options Window

The Advanced window allows users to entire search criteria pertaining to a specific city or
region in which certain customers reside. 

Advanced Window
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Dealer Master File

The Dealer Master File report allows the ability to generate a hard copy of the Dealer
account information. The Dealer Master File report will only contain the Dealer specific
information.

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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DNIS Maps

DNIS stands for Dialed Number Identification Service. The DNIS report will display
mappings used within the system at this time. 
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Users may search by Receiver Line Prefix, Monitoring Group, or Dealer ID. Once the search
parameters are set, click Next to continue running the report. 

Event Categories

The Event Categories report allows for narrowing of event category data. If there are Event
Categories specified for a single Monitoring Group, this information will also be listed. The
default results show all the Event Categories for all Monitoring Groups. The only filtering
possible for this report is based on the Monitoring Groups. All Event Categories for this
report will always print every time. The only restriction will be based on the Monitoring
Group.
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Event Codes

The Event Codes report will list the Event codes and their details. This could potentially be a
very large report when run on the defaults, so it is recommended to narrow the results by
select specific search criteria. 
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Users can narrow search results by selecting or de-selecting specific Event Categories (such as
Burglary, Fire Alarm, etc.) The report may be ordered by certain criteria as well. 

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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When using the advanced option to narrow the search by Event Code (alarm type), it is
possible to select one or several event codes to get the results requested.  Once the search
parameters are set, click Next to continue running the report. 

Event Maps

The Event Maps report shows the relationship of how a signal arrives into automation and
how Manitou translates it. This information will show where it is not necessary to program
signals that Manitou already knows how to translate.  
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Global Holidays

The Global Holiday report lists the entered global holidays listed within the Manitou system
by country. Users may simply select which countries they wish to view global holidays, as
well as the format (Month, Day or Day, Month) in which the report will format the report
results. 
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Global Keyholder Master File

The Global Keyholder report lists the Keyholders that have Contact ID’s tied to their
information.  It is best to run the report without parameters to produce the best results. The
report may be customized to display as little or as much information as necessary.

Advanced Search Options
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Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:

The Options window allows for the selection or de-selection of sub-reports and keyholder
types to further narrow or expand the report results. Once the search parameters are set, click
Next to continue running the report. 

Group Codes

The Group Codes report lists the Group Codes for the Manitou System. Group Codes are
used to categorize customer accounts. These are very similar to Class Codes; however,
reporting and dealer billing is designed for class codes. Select the appropriate Group Code
from the drop-down menu and click Next to continue running the report. 
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Locales

The Locales (also known as Languages) report produces a listing of the languages within the
system. This report does not require any user-entered data. To continue running the report,
click Next. 

Monitoring Company Master File

Like the Customer Master File, the Monitoring Company Master File report produces
details of the Monitoring Company record. Users may adjust the report parameters to view as
much or as little of the customer information as desired. The report is designed to have a
reference if the customer data was lost and it was necessary to enter the data back into
Manitou.

Advanced Search Options
Clicking on the Advanced button at the bottom right corner of the screen will bring up
additional search options:
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The Options window allows for the selection or de-selection of sub-reports and Contact List
types to further narrow or expand the report results. Once the search parameters are set, click
Next to continue running the report. 

Monitoring Groups

The Monitoring Groups report will display a list of all current Monitoring Groups.

Since this report does not require any user-entered criteria, simply click Next to begin running
the report. 

Monitoring Types

The Monitoring Types report will display a list of current Monitoring Types in Manitou. 
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Users have the option to select customer type (residential, customer, etc.) and monitoring
levels, such as customer, system, transmitter, etc. Once the parameters have been entered,
click Next to begin running the report. 

Output Device Types

The Output Device Types report provides a list of all Output Devices currently configured in
the Manitou system. The report includes the Attribute, Device Type (such as a numeric
pager), protocol, rows, columns, scripts, whether the text is wrapped, pager entry and service
codes associated with each differing Device Type. 
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Users may choose to filter the report by differing attributes, such as phone, fax, or e-mail, as
well as types and protocols. The report results can be grouped by attributes, types and
protocols. Once the search parameters have been set, click Next to continue running the
report. 

Permit Types

The Permit Types report provides a list all permits for certain countries. For example, if a
permit types report is run on the United States, Police, Fire, and Medical permit types will be
displayed in the report. 



Manitou Client 1.5.2410

© 2009 Bold Technologies Ltd.

Users may choose to limit the search by country, authority type or permit type. The report may
be grouped by country, authority type or permit type as well. Once the search parameters are
set, click Next to continue running the report. 

Post Codes

The Post Codes report simply lists all post codes (or zip codes) within a certain region, city or
post code. For example, entering the city "Colorado Springs" into the City field will bring up
a list of all post codes currently entered into the Manitou system for the city of Colorado
Springs. 
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Users may limit the report to a certain country. Once the search parameters have been set,
click Next to continue running the report. 

Receiver Line Prefixes

The Receiver Line Prefixes report lists all Receiver Line Prefixes currently configured in the
Manitou system.

This report does not require any user-entered information. To continue running the report,
click Next. 

Receiver Types

The Receiver Types report provides a list of all Receiver Types currently configured in the
Manitou system. 
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This report does not require any user-entered information. To continue running the report,
click Next. 

Receivers

The Receivers report provides a detailed list of configuration criteria of each type of Receiver
for each FEP. The report includes the Receiver number, code, Receiver description, type,
Port, Settings, Default Line Prefix, Default Monitoring Group, Line Prefix and Transmitter
ID. 

Users may choose to limit the report to one specific FEP or a particular Receiver code. Once
the search parameters have been set, click Next to continue running the report. 

Regions

The Regions report provides a list of all regions and abbreviations currently in the Manitou
system. 
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Users may choose to enter a specific region or limit the report to a particular country. Once
the search parameters have been met, click Next to continue running the report. 

Resolution Codes

The Resolution Codes report lists all resolution codes for a particular Country or "group."
The report details the two-letter code, a description of the code and the alarm condition. Users
may wish to use this report as a listing of alarms or signals closed with a specific resolution
code, such as false alarms. 
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Once the search parameters have been met, click Next to continue running the report. 

Reverse Channel Routes

The Reverse Channel Routes report displays a list of all Protocols currently configured in
the Manitou system, as well as description of the protocol, Application Type, Receiver Line
Prefix, if the Reverse Channel is associated with a Dealer, the FEP Number, Receiver
Number, Line number and Receiver Code. 

Users may choose to filter the search results by Receiver Line Prefix, Application Type, or
Protocol, as well as Dealer Id. Once the search parameters have been met, click Next to
continue running the report. 

Script Messages

The Script Messages report provides a report of all current script messages entered into the
Manitou System. The report includes details on the script message name, the type of script
message (such as e-mail), and the text of the script message. 
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Users may filter the search results by either Locale or Script Message Type. Once the search
parameters have been met, click Next to continue running the report. 

Service Provider Device Types

The Service Provider Types report gives a detailed list of all Service Provider Types
currently configured in the system. The report includes the Protocol Type (such as TAP),
address, ID, account name/password, if the protocol is dialup, timeouts, values and port
settings. 

Users may limit the report to a specific Protocol type. Once the search parameters have been
met, click Next to continue running the report. 
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Subtypes

The Subtypes report provides a detailed list of all subtypes currently configured in the
Manitou system. The report lists the Type (such as Agency) and the Subtypes and
Description.

Users may filter the search report by Types. Once the search parameters have been met, click
Next to continue running the report. 

Temporary Comments

The Temporary Comments report lists the temporary comments listed in customer’s records.
The temporary comments in a customer record display to Operators upon loading an alarm for
that customer.  Users may want to utilize this report in order to see vital comments, such as a
customer vacationing during a specific time period, or other special instructions regarding an
account. 
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Users may enter any search criteria for a customer, such as Customer ID or the name of the
customer. Typically, including the comment details in the report will be warranted. Once the
search parameters are set, click the Next button to continue running the report. 

Time Zones

The Time Zones report provides a list of all Time Zones currently entered in the Manitou
system. 

This report requires no user-entered criteria. Click Next to continue running the report. 

Transmitter Protocol Formats

The Transmitter Protocol Format report provides a list of all Transmitter Protocol Formats
currently configured in the Manitou system. The report includes the transmitter type, signal
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type, condition picture as well as other area and zone details.

Users may filter the search by Protocol or by Type. Once the search parameters are set, click
the Next button to continue running the report. 

Transmitter Types

The Transmitter Types report provides a list of all Transmitter Types currently entered into
the Manitou system. Users may choose to filter the report by Transmitter Type or Reverse
Command Protocol. The report also has the option to include programming in the report
details.

Once the search parameters have been set, click Next to continue running the report. 
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User Groups

The User Groups report provides details pertaining to all User Groups currently entered in
the Manitou system. The report lists the name of the User Group, maximum activity,
accounting user ID as well as the call types accepted by the User Group, such as cancel alarm,
confirm alarm or schedule change. 

Users may filter the search criteria by Dealer or Branch ID, as well as User Group. Once the
search parameters have been met, click Next to continue running the report. 

Users

The Users report provides details pertaining to all Users currently entered in the Manitou
system. The report includes details on User ID, Name, Contact Point, Locale, Country,
Profile, Password changes, Alarm Queue accessibility and Accounting access.
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Users may filter the search results by Dealer or Branch ID, User Group or Locale. Once the
search parameters have been set, click Next to continue running the report. 

Window Codes

The Window Codes report lists all Schedule Window Codes currently entered into the
Manitou system. The report will list the code, description and minutes before/after. 

Users may choose to leave the search parameters blank to list all window codes in the system.
Once the search parameters have been set, click Next to continue running the report. 

Workstation Groups

The Workstation Groups report lists all workstation groups currently entered into the
Manitou system. This report requires no user-entered data. Click next to continue running the
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report. 

Workstations

The Workstations report provides a list of all workstations currently entered into the
Manitou system. The report includes details on a specific workstation, such as which
workstation is associated with a Manitou client, the description, security level, when the
workstation was last active, monitoring group, attributes, locale and time zone. 

Users may filter the report by Client type - either Operator or Supervisor Workstation. Once
the search parameters have been set, click Next to continue running the report. 

System Reports

The System Reports section contains reports related directly to information stored within the
Manitou system. 

Customer Count

The Customer Count report lists customer status for all customers in the system. It can be
grouped by Dealer, Branch or Class Code and includes summaries. Users may choose to order
the report by Customer ID or Customer Name.  
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Customer Services

The Customer Services report will produce a list of all current monitored services, including
pending, active, inactive and deactivated statuses. The report also has the option to only
include services that are chargeable. 
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Customer Status

The Customer Status report is a “bare bones” report which displays only the current status of
the customer or customers for which the report is run. Users can run this report to also find
the Out-of-Service status of customers. To get a proper on test report, leave all the options
blank with the exception of the Customer Status section.
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Customer Status Change

The Customer Status Change report lists all status changes in a specified date range.  Data
can be searched by Dealer, Branch, or Class. The Class search parameters are defined by
Weekly Activity, Monthly Open Close activity, or Regular Account activity. 

The details in this report lists all signal/alarm details, open and close activity and any
exception activity (unexpected openings/closings, for example.)

Users can limit the search to a particular Operator, as well as activated, inactivated or
deactivated customers in the system. 

Dealer Billing

The Dealer Billing report calculates a Dealer's billing invoice based on his or her specific
Dealer charges housed within the record. This report can only be specified by date range and
can include either mail format or specific details. 
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False Alarm Summary

The False Alarm Summary report gives a listing of all false alarms received within a
specific date range. Search parameters can be limited to Dealer, Branch or Authority ID and
can be grouped by either Dealer or Branch. 

Operator Time Cards

The Operator Time Cards report lists the times an Operator logs in and out of the Operator
workstation. Search parameters are limited to searching by User ID, date and time. 

On Test

The On Test report lists all systems that are recently, currently, or will be on test.  Users can search
by Customer ID/Name, Dealer, Branch, Group or Class. 

Raw Data Log

The Raw Data Log Report displays details of all alarms and other signals received by
Manitou from the alarm receivers connected to the system based on a specific date range.
Users must specify a Receiver Line Prefix and/or a Transmitter ID. If no search parameters
are specified, the report will not list any details. 

Once the search parameters have been set, click Next to continue running the report. 

Receiver Line Loading

The Receiver Line Loading report lists either all or the selected receiver’s limits, usage and
availability. Limits refers to the UL specific guidelines for the number of opens or closes
allowed on the particular receivers. Central Station managers and Operators should need to
refer to their UL representative for more information.
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Once the search parameters have been set, click Next to continue running the report. 

System Connection Status

The System Connection Status report lists the system status of customers under certain
Dealers, Branches, Authorities, Groups or Classes. The report may also be run on just one
customer without any additional search parameters. 
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Users may choose to include either enabled or terminated systems, and may order the report
by Customer ID or date. Once the search parameters are set, click Next to continue running
the report. 

System Log

The System Log report provides a detailed list of all logins and log-offs to the system, the
category where a user made adjustments, qualifiers, event text. 

Users may filter the search criteria by category, qualifier or user initials, as well as a specific
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date and time range. Click Next to continue running the report once the search parameters
have been set. 

Transmitter Count by Receiver

The Transmitter Count by Receiver report provides a list of all Receiver Types or Receiver
Line prefixes based on FEPs or Receivers. The report includes details of FEP number,
Receiver number, Receiver Type, Description, among other details. 

Users may limit the search results to display only certain Receiver Types or Receiver Line
Prefixes, as well as FEP numbers or Receiver numbers. Once the search parameters have been
set, click Next to continue running the report. 

Transmitter Count by Tx Type

The Transmitter Count by TX Type report lists all transmitters currently in the system by
Transmitter Type. Users may limit the search to only include a specific Transmitter type, by
Customer ID, Dealer Id or Branch ID. Users also have the option to include Customer Details
in the report. 
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Once the search parameters have been set, click Next to continue running the report. 

Unused Transmitters

Unused Transmitters are transmitter numbers within a transmitter range, set up within the
Dealer and Monitoring Company records, that are not yet assigned to a Transmitter on a
Customer record. 

User Statistics

The User Statistics report provides the details of each Operator’s user session including the
login and logout times, total session time, number of accounts edited, added and deleted, and
the number of alarms handled of priorities 1-4 and 5-10. This information is mined from the
User Status form found in the Supervisor Workstation. 

Run a System Report
1. Select the desired report from the reports list.

2. Check the Priority level of the report. Manitou will use this number to determine which
reports in the report queue to print first - the lower the number, the higher the priority.
Unless urgent, this number should be set to 6.
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3. Enter any relevant search criteria.

4. Click Next.

5. On the Distribution page, select the distribution method and destination for the report.

A number of options are available. Users can:

· View it on screen, using the preview facility.

· Print it locally (in the central station), with an option to preview first.

· Send it to a nominated customer or dealer, with an option to review first. 

· Send it to any individual (whether on the system database or not) by email or fax, also
with an option to preview.

Destination Window



Reports Menu 431

© 2009 Bold Technologies Ltd.

The following sections detail printing, sending and previewing a report. 

Print a System Report

1. After the desired report has been selected, click Next.

2. In the Contact List Destination area, select Printer from the drop-down Default Printer

menu.

3. In the Contact List Type field, select Company 

4. If the user wishes to preview the report on screen before printing, check the Hold for

preview box.

5. Click Finish to queue the chosen report. The report will now be queued for publishing.
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Send a System Report to a Customer or Dealer

1. After the desired report has been selected, click Next.

2. In the Contact List Type field, select Customer or Dealer as appropriate.

3. In the Customer field, click the search button to the right of the field.

4. Type a * in the Customer or Dealer search field. 

5. Select the customer or dealer from the results list by clicking Load.

6. Select the specific keyholder or contact from the left hand pane and then click the include

arrow .

7. If the user wishes to preview the report on screen before printing, check the Hold for

Preview box. 

8. Click Finish to queue your chosen report. The report will now be queued for publishing.
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Send a System Report by Fax or E-mail

Utilizing this option will allow a report to be sent to a client who has not been entered into the
Manitou database.

1. After the report has been selected, click Next.
2. In the Override Recipient’s Name field, type the name of the recipient for the report.

3. In the Override Destination Type field, select either e-mail or fax.

4. In the Override Email Address or Override Fax Number field, enter the full e-mail address

or fax number.

5. Click the "Add to list" button.

6. If the user wishes to preview the report on screen before printing, check the hold for

preview box. 
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7. Finally, click Finish to queue the chosen report. The report will now be queued for

publishing.

Send a System Report by Fax or E-mail Window

Preview a System Report

1. Select the desired report from the reports list.

2. Check the Priority level of the report. Manitou will use this number to determine which
reports in the report queue to print first - the lower the number, the higher the priority.
Unless urgent, this number should be set to 6.

3. Enter any relevant search criteria.

4. Click Next.

5. On the Distribution page, check the Hold for Preview button.

6. Click Next.

7. A warning message will now be displayed that the user has not chosen any recipients for
your report. Click Yes to queue the report for previewing only. 

8. Open the Report Queue.
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9. Double-click on the Report to view the previewed report. 

Report Queue

The Report Queue allows a user to view the current Manitou report queue or to search the
queue by specific criteria (for example: date / time range or by system user name). Once a
report is run, it is sent to the Report Queue to be viewed. 

The Report Queue can also be easily accessed from the Quick-Launch toolbar by clicking on

the Report Queue button. 

Preview a Queued Report

To preview a report in the queue list, select the desired report by clicking on the report in the
list and then clicking the Preview button. The selected report will now be displayed for
viewing. 

Note: Users may now edit this copy or print it locally. Changes made in the report viewer will
not affect the report of the copy held in the queue. 

View Reports for a Specific User

By default, only reports published or queued for preview by the current user will be displayed.
To display reports queued for a specific user, type the user name into the ‘User’ field in the
filter area of the workspace and then click the Filter button. Reports for the specific user will
now be displayed in the report queue area.
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To remove a filter you have applied, click "Remove Filter."

Filter the Queue by a Specific Date/Time

To view reports that have been queued for publishing at a specific date or time, but have not
yet been published, specify the date range and times in the fields provided within the filter
area. Users can also view reports according to how they will be published by checking or
un-checking the following parameters:

· Ad-Hoc – reports that have been requested by system users on an "as required" basis. 

· Scheduled (run once) – reports that have been pre-programmed to publish automatically at
a specific time or date. 

· Scheduled (repeating) – reports that have been pre-programmed to publish automatically
at a certain time or day on a recurring basis.

When the required parameters have been selected, click the Filter button. Only reports that
fully meet the selected criteria will now be displayed.

Show All Reports

Clicking on the Show All button located next to the Filter button on the Scheduled Reports
window will display all reports currently scheduled. 

Scheduled Reports

The Scheduled Reports option provides facilities by which to create reports that can then be
published automatically by Manitou according to a specified schedule. The "Scheduled
Reports" section contains a list of all report publishing instructions that currently exist in the
system. Any instruction contained in the list can be selected for viewing or editing by clicking
the appropriate row with the left mouse button. The "Publishing Destinations" section
provides a list of recipients for the instruction selected in the upper pane.  

Please note that scheduling reports cannot be done from the Reports menu, but rather in the
customer, dealer, monitoring company, agency, branch and global keyholder records. For
example, to schedule a report for a Dealer, the user must select the Dealer from the Dealer
menu and schedule the reports using the form found in the Jump To menu. The following
form is a general form used in a customer context, but can be easily adapted for each entity.
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Schedule a Report

Prior to working with this feature, it is recommended the user become familiar with the
procedures contained in the System Reports. 

1. Open the Schedule Reports window by clicking on Reports in the Jump To menu. The
Schedule Reports form will appear. 

2. Click the Add New button to add a new report. 

3. Select the specific report required from the list displayed in the tree now displayed to the
left of the form. Users may have to expand the items in the list in order to find the desired
report.
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4. Complete the relevant fields on the report details form and click Next. 

Script Messages Sent with E-mailed Reports
The default script message that is sent with E-mailed reports can be found in the Supervisor
Workstation under the Tools > Options > Reports menu. To edit the script message, go to the
Supervisor Workstation > Maintenance menu > Script Messages. When making a new email
script message to be sent out with E-mailed reports, only two of the script codes will populate
with the information from the emailed report: {RD} and {UC}.  

Edit an Existing Publishing Instruction

At times, it may be necessary to change the content of existing publishing instructions. 

1. Open the Report Queue by clicking on the Reports menu and selecting Report Queue.

2. Select the publishing instruction that needs to be changed by clicking the appropriate row
of the Scheduled Reports list.
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3. Click the Edit button.

4. Click the Edit selected button.

5. Change any necessary details on the reports pages, distribution criteria or the frequency

criteria.  

6. When the editing is complete, click Finish.

7. Click Save. 

Troubleshooting

Caller ID Mismatch

If the phone number specified by the receiver is found on a transmitter record anywhere in
Manitou AND the transmitter record for this signal is not one of those found, this constitutes
a "Caller ID Mismatch." If will force an alarm based upon the MOption setting.

If no transmitters were found with this number, this will cause "Caller ID not found." If the
transmitter for this signal does have something in Ref1 or Ref2, then it is handled as a "Caller
ID Mismatch." Again, it will force an alarm or not based upon the MOption setting. If the
transmitter does not find anything in Ref1 or Ref2, then the system logs an additional detail
line documenting the phone number received for this event, as it could not verify the rightness
or wrongness, so it is simply logged. Many customers like this option, as it allows them to go
back later and add in the correct Caller ID info based upon what is showing in CLog. Also,
this allows them to tell their dealers what number it was calling from if there is any questions.

Agency Rights

In order for Agencies to have the ability to authorize a schedule change for a customer, the
"Can Edit Customer" button must be checked in the Agency contact's Permissions list. 
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Keyboard Shortcuts

Manitou utilizes several Keyboard Shortcuts which allow the user to quickly use a sequence
of keystrokes to launch a function or application. The following Keyboard Shortcuts are
available:

· CTRL Keys
· ALT Keys
· F Keys

CTRL Keys

· CTRL+E
Edits the current form if the form can be edited and is in view.

· CTRL+S 
Saves the current form if the form is currently in edit mode.

· CTRL+D
Deletes the current record providing the form is in the correct location and can be deleted.

· CTRL+Q
Toggles through the open forms within Manitou alone.

ALT Keys

Using the ALT key plus any underlined letter on a form will activate that letter and function
on the form.  For example, if an Operator is viewing a customer record in Edit mode on the
Contact List form and they wish to add a new Keyholder, they can press the ALT+A and the
Add dialog launches for data entry.  If the form is not the current focus, the ALT key will
bring focus to the File menu at the top of the Manitou application.

When using the Alt keys to get focus on the top application menus (File, Edit, View, etc.), use
the ESC key to close the dropped menus, but to get focus back onto the application form it is
necessary to press the ESC key a second time.

F Keys

The Function Keys such as F2, F3, F4, F5, F6, F7, F11, and F12 perform specific functions on
specific forms.  

· F2 
The F2 key brings focus to the left-hand Manitou navigator.

· F3
The F3 key brings focus to the Notes tab of the left-hand Manitou navigator.
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· F4
The F4 key loads the Manual Signal form.  If this is launched from a customer form the
customer record loads into the form.

· F5
The F5 key is multi functional depending on the form that is loaded at the time.  For example,
if the Manual Signal form is loaded and completed the F5 key sends the manual signal to the
Signal Handler.  Generally the F5 key sends the completed form’s details to the appropriate
location.

· F5 – Additional enhancements
F5 now has some additional functionality outside of the Manual Signal form.  On any form
that has a refresh button the F5 key will now refresh those forms.  The forms that will NOT
refresh with the F5 key are System Log, Raw Data Log, Customer Activity Log and System
Application Log.

· F6 
The F6 key loads the On Test form.  If this is launched from a customer form the customer
record loads into the form.

· F7 
The F7 key brings focus to the Instant Messenger tab on the left-hand Manitou navigator.

· F9 – Pre-Cancel
The F9 key will now launch the Pre-cancel form.

· F10 – Dealer Maintenance form
F10 will now launch the Dealer Maintenance form and if the button is launched from a
customer record that contains a Dealer record the form will auto-load that dealer record.

· F11 
If the Operator is on any entity form, such as the customer, dealer, authority, etc., the F11 key
takes focus to the Bold Mode buttons across the top of the form.  Any form that has those
buttons across the top will get focus when the F11 key is pressed.  There is an additional
feature called speed keys on this bar as well.  The Operator may use the first letter of the key
they wish to focus upon to quickly locate there.  For example if an Operator wishes to cancel
out of the form they recently edited they may quickly get out of the record by pressing F11,
then “C”, then Enter.

· F12
The new “Jump To” menu is brought into focus by pressing the F12 key.  Like the F11 key,
this too has the speed key feature where pressing the first letter of the desired form will speed
access to it.  Please be aware that the speed key only works on the first letter of the form. 
This means that if there is more than one form that begins with the letter “C” then the speed
key process would be F12 then C then C again until the Operator gets to the form they want
then they press the Enter key.  F12 + Home will take the Operator to the top form for that
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entity and F12 + End will the Operator to the bottom form for that entity.

UL Required Reports

In compliance with UL specifications, detailed in the UL 1981 Standard for Central Station
Automation Systems, Manitou is capable of producing the following on-demand reports, each
of which is described in a previous section of this manual:

· Alarm Detail 

· Alarm Detail by Alarm Number

· Master File report sorted by UL Certificated Accounts 

· Customer Status - Active/Inactive

· Receiver Line Loading - accounts on each receiver ID 

Alarm Detail

The Alarm Detail report satisfies all requirements of UL 1981 Paragraph 19.8, items a
through p, which lists the requirements of an on-demand alarm report for non-certificated
systems. See Section 7.02 - UL Alarm Ticket for more information.

This report satisfies one of the documentation and reporting requirements of UL 1981. Please
see Appendix section 7.02 - UL Required Reports for more information.

Follow the instructions below to run an Alarm Detail report:

1. Select Maintenance>>System Reports.

2. Select the Alarm Detail Report by clicking it in the Report navigator on the left edge
of the System Reports screen.

3. Tab or click into the Report Description field and enter a detailed description for the
report. It is important to be descriptive so that this report may be easily identifiable in
the Report Queue.

4. On-demand reports default to a priority level of 5. However, if the report needs to be
processed more quickly than other, less important reports, use the UP arrow to select
4, 3, 2, or 1, giving the report a "higher" priority.

5. Select the necessary details within one or more applicable fields, as described below.
(It is possible to enter information in a single field or in many fields depending on how
specific the resulting report information should be.)

· Contract ID

1. Enter the Contract ID (Account Number) into the left-hand From field
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or use the Search icon to locate the customer record. 

2. Tab or Click into the To field. The From Contract ID number
automatically loads into the To field. If the report is for only the one
customer record leave the field as is. If the report is for a range of
customer records enter the last Contract ID number in the range or click
the Search button to locate the customer account. Remember, the wider
the range the larger report and therefore the longer the processing time.

· Customer Name

1. If the Contract ID is not necessary and the desired result of the report is
to get all accounts containing a particular customer name, enter that
name into the From Customer Name field.

2. Tab or Click into the To field, the customer name entered in the From
field automatically loads into the To field. If this is correct, leave it as
is, if not, enter the last name in the range into this field.

· Dealer ID 

1. To get activity information based on Dealers that establish the accounts
tab or click into the Dealer ID From field and enter the Dealer ID
number into the field or use the Search button to locate the Dealer
name. 

2. Tab or Click into the To field. The Dealer Number entered into the
From field automatically loads into the To field. If this is correct, leave
it as is, if not, enter the new Dealer ID or use the search icon to find the
Dealer ID.

· Group

1. Group codes can help define the Customer Activity for reporting
purposes. Enter the Group Code or click the drop-down arrow to the
right of the From field and select the group from the list.

2. Tab or Click into the To field, the selected Group code loads
automatically into the To field. If this is correct, leave it as is, if not,
enter or select the ending Group code into the To Field.

· Class 

1. Class codes can also help define the customer activity for reporting
purposes. Enter the Class Code or click the drop-down arrow to the
right of the From field and select the group from the list.

2. Tab or Click into the To field, the selected Class code loads
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automatically into the To field. If this is correct, leave it as is, if not,
enter or select the ending Class code into the To Field.

· Zip/Post 

1. The Zip or Postal code can help further define the specifics of a search.
Tab or click into the From field and enter the zip/postal code for this
report.

2. Tab of Click into the To field, the entered zip/postal code automatically
loads into the To field. If this is correct, leave it as is, if not, enter the
proper zip/postal code.

· Activity Date/Time 

1. Use the drop-down arrow to the right of the From Date field and select
the From date for the report. 

2. Tab or click into the Time field and set the From time by typing it in or
using the up/down arrows.

3. Use the drop-down arrow to the right of the To Date field and select the
From date for the report. 

4. Tab or click into the Time field and set the To time by typing it in or
using the up/down arrows.

· UL Grades 

1. To include Alarm Details only within customer accounts with specific
UL Grades, use the checkboxes. If nothing is selected the system will
disregard this parameter.

· Dispatched

1. Use the radio buttons to specify which alarms to include - all,
Dispatched or Not Dispatched.

2. Upon entering all the parameters necessary to produce the Unrestored
Signals Report, Click Next.

3. The next page contains distribution destinations. Upon load, if a
customer was selected on the previous page, the customer contacts load
with printer, fax and email contact information.

4. Select the publishing destinations in the left-hand window on the lower
left of the distribution form. Either double click the item to move it to
the right or click the right arrow [>]. If all destinations are required
click the double right arrow button [>>] to move all destinations. If any
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items are moved in error select the item and either double click or click
the left arrow [<] to move the arrow back to the left-hand frame or the
double arrow [<<] to move them all.

5. There are times when some destinations are not on the customer record
the top section of the form is designed to allow the addition of
non-listed destination. Tab or click into the Override recipient's name
field and enter the name of the override recipient. 

6. Click the drop-down list to the right of the Override destination type
and select the type of destination. The choices are: Printer, Fax and
Email.

7. Tab or click into the Override destination address (Fax/Email) and
enter the Email address or Fax number.

8. Once all the override information is entered properly click the Add
button

9. Repeat the above steps for all additional destinations.

10. Upon completion of all destinations and override destinations click
Finish.

11. The system then pops up a notification that the message was properly
queued and is running.

Alarm Detail by Alarm Number

The Alarm Detail report satisfies all requirements of UL 1981 Paragraph 19.8, items a
through p, which lists the requirements of an on-demand alarm report for non-certificated
systems. See Section UL Alarm Ticket for more information.

This report satisfies one of the documentation and reporting requirements of UL 1981. Please
see Appendix section  UL Required Reports for more information.

The Alarm Detail by Alarm Number report lists detailed activity by alarm number, showing
Operator actions, comments and dispatch information. All activity performed on a single
alarm will be included in this report.

1. Select Maintenance>>System Reports.

2. Select the Alarm Detail by Alarm Number (Alarm Detail by Alm Num) Report by
clicking it in the Report navigator on the left edge of the System Reports screen.

3. Tab or click into the Report Description field and enter a detailed description for the
report. It is important to be descriptive so that this report may be easily identifiable in
the Report Queue.
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4. On-demand reports default to a priority level of 5. However, if the report needs to be
processed more quickly than other, less important reports, use the UP arrow to select
4, 3, 2, or 1, giving the report a "higher" priority.

5. Select the necessary details within one or more applicable fields, as described below.
(It is possible to enter information in a single field or in many fields depending on how
specific the resulting report information should be.)

· Contract ID 

1) Enter the Contract ID (Account Number) into the left-hand From field
or use the Search icon to locate the customer record. 

2) Tab or Click into the To field. The From Contract ID number
automatically loads into the To field. If the report is for only the one
customer record leave the field as is. If the report is for a range of
customer records enter the last Contract ID number in the range or click
the Search button to locate the customer account. Remember, the wider
the range the larger report and therefore the longer the processing time.

· Date/Time 

1) Use the drop-down arrow to the right of the From Date field and select
the From date for the report. 

2) Tab or click into the Time field and set the From time by typing it in or
using the up/down arrows.

3) Use the drop-down arrow to the right of the To Date field and select the
From date for the report. 

4) Tab or click into the Time field and set the To time by typing it in or
using the up/down arrows.

· Alarm Number 

1) To display all alarms within the Contract ID and Date range already
indicated, leave the Alarm Number fields blank. To display a select
alarm, or a range of alarm numbers, type the lowest alarm number into
the first field. 

2) Click or tab into the second Alarm Number field and type in the highest
alarm number in the range.

3) The Alarm Number is the same as the Log Sequence Number found in
the Alarm Detail report, or on the Log Details screen. To open the Log
Details screen, open the Customer record for which this alarm
occurred. 
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4) Click on the Logs button on the right side of the interface. 

5) Scroll within the log information to find the alarm. 

6) Double-click on the alarm row to open the Log Details. One of the
entries there is the Log Sequence Number. 

6. Upon entering all the parameters necessary to produce the Unrestored Signals Report,
Click Next.

7. The next page contains distribution destinations. Upon load, if a customer was
selected on the previous page, the customer contacts load with printer, fax and email
contact information.

8. Select the publishing destinations in the left-hand window on the lower left of the
distribution form. Either double click the item to move it to the right or click the right
arrow [>]. If all destinations are required click the double right arrow button [>>] to
move all destinations. If any items are moved in error select the item and either double
click or click the left arrow [<] to move the arrow back to the left-hand frame or the
double arrow [<<] to move them all.

9. There are times when some destinations are not on the customer record the top section
of the form is designed to allow the addition of non-listed destination. Tab or click
into the Override recipient's name field and enter the name of the override recipient. 

10. Click the drop-down list to the right of the Override destination type and select the
type of destination. The choices are: Printer, Fax and Email.

11. Tab or click into the Override destination address (Fax/Email) and enter the Email
address or Fax number.

12. Once all the override information is entered properly click the Add button

13. Repeat the above steps for all additional destinations.

14. Upon completion of all destinations and override destinations click Finish.

15. The system then pops up a notification that the message was properly queued and is
running.

Master File Report Sorted by UL Certificated Accounts

This report satisfies one of the documentation and reporting requirements of UL 1981. Please
see Appendix section UL Required Reports for more information.

The Master File report, reports all selected customer details for file maintenance.

1. Select Maintenance>>System Reports.
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2. Select the Master File Report by clicking it in the Report navigator on the left edge of
the System Reports screen.

3. Tab or click into the Report Description field and enter a detailed description for the
report. It is important to be descriptive so that this report may be easily identifiable in
the Report Queue.

4. On-demand reports default to a priority level of 5. However, if the report needs to be
processed more quickly than other, less important reports, use the UP arrow to select
4, 3, 2, or 1, giving the report a "higher" priority.

5. Select the necessary details within one or more applicable fields, as described below.
(It is possible to enter information in a single field or in many fields depending on how
specific the resulting report information should be.)

· Contract ID

1) Enter the Contract ID (Account Number) into the left-hand From field
or use the Search icon to locate the customer record.

2) Tab or Click into the To field. The From Contract ID number
automatically loads into the To field. If the report is for only the one
customer record leave the field as is. If the report is for a range of
customer records enter the last Contract ID number in the range or click
the Search button to locate the customer account. Remember, the wider
the range the larger report and therefore the longer the processing time.

· Customer Name 
1) If the Contract ID is not necessary and the desired result of the report is

to get all accounts containing a particular customer name, enter that
name into the From Customer Name field.

2) Tab or Click into the To field, the customer name entered in the From
field automatically loads into the To field. If this is correct, leave it as
is, if not, enter the last name in the range into this field.

· Dealer ID

1) To get activity information based on Dealers that establish the accounts
tab or click into the Dealer ID From field and enter the Dealer ID
number into the field or use the Search button to locate the Dealer
name. 

2) Tab or Click into the To field. The Dealer Number entered into the
From field automatically loads into the To field. If this is correct, leave
it as is, if not, enter the new Dealer ID or use the search icon to find the
Dealer ID.
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· Group 

1) Group codes can help define the Customer Activity for reporting
purposes. Enter the Group Code or click the drop-down arrow to the
right of the From field and select the group from the list.

2) Tab or Click into the To field, the selected Group code loads
automatically into the To field. If this is correct, leave it as is, if not,
enter or select the ending Group code into the To Field.

· Class

1) Class codes can also help define the customer activity for reporting
purposes. Enter the Class Code or click the drop-down arrow to the
right of the From field and select the group from the list.

2) Tab or Click into the To field, the selected Class code loads
automatically into the To field. If this is correct, leave it as is, if not,
enter or select the ending Class code into the To Field.

· Commission Date

1) Use the drop-down arrow to the right of the From Commission Date
field and select the From date for the report. 

2) Tab or click into the Time field and set the From time by typing it in or
using the up/down arrows.

3) Use the drop-down arrow to the right of the To Commission Date field
and select the From date for the report. 

4) Tab or click into the Time field and set the To time by typing it in or
using the up/down arrows.

· Create date

1) Use the drop-down arrow to the right of the From Create Date field and
select the From date for the report. 

2) Tab or click into the Time field and set the From time by typing it in or
using the up/down arrows.

3) Use the drop-down arrow to the right of the To Create Date field and
select the From date for the report. 

4) Tab or click into the Time field and set the To time by typing it in or
using the up/down arrows.

· Last update date 
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1) Use the drop-down arrow to the right of the From Last Update Date
field and select the From date for the report. 

2) Tab or click into the Time field and set the From time by typing it in or
using the up/down arrows.

3) Use the drop-down arrow to the right of the To Last Update field and
select the From date for the report. 

4) Tab or click into the Time field and set the To time by typing it in or
using the up/down arrows.

· Marked for reprint

1) To include any customer accounts that are marked for reprint, click the
checkbox.

· Sub-reports

1) Select the additional items to include on the report by clicking the
desired checkboxes to the left of the sub-report title.

6. Upon entering all the parameters necessary to produce the Master File Report, Click
Next.

7. The next page contains distribution destinations. Upon load, if a customer was
selected on the previous page, the customer contacts load with printer, fax and email
contact information.

8. Select the publishing destinations in the left-hand window on the lower left of the
distribution form. Either double click the item to move it to the right or click the right
arrow [>]. If all destinations are required click the double right arrow button [>>] to
move all destinations. If any items are moved in error select the item and either double
click or click the left arrow [<] to move the arrow back to the left-hand frame or the
double arrow [<<] to move them all.

9. There are times when some destinations are not on the customer record the top section
of the form is designed to allow the addition of non-listed destination. Tab or click
into the Override recipient's name field and enter the name of the override recipient. 

10. Click the drop-down list to the right of the Override destination type and select the
type of destination. The choices are: Printer, Fax and Email.

11. Tab or click into the Override destination address (Fax/Email) and enter the Email
address or Fax number.

12. Once all the override information is entered properly click the Add button

13. Repeat the above steps for all additional destinations.
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14. Upon completion of all destinations and override destinations click Finish.

15. The system then pops up a notification that the message was properly queued and is
running.

Customer Status - Active/Inactive

This report satisfies one of the documentation and reporting requirements of UL 1981. Please
see Appendix section UL Required Reports for more information.

The Customer Status report, lists the current active alarm status for a single customer or all
customer accounts.

1. Select Maintenance>>System Reports.

2. Select the Customer Activity Report by clicking it in the Report navigator on the left
edge of the System Reports screen.

3. Tab or click into the Customer Status field and enter a detailed description for the
report. It is important to be descriptive so that this report may be easily identifiable in
the Report Queue.

4. On-demand reports default to a priority level of 5. However, if the report needs to be
processed more quickly than other, less important reports, use the UP arrow to select
4, 3, 2, or 1, giving the report a "higher" priority.

5. Determine if the report should run on All Customers or a Single customer.

6. For the Single customer selection tab or click into the Contract ID field and enter the
Contract ID or click the Search button and locate the customer.

7. Upon entering all the parameters necessary to produce the Customer Status Report,
Click Next.

8. The next page contains distribution destinations. Upon load, if a customer was
selected on the previous page, the customer contacts load with printer, fax and email
contact information.

9. Select the publishing destinations in the left-hand window on the lower left of the
distribution form. Either double click the item to move it to the right or click the right
arrow [>]. If all destinations are required click the double right arrow button [>>] to
move all destinations. If any items are moved in error select the item and either double
click or click the left arrow [<] to move the arrow back to the left-hand frame or the
double arrow [<<] to move them all.

10. There are times when some destinations are not on the customer record the top section
of the form is designed to allow the addition of non-listed destination. Tab or click
into the Override recipient's name field and enter the name of the override recipient. 
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11. Click the drop-down list to the right of the Override destination type and select the
type of destination. The choices are: Printer, Fax and Email.

12. Tab or click into the Override destination address (Fax/Email) and enter the Email
address or Fax number.

13. Once all the override information is entered properly click the Add button

14. Repeat the above steps for all additional destinations.

15. Upon completion of all destinations and override destinations click Finish.

16. The system then pops up a notification that the message was properly queued and is
running.

Receiver Line Loading - Accounts on Each Receiver ID

This report satisfies one of the documentation and reporting requirements of UL 1981. Please
see Appendix section UL Required Reports for more information.

This report lists Receiver Lines, showing customer allocation to each. It is important to know
which Receivers are processing signals and alarms from which customers, and the load on
each receiver, in order to troubleshoot the system when and if necessary. Below are the
instructions for running the Receiver Line Loading report:

1. Select Maintenance>>System Reports.

2. Select the Receiver Line Loading (Rec Line Loading) Report by clicking it in the
Report navigator on the left edge of the System Reports screen.

3. Tab or click into the Report Description field and enter a detailed description for the
report. It is important to be descriptive so that this report may be easily identifiable in
the Report Queue.

4. On-demand reports default to a priority level of 5. However, if the report needs to be
processed more quickly than other, less important reports, use the UP arrow to select
4, 3, 2, or 1, giving the report a "higher" priority.

5. Select the necessary details within one or more applicable fields, as described below.
(It is possible to enter information in a single field or in many fields depending on how
specific the resulting report information should be.)

6. Check the checkboxes corresponding with the Receiver Lines to be displayed on the
report.

7. Click Next.

8. The next page contains distribution destinations. Upon load, if a customer was
selected on the previous page, the customer contacts load with printer, fax and email
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contact information.

9. Select the publishing destinations in the left-hand window on the lower left of the
distribution form. Either double click the item to move it to the right or click the right
arrow [>]. If all destinations are required click the double right arrow button [>>] to
move all destinations. If any items are moved in error select the item and either double
click or click the left arrow [<] to move the arrow back to the left-hand frame or the
double arrow [<<] to move them all.

10. There are times when some destinations are not on the customer record the top section
of the form is designed to allow the addition of non-listed destination. Tab or click
into the Override recipient's name field and enter the name of the override recipient. 

11. Click the drop-down list to the right of the Override destination type and select the
type of destination. The choices are: Printer, Fax and Email.

12. Tab or click into the Override destination address (Fax/Email) and enter the Email
address or Fax number.

13. Once all the override information is entered properly click the Add button

14. Repeat the above steps for all additional destinations.

15. Upon completion of all destinations and override destinations click Finish.

16. The system then pops up a notification that the message was properly queued and is
running.

UL Standards

In compliance with UL requirements for documentation, this UL Addendum contains the
following sections:

· Revision History

· UL Alarm Ticket

· UL Required Reports

· UL Required Signal Priorities

· Manitou System Configuration

· Replication Switchover Procedure

· Manitou Remote Access

· UL Alarm Handling Summary - Operation
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Additionally, this UL Addendum contains excerpts from the UL 1981 Standard for Central
Station Automation Systems, describing the necessary components a Central Station must
have to maintain UL 1981 compliance. For further information please refer to the referenced
sections of the UL 1981 Standard for Central Station Automation Systems.

Revision History

UL Alarm Ticket

1. This section has been included in accordance with UL 1981 Paragraph 19.8, items a
through p, which lists the requirements of an on-demand alarm report for non-certificated
systems. The report shall include the following items, as applicable:

2. Name and address of subscriber (fire/burglary).

3. Type of alarm (burglary, hold-up, fire).

4. Grade of service (burglary).

5. Time alarm received by the Central Station receiver (fire/burglary).

6. Time police/fire department notified and police/fire department identification number
(fire/burglary).

7. Time alarm investigator No. 1 dispatched, name and employee ID (fire/burglary).

8. Time alarm investigator No. 2 (if any) dispatched, name and employee ID (fire/burglar).

9. Time alarm investigator No. 1 arrived (fire/burglary).

10.Time alarm investigator No. 2 arrived (if dispatched) (fire/burglary).

11.Elapsed time between the receipt of the alarm signal at the Central Station and the
investigator's arrival at the protected premises.

12.Method used to verify alarm investigator's arrival such as radio, telephone, or the like
(fire/burglary).

13.Whether the Central Station holds keys.

14.Whether keys were used or not used (fire/burglary).

15.Time subscriber notified, name of subscriber notified (may need 2 or 3 lines for multiple
notifications) (fire/burglary).

16.Disposition of alarm (fire/burglary).

17.Whether a sounding device is used on the system.
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By running the Alarm Detail report for a specific day (date), an Operator can look up alarm
numbers on which to run the Alarm Detail by Alm Num report. This report contains all of the
requirements above and may be run on-demand by Operators. 

All UL Certificated Customers must have an action pattern that gathers the following
information:

1. Authority responding to the alarm (Fire Department, Police Department, etc.)

2. Alarm Investigator (Agency) responding to the alarm (Guarding Agency, Inspection
Agency, etc.)

3. Verification of contact with the Customer or a Keyholder on the account

4. Attention field denoting whether or not the Central Station possesses keys for the
Premises.

WARNING: If the above items are not gathered, the Alarm Ticket does not satisfy UL 1981
requirements

UK-Specific Topics

Remote Reset

Remote Reset is available in the Customer Activity Logs form for UK (country 44)
customers. The dealer must belong to the UK 44 country code in order for the remote reset
type, and the dealer seed code to appear. The customer's control panel must be one of the
"Selected" Control Panels for that dealer and the remote reset type and seed code must be
entered. Policed and non-Policed response info is entered on the dealer and company (default
if not entered on the dealer) record. "Reset No Signal" should always be available on the
Customer Logs form.

When a signal or alarm is the currently selected Log item, the "Reset Signal" button enables
and "Resent No Signal" disables. When either "Reset Signal" or "Reset No Signal" is selected,
a dialog will show prompting the user for an Anti-Code. This is a number displaying on the
customer's keypad. Enter that number and then press the Get Code button.

If the setup is good, the Reset Code will display on the dialogue and a line will be added to
the log, either as a general of Reset No Signal or as a detail of a signal or alarm. The Operator
would relay this Reset Code to the end user to enter ont he keypad and reset the system. 

The dealer's set up determines whether a panel is a valid type. Under the Control Panels
section of the Dealer, select the correct Remote Reset Type and enter that Dealer's Seed Code
for that reset type for each applicable control panel type. Next, enter the number of resets and
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day period on the Remote Resets section. If set to 0, it will use the Company's settings. If the
Company's settings are also both 0, then no checks will be made to determine if the reset limit
has been reached. A dealer's customer with a control panel type that has Remote Reset Type
information attached will now be able to do remote resets.

The "Number of resets allowed" and "Number of days resets allowed" forms determine how
many resets are allowed per week. For example, if 7 is entered, then 7 resets per week are
allowed. This information is stored in Customer Activity. The limit is per customer (not
dealer). An error will be returned to the operator if the customer has reached or exceeded their
limit. The operator can request that the reset be generated even though the customer has
exceeded their limit. 

Language Utility

A Language Utility is available for use for translation in Manitou. The Operator Workstation
and Supervisor Workstation clients have been made to be fully translatable, and it is possible
to have one client displaying in one language and another client in a different language. Each
workstation has a default language (Locale) assigned to it. However, when an operator logs
in, the client will then use the language setting of that user.

The user must create an ODBC connection to the Manitou database and then point the utility
to the ODBC. To do this, create a shortcut and then put the name of the new ODBC
connection at the end of the target line. 

e.g. "C:\Program Files\Bold Technologies\Manitou\LanguageUtility.exe" SPAIN

In this example, an ODBC connection to the Manitou database called SPAIN was created:
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Language Settings

In order to translate text that may appear before a server connection is established, a text file
named ‘Startup.txt’ can be placed in the same directory as the workstation clients. If this file
exists, translation text will be used from it until a server connection is established, in which
case, translation text will be pulled from the database. The file is a simple text file with two
double-quoted pieces of text separated by a comma. The ‘right-side’ text is the original text
from the client that must not be changed in any way. The ‘left-side’ text is the translated text
to be displayed in its place. Each physical workstation can have a different Startup.txt file, if
desired (though not likely). The default file supplied contains the same text on both ‘sides’.
Only use this in cases where the client is being translated. It will otherwise unnecessarily slow
the client down if not needed.

In order to determine which locales are to be translated, a new option has been added to the
Locales form. If selected, that locale will attempt to translate all default English text. The
database of translated text is self-learning. Any text not found will automatically be added
with the original English text as the translated text. A translation tool is available for editing
the translated text.

For new installations needing translated text, the Operator Workstation will also display the
license agreement text from an external file, if installed in the same directory as the client.
The file name is ‘ManitouLicense.rtf’. If this file is installed, all requirements, implications,
limitations, exclusions and assertions of the legal statements, must be conveyed with the same
meaning as the original English version with regard to Bold Technologies, Ltd.
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For the above language translation reasons, the Alarm Available dialog will no longer respond
to the ‘Y’, ‘P’, and ‘E’ keystrokes. The Yes equivalent button is now the default button
(selected when the button has focus and the Space Bar or Enter key is pressed – has the initial
focus by default) and the Exit equivalent button is the cancel button (selected when ESC is
pressed). The Pause equivalent button must be selected either via the mouse or by tabbing to
it and pressing the Space Bar or Enter key.

Appendix A - Software Compatability Chart

VertX Firmware V100 V200 V300

R1.0.0 V100EE_r100.hex V200EE_r100.hex V300EE_r101.hex

R1.1.0 V100EE_r100.hex V200EE_r100.hex V300EE_r101.hex

R2.0.0 V100EE_r102.hex V200EE_r102.hex V300EE_r102.hex

R2.1.0 V100EE_r102.hex V200EE_r102.hex V300EE_r102.hex

R2.2.0 V100EE_r103.hex V200EE_r103.hex V300EE_r102.hex

R2.2.1 V100EE_r104.hex V200EE_r104.hex V300EE_r103.hex

R2.2.2 V100EE_r104CIFO.hex V200EE_r104.hex V300EE_r103.hex

R2.2.3 V100EE_r104CIFO.hex V200EE_r104.hex V300EE_r103.hex

R2.2.5 V100EE_r109.hex V200EE_r104.hex V300EE_r103.hex

R2.2.6 V100EE_r110.hex V200EE_r105.hex V300EE_r104.hex



Appendix B - Manitou Sevices Descriptions 459

© 2009 Bold Technologies Ltd.

Appendix B - Manitou Sevices Descriptions

Dates on Services

With the exception of the Standard Service all other services may have a start and end date. 
The Manitou application will enable and disable those services based on those dates.

Standard

The Standard service (previously Alarms Only) is used to define an account in Manitou.  If
there is a customer account in Manitou it should have the Standard service.  This simply
makes sure that the programming is enabled for the record.

User Defined Services

This service can be added multiple times provided the description name is changed to
something different each time.  This is provided to the monitoring company to add services
they offer that are not listed in Manitou’s default services list.

Open/Close

The Open/Close service turns on the Schedules and enables the monitoring or recording of
openings and closings of the system.  When this service is set to Monitor any exceptions will
trigger alarm events requiring some sort of operator intervention.  When this service is set to
Record no events, exception or not, will trigger alarms.  Exception events can be reviewed
through the activity log and reporting.

Fire Test

The Fire Test service is for Fire systems that want to separate out the Test and standard
service.  This doesn’t turn any other functions on or off within the application it just for
reference purposes only.  This service, like all others, can be flagged as chargeable.

Executive Protection

This service is designed for personal protection services.  This does not turn on any other
functions within Manitou.  Generally how Manitou would track executive protection would
most often be through a schedule where the application would expect a “check-in” at certain
times of day.  If no “check-in” happened (operators would send in a manual signal when they
received the telephone call) the system would then generate a “late-to” signal and the operator
would then attempt to contact the protection agent and the protected person.  If they were
unable to contact them they would then dispatch to the last known location.

Lone Worker

This service is designed for someone like a door-to-door sales person that works a route or
region alone, or a person that works in a business alone.  Like Executive Protection generally
how Manitou would track lone worker would most often be through a schedule where the
application would expect a “check-in” at certain times of day.  If no “check-in” happened
(operators would send in a manual signal when they received the telephone call) the system
would then generate a “late-to” signal and the operator would then attempt to contact the
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worker.  If they were unable to contact them they would then dispatch to the last known
location.  

Log Only (All Signals Logged)

This service will override all other services on the account.  This would most often be
utilized when an account is either not yet ready to receive live signals or has reached its
contract end date and has not yet renewed.  This is used to override the existing services
without having to remove the services.

Transmitter Test

The Transmitter Test service enables the Transmitter Test interval on the Transmitter form
within the customer record.    The default test interval set when this service is selected is
seven days.  This service is most often utilized to ensure that the transmitter is indeed
functioning every day, week, or month.  If the system doesn’t receive its expected test or
qualifying signal within the test period the system will then generate a Late to Test alarm.

Dual Signaling

The Dual Signaling service is used when an account has two transmitters and one backs up
the other.  For example, a telephone line transmitter may be backed up by a radio transmitter. 
Obviously, the monitoring company doesn’t want to have to deal with two alarms each time
so it is possible to link the two signals together through transmitter programming.  If the
telephone line alarm comes into the system it waits for the radio signal for a defined period of
time and if the radio signal does not arrive the system gets an additional alarm stating that the
alarm was missing its dual signal.  If the radio signal does arrive the one becomes a signal and
the other becomes the alarm.

Two Trip Signaling 

The Two Trip service turns on the programming commands to enable the ability to wait for a
second alarm before triggering an alarm.  This would be used most often when a door contact
may not be the most secure so the customer wants to wait for a secondary zone to trigger
before generating an alarm.  This requires some very specific programming and the signals
themselves must have the ability to participate in two trip signaling.  Please refer to the
advanced programming commands for more information.

Entry/Exit Delay

The Entry Exit Delay service is used when a person may take longer than the standard length
of time and/or trigger multiple zones prior to reaching the key panel to disarm, or exit, the
location.  

Reports

This service does not turn anything on or off within the Manitou application it is for tracking
or display purposes only.

Audio Monitoring

This service does not turn anything on or off within the Manitou application it is for tracking
or display purposes only. 
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Video Monitoring

This service does not turn anything on or off within the Manitou application it is for tracking
or display purposes only.

UL Account

This service enables the UL features for the customer record.  UL is for United States and
Canada and refers to specific response times required for certain alarms.

Verify Open/Close User

This service is designed for the system to bring open and close signals to the operator’s
attention so that the Open and Closing users are verified.  It is important that there is an
appropriate action pattern applied to these open and close signals so that the Police authorities
are not contacted unless the verification is not successfully completed.

Guard Tour

The Guard Tour service enables the advanced programming commands and is designed so
that when a guard on a property does their tour of the property they trigger specific zones in a
specific order.  If they do not trigger the zones in order or miss a zone, this will generate an
exception at the monitoring company.  This requires some very specific programming and the
event codes themselves must be programmed for inclusion in a guard tour.  Please refer to the
advanced programming commands document for additional information.

Maintenance Services

This service does not turn anything on or off within the Manitou application it is for tracking
or display purposes only.

Appendix C - Entry/Exit Programming

Entry/Exit Delay

This command is used when signals are sent prior to an Opening signal, and after a Closing
signal (and the panel does not itself handle Entry/Exit delays). The following rules apply to
the Entry/Exit Delay process: 

· Entry/Exit Delay service must be selected on the Services tab of the Customer record in
order to utilize this command. Time out must be reasonable for the individual site and
must be greater than zero.

· Open/Close service must also be selected for the Customer record. If a signal with this
command is received while the area is closed and within an opening window, the signal
does delay (doesn’t  drop  into the alarm queue) waiting for the Opening signal. If the
opening signal arrives within the prescribed period of time set on the Entry/Exit Delay
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service the alarm can be canceled and, if desired. If the Opening signal is received
within the timeout period, the delayed signal is ignored. If a signal with this command is
received within timeout seconds after a recent closing signal, the received signal is
ignored, providing the status is new or new/suspended. 

· The area upon which the signal is to be received must have an Open/Close schedule
attached to it.

Entry delay processing will only work when it is within a scheduled Opening window. Exit
ignore processing will always happen following a Closing (scheduled or not). It is possible to
set up a schedule such that an Opening or Closing can happen at any time. However, it is
important to realize that any signals flagged as being Entry/Exit signals will always be
delayed for the entire Entry/Exit delay time  always (since it could be followed by an Opening
signal). We do not recommended that an 'Anytime Access' schedule be used for that reason. It
should have some reasonable start and end boundaries to the window.

Schedule Examples

Open/Close at anytime (not recommended)

The following schedule will cause the Entry delay process to happen at any time (can open at
any time):

Mon 00:00 May Open/Close
Tue 00:00 May Open/Close
Wed 00:00 May Open/Close
Thu 00:00 May Open/Close
Fri 00:00 May Open/Close
Sat 00:00 May Open/Close
Sun 00:00 May Open/Close

Open/Close with no Late-to for Open or Close
The following schedule allows any access between 6am and 11pm (no Late-To for Open or
Close):

Mon 06:00 May Open/Close
Mon 23:00 No Activity
Tue 06:00 May Open/Close
Tue 23:00 No Activity
Wed 06:00 May Open/Close
Wed 23:00 No Activity
Thu 06:00 May Open/Close
Thu 23:00 No Activity
Fri 06:00 May Open/Close
Fri 23:00 No Activity
Sat 06:00 May Open/Close
Sat 23:00 No Activity
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Sun 06:00 May Open/Close
Sun 23:00 No Activity

The 'No Activity' action in the above schedule could be replaced by 'Must Close' which would
then generate a Late-To-Close alarm to ensure that the system is armed by that per normal
Open/Close scheduling. Opening and Closing signals will automatically be processed as if
they were part of an Entry/Exit cycle - no Entry/Exit() command function should be
designated, the Open or Closing signals do not need any special soft programming options
apart from the ones that signify that it is an Opening or Closing signal.

Signal Processing Commands

m – Entry/Exit
Signifies that this event can participate in Entry/Exit delays. The signals that will participate
in this process to must also contain the Signal Processing attribute of “m”

n – Delete alarm if it is canceled
If ‘c,’ ‘d,’ or ‘e’ is true then this option tells the signal handler to delete the alarm if it has
been canceled when the alarm state is new or new/suspended. If the desired outcome is to
remove this alarm from the alarm queue if the closing occurs within the prescribed time
period then the n command is also required.

Note: These attributes are not set on any events by default to ensure that each company sets
them based on their specific company practices and make a reasoned decision before using
this feature.

Service Setting
Enter the delay time (in seconds) in the Delay Time field under the Service, as shown below:

Programming
The specific signals to be delayed (the ones that normally get tripped as a part of entering the
building in order to access the keypad/panel to disarm the system) must have the Entry/Exit()
programming function attached to them. This includes any restore signals. TwoTrip() cannot
be used in conjunction with any E/E signal - TwoTrip will cause E/E to be ignored. The Event
Definitions for the signal types to be delayed must have the 'm' soft programming option
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enabled. 

Example: Burglary Alarm

m – Entry/Exit
Signifies that this event can participate in Entry/Exit delays

n – Delete alarm if it is canceled
If ‘c,’ ‘d,’ or ‘e’ is true then this option tells the signal handler to delete the alarm if it has
been canceled when the alarm state is new or new/suspended.
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Example: Open Signal

m – Entry/Exit
Signifies that this event can participate in Entry/Exit delays
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Example: Close Signal

m – Entry/Exit
Signifies that this event can participate in Entry/Exit delays

Entry Type

The final piece is the entry of the right Entry/Exit Delay Type (EntryExit() command
parameter) on the signals. With the current implementation, the following examples describe
the required Delay Types needed:

Type numbers
1 – Signifies the Start of Entry, but Intermediate for Exit.
2 – All other signals
3 – Any part of the Entry/Exit process
4 – Intermediate for Entry, but Final for Exit
5 – Start of Entry and Final for Exit

Openings
The first is for systems that reports restore on the initial entry point (perimeter burg from the
door being opened):

BA zone <x> signal: E/E Delay Type = 3 - this is the alarm signal when the
door is opened
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BR zone <x> signal: E/E Delay Type = 3 - this is the restore for the above
signal <any other zones and restores that would be received as part of a normal
Open/Close cycle would be Type = 2>. The reason for the above types is because on the entry,
the BA for the door is the first signal received.

Closings
On the way out (Closing cycle), the BR for the restore of the door is the last signal received.
With this programming, the Exit delay is not terminated upon any particular signal, it must
expire. If the BA is set to Type = 1 and the BR is set to Type = 2, then the final BR restore on
the way out will be in Customer Activity as a Signal and not Ignored (Activity will show
Closing followed by the Restore).

BA zone <x> signal: E/E Delay Type = 1 - this is the alarm signal when the
door is opened 

BR zone <x> signal: E/E Delay Type = 4 - this is the restore for the above
signal <any other zones and restores would be Type = 2>. This would then terminate the Exit
cycle upon receiving the restore signal. Any further signal would be an alarm (unless it is in
an Opening window which might start a new Entry cycle).

New Functionality

The second example is for systems that do not report a restore on the door alarm. This is not
recommended. The restore will ensure that the front door closed on the way out. The first
example should also have RestRq() command on the door alarm with a timeout value in order
to enable an Unrestored alarm event should the door not close all of the way and Restore()
property on the restore event (should be automatic based upon the restore signal's event
definition's signal processing attirubtes):

BA zone <x> signal: E/E Delay Type = 1 - this is the first and last signal
<any other zones and restores would be Type = 2>

Activity Log Example
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Appendix D - Delaying Signals for Future Handling

The purpose of this document is to provide information on how to delay signals such as AC
failure or power outages so that the operator is not overwhelmed with activity. 

In a central station there are some scenarios where acting on an event immediately when it
happens is neither desirable or in the best interests of the customer or the central station. Most
often these signals are trouble signals coming from a sensor such as an AC or power failure.
The purpose of this document is to show one method of delaying a signal or creating a
secondary event that can be acted upon. 

Delaying Signals with Restore Overdue

Methodology of a Restore Overdue 

In the case of an AC failure or power loss, a central station can program the Manitou system
to not treat the failure as an alarm but instead system handle the signal. A command can be
created to require a corresponding restoral within a specific time period be received or an
overdue signal will be generated. In this case the operator does not handle the actual event,
but instead acts upon a overdue signal that corresponds to the original power failure. 

This option prevents the alarm queue from displaying any traffic other than the signal that is
generated from restorals not being received. 

Setting the Overdue Option

This option is needs to be set per customer. If this option is not set, an overdue will not be

generated. To access the option, edit the customer and select the "Transmitters" option from

the Jump To menu. You will need to select the "Generate Restore Overdues" option.
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Transmitter Programming for the Restore Overdue

The first step of programming for a Restore Overdue is to setup the transmitter programming.
The following diagram shows the completed programming. The first line shows the
programming for an AC trouble. After you have entered the basic programming it is necessary
to add the RestRq command to the command programming. 
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Command Programming for the Restore Overdue

Command Programming is where the magic begins to happen. The Restore Required
command (RestRq) tells the Manitou system that this signal needs a restoral in a specific
amount of time. The options are: 

Event 
The event is the code that can restore the alarm. You can use the "*" to have any signal restore
the alarm, but in most cases you will want a specific event code that will act as the restoral
signal. In our case this is AR for an AC Restoral. 

Zone 
If you want to be specific, you can enter the zone for the signal that you want the restore
signal should come from. Entering a "*" will allow any zone. If you want the same zone that
came in with the AC failure you can use the "=" to represent it. 

Timeout 
This is the number of minutes before a restore overdue is generated. If you want operators to
handle the alarm an hour after the original signal came in, you would set this to 60. You need
to have the Generate Overdue Restores option turned on for this to work.
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Restored 
Indicates if the alarm zone or all zones are required to be restore in order to close the alarm. In
some cases you may want to turn this on so that the operator cannot close the generated alarm
until the restore has been received.

 

Event Actions Programming for the Restore Overdue

Since we do not want to handle the actual AC Trouble, we have added a line of programming
to the Event Actions to make the AC Trouble system handled. With this done, the basics of
the restore overdue have been completed. 
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Other Considerations for the Restore Overdue

Some central stations may find that the default priority of the Restore Overdue (*RO) may be
too low for the event generated. This can also be changed through the transmitter
programming. By using the Pri() command it is possible to change the priority. The Pri()
command has one option which is the new priority of the alarm. 
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What the Operator Should See for the Restore Overdue

The following screen shots show what an operator should expect with a Restore Overdue:
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Programming at the Transmitter Level

Users can make this programming more global by adding the commands to the Event
Programming on the Transmitter Types. Users still need add the option for Generate Restore
Overdues to each account. Users will also need to add the transmitter type to each account
that you want to have the programming. 

UL Required Signal Priorities

Alarm Priorities in Manitou are based on UL requirements as follows:

Priority Alarm Type

1 Fire

2 Panic or Hold-up

3 Medical

4 Industrial supervision if a danger can result

5 Burglary
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6 All other

Manitou System Configuration

Core Server Components

Manitou is not a single application. It is actually a collection of components working in
concert to accomplish the complicated task of central station automation. These components
can be Windows applications or Windows services. Collectively they create the Manitou
System. There are eight core components of Manitou required by every Manitou System.

· Database

· Broker

· Sentry

· Application Server

· Front End Processor (FEP)

· Marshaller

· Signal Handler

· Watchdog

Database

Manitou uses Sybase Adaptive Server Enterprise for data storage. Future versions of Manitou
will include support for Microsoft SQL Server.

Broker

The Broker serves as the heart of Manitou. It controls communication between the other
components, holds global information, manages alarms tracking and controls record locking.

Sentry

The Sentry controls access to Manitou by validating a users basic access, priority and
permissions. The IP address of the server running Sentry is the only published IP address to
the system. Upon receiving an authentication request it returns an access token and the IP
address of the Application server to the client software. This allows Sentry to load balance
between multiple Application servers.
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Application Server

The Application Server works on behalf of the client to access the database, apply business
rules and cache data.

Front End Processor (FEP)

Each FEP communicates with multiple receivers. Signals are then translated from various
incoming formats to a standard format used by Manitou. Each signal is also stored locally on
the hard drive. This prevents lose of signals due to failure of other system components.

Marshaller

The Marshaller controls the distribution of signals to the Signal Processor. It ensures that time
dependant signals are sent in the correct order, and reports processing times to the Signal
Handler.

Signal Handler

The Signal Handler takes incoming signals from the Marshaller and manages proper insertion
to the database.

Watchdog

The Hardware Watchdog connects to Manitou to provide audio and visual alerts
corresponding with Hardware failure, software failure or predefined system triggers.
Hardware Watchdog alerts correspond with the Watchdog messages displayed in the status
area of the Manitou Client and Supervisor Workstation. For example, failure of any
system-critical component will trigger the hardware watchdog to beep and light one of the
three component-related LEDs. Operators use the switch on the front of the hardware
Watchdog to reset each time an alert sounds. The fourth LED monitors a constant heartbeat
signal between the hardware and software Watchdog components. If that signal is not
received on the expected interval, the hardware Watchdog will emit a beep and the fourth
LED will light up.

Optional Server Components

Publisher

Manitou’s Publisher distributes all information external to the central station. This may
include alphanumeric or numeric pages, faxes, email, or printed reports.

Voice Response Terminal (VRT)

Supervisor Workstation

One or more Supervisor Workstations will be required to configure and manage the Manitou
System. Supervisor Workstation allows administrator level access to system options. It also
receives Watchdog reports and signal handling statistics.
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Manitou Client

One Manitou Client will be required for each central station operator as well as any data entry
personnel. The Manitou Client provides for data entry and alarm processing.

System Scalability

One of the principal goals of Manitou is scalability of the system. Adding additional hardware
enables it to expand from a small single user system to a system capable of handling a Super
Central Station. Manitou components can be grouped differently to support systems of
different sizes. This means that having to throw away hardware is a thing of the past. If you
need more computing power you simply separate a task and put it on its own server. 

Sample Configurations

The following examples will illustrate three different base systems. All base systems will
include the eight Manitou core components as described in the first section above. Optional
server components can be added to any base configuration.

Key

The following abbreviations will be used in all diagrams.

Abbr. Description

DB Database Server

AS Application Server, Sentry, Broker

SH Signal Handler, Marshaller

RS Report Server

PU Publisher

FEP Front End Processor

WD Watchdog

VRT Voice Response

RAS Web Server, SMTP Mail Server, Microsoft Terminal Services

† Optional

* Backup

Non-redundant Base System

Suitable for the small central station or proprietary system, the non-redundant base system is
the most basic Manitou configuration (Fig. 1). For systems with less than five receiver lines
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the FEP may be installed on the Application Server. 

Fig 1

Minimum System Requirements

Application/Database Server

(1) Intel Pentium III 1GHz processor

(1) 1GB RAM

(2) 18GB hard drives with RAID 1

(1) CDROM drive

(1) Floppy disk drive

(2) Redundant power supplies

FEP Server

(1) Intel Pentium III 500MHz processor

(1) 256MB RAM

(1) 20GB IDE hard drive

(1) CDROM drive

(1) Floppy drive

Workstations
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(1) Intel Pentium III 500Mhz processor

(1) 256MB RAM

(1) 20GB IDE hard drive

(1) CDROM drive

(1) Floppy drive

(1-2) 19” monitor(s)

(1) Sound Card (SoundBlaster Pro or Compatible)

(1) Pair PC Speakers

Serial Concentrator

(1) Digi EtherLite 80 (Provides connections for up to eight receivers) 

Ethernet

10/100baseT Ethernet hub with enough ports for each server, workstation and serial
concentrator plus room for growth

Cat 5 twisted pair wire to each server, workstation and serial concentrator

Redundant Base System

Manitou is a mission critical system capable of taking full advantage of redundant servers (
Fig 2). The redundant base system configuration is the solution for larger central stations or
those wishing to obtain Underwriters Laboratories (UL) certification. 
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Fig 2

Minimum System Requirements

Application/Database Servers

(1) Intel Pentium III 1GHz processor

(1) 1GB RAM

(3) 18GB hard drives with RAID 5

(1) CDROM drive

(1) Floppy disk drive

FEP Servers

(1) Intel Pentium III 500MHz processor

(1) 256MB RAM

(1) 20GB IDE hard drive

(1) CDROM drive
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(1) Floppy drive

Workstations

(1) Intel Pentium III 500Mhz processor

(1) 256MB RAM

(1) 20GB IDE hard drive

(1) CDROM drive

(1) Floppy drive

(1-2) 19” monitor(s)

(1) Sound Card (SoundBlaster Pro or Compatible)

(1) Pair PC Speakers

Serial Concentrator

(1) Digi EtherLite 160 (Provides connections for up to sixteen receivers) 

Ethernet

10/100baseT Ethernet switch with enough ports for each server, workstation and serial
concentrator plus room for growth

Cat 5 twisted pair wire to each server, workstation and serial concentrator

Expanded Redundant System

As your central station grows Manitou will grow with you. The addition of servers allows you
to scale the system smoothly without jeopardizing your existing investment in hardware.
Additional application servers can be added to support larger numbers of operator
workstations. Placing the database on separate servers allows for greater performance (Fig 3).
Servers may also be equipped with additional RAM and hard drives to improve performance
of an individual server.



Manitou System Configuration 483

© 2009 Bold Technologies Ltd.

Fig. 3

Minimum System Requirements

Application/Database Servers

(2) Intel Pentium III 1GHz processor

(1) 2GB RAM

(3) 18GB hard drives with RAID 5

(2) 18GB hard drives with RAID 1 for operating system



Manitou Client 1.5.2484

© 2009 Bold Technologies Ltd.

(1) CDROM drive

(1) Floppy disk drive

FEP Servers

(1) Intel Pentium III 500MHz processor

(1) 256MB RAM

(1) 20GB IDE hard drive

(1) CDROM drive

(1) Floppy drive

Workstations

(1) Intel Pentium III 500Mhz processor

(1) 256MB RAM

(1) 20GB IDE hard drive

(1) CDROM drive

(1) Floppy drive

(1-2) 19” monitor(s)

(1) Sound Card (SoundBlaster Pro or Compatible)

(1) Pair PC Speakers

Serial Concentrator

(1+) Digi EtherLite 160 (Provides connections for up to sixteen receivers) 

Ethernet

10/100baseT Ethernet switches with enough ports for each server, workstation and serial
concentrator plus room for growth

Cat 5 twisted pair wire to each server, workstation and serial concentrator

Replication to Multiple Sites

In addition to replicating data between the primary and backup servers, data can be replicated
to a remote site for additional protection (Fig. 4). Server specifications are the same as for the
redundant base system. 
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Fig. 4
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Replication Switchover Procedure

These procedures will assume a switch from System 1 to System 2 in the case that System 1 is
initially the active server. To switch from System 2 to System 1 you must reverse the
references to MANAPP1 and MANAPP2 in all instructions.

The following instructions detail the Switchover procedure on a Manitou System in a Sybase
database and Sybase Replication Server environment. Procedures for both the Replication
Switchover Tool and a Manual Switchover are provided below.

Before beginning the Switchover, stop all connections to the active database, Log out of all
clients and stop the services in the MSM. The FEP will buffer signals during the Switchover
and therefore does not need to be stopped. 

Using the Replication Switchover Tool - RepSwitch.exe

Stop Connections to the Database

1. Open the MSM on the active server (MANAPP1). 

2. Right-click on the Broker and select Stop. 

3. Wait for all lights to turn red. 

4. Close any open windows (MSM, Logger, LogMonitor.exe) 

Switch Database Replication

1. Open the Replication Switchover application on MANFEP2. 

2. Select the active system from the server list. 

3. Click on Switch. 

4. Wait for the Switch Complete message and click OK. 

5. Click Who to verify that no replication services are down. The command prompt
window should show the underlined header information, but no additional information
should appear under that. 

6. Use any key to close the command prompt window. 

Start the Other System

1. Open the MSM on the standby server (MANAPP2). 

2. Make sure that (System 2) is selected in the drop-down menu at the top of the
window. 
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3. Right-click on the Broker and select Start All. 

4. Double click the Logger icon on the desktop. 

Switch the FEPs

1. In the MSM right-click on FEP1 and select Stop. Wait for the light to turn red. Then
right-click again and select Start. 

2. Repeat above step for the FEP 2 service. 

3. If applicable, follow the procedures to stop the Demonstration Receiver on
MANFEP1. 

Finish the Switchover

1. Start the Publisher by double-clicking the desktop icon on the new standby server
(MANAPP1). 

2. Confirm that operators can log in from each workstation. 

3. Verify that the system is receiving and processing signals. 

Manual Switchover Procedure

The manual Replication Switchover procedure below includes all steps necessary to to make
the active database the standby and the standby database the new active database without
having to use the RepSwitch.exe tool.

1. Use Sql Advantage and connect to the active database server and the active database,
for example: 

MANAPP1 and MANITOU

2. Run the following sql command to stop the replication agent running against the
active database: 

sp_stop_rep_agent MANITOU

3. Select Start>>Run and type in cmd to bring up a command prompt window. 

4. Within the command prompte window, log into the replication server with the
following command: 

Isql –S NTREPSERV –U sa <ENTER> 

5. The password is blank so hit <ENTER> again

6. At the prompt type in the switch command: 
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Switch active for MANREP.MANITOU to MANAPPBACK.MANITOU <ENTER> GO
<ENTER> 

7. A message will appear that the system is in the process of switching the connection.

8. Next, type in the following command to tell the replication agent to wait (suspending
replication) until the standby database (formerly the active database) is back on line:
wait for switch for MANREP.MANITOU <ENTER> 

9. GO <ENTER>

10. Use Sql Advantage and connect to the new active database server and the active
database for example: 

MANAPP2 and MANITOU

11. Run the following sql command to start the replication agent for the new active
database: 

sp_start_rep_agent MANITOU 

12. Return to the command prompt window still logged into the replication server. Type
in the following command: 

resume connection to MANAPPSERV.MANITOU <ENTER> 

13. GO <ENTER>

14. Next, check the status of the Replication server by using the following command in
the command prompt window: 

Admin who_is_down <ENTER> 

GO <ENTER>

There should be nothing but the header lines. This means that replication is up and active. The
services in the MSM on the new active server can be started, and clients may reconnect. 

Manitou Remote Access

Remote access to Manitou through the Internet must be properly configured to provide
adequate safety of the data. 

· The remote access server should be isolated from the rest of the Manitou system in a
perimeter network (DMZ) by a hardware based firewall. 

· The firewall should be commercially available from a reputable vendor. Examples of
an adequate firewall include:
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· Cisco PIX

· Checkpoint FW

· SonicWall Pro 

· Access rules should be in place on the firewall to prevent any inbound connection
other than the necessary TCP ports required by Manitou. 

· These ports should only be accessible only by the remote access server. 

· No inbound access should be available to the Manitou system from the
Internet.

· The remote computer should be connected to the Internet by an access device that
provides protection from the Internet. 

· At a minimum the device should provide Network Address Translation (NAT)
and a private IP address to prevent inbound connection from the Internet. 

· This device may also include full firewall capability. 

· The remote computer should be password protected including a password protected
screen saver.
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UL Alarm Handling Summary - Operation

LOG IN AND RECEIVE NEW ALARM

An Operator logs into the Manitou Client and brings up the Alarm Handling screen, either by
clicking on the icon or by selecting Operations>>Alarm Handling. The “New Alarms”, “
Viewed Alarms”, and “Auto-Get Alarms” under “Operations” should already be selected
(there are check marks by those options).

A newly arrived alarm appears on screen – for this example, it’s a Fire Alarm.
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CHECK STATUS

The Alarm Handling screen shows the customer’s current status in the upper right corner. Use
the radio buttons to switch between Status and Comments screens. At the very bottom of this
pane is a Notes tab that should be checked. If it’s yellow, there’s a note associated with this
customer. To view more customer information, click the other tabs, scroll through the
Customer Log for signal details, or click on the Customer Info and/or Dealer info buttons on
the left.

PERFORM ACTIONS

The Action Pattern associated with a Fire Alarm for this customer is directly under the
Customer information on the Right side of this screen. The first item has an arrow to the left
of the line and is ready to be “actioned” – ‘Contact customer using Call List ‘Customer Fire
(CFR)’. 

There are three ways to start working on the action:

1. Press the ‘d’ key on the keyboard (for “do”) 

2. Use the mouse to select ‘Do’ from the tool bar. 

3. Double-click the first line of the action pattern. 

The Operator will use one of these three methods to perform each action within the action
pattern list and sub-lists.
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Double-Clicking the first item, “Contact customer using Call List Customer Fire (CFR)”
opens a sub-list with three items – Contact the customer, contact the Fire Department and
contact the primary Keyholder. Double-clicking on the first item opens the Auto-Dialer,
connecting Manitou to the phone system, and dialing out to make the first contact. The
customer tells the Operator that the Fire Alarm signal was a false alarm, and gives a password
to verify this information. Click ‘Finish’ to close the auto-dialer window. Type the customer’s
password into the first field, click Enter to validate, and type comments into the text field.
Check the boxes for Cancel Alarm and Close Alarm. Use the drop-down fields to select a
Resolution Code – in this case ‘FA’ for False Alarm. Click ‘Validated’ and the alarm is
closed. All comments are entered into the Customer Log. The Operator is returned to the
Alarm Handling screen and is available to receive the next alarm in the queue. 

ADDITIONAL INFORMATION

In the above example, the Operator did not need to contact and dispatch the Fire Department
or contact the Dealer (the second and third items on the Call List). Instead, the system closed
the alarm and recorded the information that it was a False Alarm.

In other situations, where there are multiple contacts to make or actions to perform, each
contact will be handled similarly until every contact or action in the action pattern has been
completed. If a contact is unavailable or unreachable, the system or the Operator will note that
before moving on to the next action. If necessary, the Operator may use the ‘View All
Contacts’ radio button (next to Action Patterns) to select other contacts, or get alternate
numbers.

Deferred Alarms

If the alarm is not handled within the required time-out period (varies for each alarm type) the
system will prompt the operator that the alarm is about to be deferred. A deferred alarm
returns to the queue and is forwarded to the next available operator. An operator who is busy
may choose to manually defer an alarm, to allow another Operator to handle it.

Suspended Alarms

An operator may also choose to suspend an alarm, if necessary while performing other tasks.
Selecting Hold>>Suspend brings up a prompt box. The operator selects the time period for
which the alarm will be suspended. When that time expires, the system prompts the Operator
again to handle that alarm.
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